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Welcome to the Torrent Suite™ Software
Help System

This help system provides instructions for using the Torrent Suite™ Software to:

• Upload or create samples
• Execute and monitor the status of runs on an Ion S5™, Ion S5™ XL, Ion PGM™, or

Ion Proton™ sequencer.
• View data, results, and QC reports after a run
• Download data files for all results from a run
• Use a variety of plugins to extend the capability of Torrent Suite™ Software
• Create and manage user accounts
• Manage and archive data for future use
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Introduction

Torrent Suite™ Software provides an integrated environment to manage your
sequencing instrument runs and the resulting sequencing data.

The Torrent Browser is organized according to the three main phases of the
sequencing lifecycle:

• Plan — The Plan tab contains both templates (reusable experiment designs) and
planned runs (executable instructions for individual sequencing runs). Choose
the experimental design for a template that can be reused many times for
sequencing runs. Template details include application, reference, BED files,
project, plugins, and the export destinations for results files.

• Monitor — View the status of your system and running jobs, including
thumbnail quality graphs for current runs. The quality graphs provide near real-
time information on your runs, so that you know early on about any instrument
issues.

• Data — View summaries of completed runs, detailed run reports, and plugin
results. Also download output files, download the run report, review the planned
run settings, and group result sets into projects for data management such as
archiving or pruning of result files.

Templates are organized by sequencing application (and by product for some
applications):

Table 1   

Sequencing application Description

AmpliSeq For Ion AmpliSeq™ applications (DNA, RNA,
and exome), including the Ion AmpliSeq™

Any Genome, and Custom Ion AmpliSeq™

panels.

DNA and Fusions For Ion AmpliSeq™ applications such as
Colon and Lung Research Panel v2.

Generic Sequencing For your own applications that do not fit in
the other categories. Here you provide all
the choices for the experiment. Your
choices are not restricted based on a
common application workflow.

Oncology - Liquid Biopsy For your liquid biopsy oncology research
panels.

Pharmacogenomics For Ion AmpliSeq™ Pharmacogenomics
Research Panels imported from
Ampliseq.com.

Torrent Suite™ Software Help 17



Sequencing application Description

RNA Seq For RNA sequencing applications.

TargetSeq For TargetSeq™ applications, with
parameters optimized for hybridization-
based target enrichment.

Whole-Genome Seq For whole genome sequencing applications,
such as Ion ReproSeq™ Aneuploidy, which
do not assume enrichment and do not
require a target regions file.

16 S Target Sequencing For the Ion 16S™ Metagenomics kit.

User versus Administrator roles

In Torrent Suite™ Software, the User role allows the creation and execution of planned
runs on a sequencing instrument. The Admin role also allows the creation and
execution of planned runs, but also allows server configuration, user configuration,
base caller configuration, reference management, and data management. For more
information on Administrator tasks, see the “Software Administration and Data
Management“ on page 379.

Plan a run

These steps describe how plan templates and planned runs fit into your Ion S5™, Ion
S5™ XL, Ion PGM™ or Ion Proton™ sequencing workflow:

1. Decide on your sequencing application and sequencing product (such as an Ion
AmpliSeq™ panel).

2. Select a pre-installed template with defaults for your application and sequencing
product, or you create your own template from scratch. You customize your
template.

3. Create new planned runs from your templates, adding the names of the samples
to be sequenced.
The Torrent Browser assigns your new plan a run code.

4. Enter the run code directly on the Ion sequencing instrument to initiate the
sequencing.
The planned run automates the process from sequencing through data analysis
and data handling.

Plan templates and planned runs allow you to enter run information via the Torrent
Browser rather than directly on the Ion sequencer. The use of templates and planned
runs reduces the chance of error and wasted runs, reduces setup time on the
sequencing instrument, and increases instrument throughput.

On the sequencer, information for a planned run is applied to the current Run Info
screen by entering the planned run's short code or by selecting the planned run from a
menu list of planned runs. You can optionally overwrite (change) planned run
information directly on the sequencer.

Introduction
User versus Administrator roles
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Register for a new account

Each new account requires administrator approval and it not active until approval is
granted.

Follow these steps to register for a new user account:

1. On the login page, click Register.

2. Fill out the new user form and click Submit.
Your account is created, pending administrator approval.

Introduction
Register for a new account
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Samples and Sample Sets

Samples and Sample Sets can be set up prior to run planning or during run planning.

In the Plan4Samples screen you can:
• Enter samples manually
• Create sample sets manually
• Import samples and sample sets
• Manage sample attributes

Enter new sample

1. In the Plan4Samples screen, click Enter Samples Manually.

2. Click Enter New Sample.

3. In the Add Sample dialog, complete all required fields (marked "Required" in
software); click Done.

Field Description

Sample Name Must follow Ion Reporter™ sample name
restrictions: A unique identifier
representing the sample, containing only
alphanumeric characters (0-9 and A to
Z0, periods(.), underscores(_), or
hyphens(-). If the actual sample name
already exists in Ion Reporter™ Software,
a string such as _v1 or _v2, etc., is
appended to the sample name.

Sample External ID A field for your own use.

Gender The gender of the sample: Male, Female,
or Unknown. Do not leave empty. Select
Unknown if the gender is not known.

Description A field for your own use.

Type The Ion Reporter™ Software relationship
type for this sample.
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Field Description

Relationship Group The Group number in the sample set.
Defines related samples, the same as
Set ID in the IonReporterUploader
plugin.

Additional fields If you create sample attributes, each
attribute has its own field in the popup
and in the CSV file. Attributes that are
marked as mandatory must be entered
for each sample. If you create an
attribute of type Integer, only numeric
characters (whole numbers) can be
entered into the field for that attribute.

Your new sample is now available in the Samples list.

Create sample sets manually

1. In the Plan4Samples screen, click Enter Samples Manually.

2. Click Enter New Sample.

3. Click Done. Your attributes appear on the Enter Samples table.

4. Enter additional samples.

5. (Optional) If you have sample pairs, set Relationship Group numbers to reflect
pairs. For example, DNA and RNA samples from the same sample would have
the same Relationship Group number.

6. Click Save Sample Set.

7. Name Sample Set or add samples to an existing sample set.

Import samples to create a sample set

If you have a large number of samples, you can use the sample import feature to
facilitate sample creation.

Note: New in version 5.2, the Sample File Format CSV template has a top row that
indicates the version of the template. If you are using sample CSV files you created in
past versions of the software, you will need to create a new CSV file with a new

Samples and Sample Sets
Create sample sets manually
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template downloaded in v5.2. Just copy and paste the contents of your existing
sample CSV file into the new template under the version row.

1. Click Sample Sets4Import Samples from File.

2. Click the Sample File Format button to download a CSV template.

3. Fill out the CSV template fields: Sample Name, Sample ID, PCR Plate,
Barcodekit, Barcode, and other relevant information, and save it to your
computer.

4. Click Select File to upload it.

5. Click Add Sample Set, then enter a Sample Set Name, Group Type, and (optional)
description. Click Save & Finish.
The software automatically imports the samples into the Sample Sets table.

This example shows a trio sample set and how the run plan reads the sample set
information for Ion Reporter™ Software users.

In the sample set

A trio sample set, named Example Sample Set, is shown in the main Sample Sets
listing:

Example use of a
sample set

Samples and Sample Sets
Import samples to create a sample set
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Click the expansion arrow to the left of the Example Sample Set entry to open the
details for the sample set:

The sample set contains three samples that are related and eventually will be
analyzed as related samples in one Ion Reporter™ Software analysis.

• The Type column contains the Ion Reporter™ Software relationship type
information.

• The Group number is the sample set mechanism to mark the samples as related.
(Related means that in the eventual Ion Reporter™ Software analysis, these
samples are analyzed in one analysis with a defined relationship between the
samples, such as Tumor and Normal.)

Sample attributes

You can add fields to samples for sample management. Attributes that you create
appear in the sample listing, in the Add Sample dialog, and in the CSV file used to
import sample information.

An attribute can be made mandatory, in which case it must be entered with every
sample.

Note: Even though you create an attribute on the Sample Set page, the attribute is
applied to each individual sample that is currently a member of the sample set. The
attribute is not applied to the sample set itself.

Samples and Sample Sets
Sample attributes
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To create a new sample attribute, select Sample Attributes4Add.

In the popup, enter the attribute name, type, and description. If you want the attribute
to be required with every sample, select the Is Mandatory checkbox.
If the Attribute Type is set to Integer, you can only enter numeric characters (whole
numbers) for this attribute.

If you hide an attribute, that attribute no longer appears in sample listings or in the
Add Sample popup. If you hide a mandatory attribute, that attribute is no longer
mandatory.

You hide a sample attribute in the attribute manage page. From the main Samples tab,
select Sample Attributes4Manage.

In the Sample Attributes page, select the Show/Hide option in the gear menu:

Add a sample
attribute

Hide a sample
attribute

Samples and Sample Sets
Sample attributes
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This table describes the fields in the Add Samples dialog. The same fields are used in
a CSV file that is imported to create samples.

Field Description

Name Must follow Ion Reporter™ Software sample
name restrictions. If the actual sample
name already exists in Ion Reporter™

Software, a string such as _v1 or _v2, etc.,
is appended to the sample name.

External ID A field for your own use.

Gender The gender of the sample: Male, Female, or
Unknown. Do not leave empty. Select
Unknown if the gender is not known.

Description A field for your own use.

Role The Ion Reporter™ Software relationship
type for this sample.

Relationship Group The Group number in the sample set.
Defines related samples, the same as Set
ID in the IonReporterUploader plugin.

Additional fields If you create sample attributes, each
attribute has its own field in the popup and
in the CSV file. Attributes that are marked
as mandatory must be entered for each
sample. If you create an attribute of
typeInteger, only numeric characters (whole
numbers) can be entered into the field for
that attribute.

Volcabulary and field restrictions

When sample sets are used to automate integration with Ion Reporter™ Software, the
sample information must follow the rules for Ion Reporter™ Software samples.

The following sample relationships are supported:
• Self
• Tumor, Normal
• Control, Sample
• Father, Mother, Self

Note: Self is used both for a single sample and for the proband sample in a trio. A
single sample is not related to other samples and is analyzed by itself. Always supply
a value for gender. If gender is not known, select unknown.

Sample
information

Samples and Sample Sets
Volcabulary and field restrictions
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Search samples

To search samples, in the Plan4Samples screen:

1. Enter a search name or label in the text box.

2. Select Sample set name or Combined library tube label from drop-down box.

3. Click Go.

Edit samples

To edit samples:

1. From the tools drop-down menu, select Edit Set.

Samples and Sample Sets
Search samples
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2. Make any desired changes, then click Done.

Delete samples

1. Click the Gear button in the row of the sample you wish to delete, then click
Delete Set.

2. Click Yes, Delete!.

Samples and Sample Sets
Delete samples
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Sort samples

To sort samples:

1. Click on any column header to sort the sample rows alphabetically or
numerically.

2. Click Clear to remove sorting.

Samples and Sample Sets
Sort samples
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Plan an instrument run

Differences between templates and planned runs

Templates and planned runs have much the same information.
• Planned runs are created from templates.
• Templates do not have sample names and run names.
• Planned runs are executable on the sequencing instrument.
• Add a sample name and run name to a template to create a planned run.
• The planned run wizard opens in the last page, so that if you accept all the

template settings, all you need do is supply are the run name and sample names
and save the new planned run.

• The last page of the wizard is different for templates and planned runs. The
planned run last page requires the run name and sample names. (Templates do
not contain this information.)

The wizard pages for a template and a planned run are the same except for the last
page. The planned run last page requires the run name and sample names.

• Template wizard:

• Planned run wizard:

• Plan by sample:

Fore more detailed information see “Templates “ on page 505 and “Plan Tab“ on
page 508 in the Reference section.

Typically you copy a product template and customize the new template with your
choices for project organization and data export handling. Then you reuse your new
template to create many planned runs, as needed. Each run plan has the correct
settings (from the original template). Or you can edit your template when
experimental or data handling changes are required.

A planned run performs template preparation on the Ion Chef™ instrument, executes
sequencing on your Ion sequencing instrument, and automates your decisions for
post-sequencing data analysis and data management.

Customizing and
editing templates
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Create a planned run using AmpliSeq™ DNA template

AmpliSeq™ DNA/Exome/RNA templates (also known as panels) can be downloaded
from AmpliSeq.com. The necessary BED files for those templates are automatically
installed with the templates. Additionaly, you can edit the templates downloaded
from AmpliSeq.com or clone those templates to meet your specific needs. The
AmpliSeq™ DNA templates are used to create planned runs for various AmpliSeq™

panels, such as Ion AmpliSeq™ Exome and Ion AmpliSeq™ Inherited Disease Panel.
You can select your Ion Reporter™ account, kits, plugins, and parameter settings.

Note: To modify default parameters, see “Configure Custom Analysis
Parameters“ on page 526.

1. Select Plan4Templates, then in the Favorites list, select AmpliSeq DNA.

2. Select a template that matches your panel. For instance, if you are using an Ion
AmpliSeq™ Exome Panel, select the AmpliSeq™ DNA template with the same
name.
The wizard launches and displays the Plan page.

3. Add samples, confirm the default settings, and enter a plan name, then click Plan
Run.

4. Run the plan on your sequencing system.

Create a Planned Run using DNA and Fusions template

The AmpliSeq™ DNA templates are used to create planned runs for various
AmpliSeq™ panels, such as Ion AmpliSeq™ RNA Lung Fusion Panel and Ion
AmpliSeq™ Colon and Lung Fusion Panel. You can select your Ion Reporter™ account,
kits, plugins, and parameter settings.

Note: To modify default parameters, see “Configure Custom Analysis
Parameters“ on page 526.

1. Select Plan4Templates, then in the Favorites list, select DNA and Fusions.

2. Select a template that matches your panel. For instance, if you are using an Ion
AmpliSeq™ RNA Lung Fusion Panel, select a template with the same name from
the DNA and Fusions category.
The wizard launches and displays the Plan page.

3. Add samples, confirm the default settings, and enter a plan name, then click Plan
Run.

4. Run the plan on your sequencing system.

Plan an instrument run
Create a planned run using AmpliSeq™ DNA template
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Plan a run using Human Identification templates

Human Identification (HID) templates are used to create Planned Runs for various
Applied Biosystems™ Precision ID panels. These templates will pre-populate your
Planned Run with parameters for the selected panel. You can then select additional
settings to plan your run.

Note: To modify the default parameters, see “Configure Custom Analysis
Parameters“ on page 526.

1. Select Plan4Templates, then in the Favorites list, select Human Identification.

2. Select a template that matches your panel.
The wizard launches and displays the Plan page.

3. Select the reference and BED files, enter the samples, confirm the default settings,
and enter a plan name.

4. To change kit information, click on the Kits chevron.

Note: If you are using the Ion PGM™ Hi-Q™ Chef Kit , select the Ion Chef option
next to Template Kit, and select the kit name. Click on the Details button to
select the Ion PGM™ Hi‑Q™ Chef for STR workflow, which was optimized in
Torrent Suite™ Software 5.2.1.

5. When you have made all your selections, click Plan Run.

6. Run the plan on your sequencing system.

Plan a run with RNA Seq templates

RNA Seq templates are used to create Planned Runs for Ion Total RNA Seq Kits.
These templates will pre-populate your Planned Run with parameters for whole
transcriptome and small RNA sequencing applications. You can then select additional
settings to plan your run.

Note: To modify the default parameters, see “Configure Custom Analysis
Parameters“ on page 526.

1. Select Plan4Templates, then in the Favorites list, select RNA Seq.

2. Select the template that matches your application.
The wizard launches and displays the Plan page.

3. Enter the samples, confirm the default settings, and enter a plan name.

4. To change kit information, click on the Kits chevron.

Note: If you are using Ion PI™ Hi-Q™ Sequencing Kit or the Ion 540™ Kit with the
Ion Chef™ Instrument, select the Ion Chef option next to Template Kit, and select
the kit name. Click on the Details button to select the Whole Transcriptome
RNA workflow, which was optimized in Torrent Suite™ Software 5.2.1.
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5. When you have made all your selections, click Plan Run.

6. Run the plan on your sequencing system.

Plan a run using Generic Sequencing template

The Generic Sequencing templates are used to create planned runs for various
applications, such as the System Generic Sequencing or the MuSeek Library. You can
select your Ion Reporter™ account, kits, plugins, and parameter settings.

Note: To modify default parameters, see “Configure Custom Analysis
Parameters“ on page 526.

1. Select Plan4Templates, then in the Favorites list, select Generic Sequencing.

2. Select a template that best matches your application. For instance, if you are
using a MuSeek library, select the template with the same name from the Generic
Sequencing category.
The wizard launches and displays the Plan page.

3. Add samples, confirm or change the default settings, and enter a plan name, then
click Plan Run.

4. Run the plan on your sequencing system.

Copy a template

You can copy the settings in existing template into a new custom template.

Note: To modify default parameters, see “Configure Custom Analysis
Parameters“ on page 526.

1. Click Plan4Templates, then in the Favorites list, click the Gear button in the row
of the template you want to start with. Click Copy.

The wizard launches and displays the Save page.
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2. Enter a name for the template.

3. If desired, go back to previous chevrons in the workflow and adjust the settings.

4. In the Save page, confirm your selections, then click Copy Template.

Export a template

You can export the settings in an existing template into a CSV file.

1. Click Plan4Templates, then in the Favorites list, click the Gear button in the row
of the template you want to start with. Select Export.

Depending on your browser settings, you may be prompted to save your
template, or the template may be created and downloaded automatically.

2. Double-click on the CSV file to open it in a spreadsheet application such as
Microsoft Excel™.

Note: Templates are exported in a format that can be imported back into Torrent
Suite™ Software. You can change the parameters in the CSV file and then re-
import.
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Import a template

You can import all the parameters in a template in the form of a CSV file.

Note: The CSV file must be formatted correctly for import. We recommend exporting
a template (see “Export a template“ on page 33) and using the exported CSV file as a
model. You can change the parameters in the exported CSV file and then rename and
import the file.

To import a template:

1. Click Plan4Templates, then in the Favorites list, select the application group
that you want to import the template into.

2. Click Upload, then select Upload Template.

3. In the Import Plan Template dialog, click Choose File, select the CSV file to
import, then click Load.
The template appears listed in the application group.

Create a Template with Ion AmpliSeq.com Import

To create a template for an Ion AmpliSeq™ panel or an Ion AmpliSeq™ custom design,
use the AmpliSeq.com import button. For community and fixed panels (not for
custom panels), the variantCaller plugin is pre-enabled in your new template and the
variantCaller plugin is pre-configured with parameters that are optimized for the
panel. Later you can further customize TVC parameters. There are three types of Ion
AmpliSeq™ templates: DNA, RNA, and Exome. Human, animal and plant reference
genomes are also available. Start with the template group that matches your
experiment type. Your choices of AmpliSeq.com panels to import are limited the
group types (DNA, RNA, or Exome).

1. Go to Plan4Templates.

2. Click the AmpliSeq.com button and select the type of panel you want to import:
AmpliSeq DNA, AmpliSeq Exome, or AmpliSeq RNA.
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3. Enter your ampliseq.com username and password (if required).

4. Select your instrument and chip.

5. The Torrent Browser lists the available panels. Some panels do not have
optimized Torrent Variant Caller parameter sets available for multiple chips and
sequencers. A caution warning denotes choices for which optimized Torrent
Variant Caller parameters have not be developed for the selected chip type,
which may lead to suboptimal variant calls. The Show solutions which were not
ordered link appears if you have unordered custom designs. Click this link if you
want to import one of those designs. Enable the checkbox for the panel or panels
you want to import, and click Import Selected.

6. The Torrent Browser opens a download and progress page. Refresh your browser
to track the progress and see the completion status.

7. When the Status column shows "Completed", go back to the Templates tab, and
you see the new template.
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Plan by sample set

When you base your run plan on a sample set, the run plan wizard reads the sample
set information and adds it to the appropriate wizard pages. For barcoded runs, the
barcode information from your sample set is added in the plan wizard. This approach
both saves you time and reduces the probability of error compared to manual barcode
assignments on data sets with many files.

The plan-by-sample-set feature is recommended for the following:
• Ion Reporter™ Software users setting up multi-sample analyses
• Sample sets that include a large number of samples

Follow these steps to initiate a run plan based on your sample set:

1. In the Sample Sets page (in the Plan4Samples tab), find your sample set.

2. Click the gear menu for your sample set and use the Plan Run menu selection to
begin a run plan for this sample set:

3. The wizard opens a popup menu listing workflows that support your sample set.
This example started with a trio sample set and offers trio-compatible workflows
(on this server, there is only one trio workflow):

Note: If you do not see the template you are looking for, check the Show All
Templates box.

4. The wizard opens to the Barcoding chevron, with the selected sample sets
displayed in a table at the bottom of the screen.
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5. In the Default Reference & BED Files region of the screen, select the appropriate
reference library and BED files for the target and hotspot regions covered by the
selected panel.

6. Select the barcoding kit used from the dropdown list. For tracking purposes, you
can enter any text written on the sample tubes in the Sample Tube Label field.

7. The Chip ID field can be used to track the barcode number printed on the chip.

8. In the table at the bottom of the screen, select the barcode used to prepare each
sample from the dropdown list in the Barcode column.

9. To identify No Template Control samples, click the Control Type column
heading in the table, and select No Template Control from the dropdown list.

Note: The No Template Control option can be used to indicate negative control
samples.

Torrent Suite™ software allows multiple samples sets to be used in a single planned
run. The sample sets must correspond to AmpliSeq™ library preparations and use the
same barcode kit to be a part of a single planned run.

1. Go to Plan4Samples.

Include multiple
sample sets in one
planned run
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2. Select multiple samples sets, ensuring that they use the same barcode kit.

3. Select the Run Template to apply to this experiment and click Plan Run.

In the Barcoding page of the Planned Run wizard, you will now see the sample sets
you added in the barcode table.
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If you want to plan a run for DNA and Fusion sample pairs and several individual
Fusion or DNA samples, you can start with a fusions template and then alter it to
accommodate single samples on the same chip. The example below is a mixed sample
set consisting of two sample pairs, one DNA-only sample and two Fusion-only
samples.

1. Copy the Ion AmpliSeq™ Colon Lung template.

2. Enter the number of samples.

3. Uncheck "Same sample for DNA and Fusions" option.

4. Renumber the samples.

5. Change DNA/RNA selections to match samples.

Create a planned
run for mixed
samples using a
template

Plan an instrument run
Plan by sample set

Torrent Suite™ Software Help 39



6. Select cancer types to match samples.

7. Select appropriate Ion Reporter workflows.

8. Enter Relation.

9. Enter gender.

10. Enter Analysis set IDs.

11. Click Plan Run.

Create multiple planned runs via CSV upload

The Plan Multiple option for a barcoded template creates a CSV file with setup
structure to create multiple planned runs. Each data line in the CSV file is a separate
run plan.

Note: New in version 5.2, the Download CSV for batch planning template has a top
row that indicates the version of the template. If you are using CSV files you created
in earlier versions of the software, you will need to create a new CSV file with a new
template downloaded in v5.2. Check that the columns are the same between the
current and old formats. If so, copy and paste the contents of your existing CSV file
into the template under the version row. If the columns are different between the
current and new template, copy one column at a time.
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Follow these steps to use the Plan Multiple feature:

1. Go to Plan4Templates, select a barcoded template, and in the row of the
template you wish to use, click the gear icon.

2. In the drop-down menu, select Plan Multiple.

3. In the Plan Runs from Template dialog, enter the number of plans and select
Multiple CSV Files. Click Download CSV for batch planning.

When Multiple CSV Files is selected, a Main CSV file and several sample CSV
files are created in a zipped file.

4. Download the zipped file and unzip it.

5. Enter the plan name(s) in the master .csv file named batchplanning....10-29.csv.
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6. Enter sample names, chip types, barcodes, and other sample attributes.

7. Save and re-zip the CSV files.

8. Click Upload Plan. The system parses the files and creates the run plans.

Analyze Ion AmpliSeq™ on Ion Chef™ samples

Ion AmpliSeq™ on Ion Chef™ samples can be analyzed.

The process involves creating a Torrent Suite™Sample Set, preparing an Ion Chef™

library, creating a Torrent Suite™ planned run, preparing an Ion Chef™ or OneTouch2
template, and sequencing on an PGM™, Ion Proton™, or Ion S5™ sequencer.

Create Sample Set

1. Import samples from a file or enter them manually.
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2. For this use case, we've selected to import samples from a file.

3. Go to Plan4Samples and click Import Samples from File.

4. On the Import Samples window, click Sample File Format button.

5. A CSV template downloads. Click on it and enter sample names, PCR Plate
positions, and DNA or RNA at minimum. Save to your desktop.

6. Now, click the Select File button, choose your CSV file, and click Open.

7. Click Add Sample Set.

8. Name your new sample set.

9. Set Library Prep Type to AmpliSeq on Chef.

10. Set Library Prep Kit to Ion AmpliSeq Kit on Chef DL8.
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11. Enter PCR plate serial number and click Save & Finish.

12. The software creates your new sample set. View it at Plan4Samples4Sample
Set. Check its status in the Status column. Either libPrep_pending,
libPrep_reserved, libPrep_done, planned, Voided, or Run are displayed.

13. Notice a new icon for AmpliSeq on Chef in the Lib Prep Type column.

14. Monitor the Ion Chef library and templating steps from Monitor4Ion Chef.

15. When the sequencing run is complete, view the Ion Chef run report. Go to
Data4Completed Runs & Results, and select your Ion Chef run.

16. Scroll to the bottom of the Run Summary page and select Chef Summary.
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17. Review the Chef Library Prep Info and Chef Template Prep Info sections.

Restart a run

Follow these steps to restart an analysis run:

1. Open a run reports listing in the Data > Completed Runs & Results tab to access
run management functions. In the list view, click the Analyze button on the right
side of the run listing:
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In the table view, click the gear menu on the right side of the run report listing
and click the Reanalyze option:

2. The Start Analysis window opens:

To rerun with the same run settings, click Start Analysis. To modify settings,
click options as appropriate. To modify Analysis Parameters, click the Custom
button.
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3. Modify the advanced options, if needed.

Note: You can also modify

4. Click the Start Analysis button.
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5. Verify that the run has started by clicking the Admin gear menu Services option
to view your job:

Realign a run to a different reference genome

This section describes how to rerun an analysis with alignment to a different reference
genome.

These steps create a new run report.

The Alignment plugin also realigns to a different reference genome, but does not
generate a new run report.

1. Log in to Torrent Browser and click the Data tab Completed Runs & Results
page. Go to the Data > Completed Runs & Results tab and find your run name.
In the table view, click the Reanalyze option in the gear menu on the right of the
run entry:
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In the list view, click the Reanalyze button on the right of the run entry:

The main run analysis dialog opens:

2. Click the Reference & Barcoding tab to display the additional options for
references. Here you can select a different reference for the entire run or a specific
reference for each barcode.
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3. Click the Alignment Reference pull-down menu and select the reference for this
run:

This menu shows the references available in your Torrent Browser. Your list is
different from the list shown here.

4. (Optional) Change other advanced options if required.

5. Click the Start Analysis button.

When you reanalyze, any setting changes you make affect only the current run (when
you click the Start Analysis button). If you instead click Edit, your changes are saved
for each subsequent reanalysis.

Start your reanalysis

1. You select the Reanalyze option either from the Completed Runs & Results table
or from a run report:

a. In the run report of a completed run, click the Reanalyze button in the
report header:

b. In the Data > Completed Runs & Reports tab list view, click the Reanalyze
button on the right of the run entry:

Reanalyze a run
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c. In the Data > Completed Runs & Reports tab table view, click the
Reanalyze option in the gear menu on the right of the run entry:

2. Follow these steps to reanalyze your run:
a. Use one of the Reanalyze buttons or menu options.

b. Enter the Report Name for the new run (required).

c. To rerun the analysis with the same settings, fill in the report name and click
Start Analysis.
To rerun the analysis with changed settings, click the tabs on the left panel to
display the analysis options and make your changes.

d. Click Start Analysis to start the run, which checks the analysis status before
displaying the run confirmation message:

e. View run progress by clicking Report or by selecting the run name in the
Monitor tab.

f. Click Log to view run progress details in text form. Click your browser
refresh button to update the log.
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Settings tabs

When you reanalyze a run, you have to option to change the run's settings. Settings
are organized by tab in the left panel:

The settings for your original run are displayed when you open these tabs.

The Reanalyze Run tab

In the Reanalyze tab, you enter a name for the new run report and the reanalysis
starting point:

Setting Description

Report Name The name of the new run report (the result
of the reanalysis).

Thumbnail only Displays thumbnail view of report.
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Setting Description

Start reanalysis from The Analysis Pipeline proceeds through
three stages: Signal Processing, Base
Calling, and Alignment. Normally report
generation proceeds through all three
steps, but if you have already generated a
report, it is possible to reanalyze the
experiment and skip the earlier stages of
the pipeline.

For example, you may wish to change the
genome that is used for Alignment. After
changing the genome for the experiment on
the Runs page using the Edit field, you need
to reanalyze data to produce a new report
using the new genome. But since there is
no need to repeat the time consuming
Signal Processing and Basecalling steps,
you can use the output from an existing
report as a starting point for Alignment, and
the report will be completed much more
quickly.

You can restart the analysis from these
points:

• Signal Processing (Default) Does not
use the Use data from previous report
field. Reprocesses from the DAT files.
You can optionally use both the
Analysis args and Basecaller args
fields.

• Base Calling Uses the Use data from
previous report field and optionally the
Basecaller args field. Reprocesses
from the .wells file. Does not use the
Analysis args field .

Use data from previous result This option applies only when starting
reanalysis from Base Calling. In this case,
the results from a previous report are used
as input for reanalysis.

Analysis Parameters Default (Recommended) are the
parameters determined to best fit the
factory template.

Custom interface allows you to change
many aspects of the analysis parameters.
For more information, see“Configure
Custom Analysis Parameters“ on page 526
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The Analysis Options tab

An example Analysis Options page is shown here:

The Analysis Options tab contains these settings:

Setting Description

Library Key Sequence used to identify library reads.
Example: "TCAG".

TF key Sequence used to identify test fragment
reads. Example: "ATCG".

3' Adapter The name and sequence of the 3' adapter.

Mark as Duplicate Reads Filter out PCR duplicates. Useful when
reanalyzing combined BAM files. Do not use
with Ion AmpliSeq™ data. .

Base Calibration Mode Four options are available: Default
Calibration, Enable Calibration Standard,
Blind Calibration, and No Calibration.

Enable Realignment Realignment is an optional analysis step
that is executed right after TMAP. This step
adjusts the alignment, primarily in the
CIGAR string.
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The Reference tab

The References tab contains these settings:

Setting Description

Default Alignment Reference The genomic reference to align to. Use this
menu to change the reference used for
alignment in the new analysis.

Default Target Regions BED File Targeted regions of interest file. Analysis is
restricted only to regions listed in this file.

Default Hotspot Regions BED File Hotspots file. The variant caller includes
each hotspot position in its output VCF file.
Variant caller filter scores are provided for
each hotspot position that does not have a
variant called.

Barcode Set The DNA barcode set.

You can now select specific references for specific sample barcodes.
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Planned run sharing among Torrent Servers

Planned run sharing among Torrent Servers was implemented in version 4.4.
Previously, run planning was limited to the Torrent Server networked to your
sequencer. Now, if you have multiple Torrent Servers and multiple sequencers, you
can create a run plan on one Torrent Server and if the dedicated sequencer is offline,
you can now transfer your planned run to another Torrent Server and run it on a
different sequencer. However, this networking capability must first be set up by an
administrator or by an Ion Torrent™ field service representative.

Using the diagram above as an example, a planned run and associated chip can be set
up on Torrent Server 1 (TS) 1 and Ion Chef™ 1 (IC 1). But if Ion PGM™ 1 (PGM 1) is
offline, you can transfer the planned run to TS 3 and run it on PGM 3 (or transfer to TS
2 and run it on PGM 2, if also networked).

To transfer a planned run:

1. On the origin Torrent Server, create a plan for Ion Chef™, execute Ion Chef™ plan,
and monitor the Ion Chef™ run.

2. After the Ion Chef™ run is complete, browse to the Planned Run list in Torrent
Suite™ Software on the origin Torrent Server.

3. From the Gear menu of the selected planned run, select Transfer. Then click the
destination Torrent Server.

Plan an instrument run
Planned run sharing among Torrent Servers

56 Torrent Suite™ Software Help



4. A confirmation window appears. Check the information and then click Transfer.

Note: You can no longer access this planned run on the origin server once it has
transferred. A status window appears. If the planned run copied successfully, a
green box states what copied correctly. If any BED files are missing on the
destination server, a red box states what is missing. Your planned run will be
transferred if the copy is successful. However, you will need to edit the
transferred run on the destination server and add the BED files or other missing
data in order to have a successful sequencing run. Click the Edit [plan name] link
in the confirmation page to fix the planned run on the destination server.

Note: If you need to move the results of a run back to the origin Torrent Server, you
can use the Run Transfer Plugin to move results from the destination Torrent Server to
the origin Torrent Server (or any other networked Torrent Server).
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Undo planned run transfer

If you find you transferred the planned run in error or else need to move the planned
run back to the origin server, you can transfer it back to the origin server or have an
administrator delete it from the destination server and restore it on the origin server.

• To transfer the planned run back to the origin server (user action):
a. On the destination Torrent Server, browse to Plan > Planned Run List and

locate the transferred planned run.

b. From the Gear menu of the selected planned run, select Transfer. Then click
the Torrent Server you wish to transfer the run back to.

• To undo the transfer of a planned run (administrator action):
a. On the destination server, delete the transferred planned run from either

Planned Run or admin pages.

Note: If deleted from the Admin page, there will not be an audit trail for the
transfer back, which could potentially make customer support efforts more
time consuming.

b. On the origin server, located the plan
on /admin/rundb/plannedexperiment/page:

– Uncheck PlannedExecuted.
– Change PlanStatus to Planned.

This method does not require the destination server to be set up for plan sharing.
Any changes made to the plan on the destination server are discarded.
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Execute a run plan on your sequencer

A planned run that you create in the Torrent Browser is executed on the Ion Torrent
sequencer by selecting it from the sequencer's Run Info screen. With the Browse
button you can select a planned run from a list of runs previously created on the
Torrent Browser. The Change button allows you to select a planned run via its run
code.

The pending run information is populated into the Run Info screen. You can
optionally change run information on the Run Info screen. When ready, click Next ‑‑>
to start your Ion Torrent™ sequencing run. Your planned run is removed from the
Plan4Planned Runs table when you approve the run confirmation.

The planned run short code can be entered by entering it manually from the touch
screen. You can also type the planned run short code (for example, ITHWQ) into the
Pending Run: text field on the Run Info screen:
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On the Ion S5™ sequencer, select your run from the Run Selection screen.
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Monitor runs

Monitor tab

The Monitor tab provides you with information, optionally in thumbnail graphs as
well as numerical format, to help you confirm that your current runs are working.

This tab provides data for you to know whether an in-progress run is working or not,
through the following metrics:

• Beads loading
• Key signal
• Usable sequence

In the Monitor tab, you can also review the planned run settings for a run that is
currently in progress on the sequencing instrument or the Ion Chef™ instrument.

Example monitoring metrics

Below is an example entry in Progress in the Monitor4Runs screen:

With the Monitor tab List View you can see at a glance if any run quality metrics fall
below the thresholds that you define in your template. Any metrics below threshold
are shown in red in the thumbnail graphs.

Other information shown in Run in Progress entries are:
• The Sequencing run name
• Run information: started date, chip type, run type, and run notes
• A link to the run report
• Run status: In progress, completed, or terminated
• A link to the run plan for this sequencing run
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• The number of flows transferred
• A flow transfer progress bar

The Monitor tab also allows you to monitor Ion Chef templating runs.

Views

The Monitor4Runs screen in Progress page supports a list view and a table view.
The list view display 3 or 4 runs per page. The table view displays 1 run per row.

The Monitor4Ion Chef™ screen supports a table view.

When you use the table view, you can sort the table by any of the columns in bold
type. Click a column header to sort the table, and click the header a second time to
reverse the sort.

Monitor runs
Views
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Auto Update

Auto Update refreshes your page display whenever a new run is available to display.
With Auto Update off, the page is a static display of information at the time you
opened the page:

When Auto Update is on, the button changes to Stop Updates:

In the Monitor tab you can review the planned run settings for a run that is in
progress.

In the table view, open the planned run review from the gear menu on the right of a
table entry. The gear menu is only available on this page while the run is still in
progress.

In the list view, click the Review Run Plan link. This link is only available while the
run is still in progress.

Review the
planned run
settings
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The following is an example of the display when you review planned run settings:
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Terminate an analysis run

Use the following procedure to terminate an analysis job for a run that has started but
not completed:

1. In the Torrent Browser, near the top right, click the Admin gear menu and click
the Services option:

2. Scroll down to the Active Jobs panel. Find the run Name you want to terminate
and click the Terminate button associated with the job (the Status Message
column indicates job is running).

3. In the confirmation dialog, click Terminate to end the run or click Cancel to let
the analysis job continue:
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4. Refresh your browser to update the information in the Active Jobs section. The
run is removed from the Active Jobs list, which displays No active jobs if no
other runs are active:

On the Data> Completed Runs & Reports list view, the deleted report shows a
TERMINATED status:

You can always start a new analysis run.
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Review data

Review data

From the Data tab, access the following functions.

“Manage completed runs and results“ on page 67

“Create and manage projects“ on page 75

“Data Management tab“ on page 404

Navigate to the Data tab and click Completed Runs & Results to access the following
functions.

• Click on the report name to access a detailed run report.

• Toggle between Table View and List View for alternative displays of the run
information.

• (Table view only) Click a header to sort the table by that column. Click a second
time to reverse the sort.

• Click Download CSV at the bottom of the page to obtain a spreadsheet of run
information to your local machine.

• “Search for a run“ on page 68

• “View the Data Management log“ on page 69

• “Edit a run plan“ on page 70

• “Reanalyze a run“ on page 70

• “Add a run to a project“ on page 72

• “Terminate an analysis run“ on page 73

• “Change the analysis reference“ on page 74

• “Change run metadata“ on page 74

• “Add barcoding to a completed run“ on page 75

• “Edit run metadata“ on page 75

Manage
completed runs
and results
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Search for a run

Navigate to the Data tab and click Completed Runs & Results to search for a run.

1. Enter a Date, Run Name, or Sample Tube Label in the fields provided.

• Click in the Date field, and select from Today, Last 7 day, This month, or
select a Date Range using pop up calendars.

• Select Run Name or Sample Tube Label from the Search names drop down,
then enter text in the Search names field

2. (Optional) Use the filters to narrow results by project, sample, reference, flow,
chip, instrument, or results status.
Click the X in a selected filter box to remove that filter and restore the search
results that were filtered.

3. (Optional) Select the blue star checkbox to restrict the search results to starred
runs.
Star any run by clicking the empty star next to the Run Name.

4. (Optional) Use the drop-down menu to order the results list by name, date,
number of flows, etc.

5. Click Go.

6. (Optional) Click Clear to remove filters and restore all results.

Delete, archive, or export run data

Navigate to the Data tab and click Completed Runs & Results to access the following
functions.

1. Click List View.

2. Navigate to your record of interest.
See “Search for a run“ on page 68 for help finding an individual record.

3. Click , then select Data management.
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4. Select the file category or categories that you are interested in.
These categories include:

• Signal Processing Input - Required input files for signal processing
• Basecalling Input - Required input files for basecalling
• Output Files - Report rendering, deliverables, plugins output
• Intermediate Files - Files used for debugging only

5. (Optional) Select the Keep checkbox next to any category.

6. Delete, archive, or export the selected files.

• Click Delete Selected, add an optional comment, and click Confirm.
• Click Archive Selected, choose either to use the configured directories or

browse to a new one, add an optional comment, and click Confirm.
• Click Export Selected, choose either to use the configured directories or

browse to a new one, add an optional comment, and click Confirm.

View the Data Management log

Navigate to the Data tab and click Completed Runs & Results to access the following
functions.

1. Click List View.

2. Navigate to your record of interest.
See “Search for a run“ on page 68 for help finding an individual record.

3. Click , then select View log.

A history log of Data Management actions taken on this run report displays, along
with the associated date and user for each action.
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Auto update runs and results

Auto Update refreshes your Completed Runs & Results page whenever a new run is
available to display. Without Auto Update, the page is a static display of information
at the time you opened the page. This feature is available in the Data4Completed
Runs & Results screen.

1. Click Auto Update.

2. Click Stop Updates to turn Auto Update off.

Reanalyze a run

If you want to reanalyze a run to correct a setup mistake or optimize parameters,
navigate to the Data tab and click Completed Runs & Results.

1. Click Table View.

2. Navigate to your record of interest.
See “Search for a run“ on page 68 for help finding an individual record.

3. Click , then select Reanalyze.

4. Enter a name for a new run report.

5. Change any parameters of the run as appropriate. Possible items to change,
include:

• Start the analysis from Signal Processing or Base Calling.
• Change Analysis Parameters. See “Configure Custom Analysis

Parameters“ on page 526 for more detail.
• Add plugins or re-run plugins.

Edit a run plan

If you want to edit a run plan to correct a setup mistake or optimize parameters for all
future re-analyses, navigate to the Data tab and click Completed Runs & Results to
access the following function. This feature is available in Table View only.

1. Click Table View.

2. Navigate to your record of interest.
See “Search for a run“ on page 68 for help finding an individual record.

3. Click , then select Edit.

4. Correct or improve any of the editable features, including:

• Name
• Custom Analysis Parameters
• Reference
• Ion Reporter account
• Plugins
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Manually run a plugin

You can manually run a plugin in the run report of a completed analysis run, with the
Select plugins to run button. Only enabled plugins are listed. Follow these steps to
manually run a plugin:

1. Go to the Data > Completed Runs & Reports tab, then click the link for your
completed analysis run.

2. In the run report, scroll down to Plugin Summary tab.

The Plugin Summary also lists any plugins that executed on your run (not shown
in this example).

3. Click Select plugins to run to see the list of plugins available in your Torrent
Suite™ Software.

4. Click the desired plugin name to run a plugin. If the plugin does not require user
input, it starts immediately, without a confirmation screen.

5. Click Close to close the Plugin List without running a plugin.
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Add a run to a project

In the Data tab Completed Runs & Reports page table view, you can add a completed
run to a project.

The following list describes advantages of grouping your results sets into projects:
• Combine multiple result sets into one (useful to later analyze as a single run)
• Export result sets to another system for additional analysis
• Group result sets into projects for convenient tracking and bulk data

management

Follow these steps to add a completed run to a project:

1. Go to the Data > Completed Runs & Reports page and click List View.

2. Find the run report you want to add to a project. For that run, click the gear
menu on the right and select Add Report To Project:
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3. The Pick Projects page opens:

4. Enable the checkbox for the project (or projects) you want the run report added
to. Click the Add projects button. The run report is added to the selected project
or projects.

Terminate an analysis run

To terminate a run that has not yet completed, go to the Services option in the Admin
menu and click Terminate to the right of the run name.

Review data
Review data

Torrent Suite™ Software Help 73



Change the analysis reference

Use the following procedure to change the reference for an analysis:

1. Follow the instructions in “Reanalyze a run“ on page 70 to open the run analysis
dialog advanced options.

2. Use the Alignment Reference menu to select the new reference:

Note: If various references were selected per barcode in the initial run, use the
lower per-barcode reference selection utility here as well.

3. Follow the instructions in “Reanalyze a run“ on page 70 to save your selection
and to redo the analysis.

Change run metadata

Select Data4Completed Runs & Results4List View, then click Edit on an
individual run to edit the following run metadata.

• Sample name
• Application type (run type)
• Library kit
• Sequencing kit
• Chip identifying barcode
• Library key
• Notes
• Alignment reference
• Target regions BED files
• Hotspot regions BED or VCF files
• Plugins
• DNA barcode set (index)
• 3' adapter

IMPORTANT! You must restart or re-analyze your run for analysis-related changes to
take effect. Changes to the sample name and to the notes take effect immediately.

When you change the metadata, you change the information in the run database.
Because the analysis pipeline is initialized with the run database information at the
time that an analysis starts, changing metadata does not affect an analysis that is in
progress. For a running analysis, you must terminate the run and start analysis
manually. For a completed analysis, you must re-analyze the run. The run report (in
the Completed Runs & Reports tab) always shows the metadata in effect for the run. If
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your changes are not shown in the run report, the changes were not in place at the
time the report was generated. If you add or change an entry in the Notes field, that
note does not appear in the run report unless you restart or re-analyze the run (even
though the note does not affect the analysis results).

Add barcoding to a completed run

Use the Edit option to do either of the following:
• Add barcoding to a run
• Change the barcode set for a run
• Remove barcoding from a run

In each case, you must reanalyze the run after editing the barcode information. These
steps apply only to completed runs.

Edit run metadata

Follow these steps to change metadata for a run:

1. In the table view, click the Edit option in the run entry's gear menu. In the list
view, click the edit button in the run entry.

2. In the Edit Run page, make your corrections to the metadata.

3. When you are done, click Save.

4. Restart the run:
a. If the run is in progress, terminate the run and restart it.

b. If the run is completed, re-analyze the run.

IMPORTANT! Your changes in the Edit Run page do not affect a run that is in
progress.

Note:
· The ChipBarCode field contains a chip identifier. The chip barcode should not

be confused with chemical barcodes and barcode sets.

Create and
manage projects
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Data Management

Opens the Data Management on-demand menu so that you can archive, delete, or
export files for the selected members of the project:

Work with analysis files

For a standard Torrent Server configuration, analysis results files are located in the
following directories:

Type of Data Directory Name

Raw /results/<Sequencer_name>/
<Run_name>/

Processed /results/analysis/output/Home/
<Report_name>/

Analysis results
file location
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Many log files, shown in the following table, are generated for different parts of the
Analysis pipeline. Some files only appear when a problem occurs. You do not need to
login to see these files. Opening a report and removing the report name gives you a
directory listing of all of the files, which you can open directly as text files. Be careful
that you do not open a large file using the web browser.

Filename Description

version.txt Lists the versions of the Ion software
packages that were installed at the time the
report was generated and the host name of
the server. This information is also
displayed on the default report.

DefaultTFs.conf Lists all of the Test Fragment Templates
that were used for generating this report. If
the file size is zero and there are no data in
the file, either no templates are installed or
none are flagged isofficial. Analysis
only checks against the templates that are
marked isofficial, which is set using
the Templates tab in the browser.

uploadStatus Lists problems uploading data to the
database. If analysis results are not being
displayed in the browser, check this file.

Normal results:

Updating AnalysisAdding TF MetricsAdding
Analysis MetricsAdding Library
MetricsAdding Quality Metrics

Error examples:

Failed addAnalysisMetricsFailed
addLibMetrics

status.txt Analysis run status. If the analysis
completed successfully, the contents of this
file are a 1. A value of 0 indicates a failure
occurred, requiring that you check other log
files to determine the cause. No specific
error information is provided in this file.

processParameters.txt Run events and duration. The command-
line passed to the Analysis program is also
included, which is useful if you want to re-
run the same analysis. These files are in
subdirectories named
sigproc_results/block_ *.

Log files in the
results folder
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Filename Description

sigproc_results/sigproc.log
basecaller_results/
basecaller.log alignment.log

Analysis pipeline log files. Always check for
errors in these files, especially the first and
the last pages.

The contents of these log files (without
HTML formatting) are available in the
Torrent Browser with the run report
Support tab View the report log link:

drmaa_stdout.txt Post-analysis events.

drmaa_stderr.txt Error messages related to processes called
after the primary analysis. This has a value
of zero if the analysis completed
successfully.

analyzeReads_err.txt Useful troubleshooting information
generated during the alignment process.
This file is only created when there is a
problem.

core A memory dump listing, usually caused by a
critical fault. You should see a related
exception or core dump message in
an analysis pipeline log file.

alignmentQC_out.txt Errors related to TMAP. If the file is not
present, it is likely that TMAP was not
called.These files are in subdirectories
named basecaller_results/block_
*.

Standard reference files are stored in the following location:

/results/referenceLibrary/<index_type>/<genome_shortname>/

Work with the database

User configuration information and experiment descriptions can be accessed and
modified directly in the database, provided you have administrator privileges.

IMPORTANT! Care must be taken when modifying database items. Setting fields to
incorrect values may corrupt the database or produce unpredictable results.

Standard
reference file
location
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For all of the common database operations, you must begin by logging in to the
database interface:

WARNING! Torrent Suite™ Software administrator-level user access is required
to make changes to the database.

1. In the Torrent Browser, near the top right, click the Admin gear menu and click
the Configure option:

2. In the Admin Configure tab, scroll down to the Database Administration section.
Click Admin Interface to access database administration functions:

3. If you are prompted to log in, enter the administrator (ionadmin) Username
and Password, and click Log In:

Access the
database
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If you manually started an analysis and realize that you typed the report name
incorrectly, you can change the report name using the following procedure. These
steps require admin login.

IMPORTANT! It is not safe to change the report name while the report is being
processed.

1. Select the Results dialog.

Change the report
name

Review data
Work with the database

80 Torrent Suite™ Software Help



2. On the Select results to change page, click the name of the run you want to
change, in the ResultsName column:
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3. Enter the new report name in the ResultsName field:

4. Click Save (on the bottom right) to save your change.
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Occasionally, the Ion PGM™ or Ion Proton™ Sequencer cannot get a date/time from the
internet time server. When this occurs, the sequencer date is set to January 1, 1969.

The date of the run is encoded in the folder name, which is parsed and used as the
Run Date in the database. This causes the new run to be displayed with the incorrect
date. With a date of January 1, 1969, the run is the last item on the last page of run
reports listings in the Data tab.

Use the following procedure to change the date for this run:

1. In the Torrent Browser Config tab, click Admin Interface and login, if prompted.

Change the run
date
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2. Click to open the Experiments database item for modification:
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3. Find your run in the experiment name list. The list is sorted by date, starting with
the newest runs in the database. Because the run from 1969 is at or near the end
of the list, it is convenient to re-sort by date, in ascending order (oldest at top).
Re-sort by clicking the Date column heading:

Review data
Work with the database

Torrent Suite™ Software Help 85



4. Click the ExpName for your run to select it and display the following run
information:

5. Use one of the following two options to change the date: a) Click the Today and
Now buttons to set the Date and Time values to the current date and time in one
click.

IMPORTANT! The automatic method is recommended because it places this run
at the top of the run report lists, in both the Data > Completed Runs & Reports
tab and the Data > Projects > projectname tabs.

b) Manually edit the date/time strings.
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6. Click Save, on the bottom right to save the new date:

7. Return to the Data tab when done.
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Do not add or change a sequencer through the Site administration Rigs configuration
item. During initial setup, sequencers automatically register themselves with the
Torrent Browser. Changes to a sequencer are also communicated directly to the
Torrent Browser.

Never delete a Rig using the Site administration Rigs configuration item. That action
could corrupt the database.

The Site administration Rigs configuration item is not to be used:

Cautions

Custom barcode design involves certain technical challenges:
• Calculation of the your barcodes' hamming distances in flow space
• Adjustment of basecaller parameters to match your barcodes' distances

Custom barcode design is for advanced users only and only if you have a compelling
need for a custom barcode set.

Add or change a
sequencer

Design custom
barcodes
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If are considering creating your own custom barcode set, we recommend that you first
contact your FBS.

IMPORTANT: The default Basecaller parameter settings are optimized for the
IonXpress barcode set. The use of a different barcode set, especially a custom barcode
set, requires custom Basecaller parameter settings.
Barcode overview

The Torrent Suite™ Software supports barcoded runs, in which multiple barcoded
samples are processed on the ION Chip during an Ion sequencing run. A barcode run
typically involves sample-prep with an Ion barcode adapter kit (or compatible kit)
such that two or more barcode adapters are present in a run. The user selects the
barcode set in the run Planning tab of the Torrent Browser. This barcode set
information is used during analysis to separate out reads by barcode, remove the
barcode and adapters from the read, and output reads by barcode into separate BAM
files. Reads are aligned against the reference genome, and results stored in BAM and
BAM index (BAI) files for each barcode. Reads that can not be classified as being one
of the barcodes in the designated set are grouped into a "no-match'" group, and
alignment against the reference also performed on the no-match group.

Alignment metrics for each barcode are available in the Output Files section of the
analysis run report. The run report shows Q20 performance metrics for all barcodes in
the run, providing a quick glance at the high-level quality of each barcode. The
barcode section in the run report also shows the following metrics for each barcode in
the run:

• The number of bases
• The number of bases at Q20 (or better) accuracy
• The number of mapped reads
• The mean read length
• A read length histogram

The Torrent Suite™ Software includes barcode sets for the latest available barcode kits.
These barcode sets are selected in the run Planning tab. Advanced users optionally
can add additional barcode sets in the References section of the Torrent Browser
admin tab, either by uploading a CSV file of all barcodes or by manually adding each
barcode.
Barcode set design considerations

Barcode sets are designed to efficiently separate reads from each other in the presence
of errors. Ion Torrent™ sequencing technology produces raw data in flow space. These
reads are best described as having a homopolymer run of length 0, 1, 2, etc., ... in flow
1, 2, 3, etc. Because of this characteristic, the most typical error patterns involve either
over- or under-estimation of a homopolymer signal in a flow. The most effective
barcodes designs for Ion Torrent™ technology are those with distinctive flow-space
representations.
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Hamming distance

One way of describing the separation of two sequences in flow space is by the
hamming distance between them for relevant flows. Hamming distance is the number
of flows in which the expected homopolymer length is different between the two
sequences. For example, if two barcodes differ in 5 flows in flows 9-22, those two
barcodes have hamming distance 5.

Hamming distance corresponds naturally to the ability to detect and correct errors.
When two sequences have hamming distance 5, 2 errors can occur on one of the
sequences and that sequence is still 3 errors away from the other sequence. Sequences
separated by hamming distance 5 can tolerate 2 errors and still be classified correctly.
Ternary encoding

One side effect of operating in flow space is that barcodes are not limited to binary
sequences. For example, each flow can correspond to 0, 1, or 2 bases in a ternary
encoding scheme. This scheme allows for a greater number of codewords occupying
the same number of flows. However, a flowspace representation must correspond to a
legitimate sequence that yields these flow-space values. For example, we cannot have
a flow of T, C, T with values 1, 0, 1. For a flow of T, C, T, both T bases are consumed in
the first flow, and the sequencing reaction yields the incorrect values 2, 0, ?.
Ion Torrent™ barcode design

We designed Ion Torrent™ barcode sets to provide at least 1-error correction
(hamming distance 3) in flow space for a large set of barcodes, and 2-error correction
(hamming distance 5) for a usefully sized subset of such codes. This goal is
accomplished by taking the ternary hamming code on 13 characters and assigning
codewords to flows 9-22 to generate flow sequences (flows 1-8 are used for the library
key and are not considered here). These flow sequences then have hamming distance
3 and are 1-error correcting. The codewords are further reduced by the constraint of
requiring that they correspond to legitimate flow sequences. We also apply the
constraint that the flow sequences must correspond to base sequences that are 9 to 11
bases in length. Finally, within the set that satisfies all these constraints, a subset is
chosen (by greedy aggregation) such that any pair of flow sequences has hamming
distance 5.

To insulate these sequences from the target sequences, a ligation adaptor CGAT is
added. The ligation adaptor performs two functions. First, the C in flow 22 provides a
synchronized flow that both marks the end of the barcodes and ensures that barcodes
ending with "0" do not have sequence overwrite those flows. Secondly, this adapter
mitigates any sequence-specific biases caused by the differing barcode sequences.

We provide a tool that classifies barcode reads by finding the flow-space
representation of the read and comparing it to the flow-space representation of the
barcodes. Classification standardly occurs after the last flow of the key (G), and
continues to the end of the barcode sequence provided in flowspace. IonTorrent
barcode sets are designed to be synchronous so that they all are classified using the
same set of flows.

For flow space classification of custom barcodes, the barcodes should be designed to
be compatible with the flow order, be synchronized at a final flow, and be well
separated. However, the Torrent Suite™ Software attempts to classify any reasonable
set of sequences that are separated in flow space. Many standard software packages
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also classify usefully in sequence space, and have been found to work well with Ion
Torrent™ data.

Overview

The Torrent Suite™ Software supports barcoded runs, which allow you to process
multiple barcoded samples in a single run on the Ion S5™, Ion PGM™, or Ion Proton™

Sequencer.

Your Torrent Suite™ Software comes pre-installed with several DNA barcode sets,
including: Ion Code, ionSet1, ionXpress, ionXpressRNA, MuSeek_5prime_tag, and
RNA_Barcode_None. These barcode sets are available for use on the Ion S5™, Ion
PGM™, and Ion Proton™ Sequencers.

A barcode run on the Ion sequencer requires a sample-prep kit such as the IonSet1 or
Ion Xpress barcode adapter kits. You select a DNA barcode adapter kit when you set
up your Ion sequencer run. The barcode sequences for the IonCode, IonSet1, Ion
Xpress, and Ion Xpress RNA barcode adapter kits are included with the Torrent
Suite™ Software.

Use DNA barcodes
with the Ion
Torrent
Sequencers
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This barcode set information is used during analysis to separate out reads by barcode,
to remove the barcode and adapters from the read, and to output reads by barcode
into BAM files. Reads are aligned against the reference genome, and the results stored
in BAM and BAM index (BAI) files for each barcode. Reads that can not be classified
as being one of the barcodes in the designated set are grouped into a "no-match"
group, and alignment against the reference also performed on this group. The new
barcode results files are available in the run report File Links section.

Alignment metrics for each barcode are available in the run report page for the given
run.

You can add additional DNA barcode sets using the Torrent Browser Admin gear
menu References option:
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Workflow

The standard workflow for a barcoded sample is similar to a normal Ion S5™, Ion
PGM™, or Ion Proton™ run and analysis. This section provides an overview of the
workflow, with the new steps involved on a barcoded run.
Summary of the recommended workflow

Here is an overview of the recommended workflow for a barcode run. Screenshots
and more details are provided below.

1. Create a template for your runs in the Plan tab Template page. In the template
wizard Kits page, select one of the available barcode sets from the drop-down
Barcode Sets menu, and fill out the other run information. Save your template.

2. When you have the actual sample name, click the Plan Run button for your
template. Enter you run name and sample name, then click Plan.

3. The Torrent Suite™ Software assigns a name to your planned run, and generates a
5-character code for your planned run name. Your run information is stored in
the Torrent Suite™ Software as a planned run until you are ready to start the run
on the sequencer.

4. When you are ready to start the run, on the Ion S5™ Run Selection screen you
select your run from a list of planned runs. Torrent Suite™ Software populates the
Ion S5™ Detail screen with the information you entered in the Planning tab. (You
may optionally change information on the Run Info screen.)

5. You start the Ion S5™ sequencer run as usual.

6. When the run and report are complete, you can review the performance of the
barcoded reads in the default report page. The following additional barcode-
specific files are available for download from the File Links download section:

• A zip of BAM and BAM index (BAI) files for each barcode
• A csv-style spreadsheet summarizing the barcode performance for each

barcode

Set up a barcode run in a template

The same steps apply to a planned run (which is created from a template).

Follow these steps to set up a barcoded run in a template:

1. Click the Plan4 Template page, click Add New Template for the application
group appropriate to your experiment.
The Template wizard opens.

2. Select the correct application group and click Next.
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3. On the Kits page, click the Barcode Set menu. Select the barcode set that
corresponds to your barcode kit.

4. Click Next and complete the rest of the wizard. On the last page, click Save.

5. Your new template appears in the Plan4 Templates page, in the application
group you selected.
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6. To run on the Ion sequencing instrument, create a planned run from your new
template. Click the Gear button > Plan Run option for the template you just
created.

7. The planned run wizard opens, in the wizard Plan page. Enter a descriptive run
name and enter the sample name for each barcode you want to use click Plan
Run to save and finish.

8. The Planned Runs page opens with your planned run at (or near) the top of the
table:

The Torrent Browser assigns a short code name to your planned run. The
example short code here is 67HYE
.
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Start your planned run on the Ion sequencer

This section describes how to go from a planned run to an actual run on the Ion
PGM™ or Ion Proton™ Sequencer. You must first create a planned run, as described in
Set up a barcode run in a template before using the instructions in this section.

1. Open the Run Info screen on the Ion PGM™ Sequencer.

2. Click on the Browse button (near the middle of the screen, to the right of the
Planned Run field).

3. The Planned Run pop-up opens with a list of available planned runs. Your
planned run is identified by short code and plan name (as listed under the Plan
tab). Select your run and click OK.

Your selection appears in the Planned Run field:
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The Ion PGM™ Sequencer Run Info fields, including your barcode set, are
populated with information from your planned run.

If required, you can manually update any Run Info fields now.

4. Click Next ‑‑> to start your Ion PGM™ Sequencer run, as usual. Approve your
run on the confirmation screen.

IMPORTANT! When you accept the confirmation screen, your planned run
information is deleted from the Data tab Planned Runs page. If you terminate your
Ion PGM™ Sequencer run and at a later time want to start the run, you must either
enter the run information on the Ion PGM™ Sequencer Run Info screen or re-create the
planned run again under the Torrent Browser Planning tab. The new planned run has
a different short code.
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Start your planned run on the Ion S5™ or Ion S5™ XL sequencer

To initiate a plan on the Ion S5™ or Ion S5™ XLsequencer:

Select the appropriate plan when you are setting up the run on the sequencer.

Other methods to import your planned run

This section describes the ways to import your planned run information into the Ion
PGM™ Sequencer Run Info screen. These are all done on the Ion PGM™ Sequencer
Run Info screen, and are all different ways to populate theIon PGM™ Sequencer Run
Info screen with the run information previously entered in the Planning tab. Choose
the method which best fits your work environment.

Planned run run code

You can type the run code for your planned run into the Planned Run: text field. An
example run code is ITHWQ.

A run code is assigned to your planned run when you enter the run information in the
Plan > Template page planned run wizard and is listed in the Plan > Planned Runs
page.
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Barcode reports and output files

This section describes output and reports for barcode runs. The barcode reports
section appears at the top of a run report for a barcode run and shows key
performance metrics for each barcode in the run. The category named "No barcode"
contains barcodes that could not be matched to known members of the barcode set
being used.

The BAM and BAI links in the barcode report download files for only that barcode.

The Output Files section of the Torrent Browser run report includes barcode-related
results files available for download. The links in the Barcodes row download zipped
files of all barcodes for the run. The data in the Reads column are before alignment.

File Type Description

Barcode-specific Library Alignments (BAM
and BAM Index)

Binary Sequence Alignment/Map (BAM), is
a compressed, binary form of the SAM file.
The BAM index (BAI) file speeds up the
access time for a coordinate-sorted BAM
file. The BAM and BAI files for each barcode
are zipped together.

IMPORTANT! The SFF and FASTQ file formats are not produced by the default
analysis pipeline.
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Plugin Support for Barcodes

The following plugins supports barcode libraries:
• Coverage Analysis
• Torrent Variant Caller

The following plugin does not support barcode libraries:
• Alignment

Scanning sequencing kits is a part of the Ion S5™, Ion PGM™, and Ion Proton™

instrument setup workflow. The Torrent Browser template wizard (under the Plan
tab) also supports specifying the sequencing kit when you create a template or a
planned run.

Here is an example of the kit scanning page and keyboard during the Ion PGM™

system setup:

Scan your
sequencing kit
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IMPORTANT! Scanning the sequencing kit is preferred to selecting a checkbox,
because scanning provides more detailed kit information that can be used for
troubleshooting or other purposes.

The choice of sequencing kit affects the nucleotide flows on the Ion sequencer.

The template wizard

Enter the sequence kit in the Torrent Browser template wizard, under the Kits
chevron.

The Projects tab

With the Data > Projects tab, you control your data analysis and data management
tasks.

Projects are simply groups of runs. You create and use these groups in a way that
makes sense for your research. Projects are useful to hold runs for instance for the
same laboratory project or runs that you will later handle in the same way (for data
export or archival).

Projects are intended to be a convenience:
• You do not have to repeatedly search through the completed runs table to find

related runs.
• You can perform data management tasks on many members of a project at a time.

In the Projects tab, you can access the main projects listing page and also the detail
page for a single project (called called the project result sets page).

Review data
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In the main projects listing page, under Data > Projects, you can do the following:
• Search the listing by project name or partial name
• Filter the listing by date (date range, current month, current week, current day, or
specific date)

• Rename a project
• Delete a project
• View a history log for a project
• Open the result sets page for a project

In a project result sets page, under Data > Projects > projectname, you can manually
perform the following data management tasks. In one action, you can do these to a
single result set (a single run), or to some or all of the result sets in the project.

• Combine multiple result sets into one (useful to later analyze as a single run)
• Archive result sets
• Prune results sets (remove some data from a result set)
• Export result sets to another system for additional analysis
• Group result sets into projects for convenient tracking and bulk data

management
• Copy result sets to other projects
• Remove result sets from the current project
• Search the result sets for by name or partial name
• Filter the project display by date (date range, current month, current week,

current day, or specific date)
• Download a CSV file of metrics for one or more analyses in the project
• Compare metrics for multiple run reports

These menus show the actions you can take on members of a project, from the project
result sets page, under Data > Projects > projectname:

You can think of these options as acting on either the run report or the run's result set
(or both).

Review data
The Projects tab

102 Torrent Suite™ Software Help



The Data > Projects page lists all projects.

Below are three ways to add a report to a project.

Before analysis

In the run plan wizard, you specify project names in the Projects chevron:

The Projects
Listing Page

Add a report to a
project
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From a completed run report

After analysis, you add a completed run report to a project from the Data >
Completed Runs & Reports page or from an existing project.

Follow these steps to add a report to a project from the Data > Completed Runs &
Reports page:

1. In the list view, click the gear menu for the report and select Add Report to
Project:

"Add to Project" is not available in the table view.

Review data
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2. The Pick Project popup opens:

Enable the checkbox for the project or projects and click the Add projects button.
The report becomes a member of the project or projects that you select.
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From an existing project

From an existing project, click the Process Selected... button and select Add to
Project. Then follow the Pick Project popup step described above.

Review data
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In a project's Results Sets listing, you can generate a CSV file of analysis metrics and
compare results across analyses.

To generate the CSV file, first select the checkboxes for the analyses, then click the
Download Selected CSV button. The button is inactive until at least one analysis
checkbox is enabled.

These menus show the actions you can take on members of a project:

You can think of these selections as acting on either the run report or the run's result
set (or both).

In each case, you first select the reports' checkboxes, then select the menu action:
• Combine Alignments. Combines reads aligned from multiple run reports. The

resulting data set can be treated the same results from a single analysis run, for
instance to export or to use as input to a plugin. Intended for use when multiple
runs analyze the same tissue sample, for example when a tissue sample is run on
more than one chip. All reports must be aligned to the same reference.

• Add to Project. Adds the selected result sets to other projects.
• Remove from Project. Removes the selected result sets from the current project.

(Does not delete the run report.)
• Data Management. Opens a data management popup you can use to archive,

delete, or export files from the selected runs.

Download a CSV
file of metrics

Project menus and
actions
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The Combine Selected... and Process Selected... menus show the actions you can take
on members of a project. You first select the reports' checkboxes, then select the menu
action.You can think of these selections as acting on either the run report or the run's
result set (or both).

For some applications, duplicate reads coming from PCR cause problems in
downstream analysis. The presence of duplicate reads may create the appearance of
multiple independent reads supporting a particular interpretation, when some of the
reads are in fact duplicates of each other with no additional evidence for the
interpretation.

Torrent Suite™ Software uses an Ion-optimized approach that considers the read start
and end positions by using both the 5' alignment start site and the flow in which the 3'
adapter is detected. Duplicate reads are flagged in the BAM in a dedicated field. Use
of the Torrent Suite™ Software method is recommended over other approaches which
consider only the 5' alignment start site.

Marking duplicate reads is not appropriate for Ion AmpliSeq™ data, because many
independent reads are expected to share the same 5' alignment position and 3' adapter
flow as each other. Marking duplicates on an Ion AmpliSeq™ run risks inappropriately
flagging many reads that are in fact independent of one another.

Use the Process Selected... > Add to Project option to copy the selected result sets to
one or more other projects. In the next screen, the project selection screen, enable the
checkbox for each project that the selected result sets are to be copied to. Use the page
1 navigation at the bottom right to scroll through the list of project names.

The Add to Project option adds the selected result sets to the other project (or
projects). The result sets are not removed from the current project.

Use the Process Selected... > Remove from Project option to remove the selected
result sets from the current project. Be careful when using this option it does not give
you a confirmation screen before removing the projects.

This option does not delete the selected run reports and their result sets it only
removes them from the current project.

In the Data > Projects page, you can search for project names and in a project details
page you can search for run report names. The search field behavior is the same in
both cases. After you press Go, the displayed information is limited to only names
which match or contain the search string.

The search field takes a complete or partial name. For example, the following project
names match the search string "mpli": amplicon, amplicon33, AmpliSeq, Samplier.

The search is not case-sensitive. Wildcards are not supported in the search string.

Click the Clear button to cancel the search and display unfiltered results.

Actions on
members of a
project

Mark as
Duplicates Read

Add to Project

Remove from
Project

Search
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The date filter controls are the same on both the Data > Projects tab and in a project
details page.

The date field opens a menu with preset choices or a date range picker:

The selection you make in the Date field takes effect immediately (depending on
server load). You do not need to click the search Go button.

• The Today selection enters the current date in the Date field and limits the run
table display only to jobs with a run date from the current date.

• The This week selection uses a date range from Monday to the current day.

• The Date Range selection opens two calendar pickers, one for the range start date
and one for the range end date. The current date is shown in pale yellow. Dates
that you select are shown in white, as are the dates of the current date range (if
any).

• You can optionally edit the date range directly in the Date field.

Use the Clear Selection button to cancel filtering and return to the full results listing.

Sort projects

You can sort the project's run reports by clicking on any of the column heading that
are in bold type. Click the heading a second time to reverse the sort.

Filter by date
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Run Reports

Introduction

A Torrent Browser run report contains statistics and quality metrics for your run.
From a run report you can do the following:

• Review pre-alignment metrics such as bead loading, Ion Sphere™ Particle (ISP)
density, total number of reads, filtering numbers, and mean read length

• Review alignment metrics such as total aligned bases, average coverage, and
mean raw accuracy

• Download the result set
• Manually run a plugin on the run results
• Review the planned run settings
• Review the test fragments used with this run and test fragment quality metrics
• Review Chef Summary.
• Review Calibration Report.
• Review analysis information and Torrent Suite™ Software versions
• Review the analysis log
• Generate a zip file for technical support

A run report is divided into the following main areas (see the example run report
below):

• Report header - Buttons to download the run report or summary in PDF format,
to review the planned run settings for the run, to reanalyze the run, and to
upload the run's output files to Ion Reporter™ Software; a menu to change to a
different result set for the same sample; and a navigation bar to jump to the
Output Files or Plugin Summary sections.

• Barcode Summary - For barcoded runs, a barcode summary table appears above
the Plugin Summary area.

• Unaligned - Metrics taken before alignment, including bead loading, ISP density
and other metrics, read and filtering metrics, and read length

• Aligned - Metrics on the aligned reads
• Plugin Previews - Summary output of completed plugins (only if supported by

the plugins that executed on this analysis)
• Output Files - Download buttons for reads both before alignment and after

alignment (full-chip Ion Proton™ analyses only offer the download of aligned
reads)

• Plugin Summary - Links to plugin reports and a button to select another plugin
to run on this analysis

• Test Fragments - Displays information about the performance of each test
fragment included in the experiment
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• Chef Summary - Displays Ion Chef™ templating results.
• Calibration Report - Displays pre-base calibration and calibration arguments.
• Analysis Details - Displays a set of information about the sequencing run

environment (run date, sample name, chip type, instrument name, barcode set,
etc.)

• Support - Displays a link to the report log and a link to generate information for
technical support

• Software Version - Displays the version of Torrent Suite™ Software and its
modules

When determining a run's quality, first look at the un-aligned metrics including: total
bases, total reads, and mean and median read length. This information comes from
the primary pipeline, base calling and signal processing.

1. Go to Data4Completed Runs & Results, select a report of interest.

2. In the Unaligned section, review Total Bases, Total Reads and Mean and Median
Read Length to determine the run's quality.

For more information on these metrics see “Run report metrics before
alignment“ on page 120.

Review pre-
alignment metrics
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The secondary pipeline aligns the run to the reference. Here you can see how many
bases align to the reference,

1. Go to Data4Completed Runs & Results, and select a run of interest.

2. Scroll down to the Aligned to reference section and review Total Aligned Bases,
Reference Coverage, Mean Raw Accuracy, and Total Bases Alignment Quality.

For more information on these metrics, see “Run report metrics on aligned
reads“ on page 130

You can download the run results in several formats.

1. Go to Data4Completed Runs & Results and select a run of interest.

2. Scroll down to the Output files selection and choose your output type: unaligned
reads BAM, or aligned reads BAM or BAI.

For more information, see the “Output files“ on page 135 section.

After your run has completed, you can further your analysis by running various
analysis plugins.

1. Go to Data4Completed Runs & Results and select a run of interest.

2. Scroll down to the very bottom of the run report and click Select Plugins to Run.

Review alignment
metrics

Download results
set

Manually run a
plugin on the run
results
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3. Select the plugin you wish to run.

If the plugin does not require user input, it is immediately queued for execution.
Other plugins display a user interface in which you will need to select options.
When finished, click Submit.

4. View results in the Plugin Summary section.
For more information, see “Available plugins“ on page 178.
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You can review the planned run settings of a completed run.

1. Go to Data4Completed Runs & Results and select a run of interest.

2. Click Report Actions4Review Plan.
A Review Plan window appears.

Review the
planned run
settings

Run Reports
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If you included key signal test fragments in your run, you can review the test
fragments and assess their quality.

1. Go to Data4Completed Runs & Results and select a run report of interest.

2. Scroll down to the bottom of the report and click Test Fragments.

For more information, see “Test fragment report“ on page 137

If you used an Ion Chef™ instrument, you can review library and template
information.

1. Go to Data4Completed Runs & Results and select your run which incorporated
an Ion Chef™ instrument.

2. Scroll to the bottom of the run report and click Chef Summary.
Here you can review the library preparation and templating information.

Review the test
fragments and
their quality
metrics

Review Chef
Summary
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You can review calibration settings applied to a run in the Calibration Report.

1. Go to Data4Completed Runs & Results, and select a run report of interest.

2. Scroll down to the bottom and click Calibration Report.

3. View your Pre Base Calibration Arguments and Calibration Arguments.

For more information, see “Base Calibration mode options“ on page 503

You can review the analysis details of a completed run.

1. Go to Data4Completed Runs & Results and select a run report of interest.

2. Scroll down to the bottom of the report and click Analysis Details.
For more information, see “Analysis details“ on page 138

You can view the report error log when troubleshooting a run. If you need further
help, you can generate a customer support archive to share with customer support.

1. Go to Data4Completed Runs & Results and select the run report of interest.

2. Scroll down to the bottom and click Support4View the report log to see a list of
errors.

3. If the error report does not help you resolve an issue with the run, click
Download to generate a customer support archive that you can then send to
your customer support representative for assistance.

For more information, see “Support“ on page 141.

Review Calibration
Report

Review analysis
information

Review report
error log
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Report header

The left side of a run report header contains the following navigation links:
• Output Files Jumps to the Output Files area
• Plugin Summary Jumps to the Plugin Summary area (which also has the Test

Fragment, Analysis Details, Customer Support, and Software Version buttons)

The right side of run report header contains buttons for the following:
• Upload to IR Copies the run report's output files to Ion Reporter™ Software.
• Report Actions

– Review Plan Opens a summary page of the planned run information for this
run

– Edit Run Plan Opens an Edit Run page
– Copy Plan Opens the run plan wizard with a copy of the run plan

information for this run
– Select plugins to run Opens the Select a plugin window
– Reanalyze Starts a reanalysis of the run (you have the opportunity to

changes settings first)
– Data Management Opens the Data Management app, which you use to

delete, archive, export, or mark as do-not-delete the files for this run report
• Reports Opens the run report of a different result set for the same sample

• – Summary PDF Downloads the run report summary in PDF format
– Plugins PDF Downloads a summary of the plugin results in PDF format
– Classic Report Opens the run report in Torrent Suite™ Software 2.x format

Run Reports
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Drop-down options shown below:

Compare run reports

From a project listing page, you can compare report metrics for multiple runs side-by-
side.

Run report metrics

This section provides background information on run metrics and detailed
descriptions of a run report.

For analyses that are members of a project, you can download a CSV file of run
metrics.

This page provides background information on quality metrics, read lengths, and
alignment. These concepts are required to understand your run report.

The Torrent Browser Analysis Report gives performance metrics for reads whose
initial bases match the library key.

IMPORTANT! These reads are generated from the input library, not from the positive
control Test Fragments.

Performance is measured based on either predicted quality or quality as measured
following alignment. Q20 and AQ20 are explained as examples of predicted quality
and quality following alignment.

Run metrics
overview

Run Reports
Compare run reports
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The number of called bases with a predicted quality of Q20 is reported. The predicted
quality values are reported on the Phred scale, defined as -10 log10 (error
probability). Q20, therefore, corresponds to a predicted error rate of one percent.

Note: Refer to http://en.wikipedia.org/wiki/Phred_quality_score for a more
complete description of Phred values.

Read alignment can be used to assess the quality of the sequencing reaction and the
quality of the underlying library where an accurate reference is available. Reads are
aligned to a reference genome. Any discrepancy in alignment to a reference (whether
biological or technical, meaning a real variant or a sequencing error) is listed as a
mismatch. Alignment performance metrics are reported depending on how many
misaligned bases are permitted. Torrent Suite™ Software reports alignment
performance at two quality levels:

• AQ20
• Perfect

Aligned read length calculation

The aligned length of a read at a given accuracy threshold is defined as the greatest
position in the read at which the accuracy in the bases up to and including the
position meets the accuracy threshold. So for example the AQ20 length is the greatest
length at which the error rate is 1% or less. The "perfect" length is simply the longest
perfectly aligned segment. For all of these calculations the alignment is constrained to
start from position 1 in the read - in other words, no 5' clipping is permitted.

The underlying assumption is that the reference to which the read is aligned
represents the true sequence that should have been seen. Suitable caution should be
taken when interpreting AQ20 values in situations where the sample sequenced has
substantial differences relative to the reference used, such as working with alignments
to a rough draft genome or with samples that are expected to have high mutation
rates relative to the reference used. In these situations the AQ20 lengths might be
short even when sequencing quality is excellent.

Specifically, the AQ20 length is computed as follows:

1. Every base in the read is classified as being correct or incorrect according to the
alignment to the reference.

2. At every position in the read the total error rate is computed up to and including
that position.

3. The greatest position at which the error rate is one percent or less is identified
and that position defines the AQ20 length.

For example, if a 100bp read consists of 80 perfect bases followed by 2 errors followed
by 18 more perfect bases, the total error rate at position 80 is zero percent. At position
81 the total error rate is 1.2% (1/81), at position 82 the error rate is 2.4%, continuing up
to position 100 where it is two percent (2/100). The greatest length at which the error
rate is one percent or less is 80 and the greatest length at which the error rate is two
percent or less is 100, so the AQ20 lengths are 80 and 100 bases, respectively.

Predicted quality
(Q20)

Quality following
alignment (AQ20)
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Alignment

Within Torrent Browser, the objective is to provide you with a view on alignment that
helps determine run and library quality.

There are many alignment algorithms available within the marketplace and you are
encouraged to consult with a bioinformatician for the most appropriate alignment
algorithm for your downstream analysis needs. Alignment algorithms are also
embedded in many of the commercial software tools available within the Ion Torrent™

Web store. You are also encouraged to experiment with these tools.

Alignment within Torrent Browser is performed using TMAP. TMAP is currently an
unpublished alignment algorithm, created by the authors of the BFAST algorithm.
Please, contact your Ion Torrent™ representative or Technical Support for more
information about TMAP.

Although TMAP is unpublished and a reference is not currently available, the
precursor to TMAP, BFAST, is based on the ideas in the following publications:

Homer N, Merriman B, Nelson SF.BFAST: An alignment tool for large scale genome
resequencing. PMID: 19907642PLoS ONE. 2009 4(11): e7767. http://dx.doi.org/10.1371/
journal.pone.0007767

Homer N, Merriman B, Nelson SF. Local alignment of two-base encoded DNA
sequence. BMC Bioinformatics. 2009 Jun 9;10(1):175.PMID: 19508732 http://dx.doi.org/
10.1186/1471‑2105‑10‑175

Which reads are used in the alignment process

The alignment stage involves aligning reads produced by the pipeline to a reference
genome and extracting metrics from those alignments. By default, Torrent Suite™

Software aligns all reads to the genome, however there may be situations, particularly
with large genomes, where the alignment takes longer than the user is willing to wait.
So for such circumstances the Torrent Suite™ Software also has the capability to define
on a per-reference basis the maximum number of reads that should be aligned from a
run.

When the number of reads in a run exceeds a genome-specific maximum, a random
sample of reads is taken and results are extrapolated to the full run. By sampling a
quickly-aligned subset of reads and extrapolating the values to the full run, the
software gives you enough information to be able to judge the quality of the sample,
library and sequencing run for quality assessment purposes.

The outputs of the alignment process is a BAM file. The BAM file includes an
alignment of all reads, including the unmapped, with exactly one mapping per read.
When a read maps to multiple locations, the mapping with the best mapping score is
used. If more than one such mapping exists, a random mapping is used and given a
mapping quality of zero.

The Unaligned area in the Run Summary section provides before-alignment metrics.
There are three sections in the Unaligned area:

• ISP Density
• ISP Summary
• Read Length

Note: Click the magnifying glass icon  in the run report to open a larger image.

Run report
metrics before
alignment
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ISP density

This table describes the Ion Sphere™ Particle (ISP) density metrics:

Metric Description

Total Bases Number of filtered and trimmed base pairs
reported in the output BAM file.

Key Signal Percentage of Live ISPs with a key signal
that is identical to the library key signal.

Bead Loading Percentage of chip wells that contain a live
ISP. (The percentage value considers only
potentially addressable wells.)

The ISP Density image is is a pseudo-color image of the Ion Chip Plate showing
percent loading across the physical surface.

Click on the image (or the magnify icon ) to open a larger version:
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Key signal

Click the magnify icon in the Key Signal area  to open the key incorporation
graphs:
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The key incorporation graph show the average signal readings for flows of the bases
T, C, and A in the library key.
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ISP summary

In the lower rows, the percentages are relative to the total in the next higher row. The
first row gives percentages of loaded wells and empty wells, relative to the number of
potentially addressable wells on the chip.

This table describes the ISP summary metrics:

Metric Description Calculation

Total Reads Total number of filtered and
trimmed reads independent
of length reported in the
output BAM file.

(Not calculated)

Usable Sequence The percentage of library
ISPs that pass the
polyclonal, low quality, and
primer dimer filters.

Final Library ISPs/ Library
ISPs

Loading Percentage of chip wells
that contain a live ISP. (The
percentage value
considersonly potentially
addressable wells.)

No. of Loaded ISPs / No. of
potentially addressable
wells

Run Reports
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Metric Description Calculation

Empty Wells Percentage of chip wells
that do not contain an ISP.
(The percentage value
considers only potentially
addressable wells.)

(No. of potentially
addressable wells minus
No. of Loaded ISPs) / No. of
potentially addressable
wells

Enrichment Predicted number of Live
ISPs thathave a key signal
identical to the library key
signal.The Percent
Enrichment value reported
is the number of loaded ISPs
that are Library ISPs, after
taking out Test Fragment
ISPs.

Library ISPs / (No. of Loaded
ISPsminus TF ISPs)

No Template Percentage of chip wells
that do not contain a DNA
template.

(No. of Loaded ISPs minus
TF ISPs) minus (Library
ISPs) / (No. of Loaded ISPs
minus TF ISPs)

Clonal Percentage of clonal ISPs
(all library and Test
Fragment ISPs that are not
polyclonal).

An ISP is clonal if all of its
DNA fragments are cloned
from a single original
template. All the fragments
on such a bead are identical
(and they respond in unison
as each nucleotide is flowed
in turn across the chip).

No. of ISPs with single
beads / No. of Live Wells

Polyclonal Percentage of polyclonal
ISPs (ISPs carrying clones
from two or more
templates).

Polyclonal ISPs / Live ISPs

Final Library Percentage of reads which
pass all filters and which are
recorded in the output BAM
file.This value may be
different from the Total
Reads due to technicalities
associated with read
trimming beyond a minimal
requirement resulting in
Total Reads being slightly
less than Final Library.

Final Library / Clonal ISPs
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Metric Description Calculation

% Test Fragments Percentage of Live ISPs with
a key signal that is identical
to the test fragment key
signal.

Test Fragment ISPs / Clonal
ISPs

% Adapter Dimer Percentage of ISPs with an
insert length of less than 8
bp.

Primer dimer ISPs / Clonal
ISPs

% Low Quality Percentage of ISPs with a
low or unrecognizable
signal.

Low quality ISPs / Clonal
ISPs

Click the ISP Summary magnify icon

to open a larger version with also a table of metrics:

These metrics are described in this table:
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Metric Description Calculation

Addressable Wells Total number of addressable
wells.

(Not calculated)

With ISPs Number (and percentage of
addressable wells) of wells
that were determined to be
"positive" for the presence
of an ISP within the well.
"Positive" is determined by
measuring the diffusion rate
of a flow with a different pH.
Wells containing ISPs have a
delayed pH change due to
the presence of an ISP
slowing the detection of the
pH change from the
solution.

Wells with ISPs / Total
Addressable Wells

Live Number (and percentage of
wells with ISPs) of wells that
contained an ISP with a
signal of sufficient strength
and composition to be
associated with the library
or Test Fragment key. This
value is the sum of the
following categories:

• Test Fragment

• Library

Live ISPs / Wells with ISPs

Test Fragment Number (and percentage of
Live ISPs) of Live ISPs with a
key signal that was identical
to the Test Fragment key
signal.

Test Fragment ISPs / Live
ISPs

Library Number (and percentage of
Live ISPs) of Live ISPs with a
key signal that was identical
to the library key signal.

Library ISPs / Live ISPs

Library ISPs Predicted number of Live
ISPs that have a key signal
identical to the library key
signal (the same value as
shown in the well
information table on the
right).

Library ISPs

Filtered: Polyclonal ISPs carrying clones from
two or more templates.

Polyclonal ISPs / Library
ISPs

Filtered: Low quality Low or unrecognizable
signal.

Low quality ISPs / Library
ISPs
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Metric Description Calculation

Filtered: Primer dimer Insert length of less than 8
bp.

Primer dimer ISPs / Library
ISPs

Final Library ISPs Number (and percentage of
Library ISPs) of reads
passing all filters, which are
recorded in the output BAM
file. This value may be
different from the Total
number of reads located in
the Library Summary
Section due to technicalities
associated with read
trimming beyond a minimal
requirement resulting in
Total number of reads being
slightly less than Final
Library Reads.

Final Library / Library ISPs

Read length

This table describes the read length metrics:
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Metric Description

Mean Read Length Average length, in base pairs, of called
reads.

Median Read Length Median length of called reads.

Mode Read Length Mode length of called reads.

The read length histogram is a histogram of the trimmed lengths of all reads present
in the output files.

Click on the histogram to open a larger version:
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The run report provides metrics on aligned reads.

Total aligned bases

The following table describes metrics in the Total Aligned bases area.

Run report
metrics on aligned
reads
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Metric Description

Total Aligned Bases Number of filtered and trimmed aligned
base pairs reported in the output BAM file.

Total number of bases aligned to the
reference sequence. Excludes the library
key, barcodes, and 3' adapter sequences.

Reference Coverage The average of the number of reads that
cover each reference position: total aligned
bases divided by the number of bases in the
reference sequence.

Does not consider enrichment.

% Aligned Bases Percentage of Total Aligned Bases out of all
reads.

% Una ligned Percentage of bases not aligned to
references.

Total Reads Number of reads generated during
basecalling.

Aligned Reads Number of reads that aligned to the
reference genome.

Unaligned Reads Number of reads that did not align to the
reference genome.

The graph in the Total Aligned reads column plots number of aligned (in blue) and
unaligned (in purple) bases byposition in an aligned sequence. (The purple area
cannot be seen easily when it is under 3 or 4 percent.)
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For each position in an aligned sequence, the height of the blue area shows the
number of aligned bases at that position. The purple area shows the number of
unaligned bases at that position. Unaligned bases are not shown by the absolute
height on the number of bases axis, but by the difference between the purple height
and the blue height.

Raw accuracy

The graph in the Raw Accuracy column plots percent accuracy for each position in an
aligned sequence:

Metric Description

Mean Raw Accuracy 1x Average raw accuracy of 1-mers plotted by
their position in the read.

Run Reports
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Alignment quality

Alignment quality calculations include the following:

Metric Description

AQ17 An error rate of 2% or less.

AQ20 An error rate of 1% or less.

Perfect The longest perfectly aligned segment.

Total Number of Bases Total number of bases at the quality level.

Mean Length Average segment length at the quality level.

Mean Coverage Depth Average coverage at thequality level.

Run Reports
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The barcode section of a run report displays the following information per barcode:

Column Description

Barcode Name The individual barcode in the barcode set.

The row labeled as No barcode reports on
unclassified barcodes, which are reads that
could not be classified as matching one of
the expected barcodes in the barcode set.

Sample Name of the sample that was sequenced on
instrument.

Output Total number of reads.

% >= Q20 The percentage of reads that have a
predicted quality score of Q20 or better.

A Q20 score is the predicted quality ofa
Phred-like score of 20 or better, or one
error in 100 bp.

Reads Total number of filtered and trimmed
library reads (independent of length). This
number is reported in the barcode BAM file.

Mean Read Length The average read length, in bp, of all
filtered and trimmed library reads reported
in the barcode BAM file.

Read Length Histogram A thumbnail histogram of the read lengths
for this barcode. Click on the thumbnail
histogram to open a larger image.

BAM Buttons to download the BAM and BAM
index file (BAI) for this barcode. The BAM
file contains aligned reads sorted by
reference location.

Barcode reports
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The number of barcodes shown in the barcode section varies according to the barcode
set used in your run and on the barcodes actually present in the sample. Only data for
barcodes present in the run are displayed in the run report.

These links permit you to directly download the data and report files. Some files are
compressed, using the .zip format, to provide data integrity and to reduce
download time.

Click on a file type button to save the file to your local computer. Most output files can
be loaded into third-party viewers (such as IGV) for visualization. The barcode row
only appears for runs on barcoded data.

Files in the barcode row are zips of one file per active barcode. To download only
BAM and BAI files for a single barcode, go to the barcode section at the top of the run
report.

Column Description

Reads Files with unaligned reads (before
alignment)

Aligned Reads Files with aligned reads

File type Reads Aligned reads

BAM Unaligned reads in BAM
format.

In this release, the BAM file
contains some flow space
information.

Aligned reads sorted by
reference location.

BAI BAM index file

Output files
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Binary Sequence Alignment/Map (BAM), is a compressed, binary form of the SAM
format. BAM files can be indexed, using the BAM Index file, for quick access to
sequence alignment data. See http://samtools.sourceforge.net.for more a more
detailed description of the SAM/BAM file format. Many tools are available for
working with SAM files.

Deprecated file formats

The following file formats are deprecated and not produced by the default analysis
pipeline. The FileExporter Plugin optionally generates these files.

IMPORTANT! The SFF and FASTQ files created by the FileExporter Plugin are
generated in the plugin directory, not in the main analysis directory.

File type Description

SFF Compressed (.zip) Standard Flowgram
Format (SFF) -formatted file that contains
"flow space" data. The bases called in a run
are stored in two formats: SFF and FASTQ.
Both files contain the nucleotide calls and
associated quality values, the SFF files,
additionally, contain signal values in flow
space and a mapping between sequence
and flow spaces.

The data are organized on a per flow basis,
and contain information about nucleotide
flows that both did and did not result in
base incorporation.

Note: The SFF file format is deprecated
and not produced by the default pipeline.

FASTQ Compressed (.zip) FASTQ-formatted file
containing data organized in a per-base
basis, including quality scores. The reads
contained in the file are unaligned reads.

Note: The FASTQ file format is deprecated
and not produced by the default pipeline.

The BAM format
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Rename your output files

See the FileExporter Plugin supports renaming your output files. (This plugin also
optionally creates SFF or FASTQ formats, or zips your output.)

Test fragment report

The Test Fragment Summary section of the Analysis Report provides information
about the performance of each Test Fragment included in the experiment.

Test Fragments are used during analysis to predict the CF/IE/DR values for each Test
Fragment, regionally. Analysis results for a Test Fragment are displayed when there
are at least 1000 high-quality Test Fragments, where there is an 85% match against the
appropriate template in the Test Fragment list. This includes CF/IE/DR estimates and
performance calculations.

IMPORTANT! The number of TFs reported includes lower quality TFs, down to 70%
match, to better represent the run quality from all TF's.

Open the test fragments report with the Test Fragments button, near the bottom of the
run report:

The Test Fragments report displays the following information:

Parameter Description

Test Fragment Test fragment name (defined in the Admin >
References tab of Torrent Browser).

Reads Number of filtered & trimmed reads
identified for this test fragment.

Percentage 50AQ17 The percentage of reads for this test
fragment with a minimum of 50 base pairs
in length and an error rate of 1 in 50,
Phred-like 17, or better. Quality is based on
alignment, not predicted quality.

Open the test
fragment report

Test fragment
metrics

Run Reports
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The test fragment sequence is also shown in the read length histogram.

This is a histogram of read lengths, in bpunits, that have a Phred-like score of 17 or
better, or one error in 50 bp (the ends only are shown because of width
considerations):

Distributions skewed to the right are ideal, showing longer read lengths (test
fragments are a discrete length). It is likely that the sequence can extend all the way
through the test fragment, if enough flows are run, so the histogram only displays a
maximum size based on the length of the test fragment.

Report information

This section describes the following run report buttons.

The Analysis Details report displays the following information:

Parameter Description

Run Name Name of the run.

Run Date Date and time the Ion PGM™ orIon Proton™ run was
started.

Run Cycles Number of Ion PGM™ orIon Proton™ cycles analyzed for
this report. Note that this number can differ from the total
number of cycles run on the sequencer.

Run Flows Number of Ion PGM™ orIon Proton™ nucleotide flows
analyzed for this report. Note that this number can differ
from the total number of flows occurring on the sequencer.

Project Names of the projects the result set is a member of.

Sample Name of the sample assigned to the run used to generate
this analysis. This is assigned on theIon PGM™ or Ion
Proton™ Sequencer.

Read length
histogram1

Analysis details
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Parameter Description

Sample Tube Label The label or written text on a sample tube used to track
each sample through the sequencing workflow.

Reference Name of the library assigned to the run used to generate
this analysis. This library name is used to specify the
reference genome used for alignment.

Instrument Name of the sequencing instrument on which the run was
performed.

Flow Order Flow order selected on Ion PGM™ or Ion Proton™

Sequencer: Samba =
TACGTACGTCTGAGCATCGATCGATGTACAGC
[Default]Regular = TACG The "regular" flow order adds
bases most rapidly to sequenced molecules but is
vulnerable to phase errors. The Samba flow order consists
of a 32-base sequence, repeated. This flow order resists
phase errors by providing opportunities for out-of-phase
molecules to catch up and is designed to sample all dimer
(nucleotide pair) sequences, efficiently. Samba is the
default flow order because it improve sequencing accuracy
for longer reads by resisting phase errors.

Library Key A short known sequence of bases used to distinguish the
library fragment from the test fragment. Example: "TCAG"

TF Key A short known sequence of bases used to distinguish the
test fragment.

Chip ID The ID number of the chip that appears on the chip
barcode label.

Chip Check A series of tests on reference wells (about 10% of the chip
in non-addressable areas) is performed to ensure that the
chip is functioning at a basic level. The value of this field is
either Passed or Failed.

Chip Type Type of chip used on the IonPGM Sequencer. Usually, 314,
316, or 318 (for the Ion 314™ chip, Ion 316™ chip, and Ion
318™ chip.) A letter follows the numbers, indicating the
chip version.

Chip Data In this release, the value is single, for a forward run.

Chip Lot Number The lot number of the chip as scanned by the Ion Proton™

Sequencer or Ion S5™ Sequencer. Not available for Ion
PGM™ runs.

Barcode Set The name of the barcode set assigned to the run. Blank for
non-barcode libraries.

Analysis Name Name of the analysis provided in Torrent Browser when
the analysis was initiated. If the analysis was scheduled to
auto-start, this is the default analysis name.

Analysis Date Date the analysis was performed.

Run Reports
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Parameter Description

Analysis Flows Number of Ion PGM™ orIon Proton™ nucleotide flows
analyzed for this report. Note that this number can differ
from the total number of flows occurring on the Ion PGM™

orIon Proton™ Sequencer.

runID The run code that the Torrent Browser assigned to the
planned run for this analysis.

The Software Version report display includes version information for the modules
installed on your Torrent Server.

IMPORTANT! The version numbers shown in the example may be different from
your current version of the software depending on the age of the analysis. See the
About tab in the Torrent Browser for a complete list of modules and version on your
server. See the Torrent Suite™ Release Notes for the package versions in a specific
release.

Parameter Description

Torrent Suite™ Version of Torrent Suite™ Software software
used to generate the analysis.

Datacollect Version of the Datacollect package.

LiveView Version of the LiveView package.

Script Version of the Script package.

ion-alignment Version of the Torrent Suite™ Software
alignment module used for this analysis.

ion-analysis Version of the Analysis Pipeline used to
generate the analysis.

ion-db reports Version of the ion-dbreports package.

ion-gpu Version of the NVIDIA® Tesla® GPU driver.

ion-plugins Version of the pre-installed plugins.

ion-torrentR Version of the TorrentR stats package.

tmap Version of the TMAP alignment package.

Software version
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The Support button opens links to the following:
• Download the Customer Support Archive Download a ZIP archive containing

the PDF and HTML version of the run report as well as useful logs in case
troubleshooting is required. See Customer Support Archive for a description of
the archive and its contents.

• Download the New Customer Support Archive Generate a new customer
support archive and download it.

• View the Report Log View the error log for this run report.

Support
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An example report log is shown below (chopped for width considerations):
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Applications

Introduction

Torrent Suite™ software supports many research applications. In this section, we
highlight some of the main ones.

Pharmacogenomics Research Analysis Plugin

The Pharmacogenomics (PGx) Research Analysis plugin is designed to be used with
the Ion AmpliSeq™ Pharmacogenomics Research Panel, which is a targeted gene panel
that allows the interrogation of Pharmacogenomics variants in samples for
genotyping and CYP2D6 copy number detection. The figure below describes the
pipeline of analyses.
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The following instructions are intended to assist Pharmacogenomics (PGx) research
panel customers in setting up Torrent Suite™ (v5.0.2 and later) planned runs
incorporating the PGx research panel template and plugin.

• https://tools.thermofisher.com/content/sfs/manuals/
MAN0013730_CreatePlannedRun_IonAmpliSeqPharm_UB.pdf

• https://tools.thermofisher.com/content/sfs/manuals/
MAN0014300_CustomizGuidelines_IonAmpliSeqPharm_UB.pdf

Ion RNASeq Plugin

The following instructions are intended to assist RNA Seq plugin customers set up
Torrent Suite planned runs incorporating the RNA Seq plugin.

The Torrent RNASeqAnalysis Plugin is an RNA Transcript Alignment and Analysis
tool for use with reference genomes hg19 and mm10. Use this plugin to analyze
cDNA reads, as produced by RNA-Seq. Reads are aligned to the reference genome
using STAR and bowtie2 aligners to find full and partial mappings. The alignments
are analyzed by HTSeq and Picard tools to collect assigned read counts and cufflinks
to extract gene isoform representation. For barcoded data, comparative representation
plots across barcodes are created in addition to individual reports for each barcode.
All alignment, detail and summary report files are available for download.

1. Log into Torrent Suite™ Software.

2. Click on the Plan Tab.

3. Click on the Templates link to view Templates.

Create an RNA
Seq analysis run
from factory
template

Applications
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4. Click the RNA Seq‑Whole Genome option under Favorites in the left side
navigation list.

The Plan tab appears.

5. Click on the Ion Reporter tab, and click None and then click Next.

6. Click on the Application tab, select RNA and then click Next.

7. On the Kits tab, change Barcode Set to IonXpressRNA. Click Next.

8. On the Plugins tab, check RNASeqAnalysis and click Configure.

Applications
Ion RNASeq Plugin
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9. Select human or mouse reference and click Save Changes.

10. Click Next.

11. (Optional) On the Projects tab, select a project and click Next.

12. On the Plan tab, select None as the reference, enter a name for the run and add
samples. Click Plan Run.

13. Run plan on your sequencing system.
Each planned run contains complete instructions for its sample, from sequencing
on instrument to export of the results files to Ion Reporter software. Here is what
a planned run from this example looks like on the Plan4Planned Run page:

A planned run is ready to execute on the sequencing instrument and is executed
by entering the 5-digit run code on the instrument. From the run code, all the
plan run's settings are available on the instrument and to the Torrent Suite
software. All of your selections, from original template and the planned run that
you saved, are known to the Torrent system and software. The system carries out
your instructions from sequencing to data export.

Applications
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If you wish to customize the template, create a copy of the template.

1. Click the  Gear button in the Ion RNA ‑ Whole Transcriptome row and select
Copy.

2. Enter a name for the template and modify settings as required.

3. Click Copy Template.

After your sequencing run completes, review results on the Run Summary page.

1. Go to Data 4Completed Runs & Results and search for your run. The Run
Summary page appears.

2. Scroll down to the RNASeqAnalysis section and you'll see the Barcode
Summary table. This is an overview table that includes columns for Barcode
Name, Sample, Total Reads, Aligned Reads, Percent Aligned Mean Read Length,
Genes Detected, and Isoforms Detected.

3. Click on the RNASeqAnalysis.html link to view other components of the report.
Below the Barcode Summary are tabs to view the results graphically.

Modify RNASeq
Template

Review run
results
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Distribution Plots

Reads Alignment Summary- A graphical summary of the number of mapped and
unmapped reads across barcodes, as reported in the barcode summary table.

Alignment Distribution - A graphical summary of the distribution of reads to
genomic features.

Applications
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Normalized Transcript Coverage - An overlay of individual normalized transcript
coverage plots for each barcode.

Distribution of Gene Reads - Distribution of genes across barcodes showing the
frequency of numbers of genes having similar log10 read counts. All curves are
plotted on the same axis scale. The counts data is fitted to a Gaussian kernel using the
default R 'density' function.

Applications
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Distribution of Isoform Reads - Distribution of transcript isoforms across barcodes
showing the counts of isoforms having similar FPKM values. All curves are plotted on
the same y-axis, normalized to the highest count and scaled for FPKM values ≥0.3.

Correlation heatmap

A heatmap of Spearman correlation r-values for comparing log2 RPM reads pair
correlation barcodes, with dendrogram reflecting ordering of barcodes as being most
similar by these values.

Applications
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Correlation plot

Barcode read pair correlation plot. Lower panels show log2(RPM+1) values plotted for
each pair of barcodes, with linear least squares regression line overlaid and line slope
reported. Upper panels show Pearson correlation r-values for the regression line.
Diagonal panels show the frequency density plot for the individual log(RPM+1)
values for each barcode. (If only one barcode has reads, a density plot is displayed.)
Click the plot to open an expanded view in a new window.

Gene heatmap

A gene representation heatmap of 250 genes showing the most variation in
representation across barcodes as measured by the coefficient of variant (CV) of
normalized read counts for genes that have at least one barcode with at least 100 RPM

Applications
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reads, plotted using log10 of those counts. For this plot, barcodes will be omitted if
they have less than 100,000 total reads.

Isoform heatmap

A transcript isoform representation heatmap of up to 250 gene transcript isoforms
showing the most variation in representation across barcodes as measured by the
coefficient of variation (CV) of FPKM values for isoforms that have an FKPM value ≥

Applications
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100 for at least one barcode, plotted using log10 of FKPM+1. Barcodes are excluded if
they have less than 1,000 isoforms detected at FPKM values ≥ 0.3.

Downloadable reports

At the bottom of the screen are links for downloading raw analysis output files:

Barcode Summary Report - This report produces a Microsoft™ Excel™ table listing
each barcode's sample name, total reads, aligned reads and percent aligned.

Absolute Reads Table - This Microsoft™ Excel™ table lists absolute reads for the genes
found on each barcode.

Absolute Normalized Reads Table - This Microsoft™ Excel™ table lists absolute
normalized reads for the genes found on each barcode.

Aligned Reads Distribution Table - Distribution of genes across barcodes showing
the frequency of numbers of genes having similar log10 read counts.

Applications
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Isoform FPKM Values Table - Table format of the Isoform gene heatmap.

Click on any barcode of interest to see similar graphs of the barcode alone.

Reference table - Plot showing the number of genes with reads in log10 counting
bins.

Gene Mapping Summary - Summary of reads mapped to genes of annotated
reference.

Base Mapping Summary - Summary of base reads aligned to genetic features of an
annotated reference.

Individual barcode
view
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Normalized Transcript Coverage - A plot of normalized transcript coverage; the
frequency of base reads with respect to the length of individual transcripts they are
aligned to in the 3' to 5' orientation.

Gene Isoform Expression - Box plots showing variation of isoforms expressed at
FPKM ≥ 0.3 for each set of genes grouped by the number of anticipated (annotated)
isoforms. Whiskers are defined by points within Q1-1.5xIQR to Q3+1.5xIQR. Only
genes with 25 or less isoforms are represented in this plot. The data and a plot for all
genes are available for download using the download reports links at the bottom of
the screen.

Applications
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Downloadable reports

At the bottom of the screen are links for downloading raw analysis output files for the
individual barcodes:

Statistics Summary - Provides an overview of the individual barcodes RNA Seq
Analysis results.
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Gene Read Counts - Lists the number of times a gene was counted for the individual
barcode.

Output Files - Provides a directory for various output files for this barcode.

Cufflinks Output Files - Provides a list of links to Cufflinks output files.

Applications
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ampliSeqRNA

The ampliSeqRNA plugin is used with the AmpliSeq™ Transcriptome Human Gene
Expression Kit, AmpliSeq™ RNA panel, and custom RNA panels.

1. Click Plan4Templates link to view Templates.

2. Click the AmpliSeq RNA option under Favorites in the left side navigation list.

3. Choose the Ion AmpliSeq Transcriptome Human Gene Expression Panel
template.

a. In the Reference Library drop-down box, select
hg19_AmpliSeq_Transcriptome_ERCC_v1.

b. In the Target Regions drop-down box, select
hg19_AmpliSeq_Transcriptome_21K_V1 BED file.

4. Click on the Ion Reporter tab, and click None and then click Next.

5. Click on the Application tab, confirm RNA and AmpliSeq RNA are selected and
then click Next.

6. On the Kits tab, confirm the following are selected, then click Next.

Create an
ampliSeqRNA
planned run with
factory template
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7. On the Plugins tab, check ampliSeqAnalysis and click Configure.

8. (Optional), consider the Filter Barcodes and ERCC Tracking options as described
in the Plugin Configuration screen. Click Save Changes then clickNext.

9. (Optional) On the Projects tab, select a project and click Next.

10. On the Plan tab, click Plan Run.

11. Run plan on your sequencing system.

After your sequencing run completes, review results on the Run Summary page.

1. Click the Data tab4Completed Runs & Results, then search for your run.

2. Click the Report Name link to open the Run Summary page for your run.

Review run
results
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3. Scroll down to the AmpliSeqRNA section, then click the ampliSeqRNA.html
link to open the ampliSeqRNA Report – Barcode Summary for all barcodes.
Alternatively, click individual barcode names to see the results for an individual
barcode.

4. In the Barcode Summary table, review your Mapped Reads, Valid Reads, and
Targets Detected by barcode.

5. At the bottom of the report, click the Distribution Plots, Correlation Heatmap,
Correlation Plot, and Gene Heatmap tabs to review the data graphically.
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Distribution Plots

Reads Alignment Summary – A graphical summary of the number of mapped and
unmapped reads across barcodes, as reported in the Barcode Summary table.
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Distribution of Gene Reads – Distribution of genes across barcodes showing the
frequency of numbers of genes having similar log10 read counts. All curves are
plotted on the same axis scale. The counts data is fitted to a Gaussian kernel using the
default R 'density' function.
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Correlation Heatmap

A heatmap of Spearman correlation r-values for comparing log2 RPM reads pair
correlation barcodes, with dendrogram reflecting ordering of barcodes as being most
similar by these values.
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Correlation Plot

Barcode read pair correlation plot – Lower panels show log2(RPM+1) values plotted
for each pair of barcodes, with linear least squares regression line overlaid and line
slope reported. Upper panels show Pearson correlation r-values for the regression
line. Diagonal panels show the frequency density plot for the individual log(RPM+1)
values for each barcode. (If only one barcode has reads, a density plot is displayed.)
Click the plot to open an expanded view.

Applications
ampliSeqRNA

164 Torrent Suite™ Software Help



Gene heatmap

Gene Representation Heatmap – Displays 250 genes showing the most variation in
representation across barcodes as measured by the coefficient of variation (CV) of
normalized read counts for genes that have at least one barcode with at least 100 RPM
reads, plotted using log10 of those counts. For this plot, barcodes are omitted if they
have <105 total reads.

Downloadable reports

The following reports are available for download as tab-delimited text files,
compatible with Microsoft™ Excel™ or similar applications.

At the bottom of the screen are links for downloading raw analysis output files:
• Barcode Summary Report – A table listing each barcode's sample name, total

reads, aligned reads, and percent aligned.
• Absolute Reads Matrix – This table lists absolute reads for the genes found on

each barcode.
• Absolute Normalized Reads Matrix – This table lists absolute normalized reads

for the genes found on each barcode.
• Differential Expression for Barcode Pair – Is a pop-up window that allows you

to compare two barcodes. You can set a threshold for minimum read count and
exclude targets from the differential expression table. Differential expression for
each target will be represented as the log2 of the ratio of RPM reads of the
experiment barcode to the control barcode.
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Oncology – Liquid Biopsy

The Oncology – Liquid Biopsy application supports tumor and liquid biopsy
oncology research applications, for the following sample types: lung, breast and
colon. The corresponding Planned Run templates for related panels are named as
follows:

Name

Oncomine™ Colon Tumor DNA

Oncomine™ Colon Liquid Biopsy DNA

Oncomine™ Breast Tumor DNA

Oncomine™ Breast Liquid Biopsy DNA

Oncomine™ Lung Tumor DNA

Oncomine™ Lung Liquid Biopsy DNA

The following instructions provide a basic overview of how to set up a planned run
for the related panels.

1. In the Template Name column, click on the template and the wizard opens on the
Plan tab.

2. In the Ion Reporter tab, select None, and click Next.

3. In the Application tab, confirm Oncology – Liquid Biopsy and Tag Sequencing
are selected. Click Next.

4. In the Kits tab, select Oncomine cfDNA Assay. Click Next.

5. In the Plugins tab, select variantCaller_cfDNA. Click Next.

6. (Optional) on the Projects tab, select a project. Click Next.

7. In the Plan tab, enter a name for your run and add samples. Click Plan Run.

1. In the Plan4Templates screen, select Oncology – Liquid Biopsy category under
Favorites.

2. Create a copy of the appropriate factory template, either Oncomine™ Lung
Tumor DNA or Oncomine™ Liquid Biopsy DNA.

a. Click the Gear button to access the Copy function in the row of the
appropriate template.

3. Define your template on the Copy Template page.
a. Enter a name for the template.

b. Verify the DNA Reference Library.

c. Add DNA Target Regions .bed file.

Plan an Oncology
– Liquid Biopsy
run from template

Create an
Oncology – Liquid
Biopsy Planned
Run template
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d. Enter a note about the template (if desired).

e. Click Copy Template.
Your new template appears under the Template Name column.

The Completed Runs Report from an Oncomine™ cfDNA Assay run is similar to
variantCaller plugin reports. The following outputs have been added.

1. After the run is complete, click Data4Completed Runs and Results, then click
the Run Report for your results.

2. To view a summary of the variant analysis, scroll down to the variantCaller
section, then click the appropriate button to download variant calls in .vcf or .xls
formats.

Review
Oncomine™ cfDNA
assay run results
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3. Review the results in the Median Read Cov, Median Mol Cov, and Targets >
0.8MM columns.

Column Description

Median Read Coverage Reports median coverage across targets.
Median Molecular Coverage reports
median number of individual
interrogated DNA molecules across
targets.

Targets >0.8 Median Molecular Coverage Reports percent of targets with
molecular coverage within 80% of the
median coverage value. This is a new
stricter definition of panel uniformity.

Median Read Coverage and Targets >0.8
Median Molecular Coverage

Measures the quality of the sequencing
run and library performance, while
Median Molecular Coverage measures
the amount and quality of the input DNA
sample.

Median Molecular Coverage Directly influences the limit of detection
in a sample run. We always require two
independent molecular families to
identify a variant for it to be called. Lower
median molecular coverage values result
in less sensitive detection of variants at
0.1% frequency, although still sufficient
for sensitive detection of variants with
higher frequency. For example, Median
Molecular Coverage of 700 is sufficient
for accurate detection of variants at 0.5%
frequency.

For sensitive variant detection down to 0.1% frequency, we see optimal results
when targeting a Median Read Coverage >25,000, Median Molecular Coverage >
2,500, and Targets >0.8 Median Molecular Coverage >60%.

4. Click a Barcode Name of interest to review Variant Calls by Allele.

By default only hotspot alleles calls are shown in the variant table. We do not
report hotspot alleles that did not meet our criteria for calling. However, we do
provide at least one record for each hotspot position. This can include: novel
allele call at hotspot position, hotspot allele call, or absent call when the first two
are missing.
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Column Description

Frequency Reports the observed frequency of hotspot allele.

LOD Reports limit of detection at hotspot position, which is
based on the number of interrogated DNA molecules
(fragments) containing target.
We use the term 0.1% LOD to mean we have data to
support specific sensitivity and specificity claims (90%
and 98%) at the 0.1% allelic frequency. By default, our
analysis tool uses minimum alternative allele
frequency threshold of 0.05% and we have a technical
lower limit of detection of 0.03% for this method.

Observed frequency can be lower than LOD due to sampling nature of the assay.
If selected to display hotspot positions with absent variant call, then only one
record per hotspot position is displayed and only one of the hotspot alleles at
that position is displayed under "Allele Name".

5. Click View Coverage Metrics to view the total number of interrogated DNA
molecules at hotspot positions (Molecular Coverage), and the number of
molecules containing the variant (Allele Mol Cov).

6. You can modify the types of calls that are displayed in the Allele Calls dropdown
list, by selecting or deselecting Absent, Heterozygous, Homozygous, or No Call.
No calls are variant calls that are classified as systematic errors.
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7. Select Absent in the Allele Call
dropdown list to visualize hotspot
positions without a valid variant call that
meets our analysis criteria. We report
one record per hotspot position with
missing alternative call, and the
alternative allele is an arbitrary value
distinct from reference. LOD and
molecular coverage metrics at those
positions are measurements for variant
absence among many interrogated
molecules.

8. To view novel alleles, select Novel (sequenced allele that is different from the
expected allele defined in the panel hotspot file) in the Allele Source dropdown
list.

16S Metagenomics application

The Ion 16S™ Target Sequencing templates are used to create planned runs for the Ion
16S™ Metagenomics Kit. You can select your Ion Reporter™ account, kits, plugins, and
parameter settings.

Note: To modify default parameters, see “Configure Custom Analysis
Parameters“ on page 526.

1. Select Plan4Templates, then in the Favorites list, select 16S Target Sequencing.

2. Select the Ion 16 S Metagenomics Template.
The wizard launches and displays the Plan page.

3. Add samples, confirm or change the default settings, and enter a plan name, then
click Plan Run.

4. Run the plan on your sequencing system.

Plan a run using
Ion 16S™ Target
Sequencing
template
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Plugins

The Torrent Browser Plugin Store

In the Torrent Browser Plugin Store you can search for plugins of interest, download
them in your Torrent Browser, and run them on your analyses.

You can install a plugin from the store automatically or manually. Each plugin page
provides an XML link for automatic installation and a zipped offline installer for
manual installation. These links are shown in the example plugin page below.

Automatic installation from the Torrent Browser Plugin Store

Follow these steps for automatic installation of a plugin from the Torrent Browser
Plugin Store:

1. In the Torrent Browser Plugin Store go to the page for the plugin to be installed.

2. Scroll to the bottom of the page, and find the XML link with these directions:
"Copy and paste this link into your Torrent Browser under the 'Config' tab after
clicking the 'Add' button in the plugin section to auto install the plugin."
An example XML link is the following: http://
torrentcircuit.iontorrent.com/warehouse/download/feedfile/
Ex.xml
Copy this link.

3. In your Torrent Browser, click the gear menu (near the top right) and select
Plugins:
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4. In the Plugins tab, click the Install or Upgrade Plugin button:

5. In the Install via URL tab, paste the plugin's XML link into the empty field, and
click Download.

After installation is complete, you must click the Enabled checkbox to make the
plugin available to users.

Manual installation of a Torrent Browser Plugin Store package

Follow these steps to download a plugin's installation package for manual
installation:

1. In the Torrent Browser Plugin Store . go to the page for the plugin to be
installed.

2. Scroll to the bottom of the page, and find the table with this explanation: "Links
to the plugin archives are provided below for manual installation." Click
theOffline Installer link.

3. Save the download to your machine.

Plugins
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4. In your Torrent Browser, go to the Admin Plugin section, and click the Install or
Upgrade Plugin button.

5. In the Install via Zip upload tab, click the Select file button. Browse to the
Offline Installer you just downloaded, and select it.

6. Click the Upload file button. The installation begins.

7. After installation is complete, you must click the Enabled checkbox to make the
plugin available to users.

Enable an installed plugin

Follow these steps to enable an installed plugin:

1. Click the Torrent Browser Admin gear menu, and select Plugins. The installed
plugins are displayed.

2. Click the Enabled checkbox for new plugins, to make them available to
users.Click the Auto-Run checkbox for plugins that you want to be run on every
analysis run.

IMPORTANT! You must click the Enabled checkbox for new plugins, to make
them available to users.

Plugins
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Delete a plugin

To delete a plugin:

1. Click the Torrent Browser Admin gear box and select Plugins.

2. For the plugin you want to remove, click the gear box menu for that plugin and
select Uninstall:

Not all plugins offer a Configure option.

Enable or disable automatic plugin execution

1. Click the Enabled checkbox for the plugin to enable the plugin to run
automatically after pipeline analysis processing. Uncheck the checkbox to disable
automatic plugin exection.

2. When the plugin Auto‑Run status is enabled, the plugin is run at the end of every
analysis job.

3. Plugins that require manual input, for instance for options or user information,
cannot be Auto‑Run.

Plugins
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Plugin Summary

The Plugin Summary section lists the plugins associated with the analysis, and
provides an interface for running and monitoring your plugin(s).

Each plugin has one of the following behaviors:
• Run without user input Plugins without a user interface display a confirmation

message that the plugin has been submitted to run. These plugin launch
immediately (without confirmation) when you click them in the Select Plugins to
Run list.

• Run with a user interface Plugins requiring input parameters display a user
interface dialog and are launched after you click Submit.

The Combine Alignment and IonReporterUploader functionality

In previous releases, Combine Alignment was a plugin available through the Select
plugins to run button. Combine Alignment is now available in a project result set
page, Data > Projects > projectname, with the Combine Selected... button. The result
sets to be combined must be members of the same project.

The IonReporterUploader plugin is available on a completed run report to launch
manually through the Select plugins to run button and can also be specified in the
template and planned run wizard, under the IonReporter chevron, to run
automatically (after the plugin is configured).

IMPORTANT! The following plugins are pre-installed.

• ampliSeqRNA
• AssemblerSPAdes
• coverageAnalysis
• DataXfer
• ERCC_Analysis
• FileExporter
• FilterDuplicates
• PGxAnalysis
• RNASeqAnalysis
• IonReporterUploader
• Run Transfer
• sampleID
• variantCaller

Run a plugin

Plugins
Plugin Summary
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To manually run a post-analysis plugin on the report data:

1. Click Select Plugins To Run.

2. The Plugin List pops up and displays a list of available plugins:

3. Click the plugin you want to run. If the plugin does not require user input, it is
immediately queued for execution.

4. Select the desired plugin options and click Submit. This runs your plugin, listing
the run status in the Plugin Summary panel.

5. For plugins that take a long time to run, click Refresh Plugin Status to update
the plugin display status.
Note: You can stop a plugin from the status screen.

After a plugin runs, it is listed in the Plugin Summary panel:

Some plugins, such as Alignment, display a preview results window in the Plugin
Summary list.

Each plug includes a summary line:

The
Plugin Summary
list 

Plugin status and
information

Plugins
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The summary line includes the following information:
• The size of the plugin report and output files.
• A trash icon

to delete the plugin report and results. (Careful, there is no confirmation dialog.)
• The plugin status, such as Queued, Started, Completed, or Error.
• The scroll icon

for the plugin's log file.

Plugin results, results summaries, links to output files, and other information are
available in the plugin report pages.

Click the plugin html link in the Plugin Summary section to open that plugin's report
page:

Plugin reports

Plugins
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Run the Installed Plugins

You customize your Torrent Suite™ Software analysis by running one or more plugin
applications at the end of each run. Your Torrent Browser includes several of these
plugins, such as for variant calling and realignment. The Torrent Browser Plugin Store
offers other plugins written by Ion Community members. The 
Torrent Browser Plugin Store is on the Ion Community (registration required).

This table lists the pre-installed and officially supported plugins.

Plugin Description

ampliSeqRNA Performs primary analysis from the
sequencing output of the AmpliSeq
Transcriptome Panel. The plugin generates
an initial summary report listing the
samples, the number of mapped reads, the
percent of valid reads, and the percent of
targets detected. A series of log2 RPM pair
correlation plots are included for rapid
correlation analysis. Microsoft™ Excel™-
compatible reports are also generated,
including differential expression tables.
Additional details around read coverage are
also provided on a per-barcode basis, along
with a list of gene annotations for each
sequenced region.

AssemblerSPAdes Allows for an initial level analysis on
assembly, with metrics such as number of
contigs, N50 and other analysis metrics.
The plugin is ideal for genomes less than 50
megabases in size.

Coverage Analysis Provides statistics and graphs describing
the level of sequence coverage produced for
targeted genomic regions.

ERCC Analysis Helps with ERCC RNA Spike-in Controls:
enables you to quickly determine whether
or not the ERCC results indicate a problem
with either the library preparation or the
sequencing instrument run.

Available plugins
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Plugin Description

FileExporter Customizes the output file names of an
analysis run. This plugin allows you to
rename output files. The plugin also offers
these options:

• Generates a Fastq format file of the
analysis output

• Generates an SFF format file of the
analysis output

• Renames Variant Caller plugin output
files (when available)

• ZIps output files

FilterDuplicates Removes duplicate reads. BAM files with
duplicate reads removed are saved in the
FilterDuplicates plugin directory.

IonReporterUploade
r

Transfers run results files to your
organization in Ion Reporter™ Software
(available under a separate license).

Please read the Ion Reporter™ Software
release notes for instructions about the
Uploader plugin.

PGxAnalysis Used with the Ion AmpliSeq™

Pharmacogenomics Research Panel, which
is a targeted gene panel that allows the
interrogation of Pharmacogenomics
variants in samples for genotyping and
CYP2D6 copy number detection. See
Pharmacogenomics section in the
Applications chapter for more information.

RNASeqAnalysis Used to analyze cDNA reads. This plugin is
an RNA transcript alignment and analysis
tool for use with the reference genomes
hg19 and mm10. See RNASeqAnalysis
section in the Applications chapter for more
information.

RunTransfer Transfers the signal processing output of a
completedTorrent Suite™ Software run from
one Torrent Server to another Torrent
Server. On the new Torrent Server, a
analysis is launched on the newly-
transferred files.
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Plugin Description

sampleID Uses sample fingerprinting to identify any
cross-contamination between samples or
between barcodes in a run.

variantCaller Calls SNP and indel variants across a
reference or within a targeted subset of that
reference. With low-frequency variant
options, the plugin can call variants down to
a 5% level of variant frequency. The plugin
can also show which variants coincide with
predefined HotSpot positions on the
reference sequence.

This table lists functionality that previously shipped as a supported plugin and that
now is available only on the Plugin Store.

Previous plugin Description

Alignment Performs a new alignment to the reference
you specify.

(The main Torrent Suite™ Software analysis
pipeline automatically performs alignment
to hg19, unrelated to the Alignment plugin.)

This table lists functionality that previously shipped as a supported plugin and that
now is replaced by the RunTransfer plugin.

Previous plugin Description

TorrentSuiteCloud Replaced by the RunTransfer plugin.

This table lists functionality that previously shipped as supported plugins and that
are replaced by the FileExporter plugin.

Previous plugin Description

FastqCreator Creates a FASTQ format file from the BAM
results file of a completed analysis run.
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Plugin configuration

This section describes the various ways plugins are configured.
• No configuration These plugins (sample ID and FilterDuplicates) do not take an

user options. These plugins are ready to use as-is on new systems. When selected
for manual launch on a completed run report, these plugins launch immediately.

• The admin Plugins tab Several plugins can be configured in the admin Plugins
tab. In this case, the one configuration is used for all runs of the plugin by all
users (unless overridden by a template configuration or manual launch
configuration). If someone changes an existing plugin configuration here, those
settings become the new configuration that is used by everyone.

• Manual launch page Many plugins can be configured on a manual launch in the
run report for a completed run. Each run can be configured with different
options.

• Plan template wizard Some plugins, IonReporterUploader andvariantCaller, also
can be configured in a run plan template. Each run using that template has the
same plugin configuration. (The IonReporterUploader has its own chevron in the
wizard. The variantCaller plugin is configured in the Plugins chevron.)

Plugin

Accep
ts

config
uratio

n

Admin Plugin
tab

configuration

Plan template
wizard

Manual launch
configuration

ampliSeqRNA Yes

Assembler
SPAdes

Yes No Yes Yes

Coverage
Analysis

Yes No Yes Yes

DataXfer

ERCC Analysis Yes Yes Yes Yes

FileExporter Yes Yes Yes Yes

FilterDuplicate
s

No No Yes No

IonReporterUp
loader

Yes Yes Yes

(IonReporter
chevron)

Yes

PGxAnalysis

RNASeqAnalys
is

RunTransfer Yes Yes Yes Yes
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Plugin

Accep
ts

config
uratio

n

Admin Plugin
tab

configuration

Plan template
wizard

Manual launch
configuration

SampleID No No Yes No

variantCaller Yes No Yes Yes

Access the admin plugin configuration area from the gear menu Plugins option:

Then click the Manage column gear menu for the specific plugin and select Configure:

Admin plugin
configuration area
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Manually run a plugin

You can manually run a plugin in the run report of a completed analysis run, with the
Select plugins to run button. Only enabled plugins are listed. Follow these steps to
manually run a plugin:

1. Go to the Data > Completed Runs & Reports tab, then click the link for your
completed analysis run.

2. In the run report, scroll down to Plugin Summary tab.

The Plugin Summary also lists any plugins that executed on your run (not shown
in this example).

3. Click Select plugins to run to see the list of plugins available in your Torrent
Suite™ Software.

4. Click the desired plugin name to run a plugin. If the plugin does not require user
input, it starts immediately, without a confirmation screen.

5. Click Close to close the Plugin List without running a plugin.

Plugins
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Automatically run plugins

When you design your sequencing protocol in the Plan4Template page, you specify
which plugins to execute. You can select any plugin that is installed and configured
on your Torrent Suite™ Software. You are not limited to the pre-installed plugins.

Assembler SPAdes Plugin

This plugin assembles reads into long sequences (contigs) and allows for basic level
analysis, with metrics such as number of contigs, N50, and other analysis metrics. The
plugin is ideal for genomes less than 50 megabases in size. The plugin assumes a
haploid genome. For multiploid genomes, reads from different copies of a
chromosome tend to assemble into different contigs.

Note: For de novo assembly, use a Generic Sequencing template for the Torrent Suite™

Software analysis.

Follow these steps to run the plugin and to review the plugin output report.Run the
AssemblerSPAdes
plugin on a
completed run
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1. To run this plugin, in the report for your run, scroll down to the Plugin Summary
section, and click Select plugins to run.
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2. In Select a plugin, select Assembler SPAdes. The plugin displays the plugin
user interface:

For most uses, you can take the defaults and click Submit the Plugin.
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This section describes the optional advanced settings. To open the advanced
parameters fields, click the Advanced Settings + button.

These are the default advanced settings:

Field Description

Fraction of reads to use If less than 100%, reads are randomly sub-
sampled.

100% is recommended the plugin
automatically handles most changes in
coverage.

Only process barcodes By default the plugin processes all
barcodes in the analysis and produces
separate set of contigs for each barcode. To
limit plugin analysis to only specific
barcodes, list those barcodes here
(separated by commas, no spaces).
Example:

Skip barcodes with fewer than Ignores barcodes whose number of reads
do not meet this threshold. Intended to
filter out barcode classification problems
with noisy data.

Advanced settings
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Field Description

RAM to allocate The plugin attempt to allocate the amount
of RAM specified here. With larger amounts
of memory, the plugin runs faster. With less
memory, the plugin takes longer to
complete.

Note: The plugin crashes if the memory
allocation fails.

SPAdes version Select the version that you prefer. Select
the default if you do not know.

Assembly settings Set this menu as follows:

• Uniform coverage Choose this setting
for data with average or low GC
content. This setting uses the default
kmers.

• Non-uniform coverage Choose this
setting for data with high GC content.
This setting uses the default kmers.

• Highly non-uniform coverage Choose
this setting for data with high GC
content. This setting uses a different
set of kmers.

Run read correction before doing
assembly

Recommended.

Skip assembly if previous results exist Recommended.

The K and Mode fields are displayed when the Assembly settings menu is set to
Custom:

The K field

The SPAdes plugin is a De-Bruijin graph assembler. The plugin breaks reads in kmers,
makes a connected graph, and traverses through that graph to produce contigs.

The K field determines the kmer size and how many kmers are used.

Notes about the kmers setting:
• Use a smaller kmer if your data contians many errors.
• If your data contains many repeats, use a larger kmer.
• Each additional kmer adds a fixed amount to the processing time (using 2 kmers

takes twice as long as one kmer).

Custom assembly
settings
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The Mode menu

Select the Single‑cell option for data with high (> 68%) GC content.

Select the Multi‑cell option for data with average or low GC content.

Output

The plugin output includes sections for downloads and statistics:
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Downloads

• Assembled Contigs Download or open a FASTA file of the assembled sequences
in the FASTA format.

• SPAdes log Download or open a text file of log messages from SPAdes. (For more
information, see the SPAdes site bioinf.spbau.ru/spades.)

• QUAST report Download or open an HTML file of assembly statistics generated
by QUAST. (For more information, see SPAdes documentation http://
spades.bioinf.spbau.ru/release2.1.0/quality.htm.)

Parameter section

The Parameter section shows the version of SPAdes that generated this run and the set
of kmers that was used:

Metric section

The Metric section shows the following information:

Metric Description

Largest Contig Length of the longest assembled contig

Total Length Total number of base pairs contained in all
assembled contigs that are at least 500 bp
in length.

Number of Contigs N umber of assembled contigs that are at
least 500 bp in length.

Assembly
Statistics
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Metric Description

N50 The contig length such that using longer or
equal length contigs produces half (50%)
the bases of the assembly. Usually there is
no value that produces exactly 50%, so the
more technical definition is the minimal
length x such that using contigs of length at
least x accounts for at least 50% of the total
assembly length.

N75 The contig length such that using longer or
equal length contigs produces 75% of the
bases of the assembly.

N90 The contig length such that using longer or
equal length contigs produces 90% of the
bases of the assembly.

N95 The contig length such that using longer or
equal length contigs produces 95% of the
bases of the assembly.

Note: SPAdes only reports contigs that are 500 bp or longer.

Coverage Analysis Plugin

The Coverage Analysis plugin provides statistics and graphs describing the level of
sequence coverage produced for targeted genomic regions. The report produced
depends on the Library Type set in the plan. AmpliSeq™ DNA reports contain the
most information, but Whole Genome runs will not have as many plots, for example.
On some charts, such as the Amplicon and Reference Coverage charts, you can click
an Export button and export the charts as graphics.

The plugin's documentation is embedded in its output page. Access the
documentation through help and options icons in the top right corner of a chart:

You can also zoom in and out on many of the plots and graphs.
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You can run the Coverage Analysis plugin automatically or manually.

Include the Coverage Analysis plugin in a run plan

To run the Coverage Analysis plugin automatically, you select Coverage Analysis
plugin during template setup. Refer to the Plan Tab and Templates pages sections for
information about how to set up a template and create a planned run.

Manually launch the Coverage Analysis plugin

To run the Coverage Analysis plugin manually, perform the following steps:

1. In the Torrent Browser, select a run report by clicking a run link, then clicking a
report from the drop-down area. The run report opens.

2. On the run report page, scroll about halfway down the screen to the Plugin
Summary area. Click Select plugins to run. The Select a plugin popup appears:

3. Select coverageAnalysis. The Coverage Analysis Plugin interface appears.

4. Select a library type.

5. If you have one and would like to use it, select a targeted regions file.

Run the Coverage
Analysis plugin
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6. Fill out the other plugin options. These options vary depending on your Library
Type selection:

• Target Padding If you would like to pad the target by a number of bases,
enter the desired number. If you do not enter a number, the default of 0 is
used.

• Use Only Uniquely Mapped Reads If you would like the plugin to examine
only unique starts, select the checkbox.

• Use Only Non‑duplicate Reads Select the checkbox to avoid duplicates. The
Torrent Suite™ analysis must have been run with Mark Duplicates enabled.

• SampleID Tracking Check this only if the Ion AmpliSeq™ library employed
sampleID tracking amplicons.

7. When you are satisfied with your selections, click Submit.
The analysis runs and a group of output reports is created.
The following sections of this document describe the output reports generated by
the Coverage Analysis plugin.

Coverage Analysis Plugin output

The plugin generates a Coverage Analysis Report. This report includes read statistics
and several charts. The statistics and charts presented depend on the library type for
the analysis. In addition, in the File Links section at the bottom of the Coverage
Analysis Report, you can download statistics files and the aligned reads BAM file.

Example statistics

The following is an example of the plugin statistics for an AmpliSeq Exome run. Most
fields names offer hover help.

The Reference Coverage chart is an overlay of where target regions are defined and
overlap on the reference.
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Reads statistics 

The library type determines which statistics are presented.

Statistic Description

Number of mapped reads Total number of reads mapped to the
reference.

Number of reads on target Total number of reads mapped to any
targeted region of the reference. A read is
considered to be on target if at least one
aligned base overlaps a target region. A
read that overlaps a targeted region but
where only flanking sequence is aligned, for
example, due to poor matching of 5' bases
of the read, is not counted.

Target Base Coverage Summary statistics for targeted base reads
of the reference. A base covered by multiple
target regions is only counted once per
sequencing read.

Bases in target regions The total number of bases in all specified
target regions of the reference.

Percent of reads on target The percentage of reads mapped to any
targeted region relative to all reads mapped
to the reference.

Total aligned base reads The total number of bases covered by reads
aligned to the reference.

Total base reads on target The total number of target bases covered by
any number of aligned reads.

Percent base reads on target The percent of all bases covered by reads
aligned to the reference that covered bases
in target regions.

Bases in targeted reference The total number of bases in all target
regions of the reference.

Bases covered (at least 1x) The total number of target bases that had
at least one read aligned over the proximal
sequence. Only the aligned parts of each
read are considered. For example,
unaligned (soft-cut) bases at the 5' ends of
mapped reads are not considered. Covered
target reference bases may include sample
DNA read base mismatches, but does not
include read base deletions in the read, nor
insertions between reference bases.

Average base coverage depth The average number of reads of all targeted
reference bases.
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Statistic Description

Uniformity of base coverage The percentage of bases in all targeted
regions (or whole genome) covered by at
least 0.2x the average base coverage depth.

Maximum base read depth The maximum number of times any single
target base was read.

Average base read depth The average number of reads of all targeted
reference bases that were read at least
once.

Std.Dev base read depth The standard deviation (root variance) of the
read depts of all targeted reference bases
that were read at least once.

Genome Base Coverage Summary statistics for base reads of the
reference genome.

Genome base coverage at N x The percentage of reference genome bases
covered by at least N reads.

Target coverage at N x The percentage of target bases covered by
at least N reads.

Targets with no strand bias The percentage of all targets that did not
show a bias towards forward or reverse
strand read alignments. An individual target
is considered to have read bias if it has at
least 10 reads and the fraction of forward or
reverse reads to total reads is greater than
70%.

Amplicon Read Coverage Summary statistics for reads assigned to
specific amplicons.Each sequence read will
be assigned to exactly one of the amplicons
specified by the targets file.Reads are
assigned to particular amplicon targets
based if their (5') mapping location being
sufficientlyclose to the end of the amplicon
region, taking the read direction (mapping
strand) in to account.

Number of amplicons The number of amplicons specified in the
target regions file.

Percent assigned amplicon reads The total number of reads that were
assigned to individual amplicons.A read is
assigned to a particular (inner) amplicon
region if any aligned bases overlap that
region.If a read might be associated with
multiple amplicons this way it is assigned
to the amplicon region that has the greatest
overlap of aligned sequence.

Average reads per amplicon The average number of reads assigned to
amplicons.
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Statistic Description

Uniformity of amplicon coverage The percentage of bases in all targeted
regions (or whole genome) covered by at
least 0.2x the average base read depth.

Amplicons with at least N reads The percentage of all amplicons that had at
least N reads.

Amplicons with no strand bias The percentage of all amplicons that did not
show a bias towards forward or reverse
strandread alignments. An individual
amplicon is considered to have read bias if
it has at least 10reads and the fraction of
forward or reverse reads to total reads is
greater than 70%.

Amplicons reading end-to-end The percentage of all amplicons that were
considered to have a sufficient proportion
ofassigned reads (70%) that covered the
whole amplicon target from 'end-to-end'.
To allow for errorthe effective ends of the
amplicon region for read alignment are
within 2 bases of the actualends of the
region.

Example charts

This section shows a couple example charts. Many charts have a Plot menu that
allows you to change characteristics of the chart, for instance, to show both strands.

Click a chart's options icon  (in the top right corner of a chart) to open the chart s
viewing options panel.

In the Depth of Coverage chart above, the left Y-axis (% reads) is the number of reads
at a particular read depth (or bin of read depths) as a percentage of the total number
of (base) reads. The right Y-axis (% cumulative reads) is the cumulative count of the
number of reads at a given read depth or greateras a percentage of the total number of
(base) reads. If your analysis includes a regions of interest file, this chart reflects only
targeted reads (reads that fall within a region of interest).
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In most charts you click on a data point to open a detail panel for that data:

In this chart, the blue curve measures the cumulative reads at that read depth or
greater. Click a point on the blue curve to open the blue detail panel for that read
depth:

The following Reference Coverage Chart is shown with the Strand Base Reads option:
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You can also zoom in on a region of interest.

Note: The Viewing options panel is revealed or hidden with the chart's options icon
. The help icon  opens a description of the chart.

Output files

Download plugin results file from links in the File Links section. This example is from
a generic sequence run:

TargetSeq™ analyses also offer the option "Download the TargetSeq coverage
summary file".

Ion AmpliSeq™ analyses also offer the option "Download the amplicon coverage
summary file".
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Click a file's question mark icon  to open a description of the file:

The following table lists the output files with a description of each. Not all output files
are generated on every type of analysis.

File Description

Coverage statistics summary A summary of the statistics presented in
the tables at the top of the plugin report.
The first line is the title. Each subsequent
line is either blank or a particular statistic
title followed by a colon (:) and its value.

Base depth of coverage Coverage summary data used to create the
Depth of Coverage Chart. This file contains
these fields:

• read_depth The depth at which a
(targeted) reference base has been
read.

• base_cov The number of times any
base was read (covered) at this depth.

• base_cum_cov The cumulative
number of reads (coverage) at this
read depth or greater.

• norm_read_depth The normalized
read depth (depth divided by average
base read depth).

• pc_base_cum_cov As base_cum_cov
but represented as a percentage of the
total base reads.
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File Description

Amplicon coverage summary Coverage summary data used to create the
Amplicon Coverage Chart. This file contains
these fields:

• contig_id The name of the
chromosome or contig of the reference
for this amplicon.

• contig_srt The start location of the
amplicon target region.

Note: This coordinate is 1-based,
unlike the corresponding 0-based
coordinate in the original targets BED
file.

• contig_end The last base coordinate of
this amplicon target region.

Note: The length of the amplicon
target is given as tlen = (contig_end -
contig_srt + 1).

• region_id The ID for this amplicon as
given as the 4th column of the targets
BED file.

• gene_id The gene symbol as given as
the last field of the targets BED file.

• gc The number of G and C bases in the
target region. Hence, %GC = 100% *
gc / tlen.

• overlaps The number of times this
target was overlapped by any read by
at least one base.

Note: Individual reads might overlap
multiple amplicons where the
amplicon regions themselves overlap.

• fwd_e2e The number ofassigned
forward strand reads that read from
one end of the amplicon region to the
other end.

• rev_e2e The number of assigned
reverse strand reads that read from
one end of the amplicon region to the
other end.

• total_reads The total number of reads
assigned to this amplicon. This value
equals (fwd_reads + rev_reads) and is
the field that rows of this file are
ordered by (then by contig id, srt and
end).

• fwd_reads The number of forward
strand reads assigned to this
amplicon.
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File Description

• rev_reads The number of reverse
strand reads assigned to this
amplicon.

Plugins
Coverage Analysis Plugin

Torrent Suite™ Software Help 201



File Description

Target coverage summary Coverage summary data used to create the
Target Coverage Chart. This file contains
fields:

• contig_id The name of the
chromosome or contig of the reference
for this target.

• contig_srt The start location of the
target region.

Note: This coordinate is 1-based,
unlike the corresponding 0-based
coordinate in the original targets BED
file.

• contig_end The last base coordinate of
this target region.

Note: The length of the target is given
as tlen = (contig_end - contig_srt + 1).

• region_id The ID for this target as
given as the 4th column of the targets
BED file.

• gene_id The gene symbol as given as
the last field of the targets BED file.

• gc The number of G and C bases in the
target region. Hence, %GC = 100% *
gc / tlen.

• covered The number of bases of this
target that were covered by at least
one read. Hence the percentage
coverage of this target is calculated as
%cov = 100% * covered / tlen. Note that
this might also not 100% because of
base deletions in the sample vs. the
reference genome.

• uncov_3p The number of bases that
are not covered at the 3' (downstream)
end of the forward DNA strand. For
TargetSeq™ analyses,this may indicate
poor probe coverage at this end of the
target.

• uncov_5p The number of bases that
are not covered at the 5' (upstream)
end of the forward DNA strand.

• depth The average target base read
depth. This value equals (fwd_reads +
rev_reads) / tlen and is the field that
rows of this file are ordered by (then by
contig id, srt and end).

• fwd_reads The number of forward
strand reads assigned to this target.
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File Description

• rev_reads The number of reverse
strand reads assigned to this target.

Chromosome base coverage summary Base reads per chromosome summary data
used to create the default view of the
Reference Coverage Chart. This file
contains these fields:

• chrom The name of the chromosome
or contig of the reference.

• start Coordinate of the first base in
this chromosome. This is always 1.

• end Coordinate of the last base of this
chromosome. Also its length in bases.

• fwd_reads Total number of forward
strand base reads for the
chromosome.

• rev_reads Total number reverse
strand base reads for the
chromosome.

• fwd_ontrg (if present) Total number of
forward strand base reads that were in
at least one target region.

• rev_ontrg (if present) Total number
and reverse strand base reads that
were in at least one target region.

• seq_reads Total sequencing (whole)
reads that are mapped to individual
contigs.

Aligned reads BAM file Contains all alignedreads used to generate
this report page, in BAM format. BAM is the
binary form of the SAM format file that
records individual reads and their
alignment to the reference genome. Refer
to the current SAM tools documentation for
more file format information.

Aligned reads BAI file Binary BAM index file as required by some
analysis tools and alignment viewers such
as IGV.

Primer-trimmed reads BAM file. Binary primer-trimmed aligned reads.
Created from the original alignment file by
trimming reads to specific amplicons
regions they are assigned to, where
necessary to resolve overlaps with multiple
amplicon target regions.

Primer-trimmed reads BAI file. Binary BAM index file as required by some
analysis tools and alignment viewers such
as IGV.
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ERCC Analysis Plugin

This section describes the ERCC Analysis plugin. This plugin helps with analyses that
use ERCC RNA Spike-in Controls. The plugin enables you to quickly determine
whether or not the ERCC results indicate a problem with either the library
preparation or the sequencing instrument run.

A plugin must be enabled before it can run. Your Torrent Suite™ Software
administrator may have already enabled ERCC Analysis plugin and then the plugin
appears in the run report Plugin Summary Select Plugin to Run list.

Follow these steps if you need to enable the plugin:

1. Scroll to the top of the Torrent Browser and click Plugins in the gear menu on the
right:

2. If the ERCC_Analysis plugin does not appear on your plugin page, click the
Name column to sort by name and scroll to the plugin. In the ERCC_Analysis
row, click the Enable column checkbox:

Note: Auto-run is not recommended for the ERCC_Analysis plugin unless most
analyses on this Torrent Server use ERCC controls.

Enable the ERCC
Analysis plugin
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Follow these steps to manually launch the ERCC_Analysis plugin. You can use the
default minimum R-squared value or enter you own value.

1. Open the run report for the analysis. Scroll down to the Plugin Summary section.

2. Click Select plugin to run to open the plugin list:

3. Click ERCC_Analysis. (The version number on your system might be different
from the version shown here.)

Manually run the
ERCC Analysis
plugin
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4. A popup window with a minimum acceptable R-squared value appears. You can
use the default value or enter your own value. The value should be in the range
from 0 to 1.

5. Click Submit to start the plugin.
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If you configure a template or planned run to execute the ERCC Analysis plugin, and
your experiment uses the Ion Total RNA-Seq Kit V2, then on the wizard Kits page,
you must make a Barcode Set selection. Select either one of the following in the
Barcode Set menu:

• IonXpressRNA Select this if your experiment uses this kit.

• RNA_Barcode_None Select this if your experiment does not use a barcode kit.
This selection is required for the correct trimming.
The following wizard image shows the two barcode kit selections. (Make only
one selection per run.)

For analysis runs with total reads under 1,000,000, the plugin normally takes 2-3
minutes to run (on supported hardware). For larger runs, the plugin takes
approximately an additional 1-2 minutes per million total reads. For example, a run
with 5 million reads may take 10-15 minutes. These run times are offered only as a
guideline. If your Torrent Suite™ Software is busy with other processing, plugin run
times are longer.

After the ERCC analysis is completed, you can view the analysis results.

Plugin analysis results appear in the plugin summary area:

Configure a
template to run
the ERCC plugin

Plugin run times

View analysis
results
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After the status of the ERCC plugin has changed to Completed, click the
ERCC_Analysis.html link in the Plugin Summary section to open the ERCC Report
and view analysis results:

The ERCC Report screen (shown on page 5) displays the ERCC Dose Response plot.
The points are color-coded, based on mapping quality. There is also a trendline, based
on the parameters shown in tabular form to the right of the graph.

The y-axis of the plot is the log (base 2) of the raw counts found for the transcript in
question. The x-axis is also logarithmic, but represents the known relative
concentration of the ERCC transcripts. Ideally, the points all fall on a straight line.

More realistically, in the good case, the raw counts and relative concentration should
at least correlate with a high R-squared (for example, 0.9 or higher). The table to the
right of the plot (shown on page 5) shows the R-squared value found for this plot, as

Interpret the data 
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well as the Slope, Y-intercept, and N (number of transcripts found) values. Although
there are 92 transcripts in the ERCC mix, it is not expected that all 92 will be detected.
The number of transcripts detected depends on the sequencing depth.

If you want to look at the details regarding a particular transcript, there are two
methods you can use:

• Hover your mouse-cursor over a point on the ERCC Dose Response plot to
display a popup window that shows details about that transcript (the name,
reads, and coverage plots).If several points are very close together on the plot and
it is difficult to hover over the point you are interested in, you can zoom in on the
plot to more easily distinguish points:

• – Use your mouse to draw a box around the point of interest and magnify it.
– To zoom out to the full view of the ERCC Dose Response plot, either

doubleclick the plot, or click the Reset Zoom button.

• Scroll to the particular transcript, and click the [+] next to the transcript
name.This method shows the same information, plus a few additional pieces. See
Definitions if the meaning of any of these pieces is unclear.

This section defines terms used in the plugin output.
• Coverage Depth The minimum and maximum number of reads covering bases in

the transcript. If coverage is 100%, the minimum value will be > 0.

• Coverage The number of base positions covered by at least one read.

• Start Sites The number of base positions that are the start site for a read.

• Unique Start Sites The number of start sites that have only one read starting at
the site.

• Coverage CV Coefficient of Variation for coverage = average coverage / stddev
coverage for the entire transcript.

You can optionally change the R-squared value to set a default value for the summary
report screen:

1. If the window showing the minimum acceptable R-squared value is open, close
it. Then scroll to the top of the Torrent Browser and click Plugins in the gear
menu on the top right:

View transcript
details

Definitions

(Optional)
Configure the
ERCC Analysis
plugin

Plugins
ERCC Analysis Plugin

Torrent Suite™ Software Help 209



2. If the ERCC_Analysis plugin does not appear on your plugin page, click the
Name column to sort by name and scroll to the plugin. In the
ERCC_Analysisrow, click the Manage column gear menu, then select Configure.

3. The ERCC Plugin Configuration screen opens:

Enter a value between 0 and 1 as your minimum acceptable R-squared value (a
lower value is indicated by a red light in the summary report). Then click
Submit.
The value you enter on the ERCC Plugin Configuration screen is used when the
plugin is auto-run and when a user manually launches the plugin without
entering a value. Users can override this value on a per-run basis when they
manually launch the plugin.
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If the ERCC_Analysis plugin status changes to Error after you click the
ERCC_Analysis.html link, then something went wrong during the running of the
plugin. In this case, look at the error log:

1. Return to the Plugin Summary, then click the log file icon to see the error log:

2. Scroll to the bottom of the log to see error messages:

An Error status for the ERCC_Analysis plugin should be a rare event and
indicates that the ERCC_Analysis plugin itself failed to run. A plugin error does
not indicate that the ERCC_Analysis results are bad.

View plugin error
information
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The External RNA Controls Consortium (ERCC) is hosted by the U.S. National
Institute of Standards and Technology. The ERCC Analysis plugin is for experiments
that use ERCC RNA Spike-In Control Mixes, set of RNA controls derived from the
ERCC plasmid reference library.

For information on ERCC RNA Spike-In Control Mixes, please refer to the 
ERCC RNA Spike-In Control Mixes User Guide (Pub no. 4455352).

For more information on ERCC analysis, refer to the following resources: Figure 2,
Analysis of ERCC read counts, in 
Sensitivity of RNA-Seq using Ion semiconductor sequencing a comparison to
microarrays and qPCR The Ion Torrent™ white paper 
Methods, tools, and pipelines for analysis of Ion PGM™ Sequencer miRNA and gene
expression data The information on the ERCC ExFold RNA Spike‑In Mix product
page.

The FileExporter Plugin

You use the FileExporter plugin to rename Torrent Suite™ Software results files and
optionally to create FASTQ, SFF, or zipped versions of the results files.

This plugin replaces the FastqCreator and SFFCreator plugins.

The plugin output section shows the input options and provides links to the files that
the plugin created or renamed:

The SELECTIONS area shows the file naming pattern used for this run. This example
uses the naming pattern Run Name, Sample Name, and Report Date:

ERCC resources

Plugin output
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Run Name Auto_user_B22-884--26953

Sample Name E129294--L-

Report Date 2013-09-17

You can configure the FileExporter plugin in two places.The configuration options are
the same in both places. Only the scope of the configuration is different.

• In the manual launch page The configuration affects only that specific run.
• In the admin Plugins tab The configuration affects all automatic FileExporter

runs by all users.

On a manual launch, the Select plugins to run button opens the plugin configuration
page.

Configure FileExporter here to set up a file naming pattern and output file options to
be used with all automatic FileExporter runs. This configuration affects FileExporter
runs that are set up in the run plan and template wizard.

To access the admin plugin configuration area, click the Torrent Browser gear menu
Plugins option:

Then click the Manage column gear menu for the specific plugin and select Configure:

Configuration
scope

Manual launch

Admin Plugin tab
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In the Output File Options section, you select the following options:

Option Comments

Create SFF? Creates an SFF-format file of your Torrent
Suite™ results.

Create FASTQ? Creates a FASTQ-format file of your Torrent
Suite™ results.

Include Variant Caller Files? Creates TVC output files named according
to your file naming pattern. If the
variantCaller plugin has not been run on
this run report, this option has no effect.
TVC output files are no included in the
zipped file.

Zip results? Zips the renamed results files (except for
TVC results). The zipped file is downloaded
from a link in the Files Created section:

In this release, if launched with no file options selected, the plugin creates FASTQ and
SFF files.

This section describes how to set a file naming pattern in the FileExporter plugin. The
naming pattern is used for the results BAM and BAI files, the SFF and FASTQ files,
and the VCF results files (depending on the output file options selected).

You can use the following run metadata in your file naming patterns:
• Run Name
• Report Name
• Report Date
• Chip Type
• Sequencer Name
• Sample ID
• Barcode Name

Output file options

Plugin naming
pattern (required)
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You also can choose the delimiter used between metadata fields. Support delimiters
are dot, dash, and underscore (a naming pattern uses only only one delimiter):

As you build your naming pattern, the Example name string section shows you the
current pattern:

Follow these steps to create your file naming pattern in the Customize file names
section. This example uses the following file naming pattern: Report
Name.SampleID.Report Date.

1. Select the delimiter dot:
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2. In the Field 1 menu, select the first part of the naming pattern. This example uses
Report Name:

Both Field 1 and the example name string show Report Name
(TSP_ANALYSIS_NAME.bam is an internal name for Report Name):

3. Click the Add another field button. In the Field 2 menu, select Sample ID:
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Field 2 shows Sample ID and the example name string shows Report
Name.SampleID (using internal names):

4. Click the Add another field button. In the Field 3 menu, select Report Date:

Your file naming pattern is ready to use.

Note: The FileExporter plugin takes no action if you do not specify a file naming
pattern.
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You can set up the plugin to run automatically when you configure your template or
run plan. In the Plugin chevron of the template wizard, select which plugins run
automatically on planned runs created from that template.

Important: Before you use the plugin in a planned run, configure the plugin in the
admin Plugins page. A run template and planned run accept the plugin when it is not
configured, but your plugin fails at run time.

The FilterDuplicates Plugin

The FilterDuplicates plugin allows you to remove duplicate reads after a run is
completed. BAM files with duplicate reads removed are saved in the FilterDuplicates
directory. The original BAM files in the main analysis directory are not modified.

FilterDuplicates is applied only to merged data.

Note: The Mark Duplicate feature in the main analysis pipeline marks reads as
duplicates but does not remove them from the BAM files.

The plugin output section contains links to the BAM files that have duplicate reads
removed:

This section also shows the percentage of reads that were removed and the percentage
of all reads that reached the adapter.

Run the plugin
automatically

Plugin output
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For barcoded runs, FilterDuplicates runs on each barcode separately.

You set up the plugin to run automatically when you configure your template or run
plan. In the Plugin chevron of the template wizard, you select which plugins run
automatically on planned runs created from that template.

You can launch the plugin manually from a completed run report.

Follow these steps to run the plugin manually:

1. Open the run report and scroll down to the Plugin Summary button. Click Select
plugins to run.

Barcoded runs

Run the plugin
automatically

Run the plugin
manually
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2. In the Select a plugin list, click FilterDuplicates. The plugin does not take user
input.

The BAM header ZC tag is produced by the base caller to indicate the flow index of
the last base of the template. FilterDuplicates plugin uses the ZC tag's information
about adapter position, when possible, to improve the resolution of duplicate marking
on fragment reads.

The base caller only creates ZC tag for reads in which the adapter is found.

The FilterDuplicates plugin groups reads with matching start coordinate, strand, and
ZC tag value, and selects one read from each group to not be a duplicate read:

1. For every read, the 5' sequencing strand coordinate, mapping strand, and ZC
value (if present) are recorded.

2. The plugin groups together reads that have the same 5 start coordinate, strand,
and ZC tag value.

3. The plugin also adds to this group those reads that do not have a ZC tag but
have the same start and strand coordinates as the group.

4. The next step depends on the longest read in the group:
a. If the longest read in the group has a ZC tag, the plugin does not mark the
first read from the group as a duplicate. The rest of the reads in the group
are marked as duplicate.

b. If the longest read in the group does not have a ZC tag, that read is not
marked as a duplicate. The rest of the reads in the group are marked as
duplicate. (In this case the base caller did not find the adapter in the read
that is not a duplicate and that remains in the plugin output BAM file while
the other reads are deleted.)

ZC tag
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Run RecognitION Plugin

The Run RecognitION plugin allows you to submit your best runs to the Ion
Community leaderboards. The leaderboards are available on the Ion Community, and
are organized in leagues according to chip type:

Your Torrent Suite™ software must be at least version 1.5.1 to use this plugin.
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Follow these steps to run to the RunRecognitION plugin:

1. Go to the report page for your run. Scroll down to the Plugin Summary section,
and click Select plugins to run.

2. In Select a plugin, click RunRecognitION:

Run the
RunRecognitION
Plugin
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The leaderboard for your chip type is shown, with a message indicating where
you rank among the leaderboard runs.

Follow these steps to submit a candidate run to the leaderboard:

1. Go to the report page for your run. Run the RunRecognitION plugin. The Run
RecognitION leaderboard is displayed for your chip type.

2. Scroll to the Ion Community Login section below the leaderboard. If you do not
have an Ion Community account, click create an account to register. Enter your
community user name and password.

Submit your run to
the
RunRecognitION
leaderboard
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3. (Optional) Enter the any of the following information about your run:
• Your site name
• The reference genome used in this run
• The application type for this run

4. Below the information fields, click Terms and Conditions and carefully read that
information. Click the checkbox " I agree to the Terms and Conditions ".

5. Click Submit at the bottom of the page. If your run qualifies, it is added to the
leaderboard:

If your run is published to the leaderboard, your Ion Community user name and
avatar are visible to other members of the community.

The SampleID Plugin

Ion AmpliSeq™ Sample ID Panel is a human SNP genotyping panel enabling accurate
sample verification for increased confidence in sample data management. The plugin
is comprised of nine primer pairs that can be combined with any Ion AmpliSeq™

Ready-to-Use or Custom Panel for the generation of a unique ID during post-
sequencing analysis of research samples.

The Ion AmpliSeq™ Sample ID Panel can be used in combination with any Ion
AmpliSeq™ Ready-to-Use or Custom Panel using the Ion AmpliSeq™ Designer 1.2 or
greater. This plugin is compatible with the Ion Xpress barcodes set.

What Information
About Me Does
RunRecognitION
Make Public
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Example plugin output is shown below:

Use the Sample ID column to verify sample fingerprints.

Click on a barcode ID to open the detail report.

With the detail report, you can review the IUPAC SNP calls. The contents of the
TaqMan® Assay ID column are links to order the corresponding TaqMan® Assay.

Plugin output
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The sampleID plugin does not take any options or configuration.

You set up the plugin to run automatically when you configure your template. In the
Plugin chevron of the template wizard, you select which plugins run automatically on
planned runs created from that template.

You can launch the plugin manually from a completed run report.

Follow these steps to run the plugin manually:

1. Open the run report and scroll down to the Plugin Summary button. Click Select
plugins to run.

Plugin
configuration

Run the SampleID
plugin
automatically

Run the SampleID
plugin manually
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2. In the Select a plugin list, click sampleID. The sampleID plugin does not take
user input. The plugin executes immediately (depending on server load) when
you click it in the Select a plugin list.

When you use the SampleID Panel, lower-than-expected number of on-target reads
may occur. To recover the correct on-target reads metrics, add back the On-Target
reads from the Sample ID Panel into the Ion AmpliSeq™ Ready-to-Use or Custom
Panel Coverage Analysis plugin data.

The RunTransfer Plugin

With the RunTransfer plugin, you transfer the signal processing output files of a
completed Torrent Suite™ Software analysis to a different Torrent Server and also
launches a re-analysis of those file on the new server. On the receiving Torrent Server,
after the re-analysis completes, the transferred run appears in the Torrent Browser as
if it had been generated on that Torrent Server.

The files that are transferred are the BaseCaller Input category of files (as defined in
the Data Management file categories), including the 1.wells file.

For Ion Proton™ analyses, you have the option of transferring only thumbnail files or
transferring the 96 block files.

You can optionally configure the plugin ahead of time in the Admin4Plugins tab.
This configuration is known as "Global Settings". The Global Settings configuration is
used whenever the plugin is automatically run and also is the default for manual
launches of the plugin.

Follow these steps to create a global configuration for the RunTransfer plugin:

1. Go to the Admin > Plugins tab:

On-target metrics

Pre-configure the
plugin
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2. Find the entry for the RunTransfer plugin (you might have to scroll or re-order
the Name column). With the gear menu for the RunTransfer plugin, select the
Configure option:
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3. Fill out the Global Settings page with information for the receiving Torrent Server
(where the run is transferred to):

Field Comments

IP The IP address

User Name The login name on the receiving Torrent
Server

Password Password for that login

Upload Path The analysis directory path

Thumbnail-only Enable to transfer only thumbnail data.
Leave blank to transfer full data. Applies
only to Ion Proton™ analyses.

4. Click Submit. (Your changes are lost if your click Close.)

Note: In this release, there is no way to remove a global configuration for the
RunTransfer plugin.
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You set up the plugin to run automatically when you configure your template or run
plan. In the Plugin chevron of the template wizard, you select which plugins run
automatically on planned runs created from that template.

Create a plugin configuration in the Admin tab before running a plugin automatically.

You can launch the plugin manually from a completed run report.

Follow these steps to run the plugin manually:

1. Open the run report and scroll down to the Plugin Summary button. Click Select
plugins to run.

Run the plugin
automatically

Run the plugin
manually
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2. In the Select a plugin list, click RunTransfer.

3. The Configure page opens. If you made a global configuration for the plugin, the
fields are filled in with that information. You can change any of the fields.
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The Partek Flow Uploader Plugin

This plugin requires a separate purchase of Partek® Flow® Software, which is a third
party software that is not supported by Ion Torrent™.

You set up the plugin to run automatically when you configure your template or run
plan. In the Plugin chevron of the template wizard, you select which plugins run
automatically on planned runs created from that template.

You can launch the plugin manually from a completed run report.

Follow these steps to run the plugin manually:

Run the plugin
automatically

Run the plugin
manually
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1. Open the run report and scroll down to the Plugin Summary button. Click Select
plugins to run.
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2. In the Select a plugin list, click PartekFlowUplpoader.

3. In the plugin export page, enter your Partek® Flow® Software information and
click Export to Partek Flow:
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Torrent Variant Calling

Introduction

The Torrent Variant Caller (TVC) plugin calls single-nucleotide polymorphisms
(SNPs), multi-nucleotide polymorphisms (MNPs), insertions, and deletions in a
sample across a reference or within a targeted subset of that reference.

This plugin provides optimized pre-set parameters for many experiment types but is
also very customizable. After you find a parameter combination that works well on
your data and that has the balance of specificity and sensitivity that you want, you can
save that parameter set and reuse it over and over in your research. This is supported
on both manual launches of the plugin and in automatic launches through the run
plan template wizard.

Torrent Variant Caller (TVC) is a genetic variant caller for Ion Torrent™ Sequencing
platforms, and is specially optimized to exploit the underlying flow signal
information in the statistical model to evaluate variants. Torrent Variant Caller is
designed to call single-nucleotide polymorphisms (SNPs), multi-nucleotide
polymorphisms (MNPs), insertions, deletions, and block substitutions.

The basic operation of the TVC plugin is as follows:

1. Find all positions with any evidence for a variant.
2. Focus on these positions and evaluates if there is enough evidence for a SNP or

indel call.
3. Filter the candidates based on key parameters (strand bias, enough coverage,

known error prone position).

TVC Pipeline
Introduction
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The image below gives a more detailed view of the variant calling process:

According to this diagram, in order to generate as final output the TSVC_variants.vcf
file in Variant Call Format (VCF) 4.1, the plugin combines output from up to three
calling modules:

1. The TVC (de novo) module uses freebayes to discover candidate variant
locations, which are subsequently scored using adaptive signal model and
filtered.

2. The second module performs assembly of reads to detect long indels.
3. If hotspots are provided, a separate TVC call scores hotspot locations and alleles

using a model.

The resulting intermediate files are merged and overlapping records are reconciled to
produce the final file. If a hotspot file is provided, the TVC_variants.vcf file, as well as
the variant tables in the plugin report, will contain a record for every hotspot (with
some exceptions*) including variant calls, reference calls, and no-calls. For no-calls,
the filtering reason listed on the Variant Calls table in the UI and in the VCF tags.

For loci that are not present in the hotspots file, it is still possible to establish whether
a lack of variant call is due to reference call or filtering. Candidate variants generated
by de-novo TVC module that were either declared absent (reference calls) or were
discarded by a filter (no calls) are saved to a separate file, small_variants_filtered.vcf.

Torrent Variant Calling
Introduction
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Input

Torrent Variant Caller operates on input BAM files generated using Torrent Suite™

Software version 3.4.2 or higher and requires the presence of flow signal specific tags
in the BAM file.

You optionally also supply TVC with target regions files and hotspot files:
• Target regions files — Sequencing is restricted to specified chromosome regions

that appear in the regions of interest file.
• Hotspot files — TVC evaluates each listed position on the genome, and reports

the filtering metrics for each position, including positions that are not called as a
variant. When a hotspot position receives a NOCALL rather than a reference call
or a variant call, the filtering reasons in the VCF output file explain the reasons
for the NOCALL.

In the 4.x and 3.6.x releases, a hotspots file can be either BED format or VCF 4.1
format. The BED format might be deprecated in a future release. Both hotspots files
and targeted regions of interest files are uploaded in the Torrent Browser References
page and are associated with a specific reference.

Variant candidates

Candidate variants are generated if they pass a minimal set of requirements set in
FreeBayes (such as base quality, apparent frequency, etc.). Candidate positions are
then evaluated by a statistical model which matches basecalling predictions under
each sequence alternative specified, and finally are filtered by a number of orthogonal
criteria to determine if the assumptions of the model do not fit the data. Each of these
processes are controlled by parameters supplied to the program. These parameters
determine the effectiveness of generating, testing, and filtering variants.

Torrent Variant Caller uses a two-staged approach to calling variants in any given
sample. Step 1 is to identify candidate positions where alternate allele frequency is
above the minimum allele frequency threshold setting. Step 2 is to further evaluate the
candidate variant identified in step 1 to assign the quality of the variant and also to
assign the genotype.

A modified version of Freebayes software is used in step 1 to identify the candidate
variants in a given sample. The minor modifications to FreeBayes are to model Ion
Torrent™ Sequencing platforms specific error modes. Torrent Variant Caller supports
Freebayes haplotype-based allele detection, where alleles can extend across several
bases across a repeat sequence. This support enables Torrent Variant Caller to
evaluate multiple haplotype-based alleles simultaneously (such as a SNP and an indel
adjacent to each other).

Output

Variants that pass all the set filters are reported to a single output VCF file and all
variants that fail any one of the set filters are reported to a filtered output VCF file.
The filtered variants have an associated filter reason tag in the VCF file, which the
users can query to identify the filters that the candidate variant failed to pass.

These reports are also available in tab-separated format:
• The Variant Calls table
• Hotspot Alleles table
• The Classic output table

Torrent Variant Calling
Introduction
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The output page called "Beta Features" in 3.6.2 is the main output page in 4.x. The
3.6.2 main page layout is available through the Deprecated Features Classic button.

Standalone TVC

TVC can be run in a standalone mode as a part of user's analysis pipeline outside of
the Torrent Suite plugin framework. It has been tested to work on Ubuntu 10.04, 11.10,
14.04, 15.04,

CentOS 6, 7, Debian Wheezy andJessie operating systems.

TVC provides several ways of handling its parameter options:
• You can select one of TVC default pre-set parameter groups. TVC provides these

defaults that are optimized for several experiment types.
• You can start with one of TVC default pre-set parameter groups and then make

your own customizations in the TVC UI.
• You can import parameter settings that are optimized for fixed panels and

community panels in ampliseq.com. (Optimized parameter sets for custom
designs are not supported in this release.)

• You can download the parameters used in a TVC run and then either customize
those parameters or reuse them in future TVC runs.

TVC's default parameters setting groups are organized according to these attributes:
• Variant frequency Somatic settings are optimized to detect low frequency

variants. Germ-line settings are optimized for high frequency settings.
• Sequencing instrument The Ion PGM™ or the Ion Proton™ sequencer. Parameter

defaults are different for Ion Proton™ data than for Ion PGM™ data.
• Stringency High stringency settings are optimized to minimize false positives.

Low stringency settings minimize false negatives.
• TargetSeq Two sets of defaults are optimized for TargetSeq™ data.

The Reference Genome field names the reference used in the original Torrent Suite™

Software. The reference cannot be changed.

The Library Type selection does not change or customize TVC's parameter settings.
When the Library Type is set to AmpliSeq, the Trim Reads option is available.
Trimming is recommended for Ion AmpliSeq™ data to remove the adapters from the
reads.

If you select Targeted Regions or HotSpot Regions files from their drop-down menus,
and they are applied to your analysis:

• Targeted Regions Analysis is restricted to only the regions of interest that you
specify in this file.

• Hotspots Variant Caller output files include these positions whether or not a
variant is called, and include evidence for a variant and the filtering thresholds
that disqualified a variant candidate.

Parameters

Reference

Library Type

Targeted Regions
and HotSpot
Regions menus

Torrent Variant Calling
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Be aware that the TVC plugin is not selected in the templates shipped with Torrent
Suite™ Software. Select the plugin when you create a run plan or a copy of a shipped
template.

Templates that you download from ampliseq.com do have the TVC plugin selected.

The TVC plugin supports the various panels in the Ion AmpliSeq™ family of
sequencing kits, including the following:

• Ion AmpliSeq™ BRCA1 and BRCA2 Panel
• Ion AmpliSeq™ Colon and Lung Cancer Panel
• Ion AmpliSeq™ CFTR Panel

The following table lists the TVC parameter options that are pre-defined and
optimized for ampliseq.com panels or TargetSeq™ data:

Panel or application TVC Pre-set parameter defaults

Ion AmpliSeq™ Exome Germline - Proton - Low Stringency

CCP PGM Somatic - PGM - Low Stringency

CCP Proton Somatic - Proton - Low Stringency

CHP2 (HSM2) Somatic - PGM - Low Stringency

CHv1 Somatic - PGM - Low Stringency

IDP Germline - PGM - Low Stringency

TargetSeq™ data Germline - Proton TargetSeq - Low
Stringency

The Torrent Variant Caller parameter settings change according to your Variant Caller
configuration radio button selection. Data from Ion PGM™ and Ion Proton™

Sequencers require different default settings. Select settings that are appropriate to
both your sequencing instrument and your experiment:

• Germ‑Line ‑ Low Stringency Optimized for high frequency variants and
minimal false negative calls.

• Somatic ‑ Low Stringency Optimized for low frequency variant detection with
minimal false negative calls.

• Germ‑Line ‑ TargetSeq Low Stringency Optimized for high frequency variants
and minimal false negative calls. (Ion Proton™ data only)

• Germ‑Line ‑ TargetSeq High Stringency Optimized for high frequency variants
and minimal false positive calls. (Ion Proton™ data only)

• Custom Settings that you customize. (You cannot select this radio button. This
button is enabled if you change a parameter value.)

Ion AmpliSeq™ and TargetSeq™ experiments

IMPORTANT! These two settings are optimized for IonTargetSeq experiments:

· Germ Line - Proton TargetSeq -Low Stringency
· Germ Line - Proton TargetSeq -High Stringency

Templates

Supported Ion
AmpliSeq™ panels

Parameter
Settings defaults

Torrent Variant Calling
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For Ion AmpliSeq™ experiments, when you import your template from
AmpliSeq.com, your template and run plans are already pre-configured with
parameters that are optimized for your panel.

First select the appropriate Variant Caller Parameter Settings radio button. Your
radio button selection loads the correct set of default parameters for that type of run.
If you want to customize parameters further, change parameter values in the main
settings area. Advanced users can also click the Show Advanced Settings button to
change values in the advanced settings.

These notes apply to the Variant Caller Parameter Settings and advanced settings
selections:

• If you do customize settings in the advanced settings area, your changes are
overwritten if you select a different Variant Caller Parameter Settings radio
button (or again click on the same radio button).

• If you make changes in the advanced settings and later want to reset these
parameters to their default values, again click your Variant Caller Parameter
Settings radio button selection.

In general, you can safely customize parameters for SNP calling. For indel calling,
changes to the parameters tend to have a significant effect in the number of indels
called. With indels, the tradeoff between sensitivity and specificity becomes too large.

Parameters are categorized as main settings, which are intended for general use, and
advanced settings, which allow additional customization of the variant calling
algorithm but are intended for advanced users only.

Upload your custom parameter values

Use the Upload Custom Settings Choose File button to upload your set of custom
parameter settings:

You can use this mechanism for the following:
• To quickly apply your own settings to all your TVC plugin runs
• To know that your parameters are consistent (for instance, that a parameter

change is not inadvertently forgotten in the UI)
• To apply a file of settings shared by others

The parameters file must be in JSON format.

After upload, the UI reflects the parameter values from your uploaded file. You can
still make additional changes in the UI.

About the use of
Variant Caller
Parameter
Settings radio
buttons

Variant Caller
parameters

Torrent Variant Calling
Upload your custom parameter values
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Follow these steps to upload a parameters file for your TVC plugin run:

1. Have the JSON file to be uploaded on your local machine. You can optionally
edit values in the file before uploading.

2. In the TVC plugin launch page, click the Choose File button under Upload
Custom Parameter Settings:

3. Browse to your parameters file and click OK.
The optimized parameters are imported into your run and are reflected in the
parameter table on the launch page.

Input files

This section describes input files that you provide for the TVC plugin.

Both a target regions file and a hotspots file must be associated with a reference before
you use them with the TVC plugin. You upload these files to a specific reference, such
as hg19, in the admin References page.

A target regions file controls the sequencing and downstream analysis of a targeted
resequencing run in this way: sequencing is restricted to specified chromosome
regions that appear in the regions of interest file. (In contrast, a whole genome
analysis sequences every position that corresponds to the reference genome.)

The regions of interest file must be a Browser Extensible Data (BED) file, which is a
tab-separated file format.

A hotspots file contains a list of positions on the genome and when configured in a
workflow affects the analysis results. For each position during variant calling:

1. Evidence for a variant is examined at that position (without regard to the
hotspots positions) and a call is made.

2. Then the hotspots positions are examined. At each position listed in the file, if a
variant is not already called, then one of the following variant calls is added:

• REF Homozygous reference
• NO_CALL A variant is not called at this position (for instance, because of

lack of coverage)

3. The filtering metrics for each position are reported in the output VCF file,
including for NO_CALLs.

By default the variantCaller plugin calls variant candidates at hotspot positions with
more sensitivity than candidates at other positions. You can customize certain
variantCaller parameters separately for hotspot candidates.

Target regions file

Hotspots file

Torrent Variant Calling
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Run the Torrent Variant Caller plugin

There are two ways to run the Torrent Variant Caller plugin: automatically, by
preconfiguring the plugin to run as soon as primary analysis has completed, or
manually, allowing you to run the plugin at any time from a completed run report.

Note: The Torrent Variant Caller takes a significant amount of time to complete.
Setting it up to run automatically saves time compared to running it manually.

Use the run plan template wizard to have the TVC plugin run automatically after the
Torrent Suite™ analysis completes.

Note: The TVC plugin run uses the same target regions file and hotspots file as the
main Torrent Suite™ Software analysis (if those files are present in the main analysis).
Through the wizard there is no facility in the TVC configuration to change the target
regions file or hotspots file. You can use a different target regions file and hotspots file
with a manual TVC launch from a completed run report.

1. When you select the plugin chevron in the template or run plan wizard and
enable the variantCaller checkbox, a Configuration link appears next to
thevariantCaller listing:

2. Link the Configure link to open the Variant Caller configuration popup:

Configure the
Torrent Variant
Caller in a
template or run
plan

Torrent Variant Calling
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3. Make your changes to the parameter values.

4. Advanced users can also click the Show Advanced Settings button and customize
those parameters.

5. Click Save Plugin Settings.

You can later return to the Variant Caller configuration page by clicking the
Configure button next to variantCaller in the Plugin chevron.

Note: Changes to parameters can dramatically affect the behavior and
sensitivity of the Variant Caller. Parameter changes are not recommended if you
are new to the Variant Caller plugin.

IMPORTANT! The Variant Caller parameter settings are saved in templates but
are not saved in run plans. Parameter changes that you make in a run plan affect
only that specific run.

When you change Variant Caller parameter settings in a template, your changes
affect all users who create run plans from that template.

IMPORTANT! The Torrent Variant Caller plugin is not run if you select Generic
Sequencing as the sequencing run type.

The TVC plugin supports multiple run analysis. The plugin can analyze a BAM file
generated from Combine Alignment on multiple reports in a project.Combine
Alignment creates a new run report (in the same project). You can open the new
combined run report and use the Select plugins to run button to launch the TVC
plugin.

To run the Torrent Variant Caller plugin manually, perform the following steps:

1. In the Torrent Browser, select a run report on the Data > Completed Runs &
Reports page or on a Data > Projects > projectname page.

2. Click Report Actions 4Select plugins to run.

Run the Torrent
Variant Caller
manually
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3. In the list of plugins, click on variantCaller.

Torrent Variant Calling
Run the Torrent Variant Caller plugin

244 Torrent Suite™ Software Help



4. The Torrent Variant Caller Plugin interface appears:

5. When you are satisfied with your selections, click Submit. Your variant caller
analysis is queued for execution.

Torrent Variant Calling
Run the Torrent Variant Caller plugin
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Barcoded variantCaller summary area

For a barcoded run:
• When the run contains multiple barcodes, the variantCaller.html link opens a

listing of the barcodes.
• Links to a separate results page for each barcode.
• A link to download all results in one zipped file.

To view the log file for a plugin run, in the plugin summary area, click the menu
arrow next to the plugin status:

To delete the results for a plugin run, in the plugin summary area, click the menu
arrow next to the plugin status:

View plugin log
file

Delete plugin
results

Torrent Variant Calling
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This action removes the plugin's output files from the file system and removes the
Torrent Browser plugin results page.

Field Button Description

Targeted regions BED Downloads the input
targeted regions BED file (if
any).

Hotspot regions BED Downloads the input
hotspots BED file (if any).

Parameters Settings Parameters File Downloads a JSON text file
of the TVC parameter values
used on this run.

Note: You can edit this file
and later upload it to set
your custom parameters in
subsequent runs.

Mapped Reads BAM, BAI Downloads the BAM file (and
its index) of mapped reads.
This file is input to TVC.

Variant Calls VCF.GZ,VCF.GZ.TBI,XLS Downloads files of the
variants calls:

VCF.GZ,VCF.GZ.TBI: Zipped
VCF file and its tabix index
fileXLS: Tab-separated
values file

Open Variants Calls in IGV IGV Link to open the results
variants in the Integrated
Genomic Browser (IGV).

Deprecated Features Classic Opens the plugin results
page in the previous format.

Ion Community Torrent Variant Caller
documentation

Opens to theTorrent Variant
Caller documentation page
on the Ion Community (login
is required).

Download files
and other actions

Torrent Variant Calling
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This option exports your variant calls to a tab-separated file. The exported file is
named subtable.xls and has the same columns as the Variant Calls table
(including columns for all three display options: View Allele Annotations, View
Coverage Metrics, and View Quality Metrics).

Click the left column checkboxes to select your variants, then click the Export Selected
button:

Barcode-aware Torrent Variant Calling

TVC manual launch now allows configuring and analyzing barcodes individually and
in a customized manner. Every barcode can be associated with its own
“configuration” that consists of Reference Genome, Target regions file, Hotspot file,
TVC parameters JSON file, and TMAP parameters (remap if different from mapped
BAM). In Torrent Suite™ Software v5.0, this feature is available today only via manual
launch of TVC - not from run planning. On a completed run, select the TVC plugin to
rerun. Then, select the Setup tab and customize parameters.

Export to file

Torrent Variant Calling
Barcode-aware Torrent Variant Calling
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In Torrent Suite™ Software v5.0 and higher, you can configure individual barcodes in
a run to be processed with their own reference genome, target regions file, hotspots
file and TVC parameters. Please note, that this functionality is only available via
manual launch of TVC after the run and not available from the run planning stage.

1. Select a completed run that you would like to reanalyze with TVC.

2. Click Report Actions4Select Plugins to Run.

3. Select variantCaller. The Torrent Variant Caller 5.0 plugin configuration screen
appears.

TVC manual
launch for custom
configuration per
barcode
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Use the Configuration drop-down menu to apply the same or different settings to all
barcodes.

To customize your TVC settings, click the Manage Configurations/Barcodes link. The
Configuration tab allows you to Edit, Delete or Add a configuration. The Setup tab
allows you to apply settings to individual barcodes.

To apply TVC changes per barcode:

1. Click the Setup tab and modify settings per individual barcodes.

2. When finished making changes, click Submit. The TVC plugin reruns and
applies the changes you made.

Apply TVC Settings
to all barcodes

Modify and apply
TVC settings for
all or select
barcodes

Torrent Variant Calling
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1. On the Configuration tab, you can Add new or Edit/Delete existing
configurations.

2. Click the Add button to add new. Name the configuration and select your
settings.

Add, edit and
delete
configurations

Torrent Variant Calling
Barcode-aware Torrent Variant Calling

Torrent Suite™ Software Help 251



3. On the Edit screen, you can modify Chip and Library types, variant frequency,
reference genome, targeted and hotspots regions and parameter settings.

4. At the bottom of the screen, you can click the Show Advanced Settings button
and further adjust variant detection and alignment parameters.

5. Save your new or modified configurations and then apply them to all or select
barcodes.

6. Click Submit to rerun TVC.

Rerun the variantCaller plugin

You can rerun the variantCaller plugin from the results page:

1. Scroll to the Adjust Parameters area at bottom of the results page, and click Show
Filter Settings:

Torrent Variant Calling
Rerun the variantCaller plugin
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2. In the parameter listings, make your changes to the parameter settings (only
main parameters are available):

3. Click Rerun Variant Caller. The plugin is submitted for execution.

Troubleshoot TVC results

In the case of missing variants (not called by TVC), an alignment viewer, such as
Integrative Genomics Viewer (IGV) or IGV Light in Ion Reporter™ software, is a
valuable tool to verify the presence of the variant in the sample at the position where
it is expected.

• IGV may reveal problems that are not imputable to the TVC - for example,
problems in mapping or low coverage.

• Visually inspect the coverage of the region where the variant is expected, paying
special attention to the depth of coverage and the quality of the bases covering
the position of the variant. Low coverage or low base quality might explain the
no-call.

• The variant could be slightly misplaced (especially for indels).

Optionally, TVC's built-in tools for displaying call details can be used.

Find False
Negatives
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If a hotspots file was used:

1. Check that the position of the variant is included in the hotspots file.

2. Check the Variant Calls output table. Values that cause a candidate to be filtered
out are shown in colored cells:

3. Adjust parameters.

4. Run the variant caller again.

If no hotspots file was used:

1. Navigate to the variantCaller results directory on the Torrent Server and open the
file small_variants_filtered.vcf. On Linux, the TS variantCaller results directory
can be found
at /results/analysis/output/Home/{analysis_report_name}/plugins/variantCaller/
for non-barcoded runs
or /results/analysis/output/Home/{analysis_report_name}/plugins/variantCaller/{
bar code}/ for barcoded runs. In the Torrent Browser, you can access the
variantCaller results directory by opening the variantCaller report page for the
sample or barcode of interest, removing the final 'variantCaller.html' from the
URL, and hit Enter.

2. If the location of the variant is found, look at the FR field (filtered reason).
3. Relate the reason to parameters using the table Filtering Codes TVC v4.x.
4. Adjust parameters.
5. Run the variant caller again.

If the location of the SNP is NOT found in the filtered.vcf file create a hotspots file
including this location.

False positives are usually related to artifacts that create unexpected amplification,
such as a primer-dimer or contamination problems. Some false positives are reported
because of the difficulties inherent in dealing with homopolymer regions.

◦These can be resolved by:

1. Adjusting parameters that control the homopolymer calls, but this can increase
the report of false negatives.

2. Or, when repeatedly running a panel, “blacklist” certain sites (positions) since
the FP tend to happen in the same positions.

Fix False Positives

Torrent Variant Calling
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Ion Reporter™ Software Features Related to Variant Calling

Both Ion Reporter™ Software and Torrent Suite™ Software offer the Torrent Variant
Caller and both provide a list of the variant positions called. This page describes
additional features that are available in Ion Reporter™ Software.

In particular, the automated annotations, links to public databases, and near real-time
filtering in the Ion Reporter™ ser interface provide time savings for researchers.

In addition to the listing of the variant calls and positions, Ion Reporter™ software also
annotates your called variants with information from both publicly and private
databases. Except where noted, these annotations are pre-built within Ion Reporter™

software. You can select which of these annotation sources to include in your analysis
workflows.

The following annotation sources are packaged with Ion Reporter™:
• dbSNP The Single Nucleotide Polymorphism Database, a free public-domain

archive for simple genetic polymorphisms, at the following site:
www.ncbi.nlm.nih.gov/projects/SNP

• COSMIC The Catalogue of Somatic Mutations in Cancer, which contains
information about somatic mutations in cancer, with more than 100,000 somatic
mutations from approximately 400,000 tumors. From their websites:
http://cancer.sanger.ac.uk/cancergenome/projects/cosmic/about.html
http://www.sanger.ac.uk/resources/databases/cosmic.html

• OMIM From the website http://www.ncbi.nlm.nih.gov/omim:
"Online Mendelian Inheritance in Man®. OMIM is a comprehensive,
authoritative, and timely compendium of human genes and genetic phenotypes.
The full-text, referenced overviews in OMIM contain information on all known
Mendelian disorders and over 12,000 genes. OMIM focuses on the relationship
between phenotype and genotype."

• GeneModel Ensembl or RefGene sources.
– GenePanel Genomic regions panels that you download from AmpliSeq.com

or your own custom panels.
– SIFT scores A SIFT score predicts whether an amino acid substitution affects

protein function.
• PolyPhen‑2 scores The PolyPhen-2 score predicts the possible impact of an amino

acid substitution on the structure and function of a human protein.
– Grantham scores The Grantham score attempts to predict the distance

between two amino acids, in an evolutionary sense.
• PhyloP PhyloP scores measure evolutionary conservation at individual

alignment sites and report either slower evolution than expected or faster
evolution than expected. For more information, visit this site and click the PhyloP
link on the site's left navigation panel:
compgen.bscb.cornell.edu/phast/background.php

Annotations
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• Gene Ontology The Gene Ontology project aims to standardize the
representation of gene and gene product attributes across species and databases
by providing a controlled vocabulary of terms for describing gene product
characteristics and gene product annotation data. The Gene Ontology
Consortium is supported by a grant from the National Human Genome Research
Institute (NHGRI). See the following sites for more information:

– http://geneontology.org
– http://amigo.geneontology.org

• Pfam From their website at http://pfam.sanger.ac.uk: "The Pfam database is a
large collection of protein families, each represented by multiple sequence
alignments and hidden Markov models".

• Ingenuity Variant Analysis Software This is not a pre-built annotation source.
From IR, you export your IR variants to this site to take advantage of the insight
and filtering that Variant Analysis offers. If you have a large number of new
variants in an analysis, Variant Analysis Software can help you filter the large set
down to the most interesting variants, based to pathways, literature citations, and
other categories. You can then import your variant set back into IR.

• Local annotation sources These are specific to your IR organization and are not
pre-built annotation sources. You can configure annotation sources for the
following:

– Maintain a list of significant variants seen in your research
– Flag variants seen previously in your research or of particular interest to

your organization
– Import positions in ampliseq.com panels
– Contain your custom free-form annotations for specific positions
– Limit variant calls to your list of preferred transcripts
– Filter out known false positives

Notes on IR annotations:
• The use of Oncomine® annotations and the Ingenuity® Variant Analysis Software

site involve additional charges.
• IR typically adds more annotation sources with each new release.
• Annotation is a separate module in IR workflows, called after the variant caller

module. IR also has a workflow that only does annotations. This workflow takes
a VCF input file of variant calls and adds annotations to those variants.

Ion Reporter™ offers pre-built workflows for paired or trio related samples. During
variant review, you can compare the incidence of variants in related samples. Variant
calls in Torrent Suite™ software are on one sample at a time.

Ion Reporter™ also offers the pre-built Tumor/Normal workflow for a pair of input
samples where one sample is a tumor sample and the other is a normal sample form
the same individual. Tumor/Normal workflow provides more than a comparison of
the presence of variants in each sample. For candidate variant positions seen in the
tumor sample, the Tumor/Normal workflow also checks the background levels of
those variants in the normal sample, providing an analysis of statistical significance of
candidate variants in the tumor sample.

Multiple-sample
workflows
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Ion Reporter™ workflows support additional variant types that Torrent Suite™

software does not call. These include copy number variation and genetic disease
variants such as compound heterozygous, trans-phase compound heterozygous, and
male maternal X.

The Ion Reporter™ Exome Trio workflow also contains a pedigree check, which finds
mis-labeling of the samples or mis-identification of the parent samples.

After your Ion Reporter™ analysis completes, you can filter your called variants
directly in the Ion Reporter™ results review screen. For example, you can use pre-built
filters to display only novel variants, or only variants that have an impact on the
coded protein.

The filtering feature greatly reduces the effort required for you to review the results of
large datasets. You can filter variants based on experimental or functional evidence.
You can use Ion Reporter™ filters on the fly in the Ion Reporter™ user interface, or
automate and reuse your filters.

Also on the Ion Reporter™ results review screen, variant details include links to
variant information in public databases such as dbSNP or COSMIC (when
appropriate).

Ion Reporter™ also offers a connection to the TaqMan® Assays site during variant
review of a completed analysis. This site returns the TaqMan® SNP Genotyping Assay
products related to your variants.

Additional variant
types

Variant filters
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In Ion Reporter™ software you can download your variants in VCF format or as a text
file.

With larger datasets and in high-throughput labs, the use of Ion Reporter™ takes some
compute load off your Torrent Server and relieves strain on your Torrent Server
compute resources.

The Command-Line Torrent Variant Caller

This version of the Torrent Variant Caller is run on the Linux™ command-line and
does not have a UI interface.

The command-line TVC is supported only on Torrent Server (release 4.2 or higher)
and requires an input BAM file of Ion Torrent™ data.

Many options have two equivalent versions. Choose the version that you prefer but
use only one of the versions. Example:

• -b BEDFILE
• --region-bed=BEDFILE

Option Description

-h

--help

Show options in a help message and exit

-b BEDFILE

--region-bed=BEDFILE

Limit variant calling to regions in this BED
file. Optional.

-s HOTSPOT_VCF

--hotspot-vcf=HOTSPOT_VCF

VCF.gz (+.tbi) file specifying exact hotspot
positions.Optional.

-i BAMFILE

--input-bam=BAMFILE

BAM file containing aligned reads

-r REFERENCE

--reference-fasta=REFERENCE

FASTA file containing reference genome

-o OUTDIR

--output-dir=OUTDIR

Output directory. Optional. Uses the current
directory if this option is missing.

-p PARAMFILE

--parameters-file=PARAMFILE

JSON file containing variant calling
parameters. Optional butrecommended.

-B RUNDIR

--bin-dir=RUNDIR

Directory path to location of variant caller
programs. Optional. Usesthe directory
where the
variant_caller_pipeline.py script
is located, if this option is missing.

Output files

Elasticity of the
cloud

Supported options
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Option Description

-n NUMTHREADS

--num-threads=NUMTHREADS

Sets the number of threads used by the TVC
process. Optional. Defaults to 12,if this
option is missing.

--postprocessed-bam=PTRIM_BAM Perform primer trimming, storing the
results in provided BAM file name. Optional.

Requires the --primer-trim-bed option.

--primer-trim-bed=PTRIM_BED BED file used for primer trimming.
Required if--primer-trim-bam is used.

About target regions BED files

When a target regions BED file is uploaded to torrent servers, it is converted into 4
different versions: merged and unmerged, plain and detailed.

The merged plain version has the duplicate regions merged or removed. Use the
merged plain BED file with the TVC --region-bed option to avoid redundant
variant calls being made.

Use the unmerged detail version of the BED file with the TVC --primer-trim-bed
option.

You can find the converted bed files under /results/uploads/BED/. The directory
structure is shown in this example:

./22/hg19/merged/plain/ColonLung.20131001.designed.bed ./22/
hg19/merged/detail/ColonLung.20131001.designed.bed ./22/hg19/
unmerged/plain/ColonLung.20131001.designed.bed ./22/hg19/
unmerged/detail/ColonLung.20131001.designed.bed

Torrent Variant Calling
The Command-Line Torrent Variant Caller

Torrent Suite™ Software Help 259



Torrent Variant Caller Parameters

This page describes Torrent Variant Caller parameters.

In general, you can safely customize parameters for SNP calling. For indel calling,
changes to the parameters tend to have a significant effect in the number of indels
called. With indels, the tradeoff between sensitivity and specificity becomes too large.

The first group of parameters are intended for general use.

The first five parameters support different thresholds for SNP, indel, and hotspot
variants. The others use the same thresholds for all variant types.

Parameter Comments

Minimum allele frequency

min_allele_freq
Minimum observed allele frequency
required for a non-reference variant call.

Lowering this value improves sensitivity
and decreases specificity (and increases
the ratio of false positives to true positives).

Allowed values: Floats 0.0 - 1.0
Recommended values for SNPs: Between
0.01 - 0.2 Recommended values for indels:
Between 0.05 - 0.2

Minimum quality

min_variant_score
Do not call variants if the phred-scaled call
quality is below this value.

Lowering this value improves sensitivity
and decreases specificity.

Allowed values: Integers >= 0
Recommended values: >= 10

Minimum coverage

min_coverage
Do not call variants if the total coverage on
both strands is below this value.

For germ line workflows, lowering coverage
improves sensitivity.

Lowering this value is dangerous for
homopolymer indels this decreases
specificity drastically.

Allowed values: Integers >= 0
Recommended values for SNPs: Between 5
- 20 Recommended values for indels:
Between 15 - 30 Recommended values for
hotspots: Between 5 - 20

Parameter
customization

Main settings
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Parameter Comments

Minimum coverage on either strand

min_cov_each_strand
Do not call variants if coverage on either
strand is below this value.

For indel calling, reducing this value
improves sensitivity but at a high cost of
specificity.

Allowed values: Integers >= 0
Recommended values: >= 3

Maximum strand bias

strand_bias
Do not call variants if the proportion of
variant alleles comes overwhelmingly from
one strand.

Allowed values: Floats 0.5 - 1.0
Recommended values for SNPs: 0.95
Recommended values for indels: 0.85
Recommended values for hotspots: 0.95

Increasing strand bias increases sensitivity.
SNP calling tolerates this adjustment better
than indel calling. Related to VCF field STB.

Minimum relative read quality

data_quality_stringency
Do not call variants if Relative Read Quality
is below this threshold. A phred-scaled
minimum average evidence per read or no-
call.

Allowed values: Floats >= 0 Recommended
values: >= 6.5

Impact of changing this value: Lowering
this value improves sensitivity and
decreases specificity. Related to VCF field
MLLD.

Maximum common signal shift

filter_unusual_predictions
Do not call variants if Common Signal Shift
exceeds this threshold. If the predictions
are distorted to fit the data more than this
distance (relative to the size of the variant),
filter this candidate position out. Allowed
values: Floats >= 0 Recommended: 0.3 =
30% of variant change size. Related to VCF
field RBI.
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Parameter Comments

Maximum reference/variant signal shift
(insertions)
filter_insertion_predictions

Do not call insertions if Reference or
Variant Signal Shift exceeds this
threshold.Filter observed clusters that
deviate from predictions by more than this
amount (relative to the size of the variant).

Allowed values: Floats >= 0
Recommended: 0.2 (which is 20% of variant
change size). Related to VCF fields VARB
and REFB.

Maximum reference/variant signal shift
(deletions)
filter_deletion_predictions

Do not call deletions if Reference or Variant
Signal Shift exceeds this threshold.

Filter observed clusters that deviate from
predictions by more than this amount
(relative to the size of the variant).

Allowed values: Floats >= 0
Recommended: 0.2 (which is 20% of variant
change size). Related to VCF fields VARB
and REFB.

Parameter Comments

hp_max_length Maximum homopolymer length for calling
indels.

Allowed values: Integers >= 1
Recommended value: 8

Related to VCF field HRUN.

downsample_to_cov
erage

Reduce coverage in over-sampled locations
to this value.

Allowed values: Integers>= 1
Recommended values: 400 (germline),
2000 (somatic)

outlier_probability Prior probability that a read comes from
some other distribution.

Lower numbers reduce the influence of
outlier observations. Higher numbers
increase the influence of outliers. Empirical
adjustment indicates that increasing the
influence of outliers leads to more false-
positives and slightly more true positives,
but at a poor tradeoff.

Allowed values: Floats 0.0 - 1.0
Recommended values: Between 0.005 -
0.01

Torrent Variant
Caller advanced
parameters
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Parameter Comments

do_snp_realignment Realign reads in the vicinity of SNP
candidates.

Allowed values:

• 0: Do no realign. Recommended for
germline.

• 1: Realign. Recommended for somatic.

prediction_precision Number of pseudo-data-points suggesting
our predictions match the measurements
without bias.

Allowed values: Floats >= 0.0

Recommended value: 1.0

Impact of changing this value: Lowering
this value increases specificity and
decreases sensitivity.

heavy_tailed How heavy the T-distribution tails are to
allow for unusual spread in the data. This
value represents the prior probability that a
given read comes from some distribution
other than the possibilities being evaluated.

Lower values mean that more reads are
forced to be assigned to one of the tested
alleles, even at very poor data fit (fewer
reads are thrown out, with the likely
tradeoff of more false positive calls). Higher
values mean that reads that are merely
slightly noisy are thrown away, resulting in
poorer sensitivity.

The proportion of reads that are discarded
as outliers is shown in the FXX info tag in
the output VCF file.

suppress_recalibrati
on

Ignore the base recalibration values from
pipeline in TVC. (Changes the way signal is
predicted.)

Allowed values:

• 0: Use base calibration values in TVC.
Recommended for Ion Proton™ data.

• 1: Ignore base calibration values in
TVC.
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Parameter Comments

hotspot_strand_bias
_pval

indel_strand_bias_p
val

mnp_strand_bias_pv
al

snp_strand_bias_pv
al

First we calculate a bootstrap estimate of
the pval to test significance of observed
strand bias against the null hypothesis of
no strand bias.

If this pval estimate is lower than the
parameter value (hotspot, indel, mnp or
snp_strand_bias_pval) and the observed
strand bias is higher than the hotspot,
indel, mnp or snp_strand_bias then this
variant will be filtered.

Lowering this value makes filtering less
stringent.

Allowed values:

• 0-1

Default value:

• 1

mnp_min_allele_fre
q

Minimum observed allele frequency
required for a non-reference variant call.
Lowering this value improves sensitivity
and decreases specificity (and increases
the ratio of false positives to true positives).

Allowed values:

• 0.0-1.0

Default value:

• 0.01-0.2

mnp_min_variant_sc
ore

Do not call variants if the phred-scaled call
quality is below this value.Lowering this
value improves sensitivity anddecreases
specificity.

Allowed values:

• integers >=0

Default value:

• >=10

mnp_min_cov_each_
strand

Do not call variants if coverage on either
strand is below this value. For indel calling,
reducing this value improves sensitivity but
at a high cost of specificity.

Allowed values:

• integers >=0
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Parameter Comments

mnp_min_coverage Do not call variants if the total coverage on
both strands is below this value.For germ
line workflows, lowering coverage improves
sensitivity. Lowering this value is dangerous
for homopolymer indels - this decreases
specificity drastically.

Allowed values:

• integers >=0

Default value:

• 5-20

mnp_strand_bias Do not call variants if the proportion of
variant allelesfrom one strand if higher
than this ratio.

Allowed values:

• 0.5-1.0

Default value:

• 0.95

do_mnp_realignmen
t

Realign reads in the vicinity of candidate
mnp variants.

Allowed values:

• 0 = off

• 1 = on

realignment_thresho
ld

Maximum allowed fraction of reads where
realignment causes an alignment change

Allowed values:

• 0-1

Default value:

• 1

use_position_bias Enables the position bias filter.

Allowed values:

• 0-1

Default value:

• 0
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Parameter Comments

position_bias Filter out variants with position bias relative
to soft clip ends in reads > position-bias
given pval < postion-bias-pval.

Allowed values:

• 0-1
Default value:

– 0.75

position_bias_pval Filter out if position bias > position-bias
given pval < position-bias-pval.

Position_bias_pval is threshold for filtering
if the pval for testing whether the position-
bias is statistically significant against the
null hypothesis of no position bias is lower
than the threshold and the position_bias is
higher than the position_bias threshold.

Note that filtering only occurs if both the
pval and the position bias is higher than the
position_bias_pval and the position bias is
higher than position_bias.

Lowering this value makes filtering less
stringent.

Allowed values:

• 0-1

Default value:

• 0.05

position_bias_ref_fr
action

Skips position bias filtering if (reference
read count)/ (reference + alt allele read
count) <= to this value.

Lowering this value makes filtering more
stringent.

Allowed values:

• 0-1
Default value:

– 0.05

sse_prob_threshold* Filters out variants in motifs with error
rates above this. Advanced filtering: read
the docs before changing.

Allowed values:

• 0-1

Default value:

• 0.2
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Parameter Comments

indel_as_hpindel Apply indel filters to non HP indels.

Allowed values:

• 0 = on

• 1 = off

Default value:

• 0

These parameters allow additional customization of the variant calling algorithm but
are intended for advanced users only.

Long indel assembly advanced settings

These parameters control the behavior of the long indel assembler (which is a module
within TVC). Again, these parameters are recommended for advanced users only.

Both the FreeBayes module and the long indel assembler generate lists of variant
candidates (other modules in TVC then evaluate the candidates). The assembly
module attempts to call any indel longer than 3 bp, but only reports indels that fail to
be called by the FreeBase module.

Parameter Comments

kmer_len Sets the length of the minimum
suffix/prefix overlap (perfect match) of any
two reads to be considered for assembly.

Increasing this value requires longer
overlaps, reducing the chances of finding
matching pairs and therefore reducing the
chances of calling false positives.
(Increasing values make indel calls less
sensitive but more specific.) Reducing the
value has the opposite effect.

Allowed values: Integers > 5
Recommended values: Between 11 - 30

min_var_count Sets the number of times a variant appears
in the assembled contigs in order to be
considered for evaluation.

Increasing this value requires more
coverage of the candidate indel to be taken
in consideration reducing the chances of
false positive calls.(Increasing values make
indel calls less sensitive but more specific.)

Allowed values: Integers > 1
Recommended values: Between 3 - 30

Advanced settings
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Parameter Comments

short_suffix_match In order for a contig to be considered for the
coverage of an indel, both sides of the
variant have to match perfectly the
reference sequence.

Increasing the size of the matching
sequence sets more stringent conditions,
reducing the chances of a contig to be
picked as containing an indel. (Increasing
values make indel calls less sensitive but
more specific.)

Allowed values: Integers > 2
Recommended values: Between 4 and
kmer_len

min_indel_size Sets the minimum size of an indel (from
assembled reads) to be reported.

Increasing this size reduces the number
(and increases the size) of the reported
indels. Increasing values make indel calls
less sensitive but more specific.

Allowed values: Integers > 0
Recommended values: Between 2 - 30

max_hp_length Sets the maximum length of the
homopolymer to be reported. The default
value has been optimized according to the
physics of semiconductor sequencing.

Increasing values make indel calls less
sensitive but more specific.

Allowed values: Integers > 1
Recommended values: Between 2 - 11

min_var_freq Sets the minimum value of the frequency of
an indel to be reported.

Allowed values: Floats 0.0 - 1.0
Recommended values: Between 0.1 - 0.4

Increasing this value requires a variant to
be highly present in the sample in order to
be called. Increasing values make indel
calls less sensitive but more specific.

Torrent Variant Calling
Torrent Variant Caller Parameters

268 Torrent Suite™ Software Help



Parameter Comments

relative_strand_bias Indels appearing in the sample more
frequently in one strand than in the other
one have an increased strand bias value.
Assembled indels for which their bias value
exceeds the value of this parameter are not
called.

Allowed values: Floats 0.0 - 1.0
Recommended values: Between 0.6 and 1.0

Increasing this value makes indel calls
more sensitive but less specific.

output_mnv Whether or not to include MNV variants in
TVC output.

Allowed values:

• 0: Do not include MNVs.

• 1: Also include MNVs.

FreeBayes advanced settings

These parameters control the behavior of the FreeBayes module, which generates a
list of variant candidates.

Again, these parameters are recommended for advanced users only.

Parameter Comments

allow_indels Enable indels in FreeBayes hypothesis
generator. When set to 0, indels are not
called. Allowed values:

• 0 = Do not generate indel hypotheses

• 1 = Generate indel hypotheses(default)

allow_snps Enable SNPs in FreeBayes hypothesis
generator. When set to 0,SNPs are not
called. Allowed values:

• 0 = Do not generate SNP hypotheses

• 1 = Generate SNP hypotheses (default)

allow_mnps Enable MNPs, including equal-length block
substitutions, in the FreeBayes hypothesis
generator. When set to 0,MNPs are not
called. Allowed values:

• 0 = Do not generate MNPhypotheses

• 1 = Generate MNP hypotheses(default)
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Parameter Comments

allow_complex Enable the generation of block substitution
variants candidate in FreeBayes hypothesis
generator. When set to 0, block substitution
variants are not called. Allowed values:

• 0 = Do not generate block substitution
hypotheses (default)

• 1 = Generate block substitution
hypotheses

Notes about setting allow_complex to 1:

• When on, allow_complex results in the
call of more true positives, but also
increases the false positive rate in
germ line analyses on Ion AmpliSeq™

exome data.

• When on, allow_complex overrides the
settings of allow_mnps

min_mapping_qv Minimum mapping QV value required for
reads to be allowed into the pileup. If a read
has a mapping QV lower than this value,
filter the position out.

Allowed values: Integers >= 0
Recommended value: 4

Impact of changing this value: Increasing
this value decreases sensitivity and
improves specificity.

read_mismatch_limit The number of mismatches allowed. If a
read has more mismatches than this value,
filter the read out.

Allowed values: Integers>= 0
Recommended value: 10

read_max_mismatch_fraction Maximum fraction of mismatches allowed
in the length of read. Filters out potentially
mis-mapped reads.

Allowed values: Floats 0.0 - 1.0

Recommended value: 1.0

Decreasing this value decreases sensitivity
and improves specificity (fewer but more
accurate reads).

gen_min_alt_allele_freq An early-on filter for allele frequency. Filter
out variant candidates that do not have at
least this frequency in the pileup.

Allowed values: Floats 0.0 - 1.0
Recommended value: 0.02 - 0.15
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Parameter Comments

gen_min_indel_alt_allele_freq An early-on filter for allele frequency for
indel callings. Filter out indel candidates
that do not have at least this frequency in
the pileup.

Allowed values: Floats 0.0 - 1.0
Recommended value: 0.02 - 0.15

gen_min_coverage An early-on filter for minimum coverage.
Filter out variant candidates that do not
have at least this depth of coverage.

Allowed values: Integers>= 0
Recommended value: 6

Parameter Comments

Torrent Variant Caller arguments This field is for internal use.

Recommended value: "tvc"

IMPORTANT! The Variant Caller parameter settings are saved in templates but are not
saved in run plans. Parameter changes that you make in a run plan affect only that
specific run.

When you change Variant Caller parameter settings in a template, your changes affect
all users who create run plans from that template.

Torrent Variant Caller Output

This page describes the Torrent Variant Caller output, which includes the following
reports and sections.

• Run report plugin summary
• Variant Caller Report
• Variant Caller Report summary section
• Variant Caller Report Variant Calls table

Torrent Variant
Caller arguments

Introduction
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The run report contains a short summary of plugin output. These summaries appear
below the run report metrics and above the Output Files section.

To jump to the plugin results:

1. Click the Plugin Summary jump near the top of the run report:

2. Click the link to go to the TVC results summary:

3. The browser jumps to the variantCaller summary.

The variantCaller summary area is slightly different for barcoded and non-barcoded
runs. In both cases, the summary section includes the following:

• Information about the analysis type, targeted regions and hotspot files, and
variantCaller parameter settings.

• The total number of variants called.
• The variantCaller.html link to the results page.
• Download links:

– The zipped VCF file of variant calls.
– The Zipped VCF index file (required for IGV).
– The results in a tab-separated file.

Run report plugin
summary
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Barcoded variantCaller summary area

For a barcoded run:
• When the run contains multiple barcodes, the variantCaller.html link opens a

listing of the barcodes.
• Links to a separate results page for each barcode.
• A link to download all results in one zipped file.

Non-barcoded variantCaller summary area

For a non-barcoded run, the sample name is listed. This link and the
variantCaller.html link open the same results page.
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To view the log file for a plugin run, in the plugin summary area, click the menu
arrow next to the plugin status:

To delete the results for a plugin run, in the plugin summary area, click the menu
arrow next to the plugin status:

This action removes the plugin's output files from the file system and removes the
Torrent Browser plugin results page.

Variant Caller Report

The open the plugin report, click the variantCaller.html link in the run report
Plugin Summary area:

The plugin report begins with a listing of information and download links, as
described in the following tables:

Field Button Description

Targeted regions BED Downloads the input
targeted regions BED file (if
any).

Hotspot regions BED Downloads the input
hotspots BED file (if any).

View plugin log
file

Delete plugin
results

Buttons for
downloads and
other actions
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Field Button Description

Parameters Settings Parameters File Downloads a JSON text file
of the TVC parameter values
used on this run.

Note: You can edit this file
and later upload it to set
your custom parameters in
subsequent runs.

Mapped Reads BAM, BAI Downloads the BAM file (and
its index) of mapped reads.
This file is input to TVC.

Variant Calls VCF.GZ,VCF.GZ.TBI,XLS Downloads files of the
variants calls:

VCF.GZ,VCF.GZ.TBI: Zipped
VCF file and its tabix index
fileXLS: Tab-separated
values file

Open Variants Calls in IGV IGV Link to open the results
variants in the Integrated
Genomic Browser (IGV).

Deprecated Features Classic Opens the plugin results
page in the previous format.

Ion Community Torrent Variant Caller
documentation

Opens to the Torrent Variant
Caller documentation page
on the Ion Community (login
is required).

The following list summarizes the features of the Variant Calls table:
• Each position is a link to open the variant in IGV. In some browsers, you save the

igv.jnlp file to your local system, and then click on igv.jnlp to open the IGV
browser.

• You can export selected variants to a table file or to the Life Technologies PCR
and Sanger Sequencing For TaqMan® Assay Design web sites.

• Click on a column header to order the table by the contents of that column.

Variant Calls by
Allele table
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• For candidates that are filtered out, the filtering reason is highlighted in the table.
For example:

The main columns are described in the following table. Use the View tabs on the right
of the table to change the display of the columns on the right:
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Column Description

Position The chromosome (or contig) name in the
reference genome, and the one-based
position in the reference genome.

Ref The reference base(s).

Variant Variant allele base(s).

Var Freq Frequency of the variant allele.

Quality Phred-scored quality field. Larger values
mean more certainty in the call.

Typically very large for reads strongly
distinguishing variants (SNPs) with good
depth; that is, under the model assumed,
evidence is overwhelming for the variant or
for the reference. Marginal values in this
field can mean either the reads do not
distinguish the variant well or there is
insufficient depth to resolve, or the
observed allele frequency is near the cutoff.
Filters to compensate for the cases in
which the model assumptions are not true
are found in the INFO tags.

Computed by posterior probability that the
sample variant allele frequency is greater
than the min-allele-frequency specified for
the variant type (if a variant), or posterior
probability that the variant allele frequency
is below this threshold (if a reference call).
Posterior probability computed conditional
on the reads observed, includes sampling
variability.
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View Allele Annotations 

These columns are displayed in the run report in the View Allele Annotations tab:

Column Description

Variant Type SNP Single nucleotide polymorphism

IND Insertion

DEL Deletion

MNP Multiple nucleotide polymorphism

COMPLEX Complex block substitution

Allele Source Hotspot if called only because of its entry in
a hotspots file

Novel all others

Allele Name The Allele name as given in the target
regions file

Gene ID The Gene ID as given in the target regions
file

Region Name The regionname as given in the target
regions file

View Coverage Metrics 

These columns are displayed in the run report in the View Coverage Metrics tab:

Column Description

Coverage Total coverage at this position, after
downsampling

Coverage + Total coverage on the forward strand, after
downsampling

Coverage - Total coverage on the reverse strand, after
downsampling

Allele Cov The number of reads that contain this
allele, after downsampling

Allele Cov + Allele coverage on the forward strand, after
downsampling

Allele Cov - Allele coverage on thereverse strand, after
downsampling

Strand bias Discrepancy between allele frequencies on
the forward and reverse strands
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Export to file

This option exports your variant calls to a tab-separated file. The exported file is
named subtable.xls and has the same columns as the Variant Calls table
(including columns for all three display options: View Allele Annotations, View
Coverage Metrics, and View Quality Metrics).

Click the left column checkboxes to select your variants, then click the Export Selected
button:

View Quality Metrics

These columns are displayed in the run report in the View Quality Metrics tab.
Associated filtering codes are given in brackets.

Column Description

Common Signal Shift Distance between predicted and observed
signal at the allele locus. [RBI]

Reference Signal Shift Distance between predicted and observed
signal in the reference allele. [REFB]

Variant Signal Shift Distance between predicted and observed
signal in the variant allele. [VARB]

Relative Read Quality Phred-scaled mean log-likelihood
difference between the prediction under
reference and under the variant hypothesis.
[MLLD]

HP Length Homopolymer length.

Context Error + Probability of sequence-specific error on
the forward strand (reported only for
deletion variants).

Torrent Variant Calling
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Column Description

Context Error - Probability of sequence-specific error on
the reverse strand (reported only for
deletion variants).

Context Strand Bias Basespace strand bias (reported only for
deletion variants).

Export to Pre-Designed Primers for PCR and Sanger Sequencing
site

With this export option, you select variants to search for pre-designed primers for
PCR and Sanger sequencing.

To initiate a search, use the checkboxes column (on the left) to select variants from the
TVC plugin report and click on the Export Selected button. A pop-up window allows
you to submit variants for the PCR and Sanger sequencing pre-designed primers site:

A new browser window opens to this site: 
Pre‑Designed Primers for PCR and Sanger Sequencing. You must be connected to
the internet to access this feature.

Torrent Variant Calling
Export to Pre-Designed Primers for PCR and Sanger Sequencing site
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TaqMan® Assay Search

After running the TVC plugin, you can select variants from a report table and submit
a search against the TaqMan® Assay Search webpage. When the search is submitted,
you can choose which TaqMan® Assay database to search. A new browser window
appears with the search results. If TaqMan® assays are available for the selected
variant, you can immediately order the assay directly from the landing page. You
must be connected to the internet to access this feature.

To initiate a search, use the checkboxes column (on the left) to select variants from the
TVC plugin report and click the Export Selected button. A pop-up window allows
you to submit variants for TaqMan® assay design.

Torrent Variant Calling
TaqMan® Assay Search

Torrent Suite™ Software Help 281



You are then presented with a list of verification assays that you can order from
Thermo Fisher.

Torrent Variant Calling
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Torrent Variant Caller Integration with TaqMan® and PCR

This page describes how to use your Torrent Variant Caller (TVC) results forpre-
designed primers for PCR and Sanger sequencing or with the TaqMan® Assay Search
web page.

With this export option, you select variants to search for pre-designed primers for
PCR and Sanger sequencing.

To initiate a search, use the checkboxes column (on the left) to select variants from the
TVC plugin report and click on the Export Selected button. A pop-up window allows
you to submit variants for the PCR and Sanger sequencing pre-designed primers site:

A new browser window opens to this site: 
Pre‑Designed Primers for PCR and Sanger Sequencing. You must be connected to
the internet to access this feature.

Export to Pre-
Designed Primers
for PCR and
Sanger
Sequencing site

Torrent Variant Calling
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After running the TVC plugin, you can select variants from a report table and submit
a search against the TaqMan® Assay Search webpage. When the search is submitted,
you can choose which TaqMan® Assay database to search. A new browser window
appears with the search results. If TaqMan® assays are available for the selected
variant, you can immediately order the assay directly from the landing page. You
must be connected to the internet to access this feature.

To initiate a search, use the checkboxes column (on the left) to select variants from the
TVC plugin report and click the Export Selected button. A pop-up window allows
you to submit variants for TaqMan® assay design.

You are then presented with a list of verification assays that you can order from
Thermo Fisher.

TaqMan® Assay
Search
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Integration with Ion Reporter™

Software

The IonReporterUploader plugin

The Ion Reporter Uploader plugin transfers results files directly from a Torrent Suite™

Software analysis to your Ion Reporter™ Software organization (available under
separate license).

You include the Uploader plugin settings in the run plan that you use for your
sequencing run. When your Torrent Suite™ Software analysis completes, the run plan
automatically launches the plugin and begins your file transfer. After the transfer,
your Ion Reporter™ Software is automatically launched.

One-time manual launch from a completed run report (with the Select plugins to run
button) is also supported. Manual plugin launch does not support automatic Ion
Reporter™ Software workflow launch.

Configure your Ion Reporter™ Uploader Plugin Access Credentials

This page describes how to configure your Torrent Browser to transfer files to your
organization on Ion Reporter™ Software.

The IonReporterUploader plugin supports multiple configurations, each with a
different login and different display name (that you assign). With these multiple
configurations, the IonReporterUploader plugin supports the transfer of results from
one Torrent Server to different Ion Reporter™ Software organizations, without the
need to change the plugin configuration.

When multiple users (with different Torrent Suite™ Software logins) configure the
IonReporterUploader plugin, each user can only see (and use) the
IonReporterUploader plugin configuration that they created themselves. When
multiple users share one Torrent Suite™ Software login, they can see and use all

Overview
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IonReporterUploader plugin configurations created with that Torrent Suite™ Software
account.

IMPORTANT! When you upgrade your Ion Reporter™ software, you must configure
your IonReporterUploader plugin to access the new version of the software. Repeat
the configuration steps each time you upgrade.

1. Log into the Torrent Browser (as either an ionadmin or a regular user).

2. Click the Admin gear menu (in the upper right) and select Ion Reporter™

Configure.
The Ion Reporter™ Uploader Configuration page opens. If the plugin is not
configured yet, this page opens:

3. Click the + Add Account menu. For the hosted cloud Ion Reporter™ Software
solution, click Ion Reporter™ Cloud. For your own Ion Reporter™ Server System,
click Ion Reporter™.

4. In the Configure popup, make these entries the hosted cloud Ion Reporter™

Software solution:

Field Directions

Server Type Enable HTTPS

Display Name Enter a meaningful name of your choice. This name is used in the
run plan template wizard and is seen by other Torrent Browser
users. Use only alphanumeric characters, spaces, and underscores.

Server Enter: 40.dataloader.ionreporter.iontorrent.com

Port Enter: 443

Username Enter your Ion Reporter™ Software login (your email address).

Password Enter your Ion Reporter™ Software login password

For your own Ion Reporter™ Server System, these entries depend on your
location system configuration: Server Type (HTTP or HTTPS), Server, and Port.
Ask your local Ion Reporter™ Server System administrator for these values.

5. The "Default Account" is the account that is configured by default in run
templates and run plans. If this is the main account to be used for file transfers,
enable the Default Account checkbox. (You can always change this selection in
the run plan template wizard and in the Upload to Ion Reporter™ quick link.)
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6. Click the Get Versions button to see what versions are available on your server.
Select the desired version.

7. Click the Add button in the bottom right.
As soon as at least one account is successfully configured, the Uploader plugin is
ready to transfer files and also launch Ion Reporter™ Software analyses. If you
configure more than one account, you have a choice of accounts to use for the
transfers, in the run plan template wizard, the Uploader plugin manual launch
page, and the
Upload to Ion Reporter™ quick link. Each Torrent Browser user can only see the
configurations they created, but if several people share a Torrent Browser login
account, those people can see and potentially use each others configurations.
The more common causes of a configuration error are:

• HTTP is selected instead of HTTPS.
• The server name is incorrect.
• The port number is incorrect.
• The login or password is incorrect or deactivated.
• There are spaces before or after the server name, port number, username, or

password.

Red status on Ion Reporter account configuration page

When you change your Ion Reporter account password or upgrade the account, the
status column on the Ion Reporter Uploader account configuration page shows a red
radio button.

If you changed your password, click the Edit icon and enter your new password.

If you upgraded your account to a new version, click Edit and delete your old account
and create your new account for the new version.

Integration with Ion Reporter™ Software
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Manage multiple configurations

With the release of Ion Reporter™ Software 4.0, the Uploader plugin can manage
multiple configurations. Repeat the process above to add another configuration.

The Get Versions button allows you to see all the Ion Reporter™ versions available on
the Cloud or your Ion Reporter™ local server.

In the Version section, select the Ion Reporter™ version that you wish to access
workflows from.

Integration with Ion Reporter™ Software
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Notes about multiple Uploader configurations:
• When you use the Uploader plugin in a Torrent Browser run template or manual

launch, you select the correct configuration based on the display name that you
entered on the plugin configuration Add Ion Reporter Account form.

• Each Torrent Suite™ Software user can only see and use configurations that are
created with that Torrent Suite™ Software user login.

Ion Reporter™ Software uses theTorrent Suite™ Software output BAM file for analysis.
The Ion Reporter™ Software annotation-only workflow also accepts the VCF output
file of the Torrent Variant Caller plugin. Use the IonReporterUploader plugin to
transfer these output files to Ion Reporter™ Software.

In a run plan template wizard, you can set up the IonReporterUploader plugin to
automatically transfer the output files to Ion Reporter™ Software, after each
completion of your Torrent Suite™ Software analyses.

A UNIX® command-line version of the Uploader is available. The command-line
Uploader runs on any standard UNIX® box (and is not limited to Torrent Servers).

Download the command-line Uploader from your Ion Reporter™ Software profile.
Instructions for the command-line Uploader available in the command-line version
and are included with the Ion Reporter™ Software documentation (which is also
downloaded from your Ion Reporter™ Software profile and available in the Ion
Reporter™ Software help).

Integration with Ion Reporter™ Software

In your analysis template, you can specify that your Torrent Suite™ Software results
files are automatically transferred to your organization in Ion Reporter™ Software.
Your results transfer, including sample definition and workflow launch in Ion
Reporter™ Software, is handled by the IonReporterUploader plugin.

You include the Uploader plugin settings in the run plan that you use for your
sequencing run. When your Torrent Suite™ Software analysis completes, the run plan
automatically launches the plugin and begins your file transfer. After the transfer,
your Ion Reporter™ Software is automatically launched.

Integration with
Ion Reporter™

Software

Command-line
version of the Ion
Reporter™

Uploader
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You can run the IonReporterUploader in these three ways to transfer your Ion
Reporter™ Software results files to Ion Reporter™ Software:

• The analysis template wizard In the wizard you use configure your analysis
template to use Ion Reporter™ Software. Then every Torrent Suite™ Software
analysis that is based on your analysis template automatically transfers results
files to your Ion Reporter™ Software organization and defines Ion Reporter™

Software samples from your newly transferred files. You have the option to
configure automatic Ion Reporter™ Software launch on the new samples.

• On‑demand manual plugin launch A one-time manual launch from a completed
run report (with the Select plugins to run button) transfers your results files and
defines samples in Ion Reporter™ Software. Manual plugin launch does not
support automatic Ion Reporter™ Software workflow launch.

• On‑demand one‑click transfer to Ion Reporter™ Software A one-time manual
launch from a completed run report (with the Upload to IR menu) transfers your
results files and defines samples in Ion Reporter™ Software. This transfer does not
support automatic Ion Reporter™ Software workflow launch.

Each of these requires that you first configure the IonReporterUploader plugin with
your Ion Reporter™ Software login ID and password.

Note: The Ion Reporter™ Software application is not included with Torrent Suite™

Software and is available under separate license.

Ion Reporter™ Software comprises a suite of bioinformatics tools that streamlines and
simplifies the data analysis, annotation, and reporting of Ion Torrent™ semiconductor
sequencing data. Designed for both exploratory and production use in performing
sequencing assays, Ion Reporter™ Software helps you overcome the bioinformatics
barriers to interpret DNA variants faster and more consistently. For researchers
needing a simple, reproducible bioinformatics tool that helps ensure consistency in
their results, Ion Reporter™ Software is an ideal solution.

Integrate your variants with comprehensive public and curated annotations, along
with your own lab-specific content. Ion Reporter™ Software is designed to reduce the
time-to-results. Configurable analysis modules and parameters allow customization
of workflows to fit your research needs.

All the steps, from data import to annotating variants, are automated in Ion Reporter™

Software workflows. Key features include the following:
• Detection of SNPs, indels, and CNVs in one easy to use workflow
• Automated analysis workflows for 1, 2, or 3 samples
• Hosted and local deployment options to suit your lab's needs
• Simple interface to drive intuitive user experience
• Role-based logins and full auditability so you can tell who did what and when
• Extensive annotations to guide understanding of your sample's variants
• Flexible batch export for integration into laboratory systems and APIs in support

of third-party tools for external analysis

What Ion Reporter
Software does
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Ion Reporter™ Software uses the Torrent Suite™ Software output BAM file for analysis.
The Ion Reporter™ Software annotation-only workflow also accepts the VCF output
file of the Torrent Variant Caller plugin. Use the IonReporterUploader plugin to
transfer these output files to Ion Reporter™ Software.

In a run plan template wizard, you can set up the IonReporterUploader plugin to
automatically transfer the output files to Ion Reporter™ Software, after each
completion of your Torrent Suite™ Software analyses.

To set a run plan to automatically transfer files (after the completion of the Torrent
Suite™ Software analysis), you define a run plan in the Torrent Browser Plan tab
before your sequencing run. Your results files are transferred to Ion Reporter™

Software and also defined as samples in Ion Reporter™ Software, and your selection of
Ion Reporter™ Software workflow is automatically launched on your newly-
transferred samples.

When you run the Uploader plugin from a completed run report, your results files are
transferred to Ion Reporter™ Software and also defined as samples in Ion Reporter™

Software. An Ion Reporter™ Software workflow is not automatically launched.

The Uploader plugin sends two email notifications for each plugin run:
• When the plugin begins to transfer your files
• When the upload to Ion Reporter™ Software is finished

The notifications are sent to the email address of the Ion Reporter™ Software user
whose authentication token was used to configure the plugin.

• There is a one-time configuration of the plugin in both the Ion Reporter™

Software UI and the Torrent Browser, before the plugin can be used.
• Because this one-time plugin configuration requires an authentication token from

Ion Reporter™ Software, you (or an administrator) must already have an Ion
Reporter™ Software user account).

• The plugin has these requirements:
– The plugin only works on completed Torrent Suite™ Software analyses that

have a run plan with the following:
– IonReporterUploader selected in the run plan wizard Export chevron,
– The Ion Reporter™ Software sample name(s), workflow(s), and sample

relationships properly defined in the Plan chevron,
– And, for barcoded runs, the correct barcode kit selected ion the Kits

chevron.
– Manual launches of the plugin (on a completed run report) also depend on

the run plan.

Integration with
Ion Reporter™

Software 

Add the Ion
Reporter™

Software to a run
plan

Manual launch of
the Ion Reporter™

Uploader plugin

Email notifications

Prerequisites
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The following limitations apply to the IonReporterUploader plugin:
• The Uploader plugin transfers results files for a completed run plan that executed

on the Torrent Server where the plugin is configured. (In addition, each run must
have the IonReporterUploader plugin enabled and configured in its run plan.)

• You cannot copy results file from a different Torrent Server and have the plugin
transfer those files.

• Only files appearing in the File Links section of a run report are transferred.
• You cannot add supplemental files to the results files of a run, in order to have the

plugin transfer those files.
• For barcoded runs:

– For automatic runs with barcoded data, the Uploader plugin only transfers
samples if the barcode kit selection in the run plan wizard is correct. If you
correct or add the barcode kit selection on the sequencing instrument, the
Uploader plugin still uses the old run plan information and the results file
transfer fails.

– For manual launches of the plugin on barcoded data, the Uploader plugin
uses the barcode kit selection that you make on the sequencing instrument.

A UNIX® command-line version of the Uploader is available. The command-line
Uploader runs on any standard UNIX® box (and is not limited to Torrent Servers).

Download the command-line Uploader from your Ion Reporter™ Software profile.
Instructions for the command-line Uploader available in the command-line version
and are included with the Ion Reporter™ Software documentation (which is also
downloaded from your Ion Reporter™ Software profile and available in the Ion
Reporter™ Software help).

Typically the BAM file output of your Torrent Suite™ Software analysis is uploaded to
Ion Reporter™ Software and then Ion Reporter™ Software runs through its analysis
phases of mapping, variant calling, and annotation. This table shows how Torrent
Suite™ Software output files are used in Ion Reporter™ Software analyses:

Torrent Suite™ Software
output file

Output from this Torrent
Suite™ Software analysis

phase

Input to this Ion Reporter™

Software workflow

BAM file TS analysis pipeline Any except annotation-only

VCF file TS Variant Caller (TVC)
plugin

Annotation only

The Ion Reporter™ Uploader plugin by default uploads both the BAM file and the
VCF file from your Torrent Server to Ion Reporter™ Software.

Ion Reporter™ Software analysis involves the following major analysis phases:

1. Mapping
2. Variant calling
3. Annotation

Transfer
limitations

Command-line
version of the Ion
Reporter™

Uploader

Torrent Suite™

Software output

Ion Reporter™

Software analysis
files
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The following table describes the input and output file types for the analysis phases:

Analysis phase Input file type Output file type

Mapping BAM file (mapped or
unmapped)

Mapped BAM file

Variant calling Mapped BAM file VCF file

Annotation VCF file (with or without
annotations)

Annotated VCF file

Each output file type is required as input to the next analysis phase. In almost all
cases, the Ion Reporter™ Software analysis phases are performed in order.

The exception is the annotation phase. The annotation-only workflow runs this phase
by itself. (All other workflows include the annotation phase as their last analysis
phase.) The annotation-only workflow requires as input a VCF file, which can be
generated from either a Ion Reporter™ Software analysis, a Torrent Suite™ Software
Torrent Variant Caller (TVC) plugin analysis, or a different source.

You can configure the Ion Reporter™ Uploader plugin to transfer your files
automatically and you can also transfer files on a completed Torrent Suite™ Software
analysis.

Set an Analysis Template to Transfer to Ion Reporter™ Software

The Ion Reporter Uploader plugin transfer results files directly from a Torrent Suite™

Software analysis to your Ion Reporter™ Software organization (available under
separate license).

You include the Uploader plugin settings in the run plan that you use for your
sequencing run. When your Torrent Suite™ Software analysis completes, the run plan
automatically launches the plugin, begins your file transfer, and eventually defines
samples and launch the analysis in Ion Reporter™ Software.

These instructions apply to Ion Reporter™ Software users.

To set an analysis to automatically transfer files (after the completion of your Torrent
Suite™ Software analysis), use the IonReporter and Plan chevrons in the Torrent
Browser analysis template wizard. (The Ion Reporter Uploader does not use the
wizard's plugin chevron.)

For barcoded data, also select the correct barcode kit in the Kits chevron. When you
select a barcode kit, the Plan chevron creates a sample name field for each barcode.

We recommend that you use the plan-by-sample feature. Plan-by-sample helps fill out
the run plan wizard with your sample information.

File Transfer

Overview

Add Ion Reporter™

Software to your
analysis template
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Here is a summary of what takes place. After your run plan is created, saved, and
then started on the sequencing instrument, each step is automated until you review
your results in the Ion Reporter™ Software UI:

1. Analysis template Make sure that your Torrent Suite™ Software analysis
template is ready. For multi-sample analyses in Ion Reporter™ Software, create a
multi-sample version of your run template in your Torrent Browser.

2. Samples and sample set You define your samples and sample set in the Torrent
Browser Plan4Samples tab. After you save your sample set, click the Plan Run
option in the sample sets' gear menu. The Torrent Browser prompts you to select
your run template.

3. Run plan wizard You follow the prompts to define a run plan based on your run
template. In the run plan, you select the Ion Reporter™ Software workflow and
barcoding kit (if required). The Torrent Browser fills out the sample information
in the wizard, based on your sample set.

4. Plan code When you save your plan, it is assigned a plan code.

5. Sequencing You enter the plan code on the Ion PGM™ or Ion Proton™ sequencing
instrument to begin the sequencing run.

6. Torrent Suite™ Software analysis After sequencing, the results are transferred to
your Torrent Suite™ Software for analysis.

7. Ion Reporter™ Software analysis When your Torrent Suite™ Software analysis is
complete, your results are transferred to Ion Reporter™ Software:

a. Your samples are defined in Ion Reporter™ Software.

b. Your choice of workflow is launched in Ion Reporter™ Software.

c. Ion Reporter™ Software sends you an email to notify you that your results
are ready for review.

8. Ion Reporter™ Software results You review your results in the Ion Reporter™

Software UI.
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The Ion Reporter chevron

Click the Ion Reporter chevron:

Sample Grouping

Sample Grouping corresponds to the sample relationship within Ion Reporter™

Software. When you select a Sample Grouping, the workflow menu displays only
workflows that match that number of samples.

Existing Workflow

Use this menu to select your Ion Reporter™ Software analysis type. When you select a
workflow from this menu, the Sample Grouping radio buttons show the sample
relationship required by that workflow.

Create New Workflow

Click this button to open Ion Reporter™ Software in a new browser window. In Ion
Reporter™ Software, create your new workflow and save it.
When you return to your Torrent Browser, refresh your browser. Then the newly-
created workflow appears in the Existing Workflow menu.
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Manage Ion Reporter™ Workflow List

To reduce the number of Ion Reporter™ workflows that appear on the drop-down
menu on the Ion Reporter™ chevron during planned run creation in Torrent Suite™

Software.

This is achieved by applying "Tag for IRU" in Ion Reporter™ Software. "IRU" stands
for Ion Reporter™ Uploader and it is the plugin that transfers Torrent Suite™ run data
to Ion Reporter™ software, but it can also tag the Ion Reporter™ workflows that you
want to see in Torrent Suite™ software.

1. Log into Ion Reporter™ software.

2. Go to Workflows 4Overview.

3. Select a workflow, then click Actions4Tag for IRU. Repeat for each workflow of
interest.

Only the 'tagged for IRU' workflows will now show up when planning your runs
in Torrent Suite™ Software.

4. To undo, select Untag for IRU.

Advanced settings

The Ion Reporter Uploader plugin now allows you to tune upload speeds and set file
segment size on the run report.

Integration with Ion Reporter™ Software
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Tune Ion Reporter™ Uploader speed parameters

New in Ion Reporter™ Uploader v5.2, you can adjust upload speed parameters.

1. In Torrent Suite™ software, go to Data4Completed Runs and select a run you
wish to upload into Ion Reporter™ software.

2. Scroll down to Output files and click Select Plugins to Run, then select
IonReporterUploader.

3. Click Advanced Settings.
a. Set the Number of Parallel Streams to Default (recommended optimal

speed) or choose 1‑5 to slow down upload.

b. Set File Segment Size to Default (recommended), or 16MB, 32MB, 64MB, or
128MB.

Note: Only change the settings if you have a slow network and have had
trouble with the default settings in the past.
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The Kits chevron

The Chip Type is required. If the template contains the chip type, that information is
silently entered into the Chip Type field here. Otherwise, select the chip from the Chip
Type menu in this chevron.

If your sequencing run uses a barcode kit, select that kit.

Important: If your analysis will use an Ion Reporter™ Software multi-sample
workflow, such as a paired or trio workflow, you must use barcoding to sequence
your samples together on one chip. Samples that are not sequenced on the same chip
cannot be automatically analyzed in Ion Reporter™ Software.

Based on your barcode kit selection, the Plan chevron pre-populates a sample field for
each barcode.

Sample gender

Whenever the gender of a sample is known, enter the gender in the plan (the gender
column is not shown in the example images). Several workflows, especially copy
number variation detection and Genetic Disease Screening (GDS), are limited when
gender is not known and also return unexpected results when gender is incorrectly
specified for a sample.

For example, with the (GDS) workflow, when the gender of the proband is not
known, variants cannot be assigned the categories HasMaleMaternalX and
HasUnknownX.

Integration with Ion Reporter™ Software
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If you transfer a research sample without specifying the gender, follow this step as a
workaround: after the files are transferred, go to the Sample > Sample Management
screen in Ion Reporter™ Software and edit the GDS sample to specify the gender
attribute.

Note: You cannot edit samples that have been launched in an analysis. Instead, define
new samples from the raw data files, and add the correct gender metadata to the new
samples.

Note about sample gender for Ion Reporter™ Software users:
• IGV assumes that a sample's gender is female, if the sample's gender is not
specified or specified as "Unknown".

Save the run plan or template

The title for last chevron of the wizard is different for templates, run plans, and run
plans that are planned by sample set:

• Templates The chevron title is Save. Here you enter the new template name and
optionally mark it as a favorite.

• Run plans The chevron title is Plan. Here you enter the new run plan name and
sample information.

• Plan by sample set The chevron title is Save & Finish.Here you enter the new run
plan name. (Sample information is automatically entered into the Barcoding
chevron.)

Note: Templates that are marked as favorites are listed in their own section at the top
of the Templates tab.

Results files for barcoded sequencer runs

For barcoded runs, all barcoded results files are transferred, except for results files
with a file size of zero.

The plugin logs warnings for these files:
• Files with a file size of zero
• Missing files

Note: Results files for unused barcodes are transferred, if the results file size is not
zero.rc_Plugin log files

The plugin log files are found on the Torrent Browser Completed Runs & Reports tab
Plugin Summary section, in the run report for which the plugin was run. The icon
opens the system log for the plugin run. The status arrow opens the Uploader plugin
log:
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While the transfer is in progress, the plugin has the following message. Click the here
link to open the Uploader's progress table:

Plugin log files

The plugin log files are found on the Torrent Browser Completed Runs & Reports tab
Plugin Summary section, in the run report for which the plugin was run. The menu
next to the plugin status opens the system log for the plugin run:

Manual launch of the IonReporterUploader plugin

Unlike a run that is launched through a planned run, a manual launch of the
Uploader plugin does not automatically launch the Ion Reporter™ Software workflow
for you. With a manual launch of the Uploader plugin, your Torrent Suite™ Software
results files are transferred to Ion Reporter™ Software and also defined as samples in
Ion Reporter™ Software.

Display names

The plugin launch uses display names that the Uploader plugin uses to transfer files
to the correct version of Ion Reporter™ Software and to the correct Ion Reporter™

Software organization.The display names are defined in the admin Plugin tab, in the
IonReporterUploader Configure option.

Files transferred

BAM files are the output of the mainTorrent Suite™ Software analysis pipeline. VCF
files are the output of the Torrent Variant Caller plugin. The default action is to
upload both BAM and VCF files, if available.

A VCF file is only available if the Torrent Variant Caller plugin already completed for
this run report.

Information from the run plan

The Uploader's behavior is different if the original Torrent Suite™ Software analysis
was executed because of a run plan than if the analysis did not have a run plan:

• Part of a planned run The Uploader reads the run plan and transfers files based
on the run plan.

• Not part of a planned run The Uploader checks for BAM and VCF files and
uploads all eligible files.
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Launch

Follow these steps to manually run the Uploader plugin:

1. Go to the Data > Completed Runs & Reports tab, then click the link for your
completed analysis run.

2. In the run report, scroll down to Plugin Summary tab.
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3. Click Select plugins to run button, then click IonReporterUploader:
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4. The Select Ion Report Account page opens:

5. First select the correct Upload Option for this run:
a. BAM files The output of the main Torrent Suite™ Software analysis pipeline.

b. VCF files The output of the Torrent Variant Caller plugin (if already run and
completed for this run report).

6. When multiple Ion Reporter™ Software user account are supported, your
selection on this page determines which Ion Reporter™ Software organization
receives the transferred files. Click the Launch IRU button for the correct set of
credentials and to the correct version of Ion Reporter™ Software

7. If you are sure, click Yes on the confirmation popup.

8. Please read the submission notice and do not relaunch the Uploader on this run
report without allowing time for this Uploader launch to finish transferring its
files. Click OK.

9. Click the Refresh Plugin Status button to monitor the Uploader's progress. The
Uploader section is easier to find if you click the Collapse All button.
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Monitor the upload progress

Use the plugin's progress table (in Plugin Summary section for IonReporterUploader)
to track the progress of the file transfer. While the transfer is in progress, the plugin
has the following message.

Click the here link to open the Uploader's progress table in the plugin summary
section. The status.html link opens the same progress table, but as the only content in
a new browser tab. An example progress table is shown below:

The underlined fields are links to additional information. the progress link is best for
seeing how much of the transfer is complete. the log link is the best source for
troubleshooting a failure.

• stdout The standard output messages for the plugin run.
• log Plugin log messages, including errors.
• input The input file of plugin parameters and options, in JSON format.
• progress Opens a page of progress bars that track the transfer:
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Notes about the Uploader plugin

• Use only IonReporterUploader. Other versions of IonReporterUploader plugins
are not compatible with Ion Reporter™ Software 1.6.x.

• If IonReporterUploader does not appear in the Select Plugin to Run list, it is
either not enabled or not configured on your Torrent Server.

• The plugin log file (in the Torrent Browser Plugin Summary area) contains
information about the location the data files are transferred to in Ion Reporter™

Software.

• For Torrent Suite™ Software analyses that do not have the Ion Reporter™ Software
configured in a run plan (in the IonReporter chevron), sample names in Ion
Reporter™ Software are created using the Torrent Suite™ Software analysis name.
With barcoded runs, the barcode name is also added to the sample name.

Double submission warning message

This warning is shown when there is the possibility that an upload of the current
results is already in progress:

If the Uploader plugin has Error status, you can safely click Yes and retry the upload.

If the Uploader plugin status is Queued or Started, click No. A second submission of
the plugin on the same run report causes both submissions to fail.
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One-Click Transfer to Ion Reporter™ Software

In the report header for a completed analysis, you can use the Upload to IR button to
transfer the output of that analysis to Ion Reporter™ Software. You choose whether to
transfer the BAM or VCF output files, or both file types. This button transfers the data
but does not define a sample in Ion Reporter™ Software or launch an analysis in Ion
Reporter™ Software.

The Ion Reporter™ Uploader plugin must be configured before you can use the
Upload to IR button.

Transfer to Ion Reporter™ Software

Follow these steps to transfer the run report's output files to Ion Reporter™ Software
with the Upload to IR button:

1. Open the run report in the Torrent Browser. The analysis must be complete.

2. Click the Upload to IR button in the run report header area:

3. Select your IonReporterUploader configuration:
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4. In the popup, select which type of output file you want to transfer:

5. You see a message confirming that the transfer has started:

Monitor the transfer

A new IonReporterUploader instance opens in the run report's Plugin Summary area.
The summary of any previous IonReporterUploader run is not overwritten.

When transfer is finished, the plugin shows a status of Completed:
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Nuances of the Ion Reporter Uploader plugin

• You can configure the Ion Reporter™ Uploader plugin to transfer your files
automatically (in your run plan template).

• You can also transfer files on a completed Torrent Suite™ Software analysis, by
launching the plugin on a completed run report.

• The Ion Reporter™ Uploader plugin defines samples in Ion Reporter™ Software
for your newly- transferred files. The plugin also defines sample relationships for
paired and trio samples and defines sample attributes.

• You can configure the Ion Reporter™ Uploader plugin to automatically start an
Ion Reporter™ Software analysis after your files are transferred and samples are
defined.

A manual launch of the IonReporterUploader plugin in a run report's Plugin
Summary area supports defining the sample in Ion Reporter™ Software and launching
anIon Reporter™ Software analysis on your newly-defined sample.

Review Torrent Suite™ run results before auto upload to Ion Reporter™

software

New in Torrent Suite™ software v5.2, you can review run results and decide whether
or not to upload them to Ion Reporter™ software for further analysis. You can set this
quality check pause when setting up your run plan template or when editing a
planned run.

Set Run Plan template for QC pause

1. Go to Plan4Templates and click template of interest.

2. In the Ion Reporter tab, select your Ion Reporter server or cloud account.

3. Select an existing workflow and then select Review results after run completion,
then upload to Ion Reporter.

4. Make any other required changes, name your template, and click Save and
Finish.

5. Go back to Plan4Templates, locate your new template, click the gear button in
its row and select Plan Run.
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6. Execute the run on the sequencer.
After run is completed, the Plugin Summary reports the IonReporterUploader
status as completed. In order to proceed with the IRU upload or auto-launch,
you must do the next step.

7. Review the Run Results. If results are acceptable, click Upload to IR4Upload as
Planned.

A confirmation window appears.
• Select Yes to upload as planned.
• Select No to cancel.
• Select Review‑Plan to look at the run results.

8. Review the Ion Reporter Uploader results in the status.html or summary.html
files.
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Edit Run Plan for QC pause

1. In the Data4Completed Runs & Results page, select your run and review the
results.

2. Click Report Actions4Edit Run Plan.

3. In the Ion Reporter screen, select your Ion Reporter server or cloud account.

4. Select an existing workflow and then select Review results after run completion,
then upload to Ion Reporter.

5. Make any other necessary changes and click Update Run & Reanalyze.

6. Review the Run Results. If results are acceptable, click Upload to IR4Upload as
Planned.

A confirmation window appears.
• Select Yes to upload as planned.
• Select No to cancel the Ion Reporter workflow upload or workflow auto

launch.
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• Select Review‑Plan to look at the run results.

7. Review the Ion Reporter Uploader results in the status.html or summary.html
files.

Check IRU status in log file

If there is no status.html file, you can check the status of the IonReporterUploader in
the log file:

1. After the report is complete, click H+ to launch Metal.

2. Go to (your server
name)/report/399/metal/plugin_out/IonReporterUploader_out.
(plugin number)/post/log.txt to see the status:

Check the Progress of your File Transfer

Email notifications

The Uploader plugin sends two email notifications for each plugin run:
• When the plugin begins to transfer your files
• When the upload to Ion Reporter™ Software is finished

The notifications are sent to the email address of the Ion Reporter™ Software user
whose authentication token was used to configure the plugin.
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Plugin log files

The plugin log files are found on the Torrent Browser Completed Runs & Reports tab
Plugin Summary section, in the run report for which the plugin was run. The menu
next to the plugin status opens the system log for the plugin run:

Plugin progress table

The plugin progress table is in Plugin Summary section for IonReporterUploader and
is useful to monitor the transfer of large files. While the transfer is in progress, the
plugin has the following message.

Click the here link to open the Uploader's progress table in the plugin summary
section. An example progress table (empty):

The status.html link opens the same progress table, but as the only content in the
browser tab.
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When the IonReporterUploader Plugin is Not Configured

This pages shows how various IonReporterUploader-related pages appear when your
IonReporterUploader plugin is not yet configured to transfer to your Ion Reporter™

Software organization.

In the plugin manual launch page

Before the plugin is configured, if you launch the IonReporterUploader plugin on a
completed run report (with the Select plugins to run button), the following page
opens with an empty "Select Ion Reporter™ account" area. When the
IonReporterUploader plugin is properly configured, theIon Reporter™ Software
account or accounts appear in this area. (Multiple accounts are not supported when
transferring to Ion Reporter™ Software1.6.x.)
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In the run plan template wizard

Before the plugin is configured, if you click the Ion Reporter™ chevron in the run plan
template wizard, the Ion Reporter™ Software workflow selection menu does not
appear. Also, IonReporterUploader credential choices do not appear (these normally
are listed below the None radio button.

In the plugin configuration page

When the plugin is not configured, the admin Plugins configuration page contains
this:

Click the Add Account button to begin the configuration.
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IonReporterUploader Plugin Usage Page

The Uploader plugin Usage page lists the run reports on which the plugin has been
run, the Uploader's completion status, and the sizes of the plugin output folders. You
can check for errors and delete large plugin output folders.

Open the Uploader plugin Usage page

Open the Usage page from the plugin table in the Services tab. Click the Usage option
in the gear menu for the IonReporterUploader entry:

Delete plugin report files

The Delete button permanently deletes the Uploader plugin report for a run. This
action is the same as the trash can icon on the run report page plugin summary.

Use the Delete button to permanently delete the plugin output files for a specific
Uploader run:
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Rescan plugin output files for a specific run

Click the Rescan button to recalculate the size of plugin's output files for a specific
run:

Configure Your IonReporterUploader Plugin Access Credentials

Overview

This page describes how to configure your Torrent Browser to transfer files to your
organization on Ion Reporter™ Software. (Beginning with the Ion Reporter™ Software
4.0 release, you configure the IonReporterUploader plugin with yourIon Reporter™

Software login ID and password.)
Multiple configurations

The IonReporterUploader plugin now supports multiple configurations, each with a
different login and different display name (that you assign).With these multiple
configurations, the IonReporterUploader plugin supports the transfer of results from
one Torrent Server to different Ion Reporter™ Software organizations, without the
need to change the plugin configuration.

When multiple users (with different Torrent Suite™ Software logins) configure the
IonReporterUploader plugin, each user can only see (and use) the
IonReporterUploader plugin configuration that they created themselves. When
multiple users share one Torrent Suite™ Software login, they can see and use all
IonReporterUploader plugin configurations created with that Torrent Suite™ Software
account.

Configure the Uploader plugin in the Torrent Browser

This sections describes the last step in configuring the plugin. You configure the
plugin in the Torrent Browser with the Ion Reporter™ Software authentication token.

IMPORTANT! See the Ion Reporter™ Software documentation for the latest
configuration information. Both Ion Reporter™ Software and the Uploader plugin may
be updated on a different schedule than Torrent Suite™ Software (and these
documentation pages).
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Follow these steps to configure your Ion Reporter™ Uploader plugin in your Torrent
Browser:

1. Log into the Torrent Browser (as either an ionadmin or a regular user).

2. Click the Admin gear menu (in the upper right) and select Ion Reporter™

Configure:

3. The Ion Reporter™ Uploader Configuration page opens. If the plugin is not
configured yet, this page opens:
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4. Click the + Add Account menu. For the hosted cloud Ion Reporter™ Software
solution, click Ion Reporter™ Cloud 4.0:

For your own Ion Reporter™ Server System, click Ion Reporter™ 4.x.

5. In the Configure popup, make these entries the hosted cloudIon Reporter™

Software solution:

Field Directions

Server Type Enable HTTPS.

Display Name Enter a meaningful name of your choice.
This name is used in the run plan
template wizard and is seen by other
Torrent Browser users. Use only
alphanumeric characters, spaces, and
underscores.

Server Enter:
40.dataloader.ionreporter.iontorrent.com

Port Enter: 443

Username Enter your Ion Reporter™ Software login
(your email address)

Password Enter your Ion Reporter™ Software login
password

For your ownIon Reporter™ Server System, these entries depend on your location
system configuration: Server Type (HTTP or HTTPS), Server, and Port. Ask your
local Ion Reporter™ Server System administrator for these values.

6. The "Default Account" is the account that is configured by default in run
templates and run plans. If this is the main account to be used for file transfers,
enable the Default Account checkbox. (You can always change this selection in
the run plan template wizard and in the Upload to IR quick link.)

7. Click the Add button in the bottom right.
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As soon as at least one account is successfully configured, the Uploader plugin is
ready to transfer files and also launch Ion Reporter™ Software analyses. If you
configure more than one account, you have a choice of accounts to use for the
transfers, in the run plan template wizard, the Uploader plugin manual launch page,
and the Upload to IR quick link. Each Torrent Browser user can only see the
configurations they created, but if several people share a Torrent Browser login
account, those people can see and potentially use each others configurations.

Configuration errors

The more common causes of a configuration error are:
• HTTP is selected instead of HTTPS.
• The server name is incorrect.
• The port number is incorrect.
• The login or password is incorrect or deactivated.
• There are spaces before or after the server name, port number, username, or

password.
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Reference Management

GRCh38 human reference

New in Torrent Suite™ Software v5.2, you can begin using the Ion GRCh38 human
reference in custom run plans. The new Ion GRCh38 Reference Genome is based on
the latest GRC human reference assembly and is the first major update since 2009.
Highlights include: changes to chromosome coordinates, fixed errors in the former
sequence, addition of Mitochondria, and multiple loci for some highly variable genes.

AmpliSeq™ Designer currently offers one custom AmpliSeq™ panel and related target
and hotspot regions files for GRCh38 experiments. Optionally, you can also convert
existing coordinates to GRCh38 by using a publicly available lift-over tool, such as 
CrossMap.

To use the GRCh38 human reference in Torrent Suite™, you must import it.

1. Log into Torrent Suite™ as administrator.
2. Go to the Reference page and click Import Preloaded Ion References.
3. Select GRCh38 and click Import.

Now the reference is available and can be selected in run plan.

AmpliSeq™ Designer preloaded reference genomes

AmpliSeq™ Designer includes many preloaded reference genomes, including:
• Human (GRCh38)
• Human (hg19)
• Mouse (mm10)
• Cow (boxTau7)
• Chicken (galGal4)
• Pig (susScr3)
• Sheep (oviAri3)
• Maize (AGPv3)
• Rice (IRGSP-1.0)
• Soybean (Glyma1.1)
• Tomato (SL2.40)

Add the Ion
GRCh38 Reference
to Torrent Suite™

Software
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References Management Guide

Use the Admin References tab to enter nucleotide sequence Test Fragments,
Reference Genomes for aligning reads, and DNA Barcodes for barcode set
management.

Access the References tab from the Admin gear menu (near the top right of a Torrent
Browser page), with the References option:

The main reference management page opens:

In this page you can click into reference details, download a reference file from your
Torrent server, add a new reference, or use the navigation tabs on the left:

• Reference Sequences The main reference management page (shown above).
• Obsolete Reference Sequences. Lists references that need to be reindexed before

use. Reindexing is required only on releases that involve a TMAP index change.
• Target Regions. Analysis is restricted to only the regions of interest that you

specify in this file.
• Hotspots. Variant Caller output files include these positions whether or not a

variant is called, and include evidence for a variant and the filtering thresholds
that disqualified a variant candidate.

• Test Fragments. Known sequences used to monitor system characteristics.
• Barcodes. Work with Ion barcode sets or your own custom barcodes sets.
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• Upload History. Shows the recent uploads of target regions, hotspots, and
ampliseq.com zip files:

The Status column shows any error results.

This warning often appears in the References tab:

This warning appears if your server has references listed in the Obsolete References
section. Your action in response to this warning depends on your particular upgrade
scenario and obsolete references situation:

• If you upgrade from release 2.2 or higher to 4.x, you do not need to rebuild your
reference indices.

• If you upgrade from a release earlier than 2.2, you must rebuild your reference
indices after the first upgrade to a 3.x or 4.x release (and before using the upgraded
server for analyses).

Rebuild warning
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The following pages describe how to manage your references and related files.

As part of the standard analysis process, reads are aligned to a genomic reference,
using the TMAP aligner that comes pre-installed on the Torrent Server.

Note: Currently, TVC does not support IUPAC base codes other than A, C, T, G, and
N. When Torrent Suite™ software uploads a genome containing other IUPAC
characters, each such character is replaced with N.

For a new genome sequence, use the Admin4References tab to add the new
reference genome. (These reference sequences are also displayed on the Ion PGM™ or
Ion Proton™ Sequencer when you load a sample.)

The following are prerequisites to uploading a new reference file:

• Create a FASTA format reference sequence file (on your client machine).

Note: FASTA files can be found at: http://www.ncbi.nlm.nih.gov/sites/genome
download the FASTA file to your local client machine.

IMPORTANT! It is important that the format of your FASTA file conform to Ion
Torrent™ requirements.

IMPORTANT! When working with larger genomes, performance improves if you
first zip the FASTA file. The create index tool supports a zip archive, provided the
file contains only a single FASTA file.

• Prepare a descriptive name for the genome.

• Prepare the short name for the genome.

• Prepare a version for the genome.

• Know the number of reads to randomly sample for alignment.

• Prepare a regions of interest file or hotspots file (on your client machine).

Note: To provide a better uploading experience, Adobe™ Flash® or Microsoft™

Silverlight® plugins are required to be installed for your browser. You may need
to contact your local system administrator for assistance.

– Silverlight® can be downloaded from http://www.silverlight.net/getstarted/.
– Adobe™ Flash® can be downloaded from Flash® player/.

Reference pages

Upload a new
reference file

Prerequisites
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You upload reference files with the Admin gear menu References tab:

Follow these steps to upload a reference genome:

1. On the Admin4References tab, in the References Sequences section, click the
Upload a Custom Reference button:

Upload the
reference
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2. Fill out the Add New Reference Genome page. Required fields are noted on the
page.
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Field Description

Descriptive name [required] This entry may be any text
string. The description usually includes
the genus-species, version, and other
identifying information. The description
entered here is displayed in various
report output, and is listed in the
Reference Sequences section of the
Admin > References tab.

Short name [required] A shortened form of the
genome name, the short form of the
genome name may be any alphanumeric
character and the underscore (_)
character. The name should not match
any existing references installed in the /
results/referenceLibrary/
<index_type>/
<genome_shortname>/ directory,
including previous unsuccessful
attempts at creating reference
sequences. Undesired sequences can be
removed. Deletion allows the short name
to be used for a new genome.

Genome version [required] Enter any string for the
genome version number. The accession
number, if there is one, is a good choice.
The version entered here is displayed in
various report outputs.

Notes [optional] Use this field to record any
notes about the reference genome

3. Click the Select File button and browse to the genome file (on your local
machine).

4. Click the Upload file and create reference button.

5. Wait while the genome is uploaded.
After the reference is created, you can optionally add target regions BED files
and hotspots BED or VCF files to the reference.
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If you uploaded an invalid FASTA file, the following error displays when you attempt
to view the reference sequence associated with the file:

To recover from the error:

1. Delete the existing reference sequence entry.

2. Identify and correct formatting errors in the FASTA file.

3. Retry uploading the reference.

Browser Extensible Data (BED) files and Variant Call Format (VCF) files supply
chromosome positions or regions. When applied to a reference genome in the Torrent
Browser, these files perform these two functions:

• Targeted regions of interest Specifies your regions of interest, for instance the
amplified regions that are used with targeted sequencing. Analysis in the
complete Torrent Suite™ Software analysis pipeline, including plugins, is
restricted to only the specified regions. (BED file only)

• Hotspot Instructs the Variant Caller to include these positions in its output files,
including evidence for a variant and the filtering thresholds that disqualified a
variant candidate. Only affects the variantCaller plugin, not other parts of the
analysis pipeline. (Either a BED or VCF file)

Error handling

Target Regions
Files and Hotspot
Files
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Target regions files and hotspot files are listed in the admin References tab. These files
are uploaded to a specific reference and available for use only when that reference is
used for an analysis.

To view the target regions files and hotspot files on your system, click the admin gear
menu References option:

In the References tab left navigation panel, click the Target Regions or Hotspots tab:

The left navigation tabs openHotspots or Target Regions pages, which are very
similar:
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Both Hotspots andTarget Regions pages offer the following actions:
• Click the file name to open its details page.
• Use the references selection menu (default Show all References) to display only
files of one reference.

• Click the Add Hotspot or Add Target Regions button to upload a new file (to
associate with any reference).

File details and download

In either the Hotspots or Target Regions page, when you click on a hotspot file name
or a target regions file name, a details page opens with details of both the hotspot file
and the related target regions file (provided both are available):

Details page
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In these details sections, you can do the following:
• Click on the Processed File link to download the hotspot or target regions file.
• Add a description or notes.
• Uncheck the Enable check box to prevent the file from being used in an analysis.

Click the Save Change button to save your description, notes, or Enable status.
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Zip file details and download

For files imported for ampliseq.com, the details page also shows the zip file that was
imported from ampliseq.com:

Note: The Delete button in the Original Upload section removes the hotspot or target
regions file from the system. The file is not available to be used in analyses.

Upload log file

The details page also has a section with the validation log from when the hotspot and
target regions files were originally uploaded.

Manage Target Regions Files and Hotspot Files

This page describes how to add, download, and remove target regions files and
hotspot files.

Browser Extensible Data (BED) files and Variant Call Format (VCF) files supply
chromosome positions or regions. When applied to a reference genome in the Torrent
Browser, these files perform these two functions:

• Targeted regions of interest Specifies your regions of interest, for instance the
amplified regions that are used with targeted sequencing. The complete Torrent
Suite™ Software analysis pipeline, including plugins, is restricted to only the
specified regions. (BED file only)

• Hotspot Instructs the Variant Caller to include these positions in its output files,
including evidence for a variant and the filtering thresholds that disqualified a
variant candidate. A hotspots file affects only the variantCaller plugin, not other
parts of the analysis pipeline. (Either a BED or VCF file)

With the Torrent Browser, you add BED and VCF files to an existing reference. The
reference must be listed in the Torrent Browser Admin > References tab before you
can upload our BED or VCF files.

Overview
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Your uploaded BED and VCF files are then available as an option when you create a
new template or planned run in the Plan tab. In the template and planned run wizard,
menus on the Reference chevron page offer the BED and VCF files that you uploaded
to a reference.

You can optionally upload multiple BED and VCF files to a reference. In the template
and planned run wizard, you specify the BED or VCF files used for each template or
each run.

Notes about hotspot files:
• By default the variantCaller plugin calls variant candidates at hotspot positions

with more sensitivity than candidates at other positions. You can customize
certain variantCaller parameters separately for hotspot candidates.

• The Torrent Browser also accepts VCF files as hotspot files.

IMPORTANT! Target regions BED files provide an option to restrict the analysis of
the entire reference genome. Whole genome analysis is supported by the run type
Whole Genome Analysis. Do not specify a target regions BED file on the Planning tab
run registration page if the variants are to be called over the whole genome.

IMPORTANT! All regions specified in your t arget regions BED files are analyzed.
Follow the instructions in “Modify a BED file“ on page 333 (before uploading your
Target regions BED file) to delete lines representing regions that span variants that
you do not wish to call.

IMPORTANT! The BED file coordinates (example: chr2 29443689 29443741) use zero-
based indexing and a half-open interval. The start position is included, and the range
extends up to, but not including, the end position.

IMPORTANT! BED files used with Ion AmpliSeq™ workflows define the internal
segment only, and do not include the primer sequence.

IMPORTANT! A BED or VCF file is tied to specific reference. The coordinates within a
BED or VCF file must match coordinates and the coordinate sorting in the reference
genome. Torrent Suite™ Software reference genomes are sorted alpha-numerically (not
by a chromosome sort). The BED files and VCF files that you use with Torrent Suite™

references must also use an alpha-numeric sort. If you upload your own reference
genome, the BED and VCF files that you use with that reference must be sorted by the
same method as your reference file.
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Before your analysis run or run registration (on the Planning page), you can add BED
or VCF files to your genome reference:

1. Use the Torrent Browser to upload the BED or VCF file from your local client
machine to Torrent Suite™ Software.

2. During file upload, the Torrent Browser validates the BED or VCF file, and
ensures that the BED or VCF file's coordinate regions are valid for the genome
reference.

3. The new BED or VCF file is then available as an option when you create a new
run registration in the Planning tab. Your new file also appears in the Target
Regions or HotSpots menus in the template and planned run wizard References
chevron.

Modify a BED file

You can optionally modify a BED file before adding it to your reference genome. You
can use this technique to avoid regions for which you do not want variants called
(even if the variants appear in your sample).

You can modify a BED file only before uploading the file with the Torrent Browser.

Follow these instructions to modify a BED file:

1. Make a copy of your BED file. Rename the two files in a way that reflects changes
you make to the regions being analyzed.

2. Open the BED file with a text editor.

3. Delete the lines for regions you do not want.

4. Save the file.
If the region (or regions) appear in both your targeted regions BED file and in
your hotspots BED or VCF file, you must delete the line for those regions from
both types of BED file.

Supported file types

• Targeted regions of interest BED file only. Supported file extensions
are .bed, .zip, and bed.gz.

• Hotspot BED file or VCF file. Supported file extensions are .bed, .vcf.gz, .zip,
bed.gz, and .vcf.gz.

Upload a BED or VCF file

These instructions upload a BED or VCF file from your local client machine to Torrent
Suite™ Software. These instructions apply to both targeted regions of interest files and
hotspot regions files.

IMPORTANT! You must upload only BED or VCF files that both match the reference
and are for the correct reference version. The uploader attempts to validate the BED or
VCF files, but cannot always detect the errors listed below.

Summary of steps
to add a target
regions or
hotspots file
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You have the responsibility to avoid the following mismatch errors. The uploader
does not always detect these errors:

1. Upload a BED or VCF file to a reference genome of a different version (for
example, an hg18 BED or VCF file with an hg19 reference).

2. Upload a BED or VCF file for a different species.

3. Upload a hotspots BED file as a targeted regions BED file, or upload a targeted
regions BED file as a hotspots BED file.
Follow these steps to upload a target regions BED file or hotspots BED or VCF
file to a reference:

a. In the Reference tab, click either the Hotspots or Target Regions tab in the
left navigation panel:

The Hotspots (or Target Regions) page opens:
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b. Click the Add Hotspots (or Add Target Regions) button in the top right
corner. The New Hotspots (or New Target Regions) page opens:

c. Click the Select File button and browse to the file to be uploaded.

d. In the Reference menu, be careful to select the correct reference. The new file
can only be used with this reference.

e. Add the optional (but recommended) description and notes.
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f. Click the Upload Hotspots File (or Upload Target Regions File) button.
Wait while the file is validated:

For large files, validation can take a couple minutes. Refresh your browser to
check that validation is complete.
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After upload

After validation, the Torrent Browser opens to the Hotspots detail page for your new
file:

From this page, you can download the hotspots file or target regions file, remove the
file from the system, and view the validation log.
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Uploading errors

Validation errors appear in the Processing Log section of the details page.

Some types of error do not appear in the Processing Log section. There are major
problems that prevent validation from being attempted:

• Incorrect file format
• Incorrect file extension
• Zip contains 0 or multiple files
• A corrupted .zip .gz file

Follow these steps to download a hotspots BED or VCF file, or a target regions BED
file:

1. Go to the admin References tab and click either the Hotspots or Target Regions
tab in the left navigation panel:

2. In the Hotspots (or Target Regions) page, click the name:

Download a
hotspots or target
regions file
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3. In the details page, click the link in the Processed File field:

The Original File link in the Original Upload section also downloads the same
file.

Note: This step removes the file from the system. There is no recovery or undo.
Consider first downloading the file as a backup.

Follow these steps to delete a hotspots or a target regions file:

1. Go to the admin References tab and click either the Hotspots or Target Regions
tab in the left navigation panel:

Delete a hotspots
or target regions
file
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2. In the Hotspots (or Target Regions) page, click the name:

3. In the details page, go to the Original Upload section and click the Delete button.
If you are sure, click Yes in the confirmation popup.

The Browser Extensible Display (BED) format is used for both target regions files and
hotspot files. The Torrent Browser also accepts the Variant Call Format (VCF) for
hotspot files.

BED files are text files with tab-separated fields.

Target regions BED files use 3-column, 4-column, 6-column, and 8-column formats.

3-column Target Regions BED File Format

The 3-column BED file format is used when amplicon IDs and gene names are not
known.

The track line is optional. If present, it includes these tab-separated fields:

Field Type Description

Name string A unique design identifier.
Optional.

Description string Description of the design.
Optional.

The following is an example track line:

track name="ASD270245" description="AmpliSeq Pool ASD270245"

In a 3-column target regions BED file, the coordinates lines require the following tab-
separated fields:

BED File Formats
and Examples

Target Regions
File Formats
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Field Type Description

chrom string (chars >= 0x20, other
than \tab)

Name of the chromosome.
This name must be an exact
match with a chromosome
in the reference.

chromStart unsigned int64 Starting position of the
feature (zero-based).

chromEnd unsigned int64 Ending position of the
feature (not inclusive). Must
be greater than chromStart.

Partial example of a 3-column target regions BED file:

chr9 133738312 133738379 chr9 133747484 133747542 chr9 
133748242 133748296 chr9 133748388 133748452 chr9 133750331 
133750405 chr9 133738312 133738379 chr9 133747484 133747542 
chr9 133748242 133748296 chr9 133748388 133748452 chr9 
133750331 133750405 chr14 105246407 105246502 chr14 105246407 
105246502 chr14 105246407 105246502 chr2 29432658 29432711

4-column Target Regions BED File Format

The 4-column BED file format is used when gene names are not known and some or
all amplicon IDs are known.

The track line is optional. If present, it includes these tab-separated fields:

Field Type Description

Name string A unique design identifier.
Optional.

Description string Description of the design.
Optional.

The following is an example track line:

track name="ASD270245" description="AmpliSeq Pool ASD270245"

In a 4-column target regions BED file, the coordinates lines require the following tab-
separated fields:
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Field Type Description

chrom string (chars >= 0x20, other
than \tab)

Name of the chromosome.
This name must be an exact
match with a chromosome
in the reference.

chromStart unsigned int64 Starting position of the
feature (zero-based).

chromEnd unsigned int64 Ending position of the
feature (not inclusive). Must
be greater than chromStart.

AmpliconID string Amplicon ID. If missing, the
following string is used
"chrom" + ":" +
"chromStart" + "-" +
"chromEnd"

Partial example of a 4-column target regions BED file:

chr9 133738312 133738379 amplID73150 chr9 133747484 133747542 
amplID73075 chr9 133748242 133748296 amplID73104 chr9 
133748388 133748452 491413 chr9 133750331 133750405 74743 chr9 
133738312 133738379 73150 chr9 133747484 133747542 73075 chr9 
133748242 133748296 73104 chr9 133748388 133748452 491413 chr9 
133750331 133750405 74743 chr14 105246407 105246502 329410 
chr2 29432658 29432711 34014

6-column Target Regions BED File Format

The 6-column BED file format is used when some or all of the gene names are known.
BED files that are generated by AmpliSeq.com use this 6-column format.

The track line is required in a 6-column target regions BED file. The following is an
example track line:

track name="ASD270245" description="AmpliSeq Pool ASD270245" ? 
type=bedDetail

The track line includes these tab-separated fields:

Field Type Description

Name string A unique design identifier.
Optional.

Description string Description of the design.
Optional.

Type string Must be "bedDetail" (without
quotes). Required.

ionVersion string Introduced in the Torrent
Suite™ Software 4.0 release.
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In a 6-column target regions BED file, the coordinates lines require the following tab-
separated fields:

Field Type Description

chrom string (chars >= 0x20, other
than \tab)

Name of the chromosome.
This name must be an exact
match with a chromosome
in the reference.

chromStart unsigned int64 Starting position of the
feature (zero-based).

chromEnd unsigned int64 Ending position of the
feature (not inclusive). Must
be greater than chromStart.

AmpliconID string Amplicon ID. If missing, the
following string is used
"chrom" + ":" +
"chromStart" + "-" +
"chromEnd"

ID string Customer-specified ID. If
missing, set to '.'. This field
is not used currently.

GeneSymbol string Gene name. If missing, set
to '.'.

Partial example of a 6-column target regions BED file:

? track name="ASD270249_v1" description="AmpliSeq Pool 
ASD270249" type=bedDetail chr9 133738312 133738379 AM73150 
NM_005157 ABL1 chr9 133747484 133747542 AM73075 NM_005157 ABL1 
chr9 133748242 133748296 AM73104 NM_005157 ABL1 chr9 133748388 
133748452 AM491413 NM_005157 ABL1 chr9 133750331 133750405 
74743 NM_005157 ABL1 chr9 133738312 133738379 73150 NM_007313 
ABL1 chr9 133747484 133747542 73075 NM_007313 ABL1 chr9 
133748242 133748296 73104 NM_007313 ABL1 chr9 133748388 
133748452 491413 NM_007313 ABL1 chr9 133750331 133750405 74743 
NM_007313 ABL1 chr14 105246407 105246502 329410 NM_001014431 
AKT1 chr14 105246407 105246502 329410 NM_001014432 AKT1 chr14 
105246407 105246502 329410 NM_005163 AKT1 chr2 29432658 
29432711 34014 NM_004304 ALK

8-column Target Regions BED File Format

An 8-column BED file format is for Fusion panels.

The additional columns are:

Field Type Description

Score Unsigned int64 Score. If missing, set to "."

Strand string (+ or -) Strand. If unknown, set to
"+".
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BED files generated by AmpliSeq.com custom designs

The track line for BED files generated by AmpliSeq.com custom designs follows the 6-
column BED format, but with two additional fields. These additional fields are not
used by Torrent Suite™ Software.

Field Type Description

Name string A unique design identifier.

Description string Description of the design.

Type string "bedDetail" (without quotes).

ionVersion string Introduced in the Torrent
Suite™ Software 4.0 release.
When set to "4.0" or higher,
indicates that the BED file
supports the Extended BED
Detail format.

db string The UCSC Assembly ID.

reference string The Torrent Server
reference ID. Present for
AmpliSeq.com 5.2 and
higher.

color string Code for color track in UCSC
Genome Browser (when
uploaded from
AmpliSeq.com).

priority string Sets the order for color
track in UCSC Genome
Browser (when uploaded
from AmpliSeq.com).
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The track line is required in a HotSpots BED file. The following is an example track
line:

The track line includes these tab-separated fields:

Field Type Description

Name string A unique design identifier.
Optional.

Description string Description of the design.
Optional.

Type string Must be "bedDetail" (without
quotes). Required.

db string The UCSC Assembly ID.
Optional.

reference string The Torrent Server
reference ID. Optional for
hg19. Required for GRCh38.

The following is an example track line:

track name="ASD270245" description="HotSpots locations for 
AmpliSeq ASD270245" type=bedDetail db=hg38 reference=GRCh38.p2

In HotSpots BED files, the coordinates lines require the following tab-separated fields:

Field Type Description

chrom string (chars >= 0x20, other
than \tab)

Name of the chromosome.
This name must be an exact
match with a chromosome
in the reference.

chromStart unsigned int64 Starting position of the
feature (zero-based).

chromEnd unsigned int64 Ending position of the
feature (not inclusive). Must
be greater than chromStart.

HotSpotName string This ID is either the COSMIC
ID, dbSNP ID, or user-
defined. If missing, the
following string is used
"chrom" + ":" +
"chromStart" + "-" +
"chromEnd"

HotSpots File
Format
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Field Type Description

HotSpotAlleles string This field describes the
variant, using this format
(see examples below): REF=
reference_allele ; OBS=
observed_allele ; ANCHOR=
base_before_allele

AmpliconID string Amplicon ID. If missing, the
following string is used
"chrom" + ":" +
"chromStart" + "-" +
"chromEnd"

The HotSpotAlleles field

This field specifies the alleles involved in variant calls, using this format:

REF= reference_allele; OBS= observed_allele

Examples:
• A TT insertion with 1-base prior at reference C: REF=;OBS=TT
• A TT deletion with 1-base prior at reference G: REF=TT;OBS=

Notes:
• 6-column format

– The elements can be empty: "REF=;" or "OBS=;". Empty means deletion.
– An additional element ANCHOR=base_before_allele can be provided for

backward compatibility, but is completely optional. In fact, it is
recommended that the ANCHOR key it is NOT provided for TS >= 4.2.

– Insertion alleles should have the same start and end position, and that
position corresponds to a region between two bases. SNV, MNV, deletion,
and complex variants should correspond to the reference bases that are
spanned by the event.

– The REF and OBS should be on the forward genomic strand. There should be
one alternative allele per line.

8-column format
– The +/- strand notation in the hotspot file refers to the orientation of the Ion

AmpliSeq™ design input sequence, not to the reference sequence. REF and
OBS alleles must always be reported on the forward strand of the reference
sequence.

– HotSpotAlleles are always reported based on the allele information from the
positive strand of the reference sequence. Even if the allele strand is negative,
the REF and OBS bases still report the alleles on the positive strand.

For example, if there is a hotspot either on the positive strand or on the negative
strand on a genomic coordinate, the strand information makes no difference to
what is reported on the HotSpotAlleles column. HotSpotAlleles column always
reports the alleles on the positive strand. In the following example, the strands
are different, but the reported alleles are always from the positive strand:
chr 143815007 43815009 ID1 0 - REF=TG;OBS=AA AMPL1
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chr 143815007 43815009 ID2 0 + REF=TG;OBS=AA AMPL2

Partial example of a HotSpots BED file

track name="HSMv12.1" description="AmpliSeq Pool HSMv12.1" 
type=bedDetail

chr1 43815007 43815009 COSM19193 REF=TG;OBS=AA AMPL495041 
chr1 43815008 43815009 COSM18918 REF=G;OBS=T AMPL495041 
chr1 115256527 115256528 COSM585 REF=T;OBS=A AMPL30014 
chr1 115256527 115256528 COSM586 REF=T;OBS=G AMPL30014 
chr1 115256527 115256529 COSM33693 REF=TT;OBS=CC AMPL30014 
chr1 115256527 115256529 COSM30646 REF=TT;OBS=CA AMPL30014 
chr1 115256527 115256530 COSM53223 REF=TTG;OBS=CTT AMPL30014 
chr1 115256528 115256529 COSM583 REF=T;OBS=A AMPL30014 
chr1 115256528 115256529 COSM584 REF=T;OBS=C AMPL30014 
chr1 115256528 115256529 COSM582 REF=T;OBS=G AMPL30014 
chr1 115256528 115256530 COSM12725 REF=TG;OBS=AA AMPL30014 
chr1 115256528 115256530 COSM579 REF=TG;OBS=CT AMPL30014

Note: The REF=;OBS= field is required, as is the track line.

Extended BED Detail format

Beginning with the 3.0 release, AmpliSeq.com uses this format for the following fixed
panels:

• CCP
• CFTR
• CHP v2
• Ion AmpliSeq™ Exome

New fixed panels introduced after the AmpliSeq.com 3.0 release also follow this
format. Other panels, and all panels from previous releases, do not use this format.

The Extended BED Detail format contains two additional fields (at the end of each
line):

Name Values Description

Id Any string, if supplied by the
user, or '.'

User-supplied name or id
for the region.

Description key-value pairs separated by
semicolon, or '.' if empty

Contains a '.' or one or more
of the following:

• GENE_ID=

• SUBMITTED_REGION=

• Pool=

These key-value pairs are
described in the next table.

This table describes the key-value pairs that are supported in the Description column:
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Key Description

GENE_ID A gene symbol or comma-separated list of
gene symbols. If no gene symbol is
available, this key is absent.

Example: GENE_ID = brca1

Example: GENE_ID = brca1, ret

Pool The Ampliseq.com pool or pools containing
this amplicon.

Example: Pool=2

If an amplicon is present in multiple pools,
the pools are delimited with "," a comma,
with the primary pool listed first. For
example, if an amplicon is present in pools
1 and 3, and 1 is the primary pool, the entry
is: Pool=1,3.

Single-pool designs do not include the
Pool= key-value pair.

SUBMITTED_REGION The region name provided by the user
during theAmpliSeq.com design process. If
a region name is not provided, this key is
absent.

Example: SUBMITTED_REGION=Q1

CNV_ID A gene symbol used to specify a copy
number region for the cnv pca algorithm.
This will take precedence over the GENE_ID
and once CNV_ID can span multiple
GENE_IDs.

CNV_HS A CNV region hotspot. This can be a value of
either 0 or 1. A 1 will report as a hotspot
(HS) in the output VCF file from the CNV
PCA algorithm. A 0 will not be reported as
HS.

The Extended BED Detail format requires a track line with both type=bedDetail
and ionVersion=4.0. The Torrent Suite™ Software BED validator treats these fields
(Id and Descriptor) as optional.

Examples from BED files in the Extended BED Detail format

This example shows the GENE_ID= and Pool= keys:

track name="4477685_CCP" 
description="Amplicon_Insert_4477685_CCP" type=bedDetail 
ionVersion=4.0 
chr1 2488068 2488201 242431688 . GENE_ID=TNFRSF14;Pool=2 
chr1 2489144 2489273 262048751 . GENE_ID=TNFRSF14;Pool=4 
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chr1 2489772 2489907 241330530 . GENE_ID=TNFRSF14;Pool=1 
chr1 2491241 2491331 242158034 . GENE_ID=TNFRSF14;Pool=3

This example is from the CFTR designed.bed file:

track type=bedDetail ionVersion=4.0 
name="CFTRexon0313_Designed" 
description="Amplicon_Insert_CFTRexon0313" 
chr7 117119916 117120070 CFTR_1.91108 . 
GENE_ID=CFTR;Pool=1;SUBMITTED_REGION=1,31 
chr7 117120062 117120193 CFTR_1.38466 . 
GENE_ID=CFTR;Pool=2;SUBMITTED_REGION=1 
chr7 117120186 117120304 AMPL244371551 . 
GENE_ID=CFTR;Pool=1;SUBMITTED_REGION=1,32

Merged Extended BED Detail format files

In the case of two overlapping records, those records are merged during upload into
Torrent Suite™ Software. An ampersand (&) is the delimiter between multiple values
in merged files.

Example 1

When these two GENE_ID fields appear in overlapping records:

GENE_ID = raf

GENE_ID = brca1

The merged GENE_ID field is:

GENE_ID=raf&brca1

Example 2

When these two GENE_ID fields appear in overlapping records:

GENE_ID = raf

GENE_ID = brca1,ret

The merged GENE_ID field is:

GENE_ID=raf&brca1,ret

The score and strand fields in uploaded BED files

Uploaded BED files are converted to add score and strand columns, with the default
values 0 and +. You see these values in BED files that you download from Torrent
Suite™ Software:

track type=bedDetail name="BRCA1.BRCA2_HotSpots" 
description="BRCA_HOTSPOT_ALLELES" 
allowBlockSubstitutions=true 
chr13 32890649 32890650 COSM35423 0 + REF=G;OBS=A 
AMPL223487194 
chr13 32893206 32893207 COSM23930 0 + REF=T;OBS= AMPL223519297 
chr13 32893221 32893221 COSM23939 0 + REF=;OBS=CCAATGA 
AMPL223519297 
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chr13 32893290 32893291 COSM172578 0 + REF=G;OBS=T 
AMPL223521074

This page describes the target regions Browser Extensible Display (BED) format used
with Ion AmpliSeq™ RNA fusion designs. BED files are text files with tab-separated
fields

Track line

The track line is required in the target regions BED file. The following is an example
track line:

track name=

"Fusions 2.6"

description=

"AmpliSeq RNA"

type=bedDetail ionversion="4.0"

The track line includes these tab-separated fields:

Field Type Description

Name string A unique design identifier.
Optional.

Description string Description of the design.
Optional.

Type string Must be "bedDetail" (without
quotes). Required.

ionVersion string Introduced in the Torrent
Suite™ Software 4.0 release
(AmpliSeq.com 3.0 and
higher fixed panels). When
set to "4.0", indicates that
the BED file supports the 
Extended BED Detail format.
Optional. This field relates to
BED File format version
only, not the version of panel
designs.

Columns

This format includes 8 required columns separated by a tab (\t) character:

RNA Fusions BED
File Formats and
Examples
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Field Type Description

chrom string (chars >= 0x20, other
than \tab)

Name of the chromosome.
This name must be an exact
match with a chromosome
in the reference.

chromStart unsigned int64 Starting position of the
feature ( Insert Start not the
Amplicon Start). Must be
zero-based.

chromEnd unsigned int64 Ending position of the
feature (not inclusive) (Insert
End not the Amplicon End).
Must be greater than
chromStart.

AmpliconID string Amplicon ID. If missing, the
following string is used
"chrom" + ":" +
"chromStart" + "-" +
"chromEnd"

Score Unsigned int64 Score.If missing, set to '.'.
This field is not used
currently.

Strand string (+ or -) Strand. If unknown, set to
'+'.

ID string Customer-specified ID. If
missing, set to '.'. This field
is not used currently.

Key-value pairs string Multiple attributes specified
as semi-colon separated
key-value pairs. See below
for specific key-value pairs.
All of these KVPs are
mandatory for Fusions
designs files, but most of
these are optional for other
White Glove designs.

Note that the Genomic (hg19) coordinates provided in the Key-Value pairs must
represrent the entire Amplicon sequence. If we want to generate the fusions mapping
reference fasta file from the BED file, all the information needed to do that should be
available in the Bed file.

These key-value pairs are supported:
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Key Value Example

TYPE Type of the event. Allowed
values:

• Fusion

• CONTROL or
ExpressionControl

• Driver_Gene or
5p3pAssay

• GeneExpression

• RNA_Hotspot

TYPE=Fusion

FP_TRANSCRIPT_ID Transcript ID for the Five
Prime Gene partner. This
key value pair is only for
Fusion type Targets.

FP_TRANSCRIPT_ID=ENSG0
0000156735

TP_TRANSCRIPT_ID Transcript ID for the Three
Prime Gene Partner.(This
field is absent for CONTROL
type amplicons).This key
value pair is only for Fusion
type Targets.

TP_TRANSCRIPT_ID=ENSG0
0000077782

BREAKPOINT Position in the sequence for
the breakpoint. Applicable to
only FUSION Type
amplicons. This position is
number of bases from the
Insert start, not the
Amplicon Start.

BREAKPOINT=56

FP_GENE_ID Name of the Five Prime
Gene partner in the
Fusion.This key value pair is
only for Fusion type Targets.

FP_GENE_ID=BAG4

FP_GENE_STRAND Strand for the Five Prime
Gene partner. Allowed
values are '+' and '-'.This key
value pair is only for Fusion
type Targets.

FP_GENE_STRAND=+

FP_EXON_NUMBER Exon number in the Five
Prime Gene. Use comma
separated values if there the
Amplicon spans multiple
Exons.This key value pair is
only for Fusion type Targets.

FP_EXON_NUMBER=2

Reference Management
Manage Target Regions Files and Hotspot Files

352 Torrent Suite™ Software Help



Key Value Example

TP_GENE_ID Name of the Three Prime
Gene Partner in the Fusion.
(This field is absent for
CONTROL type
amplicons.).This key value
pair is only for Fusion type
Targets.

TP_GENE_ID=FGFR1

TP_GENE_STRAND Strand for the Three Prime
Gene partner. Allowed
values are '+' and '-'. (This
field is absent for CONTROL
type amplicons.). This key
value pair is only for Fusion
type Targets.

TP_GENE_STRAND=-

TP_EXON_NUMBER Exon number in the Three
Prime Gene.Use comma
separated values if there the
Amplicon spans multiple
Exons. This key value pair is
only for Fusion type Targets.

TP_EXON_NUMBER=6

FP_CHROM Chromosome of the Five
Prime Gene.This key value
pair is only for Fusion type
Targets.

FP_CHROM=chr8

FP_START Start position for the Five
Prime Segments, Use
comma separated values if
there are multiple segment
Starts.This key value pair is
only for Fusion type Targets.

FP_START=38050257

FP_END End position for the Five
Prime Segments. Use
comma separated values if
there are multiple segment
Ends.This key value pair is
only for Fusion type Targets.

FP_END=38050313

TP_CHROM Chromosome of the Three
Prime Gene. (This field is
absent for CONTROL type
amplicons.).This key value
pair is only for Fusion type
Targets.

TP_CHROM=chr8

TP_START Start position for the Three
Prime Segments, Use
comma separated values if
there are multiple segment
Starts.This key value pair is
only for Fusion type Targets.

TP_START=38283673
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Key Value Example

TP_END End position for the Three
Prime Segments. Use
comma-separated values if
there are multiple segment
Ends.

TP_END=38283763

HOTSPOT_POSITION Genomic coordinate of the
hotspot snp covered by the
amplicon. Use comma
separated values if multiple
hotspots are covered by the
amplicon.

HOTSPOT_POSITION=38283
769

CHROM Chromosome name of the
target region. This key is for
all non-fusion type targets.
For Fusion targets, we have
FP_CHROM and
TP_CHROM.

CHROM=chr8

GENE_ID Name of the Gene for non-
fusion type targets. For
Fusion targets, we have
FP_GENE_ID and
TP_GENE_ID.

GENE_ID=LMNA

TRANSCRIPT_ID Transcript Id for non-fusion
type targets. For fusion
targets, we have
FP_TRANSCRIPT_ID and
TP_TRANSCRIPT_ID.

TRANSCRIPT_ID=ENST0000
0389048

GENE_STRAND Strand of the Gene. This key
is for all non-fusion type
targets. For fusion targets,
we have FP_GENE_STRAND
and TP_GENE_STRAND.

GENE_STRAND=+

EXON_NUM Exon number(s) in the Gene.
For fusion targets, we have
FP_EXON_NUM and
TP_EXON_NUM.Use comma
separated values if there the
Amplicon spans multiple
Exons.

EXON_NUM=3,4

START Start position of the Target
segment. Use comma
separated values if there are
multiple segment starts in
genomic space. This key is
for all non-fusion type
targets. For fusion targets,
we have FP_START and
TP_START.

START=53586113,53585786
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Key Value Example

END End position of the Target
segment. Use comma
separated values if there are
multiple segments in
genomic space. This key is
for all non-fusion type
targets. For fusion targets,
we have FP_END and
TP_END.

END=53586228,53585803

MIN_READ_COUNT Minimum number of reads
needed to call the particular
target as present/absent.
This value is optional and if
present, it will override the
universal minimum read
count threshold (eg: 20).
Example Usage: For EGFR
deletion assay, we would use
a higher read count
threshold (greater than 20).

MIN_READ_COUNT=100

Example BED file entries

BAG4-FGFR1.B2F6 1 156 AMP1 . + . 
TYPE=Fusion;BREAKPOINT=36;FP_GENE_ID=BAG4;FP_ GENE_STRAND=
+;FP_EXON_NUM=2;TP_GENE_ID=FGFR1;TP_GENE_STRAND=-;TP_EXON_NUM=6
;FP_CHROM=chr8;FP_START=3805025 
7;FP_END=38050313;TP_CHROM=chr8;TP_START=38283673;TP_END=382837
63;FP_TRANSCRIPT_ID=ENSG00000156735;TP_TRANSCRIPT_ID=ENSG000000
77782 ? ITGB7.ENCTRL.E14E15 ? 1 ? 132 ? ? AMP99 ? . ? ? 
+ ? . ? TYPE=CONTROL;FP_GENE_ 
ID=ITGB7;FP_CHROM=chr12;FP_EXON_NUM=14,15;FP_START=53586113,535
85786;FP_END=53586228,53585803;FP_GENE_STRA 
ND=-;FP_TRANSCRIPT_ID=ENSG00000139626

This section describes how to manage barcode sets.

With the pre-installed Ion Torrent™ barcodes, you can view the barcode sets and the
barcodes, incuding the barcode sequences.

With your own barcodes sets, you can do the following:
• View a DNA barcode or barcode set
• Add a custom DNA barcode set
• Delete a DNA barcode set
• Add a barcode to an existing DNA barcode
• Edit or delete an individual barcode

Manage
DNA Barcodes and
DNA Barcode Sets

Reference Management
Manage Target Regions Files and Hotspot Files

Torrent Suite™ Software Help 355



Access the DNA barcode set pages

You access the barcode sets in the Torrent Browser by clicking the gear menu (near the
top right) and clicking the References option:

In the Admin References tab, click the Barcodes option in the left navigation panel:
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The DNA Barcodes page opens:
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Pre-installed DNA barcode sets

The pre-installed DNA barcode sets are seen under the Admin References tab:

View a DNA barcode or barcode set

Follow these steps to view a DNA barcode or barcode set:

1. Click the gear menu, select References, and scroll down to the DNA Barcodes
panel.

2. Either click the name of the barcode set to view or click the gear menu Edit
option for that barcode.
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This displays the barcodes in the set:

Note the page number controls to view other pages:

You can click any column header in bold to sort the display by that column.

The Action column gear menu provides Edit and Delete options:

The gear menu Edit option is the same as double-clicking the barcode name.
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Dialog buttons are displayed to add a new barcode to this set and to delete the entire
barcode set. The barcode edit and delete feature is only for custom barcode sets that
you install.

IMPORTANT! Do not edit, delete, or modify the pre-installed barcode sets IonSet1,
IonXPress, IonXPressRNA, RNA_Barcode_None, or MuSeek_5prime_tag.

IonSet1 barcodes

Here are the barcodes in the IonSet1 barcode set:

IonXpress barcodes

Here are the barcodes in the IonXPress barcode set:
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IonXpressRNA barcodes

Here are the barcodes in the IonXPressRNA set:

RNA_Barcodes_None barcode

Here is the barcode in the RNA_Barcodes_None barcode set:

Museek barcode

Here is the barcode in the MuSeek_5prime_tag barcode set:

For custom DNA barcode sets

For your own barcode sets, you can do the following:
• View a DNA barcode or barcode set.
• Add a custom DNA barcode set.
• Delete a DNA barcode set.
• Add a barcode to an existing DNA barcode.
• Edit or delete an individual barcode.
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Add a custom DNA barcode set

To add a barcode set, packaged as a list of barcodes in a Comma-separated Variable
(CSV) text file, create the CSV file then select the file to add it to the barcode set list.

1. If needed, create the CSV file containing a maximum of 96 barcodes, using
Microsoft™ Office Excel™, OpenOffice.org Calc, or an equivalent program. Save
the file with a .csv extension.

2. Click the Torrent Browser gear menu (near the top right), select the References
option, and scroll down to the DNA Barcodes panel. Click Add new DNA
Barcodes on the right side of the DNA Barcodes panel:

3. In the Add New DNA Barcodes dialog, enter the required Barcode Set Name in
the edit window and browse to find the Barcode CSV File:
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4. To view an example CSV file, click Download the example file: The example
CSV file contains column headers only. The following table describes the column
headers:

Name Type Description

id_str String The unique name for this
barcode entry.

sequence String The barcode sequence. G,
C, A, and T (always upper-
case) are allowed.

adapter String The portion of the barcode
adapter not used to
identify this barcode. Often
referred to as the "stuffer
sequence". G, C, A, and T
(always upper-case) are
allowed.

flow order -- Not used.

annotation -- Not used.

5. Click Upload & Save to add the new barcode set.

6. When you return to the DNA Barcodes section, click the Name column header to
sort the column and have your new barcode set appear.

Note: In previous releases, the CSV file used score_mode and score_cutoff fields.
These are now entered as BaseCaller parameters (--barcode-mode and --barcode-
cutoff) during reanalysis of a run.
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Delete a DNA  barcode set

This feature is only for your own custom barcode sets.

IMPORTANT! Do not delete the pre-installed barcode sets IonSet1, IonXPress,
IonXPressRNA, RNA_Barcode_None, or MuSeek_5prime_tag.

1. At the top of the page, click Delete Barcode Set. This displays a delete
confirmation prompt:

2. Click Yes, Delete! to delete the entire barcode set. Click Cancel to keep the
displayed barcodes.

Add a barcode to an existing DNA barcode set

This feature is only for custom barcode sets that you install.

IMPORTANT! Do not edit, delete, or modify the pre-installed barcodesets IonSet1,
IonXPress, IonXPressRNA, RNA_Barcode_None, or MuSeek_5prime_tag.

1. Click Add Barcode.
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2. The Add new barcode in set page opens:

3. Add the barcode information and click Save Barcode. The new barcode is added
to the set displayed in the current barcode set list.
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Delete an individual barcode

The barcode delete feature is only for custom barcode sets that you install.

IMPORTANT! Do not edit, delete, or modify the pre-installed barcode sets IonSet1,
IonXPress, IonXPressRNA, RNA_Barcode_None, or MuSeek_5prime_tag.

Follow these steps to remove a single barcode from a custom barcode set:

1. For the barcode to be deleted, click on the gear menu for that barcode and select
Delete:

2. In the confirmation window, if you are sure, click Yes, Delete!:

The barcode is removed for the barcode set.
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Edit an individual barcode

The barcode edit feature is only for custom barcode sets that you install.

IMPORTANT! Do not edit, delete, or modify the pre-installed barcodesets IonSet1,
IonXPress, IonXPressRNA, RNA_Barcode_None, or MuSeek_5prime_tag.

Follow these steps to edit a single barcode in a custom barcode set:

1. Click on the ID of a barcode, such as bc03. The Edit barcode in set page opens:

2. To edit the barcode details, make your changes and click Save Barcode.
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Update Reference Library Indices

Note: When you upgrade your Torrent Suite™ Software from a version earlier than
3.0, you must rebuild your reference indices. This process can take a few hours for
larger reference genomes. Your users should not submit data analysis jobs while the
reference indices are being rebuilt.

Follow these steps to rebuild your reference genome indices:

1. Log in with an ionadmin account.

2. Ensure that users do not submit analyses while the rebuild is in progress.

3. Click the Admin gear menu References option:

4. Click the Rebuild All Now button:

The TMAP index version used in 3.x and 4.x releases is tmap-f3.
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Work with Test Fragments

Use the Admin References tab to enter the test fragment nucleotide sequence to
search for within the sequenced nucleic acids. You can give a Name label and Key to
your test fragment sequence.

Ion Torrent™ Software provides four test fragments by default.

1. Access the Test Fragments section by clicking on the Admin gear menu (near the
top right of a Torrent Browser page) and clicking the References option:

2. In the Admin References tab, click the Test Fragment option in the left
navigation panel:
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The Test Fragment listing page opens:

3. Click on a test fragment name to see its complete sequence.
Be sure to enter the test fragment sequence using only the uppercase letters: A, T,
C and G. If you enter an invalid character or duplicate test fragment, you are not
be able to save your changes.

Contact your Ion Torrent™ representative if you have questions about the test
fragment templates installed in your Torrent Browser.
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Edit a test fragment

If Ion Torrent™ provides new test fragments as part of an updated protocol, it will be
necessary to carefully cut and paste this information into the fields.

WARNING! Do not modify the test fragment sequences for the test fragments
that are supplied by Ion Torrent™ Software: TF_A, TF_B, TF_C, and TF_D

1. Click the Name column label to display test fragment details. This example
showstest fragment TF‑C selected for editing:

2. On your own test fragment (not test fragments supplied by Ion Torrent™), you
can make the following edits:

• Change the test fragment name, key, or comments.
• Change the test fragment nucleotide sequence in the Sequence field.
• Change whether or not the test fragment is enabled.

3. Click Save to save your changes or click Cancel to end your edit session without
modifying the test fragment.
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Add a test fragment

1. Click the Add Test Fragment button at the upper right corner to add a new test
fragment.

2. Choose a unique name for your test fragment.

3. Be sure to enter thetest fragment Key and Sequence using only the uppercase
letters: A, T, C and G. If you enter an invalid character or duplicate test fragment,
you are not be able to save your changes.

4. Click Save to save your changes. Your new test fragment is displayed in the test
fragment list.(Or click Cancel to end your session without adding a new test
fragment.)
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Download an Ion Reference File

In the admin References tab, you can download a GHRC38, MM10, hg19, or E. coli
reference file.

The hg19 reference available here is the same as what is used for Torrent Suite™

analyses.

t_Steps to download a reference file

Follow these steps to download a reference file:

1. Click the Admin gear menu References option:

2. Click the Import References button:
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3. Click the Import button for the reference:

4. Wait while the file downloads. You can click the Refresh button to update the
progress percentage:

5. Alternatively, you can also import a custom reference from this page. Enter
relevant information in the Import Custom Reference pane and click Import
Custom.

Reference Management
Manage Target Regions Files and Hotspot Files

374 Torrent Suite™ Software Help



This human reference is based on the GRCh37.p5 version of the human genome
assembly. The GRCh37.p5 version is described at this web site: http://
www.ncbi.nlm.nih.gov/projects/genome/assembly/grc/human/data/index.shtml.

The remainder of this section lists differences between GRCh37.p5 and the Ion
Reference hg19 versions of the human genome.

Three positions with ambiguity codes

Three positions on chromosome 3 are marked with 'N' in the UCSC version of the
genome. These positions have IUPAC ambiguity codes in our version:

Position IUPAC Ambiguity code in Ion
reference

Hard masked character in
UCSC hg19

60830534 M N

60830763 R N

60830764 R N

Hard masked PAR regions in chromosome Y

The chromosome Y sequence has the Pseudo Autosomal Regions (PAR) hard masked.
This practice is consistent with the 1000 Genome Consortium's decision to hard mask
these regions inchromosomeY in order to prevent mis-mapping of reads and issues in
variant calling on the gender chromosomes.

The masked Y pseudoautosomal regions are chrY:10001-2649520 and chrY:
59034050-59363566. (A related file can be downloaded from ftp://ftp.ensembl.org/
pub/release‑56/fasta/homo_sapiens/dna/
Homo_sapiens.GRCh37.56.dna.chromosome.Y.fa.gz)

The following background information is from the UCSC site http://genome.ucsc.edu/
cgi‑bin/hgGateway?org=human&db=hg19

"The Y chromosome in this assembly contains two pseudoautosomal regions (PARs) that were
taken from the corresponding regions in the X chromosome and are exact duplicates:

chrY:10001-2649520 and chrY:59034050-59363566 chrX:60001-2699520 and chrX:
154931044-155260560"

Chromosome M

We use the Cambridge Reference Sequence (rCRS) for chromosome M with the
GenBank accession number NC_012920. UCSC has announced that they also are
using this version in the next human assembly release.

The following background information is from the UCSC site http://genome.ucsc.edu/
cgi‑bin/hgGateway?org=human&db=hg19

"Note on chrMSince the release of the UCSC hg19 assembly, the Homo sapiens mitochondrion
sequence (represented as 'chrM' in the Genome Browser) has been replaced in GenBank with
the record NC_012920. We have not replaced the original sequence, NC_001807 in the hg19
Genome Browser. We plan to use the Revised Cambridge Reference Sequence (rCRS) in the
next human assembly release."

Details about the
Ion hg19
Reference
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Work with Obsolete Reference Sequences

The Obsolete References Sequences section provides a checklist of the libraries that
need to be upgraded after an update to a Torrent Suite™ Software release that uses a
new TMAP index. (Your list will be different.)

The Torrent Browser aids you in identifying the obsolete sequences by automatically
recording the libraries that were installed before the upgrade. You need to upgrade
these obsolete reference sequences using the Rebuild All Now button. (However, the
Rebuild All Now process does not remove the references from the obsolete table. If
you previously upgraded to 2.2, you rebuilt your references indices at that time, and
you do not need to rebuild them again.)

The only reference library available after upgrade is E. coli DH10B, which is displayed
in the Reference Sequences panel of the Admin References tab and on the Ion PGM™

Sequencer genome choice list menu. The previous default Ion Torrent™ reference
library, E. coli K12, is permanently removed.

Why are my references obsolete

Only when a Torrent Suite™ Software upgrade requires that reference indices be
rebuilt, the upgrade involves these steps:

1. The upgrade installs only E. coli DH10B and moves other references into the
Obsolete Reference Sequences table.

2. When you do Rebuild All Now and the previously obsolete references are
copied back to the main Reference Sequences section.

3. The previously obsolete references also remain in the Obsolete Reference
Sequences table.
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Delete a Reference Sequence

The section provides instructions to delete a reference sequence.

Recovery of a deleted reference sequence is not supported.

Delete a Reference Sequence

1. Go to the Admin gear menu and select the Reference option:

2. In the Reference Sequences section, click the Name of the reference sequence
you want to delete. Click Delete Genome to delete the reference sequence:
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A confirmation box appears:

3. Click Yes, Delete It only if you are sure this genome should be deleted. Click No,
Keep It to exit the dialog without deleting the reference sequence: The deleted
reference sequence is removed from the Reference Sequences list.

In this release you cannot delete a reference from the Obsolete Reference Sequences
section.
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Software Administration and Data
Management

Administration

To perform these administrative tasks, in the Torrent Browser user interface, click the
Admin gear menu (near the top right) and select the Configure option:

The Admin Configure tab opens. Here you can perform these tasks:
• Add customer support contacts
• Add IT Contact
• Customize site name
• Change Time zone
• Enable nightly email notifications
• Administer database
• Configure Torrent Storage
• Configure Torrent Mesh

WARNING! You must use your ionadmin account for steps described in the
Torrent Suite™ Software Administration Guide. (Do not use your ionuser
account.)
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It is possible for a user to change the UI password and lock themselves out of the
Torrent Browser Admin screen, or locked out of the Torrent Browser UI altogether.

The UI password is stored in a database field. When you access to the database, you
can change the password.

Method one

The first way to change a username with minimal terminal interaction is to create a
new super user account.

1. Run the following commands: cd /opt/ion/iondb ./manage.py
createsuperuser

2. Once the new superuser account has been created, login to the admin page with
the newly created username and password.

3. Select the user section under Auth:

Note: The Auth section does not appear if you login with an ionuser account.

4. Select the account you want to change the password for:

Change Your
Torrent Browser
Password
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5. Click Change password form:

6. Enter the new desired password and click Change Password:
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Method two

IMPORTANT! This process updates the database directly, and has no undo or recover
in case of error. Do not proceed with this process if you are not comfortable with SQL
commands.

1. Login to the database
Log into your Torrent Server host and get an interactive postgres database
command prompt:

ionadmin@my-torrent-server:~$ psql -U ion -d iondb psql 
(8.4.5) Type
                        "help" for help. iondb=>

2. Display the user list
In our example, the user ionadmin forgot the password, but we know the
ionuser password. This command provides a list of users and passwords:

iondb=> SELECT username, password from auth_user; username 
|
                        password ----------
+-----------------------------------------------------
                        ionuser | 
sha1$7e254$476582a5fa365cdd6081a80ac161c1904cc9c374 
ionadmin |
                        
sha1$93099$b7da0df453d8db1c7715cabef9651c73003de849 ion |
                        sha1$7798b
$c025c463682f84b66cf3b5168356a04e3ce3b899 (3 rows)

3. Copy the password from another user
The passwords are hashed in the database, so we do not know what the actual
password is. But we know the ionuser password is ionuser, so we can copy
that hashed password to ionadmin, and that will change the ionadmin
password to ionuser.

IMPORTANT! The UPDATE command modifies the database. Do not proceed
with this step if you are not comfortable with SQL commands.

iondb=> UPDATE auth_user set
                        
password='sha1$7e254$476582a5fa365cdd6081a80ac161c1904cc9c3
74' where
                        username='ionadmin';
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4. Check that the password has been changed
Query the database one again to verify that the password has been changed. See
that ionadmin and ionuser now have the same password

iondb=> SELECT username, password from auth_user; username 
|
                        password ----------
+-----------------------------------------------------
                        ionuser | 
sha1$7e254$476582a5fa365cdd6081a80ac161c1904cc9c374 
ionadmin |
                        
sha1$7e254$476582a5fa365cdd6081a80ac161c1904cc9c374 ion |
                        sha1$7798b
$c025c463682f84b66cf3b5168356a04e3ce3b899 (3 rows)

5. Reset the password
Now you can log in via the UI as ionadmin, and reset the password. Remember
to change the password via the Change password form.

Fill in the information for a customer support contact and an IT contact at your
organization, and click the Save Contacts button.

Add Customer
Support Contacts

Software Administration and Data Management
Administration

Torrent Suite™ Software Help 383



This section describes how to change the server name displayed in the Torrent
Browser. The default name is Torrent Server. This change only affects the server
name shown in the Torrent Browser, and the default bookmark entry if you create a
browser bookmark for the server.

1. Click the Admin gear menu (near the top right) and select the Configure option:

2. Scroll down to the Customize Site Name section.

3. Enter the name of your choice and click Save Name. The server display name is
now changed.

The Torrent Suite™ Software Data Management system attempts to send email
notifications of archive space problems through Postfix.

1. In the email address configuration panel, click Add Email to add an email
address. This displays the Add Email dialog.

2. Enter an email address. Click the Selected checkbox to enable this email address
for sending email. Click Save.

3. The new email address is displayed in the Email panel:

Use the Enable column checkboxes to enable or disable email to specific email
addresses.

Change the
displayed server
name

Nightly email
configuration
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In the Database Administration panel, click Admin Interface to access the
administrative configuration dialog, which displays in a new window:

Where configuration options are directly available through an interface tab, such as
Templates, the interface tab mechanism should be used to configure the item.

The Chips dialog controls default analysis processing for a particular Ion Torrent™

chip.

IMPORTANT! Please check with Ion Torrent™ before modifying this information.

When an analysis job is started, the Torrent Browser looks up the chip type in the
database Analysis Args table for default analysis settings.

To modify the default behavior:

1. Click Chips, or Change, on the Chips line:

Database
Administration

Configure Chips
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2. In the Name column, click the chip you want to change:

3. Modify the chip fields, including the Instrument Type menu, as needed:

4. Click Save to save your change.
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The Configure Global Configs dialog permits you to specify run parameters.

This page describes advanced configuration options. Check with Ion Torrent™ if you
are unsure of the effect of modifying this information.

Configure Global
Configs
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IMPORTANT! There should only be one Global Config record. Do not create multiple
Global Configs!

1. Click Add on the Global configs line to set the values of the configuration
parameters:

• Plugin folder
• Fasta path
• Reference path
• Records to display
• Default test fragment key
• Default library key
• Default flow order
• Plugin output folder
• Default plugin script
• Web root
• Site name
• Default storage options
• Auto-Acknowledge Delete
• Enable Auto Actions
• Barcode args
• Enable Package Auto Download
• Enable Ts version lock
• Ts update status
• Base recalibrate
• Mark duplicates
• Realign
• Check for news posts
• Enable Security Updates
• Sec update status
• Enable Oncomine
• Enable Support Upload
• Enable Nightly Email
• Notifications
• Automatically disable SGE
• Queue on node errors

2. Click the Save button when you are done making changes.

Add a
configuration
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1. Click Change, to the right of Global configs, to modify an existing configuration.

2. Click the Name of the configuration you want to change.

3. Enter the values for the items you want to change.

4. Click the Save button to save your change(s).

Users typically do not make any changes in the Experiments table. Run plans and
other tables depend on the integrity of the Experiments table. Bad things can happen.

IMPORTANT! Please check with Ion Torrent™ before modifying this information.

IMPORTANT! Runs are automatically added to the database by the Crawler process,
so you should not add a run to the database using this dialog.

Change an
existing
configuration

Configure
Experiments
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Modify an experiment

1. Click Experiments, or Change on the Experiments line, to modify an existing
experiment description:

2. Click the ExpName of the run you want to change:

3. Edit the experiment description fields as necessary. Typically, you only need to
modify items that were not entered correctly at the time the information was
captured on the Ion PGM™ or Ion Proton™ Sequencer.

4. Click Save options to save your changes.
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Delete an experiment

These procedures delete the experiment and any child records generated, such as
reports.

If the raw data are still present in the file system, the Crawler re-discovers the data
and adds it to the database. To completely remove the run, you must delete the raw
data before deleting the experiment from the database.

Delete a single experiment

1. Click the ExpName you want to delete.
2. Click Delete, on the lower left
3. Confirm the deletion.

Delete multiple experiments

1. Check the checkbox of the experiment(s) you want to delete, or check the top
checkbox to select all experiments for deletion:

2. In the drop-down menu, select Delete selected experiments:
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3. Click the Go button to perform the requested Action:

4. When prompted to confirm the deletion, click Yes, I'm sure. The list of
experiments confirms your deletion.

IMPORTANT! The recommended mechanism to create user accounts is to add them
through the login page Register link.

The Users dialog provides for creating or modifying user accounts to access Torrent
Suite™ Software using the Torrent Browser:

Configure Users
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Add a User

1. Click Add on the Site administration menu for Users.
2. Enter a Username and Password ; enter the password twice to confirm:

Note: If the user already exists or the password is invalid, you will be prompted
to enter the correct information before continuing.

3. Click the wanted save option. Clicking Save permits you to provide additional
user information using the Change user dialog, as follows.

4. In the Personal info dialog, optionally, enter a First name, Last name and E‑mail
address:

Software Administration and Data Management
Administration

Torrent Suite™ Software Help 393



5. (Optional) In the Permissions dialog, check the Active, Staff status and
Superuser status checkbox(es), as needed, and select the wanted User
permissions:

Checkbox Description

Active Designates whether or not this user is
treated as active. The recommended
method is to uncheck this item rather
than delete this account.

Staff status Designates whether or not this user can
login to this administration site.

Superuser status Designates that this user has all
permissions without explicitly assigning
them.

Select User permissionsThere are three ways to specify User permissions:

a. Enter a string in the search window. All permissions matching the string are
displayed, from which you may select permissions by highlighting the
permission(s) and clicking the right arrow, in the center.

b. Scroll through the permissions list. Highlight the wanted permission and
click the right arrow to select the highlighted permission. Also hold down
the control key to select more than one permission.

c. Click Choose all at the bottom of the dialog, to highlight all available
permissions, and click the right arrow to select all permissions. To deselect
any permission, highlight selected permission(s), in the right window, or
click Clear all followed by clicking the left arrow.

Software Administration and Data Management
Administration

394 Torrent Suite™ Software Help



6. (Optional) Set the Last login and Date joined times, manually or using the
calendar and clock icons. Click Today and Now to set the values to the current
date and time:

7. (Optional) Click the plus sign to display the Add group dialog.

8. (Optional) Currently, the Add group dialog is the same as the User permissions
dialog in step 5, above. Add the user to the group in the same way as described
in step 5.

9. Choose one of the following Save options to complete adding the new user.

• – Save and add another Choose this option to complete adding the new user,
and return to the Add user page to another user.

– Save and continue editing Choose this option to complete adding the new
user, and return to the Change user page.

– Save Choose this option to complete adding the new user. Clicking Save
takes you to the Select user to change page.
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Modify a User Entry

Use the following procedure to modify the information and permissions for an
existing user:

1. On the Users line of the main Site administration menu, click Change.
2. On the Select user to change page, click the Username of the user you want to

change. Usernames can be filtered, selected to the right, according to: By staff
status, By superuser status or By active status.

3. Use the Change user dialog to modify user information in the same way as
described for adding a user, beginning in step 4 above.
To be able to login to the server, it is important that you remember to check the
Staff status checkbox in the Permissions dialog, shown in the following figure.

4. Choose one of the Save options at the bottom of the page to save your changes.

Delete a User Entry

Use one of the following procedures to delete an existing user.

Delete a Single User

1. In the Users line of the main Site administration menu, click Change.
2. On the Select user to change page, click the Username of the user to be deleted.
3. At the bottom-left of the user information page, click Delete.
4. Confirm that you want to delete the user by clicking Yes, I'm sure:
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Delete Multiple Users

1. In the Users line of the main Site administration menu, click Change.
2. On the Select user to change page, check the checkbox for each of the users you

want to delete.
3. Click the drop-down menu and select Delete selected users:

4. Click Go:

5. Confirm the list of users you want to delete by clicking Yes, I'm sure.
6. On the Select user to change page, the list of users confirms your deletion(s).
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This section describes how to use the Admin Interface to change the basecaller default
parameters, which include the quality trimming parameters.

Each chip type has a separate basecaller parameter field. The basecaller parameters
and quality trimming parameters can be customized for each chip type.

The quality and trimming parameters are described in this table:

Parameter Description

Qual cutoff Sets the threshold for the
average quality values
within the qual window.

A read is trimmed when the
average of quality values
measured over the (sliding)
window of size Qual
window drops below the
Qual cutoff value.

Basecaller parameter: --
trim-qual-cutoff

Qual window Sets the size of a sliding
window inside of which
quality values are measured
and averaged.

Basecaller parameter: --
trim-qual-window-
size

Adapter cutoff Controls how accurate a
match is required between
the called sequence and
adapter sequence this field
sets the cutoff required to
actually perform the adapter
trimming. The lower the
value, the more accurate
match between the called
sequence and adapter
sequence is required to trim.

(The value also depends on
adapter length. Typically a
value of half the adapter
length [ 0.5 * (adapter
length)] is reasonable.)

Basecaller parameter: --
trim-adapter-cutoff

Note: Basecaller arguments by default are different for sequencer type, regular
analyses, thumbnail analysis, and recalibration. This example shows the Basecaller
arguments for regular analyses on Ion PGM™ data.

Configure
Basecaller Default
Parameters
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Follow these steps to change or customize basecaller parameters:

1. In the Rundb administration page, select Analysis Args:
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2. In the Name column, click on the name for your chip type:

3. Make your basecaller parameter and quality parameter changes to the Default
Basecaller args: field:

Note: Enter the basecaller arguments in one line. The example here is wrapped.)

4. Click Save.

5. Repeat your changes to other chip types also, if required.

Note: Take care not to unintentionally have different quality and trimming settings
for different chip types. Differences in these settings can lead to differences in results.

Adapter trimming is described in the section Removal of Adapter Sequence.
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Quality trimming is described in the section Removal of lower-quality 3' Ends with
Low Quality Scores.

Users can add text in the Add LIMS Metadata text-entry box on the Plan page when
setting up a planned run. The entered text is associated with the Torrent Suite planned
run and can be extracted using APIs for Laboratory Information Management System
(LIMS) consumption.

The purpose of the metadata field is to allow users to insert arbitrary strings during
Torrent Suite™ driven planning that a LIMS system can use to identify runs during
post-processing (via a plugin or querying the REST API).

If the LIMS system is driving planning through the API, then it fills in the metadata
field directly. However, during manual plan creation, the user can also use this field to
provide hints to the LIMS system to link with external data later.

Specifics of content should be determined by the users' LIMS system. This text field is
essentially a hook for external systems, but is likewise user driven and user visible.
Use your laboratory protocols to determine what types of data to retrieve from this
field.

1. Enter text in the text entry box is at the bottom of the Plan page in the planned
run setup wizard.

2. View the text on the Review Plan screen (Data4Completed Runs &
Results4Review Plan.)

Configure LIMS
Metadata export
from Planned
Runs
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New users can request accounts on the Torrent Browser login page. An admin must
approve each request in the admin Account tab before the new account is active.

An ionadmin account is required to approve a user account request.

Approved accounts are created with ionuser permissons.

Notification

1. Open the admin Accounts tab with the gear menu (near the top right of the
Torrent Browser). Click the Accounts option:

2. When user account requests are pending, the Accounts tab contains notifications
such as the following:
New pending user registration for 'ExampleNewUser'. Please visit Account
Management (as an admin user) to review.

Approve User
Account Requests
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Approval and rejection

The User Registration section of the Admin Accounts tab shows the pending requests
for new user accounts:

To approve a new account, click the green Approve button in the User Registration
section, and in the popup, click the Yes, Approve! button:

When you approve an account request, the account status is changed to Active in the
user database and the user can log into the Torrent Browser.

To reject a new account request, click the red Reject button in the User Registration
section, and in the popup, click the Yes, Reject! button:
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Data Management tab

In the Data > Data Management tab, you perform the following data management
tasks:

• Configure data management rules for archival, deletion, export, or protecting
results sets and file categories

• Import files from removable media
• Monitor disk usage and free disk space
• View active data management jobs
• View data management statistics
• Manually change data management settings for specific analyses

The Configuration link opens the Data Management Configuration tool, where you
set data management rules for archival, deletion, export, or protecting results sets and
file categories. You define automatic data management action based on file categories
(such as output files and intermediate files), run report age rules, and other factors.

Configuration

Software Administration and Data Management
Data Management tab

404 Torrent Suite™ Software Help



Use the Import button to import files from external media:

Import brings in your selected files categories of previously exported or archived
runs.

Notes about the Import button:
• After the import, you can use these files just as if they are normal analysis files.
• Import cannot retrieve file categories that were notpreviously exported or

archived. For instance, if you import files from an archive that does not include
the Signal Processing Input or Basecalling Input categories, the Import action
cannotretrieve these files for you.

• If exported or archived files are still on your local Torrent Server, you do not have
to import them. The Torrent Browser can use these files directly in their exported
or archived location. This is also true if the exported or archived location is on
media that is currently mounted.

Data Import
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It is critical that enough disk space is available on the server to avoid data loss. It is
important to have a strategy that periodically monitors disk space and archives or
deletes data as needed.

Graph usage indicators

The Data > Data Management tab Disk Usage section reports disk space usage for
both server file systems and archive locations:

The color keys are explained in this table. The descriptions are based on the default
disk usage threshold of 90%. (The threshold for the Signal Processing Input file
category is used if your file categories have different thresholds.)

Color Meaning

Green Your Torrent Server hard drive is less than
70% full. The height of the green bar
corresponds to the percentage of disk
space in use.

Orange Your Torrent Server hard drive is between
70% and 90% full.

Red Your Torrent Server hard drive is more than
90% full.

Blue Free space.

Disk Usage
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Error messages

Monitor the Disk Space Management section for messages that require administrator
action:

• Backup drive is full or missing Replace the backup drive.
• Error Check the file /var/log/ion/data_management.log for information

regarding the specific error condition. If appropriate, report the error to Ion
technical support.

Active Data Management Jobs

This section lists processes that are carrying out either automatic data management
rules or manual data management actions. Each entry lists the report name, the file
category involved, the size of those files, and whether the job is initiated by an
automatic rule or manual action. For archival and export jobs, the destination media is
also listed.

This table tracks the size of the file categories currently on your system (in the Local
column), and shows the totals of file categories that have been removed form your
system by data management archival and deletion. Error totals for data management
jobs are also given.

Note: Error column displays the count of file categories that are currently in an error
state. If a data management action is re-run on one of these file categories and
completes successfully, then that file category no longer appears in the error count.

Category
Statistics
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This section lists each run report in your file system partitions:

Click the Keep checkboxes for any file categories you want to save. To change the
other settings for any report, click the gear menu to the right and click Actions:

Disk Space
Management
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This opens the Data Management popup, which you use to reset the data
management actions for this report or to initiate deletion, archival, or export on-
demand.

Back Up and Restore Data

The Torrent Server maintains the following types of data in separate locations:
• Ion PGM™ and Ion S5™ sequencer data are stored in the /results/<

PGM_Name/S5 Name> directory, by default.
• Ion Proton™ Sequencer data are stored in the /rawdata/<Proton_Name>

directory, by default.
• Report data are stored in the /results/analysis/output/Home directory, by

default.
• Database records are stored in the PostgreSQL database.

The nightly backup of the database is created and stored for 30 days.

The following instructions delete the current database.

• To restore the database, you need a complete working Torrent Server installation.
The two scenarios for restoring a database are:

a. Installing a new Torrent Server from the Torrent Server installation disk due
to migrating the database to a new server or needing to reinstall the server.

b. Replacing the database on an existing Torrent Server, possibly because the
database is corrupted and you want to restore a previous version.

• To restore the database from the backup file, execute these commands on the
Torrent Server:

# copy the backup file to the server and decompress it 
gzip -d iondb.20100711_142442.backup.gz 

# stop the Torrent Server background processes 
sudo /etc/init.d/ionCrawler stop 
sudo /etc/init.d/ionJobServer stop 

Restore the
PostgreSQL
Database
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sudo /etc/init.d/ionPlugin stop 
sudo /etc/init.d/celeryd stop 

# login as user postgres sudo su postgres 

# restart the service to clear database connections
 /etc/init.d/postgresql-8.4 restart 

# drop the existing iondb database dropdb iondb 

# create a new empty database 
psql <<-EOFdb CREATE DATABASE iondb; 
GRANT ALL PRIVILEGES ON DATABASE iondb to ion; 
\q EOFdb 
# import data psql -e iondb < iondb.20100711_142442.backup 

# logout of user postgres exit 

# start the Torrent Server background processes 
sudo /etc/init.d/ionCrawler start 
sudo /etc/init.d/ionJobServer start 
sudo /etc/init.d/ionPlugin start 

sudo /etc/init.d/celeryd start

Occasionally, there is a django error after completing the import data step.
If an error is displayed on the browser UI, repeat the following steps:

a. Drop database.

b. Create database.

c. Import data.
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The Admin Menu

The Torrent Browser Admin pages are accessed through the gear symbol menu near
the top right of a Torrent Browser page:

• About View information on installed packages and versions, and access links to
community, support, documentation, and diagnostic resources.

• Analysis Parameters View or copy and customize analysis parameters by chip
type.

• References Manage your references, regions of interest files, hotspot files,
barcode sets, and test fragments.

• Services Monitor your system and perform Data Management tasks:
– View the status of Torrent Suite™ Software modules, running analyses, file

system space, and RAID drives.
– View Data Management logs, and view or configure Data Management
settings.

– Initiate archive, export, or import actions.

• Plugins Install, configure, and manage plugins.

• Configure Access the Admin Interface, and configure contact information, your
Torrent Server name, and email addresses.

• Ion Reporter Configure Configure one or many Ion Reporter accounts.

• Accounts Configure your user profile, and respond to requests for new user
accounts.

• Updates Select and install product and plugin updates that occur between
software launches.

The Torrent Browser provides announcements of product updates and releases from
Ion Torrent™.

The announcement flag next to the admin gear menu shows the number of new Ion
Torrent™ announcements, if any:

Announcements
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The following is an example announcements listing:

Click on a headline to see a brief text summary of the announcement.

This document supports the deployment and maintenance of the Ion Torrent™ Server.

The Ion Torrent™ Server is a dedicated server that performs DNA sequencing analysis
of data received from the Ion Proton™ and Ion Personal Genome Machine™ (Ion
PGM™) Sequencers.

This document is intended for system and network administrators responsible for
setting up and maintaining server hardware, software and network connectivity. By
presenting typical use cases, we identify best-practice operational scenarios to ensure
that your system installs correctly and continues to run smoothly.

Dell® T630 for Ion S5™ Sequencer

Feature Ion Torrent™ Server

CPU Two Intel® Xeon® CPU E5=2680 v3, 12 cores
@ 2.50GHz

GPU NVIDIA®Tesla K40 GPU

RAM 128 GB

OS Ubuntu®14.04 Server

Network controllers Two Intel® Built-in Ports

Broadcom Quad-Port NIC

Hard Drives 10 4-TB hard drives in RAID6

25 TB usable space

Optical Drive None

Keyboard, Mouse Included

Dell® T620 for Ion Proton™ Sequencer, Rev 2

Introduction

Audience

Server
configuration
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Feature Ion Torrent™ Server

CPU Two Intel® Xeon® CPU E5=2690 , 8 cores @
2.60GHz

GPU NVIDIA®Tesla K20 GPU

RAM 128 GB

OS Ubuntu® 10.04 and 14.04 Server

Network controllers Two Intel® Built-in Ports

Broadcom Quad-Port NIC

Hard Drives 12 3-TB hard drives in RAID5

25 TB usable space

Optical Drive None

Keyboard, Mouse Included

Dell® T620 for Ion PGM™ Sequencer

Feature Ion Torrent™ Server

CPU Two Intel® Xeon® CPU E5=2670 , 8 cores @
2.60GHz

GPU NVIDIA®Tesla K20 GPU

RAM 64 GB

OS Ubuntu® 10.04 and 14.04 Server

Network controllers Two Intel® Built-in Ports

Broadcom Quad-Port NIC

Hard Drives 6 3-TB hard drives in RAID5

12 TB usable space

Optical Drive None

Keyboard, Mouse Included

Dell® T7500 PGM Sequencer

Feature Ion Torrent™ Server

CPU Two Intel® Xeon® 5650 6-core processors @
2.67 GHz

GPU NVIDIA® Tesla C2075 GPU

RAM 48 GB

OS Ubuntu® 10.04 and 14.04 Server
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Feature Ion Torrent™ Server

Network controllers Broadcom Quad-Port NIC

Hard Drives 8 2-TB hard drives in RAID 5

12 TB of usable storage

Optical Drive Included

Keyboard, Mouse None

For more information on Ubuntu® technical specs, including version numbers of other
associated software packages like Apache™ Software and PostgreSQL, please visit 
https://help.Ubuntu.com/community/Server/TechSpecs/1004LTS.

Use the admin gear menu to access the admin areas of the Torrent Browser:

• About View information on installed packages and versions, and access links to
community, support, documentation, and diagnostic resources.

• References Manage your references, regions of interest files, hotspot files,
barcode sets, and test fragments.

• Services Monitor your system and perform Data Management tasks:
– View the status of Torrent Suite™ Software modules, running analyses, file

system space, and RAID drives.
– View Data Management logs, and view or configure Data Management
settings.

– Initiate archive, export, or import actions.
• Plugins Install, configure, and manage plugins, including the Ion Reporter™

Uploader plugin.
• Configure Access the Admin Interface and Report Data Management settings,

and configure contact information, your Torrent Server name, and email
addresses.

• Accounts Configure your user profile, and respond to requests for new user
accounts.

Admin tabs
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This section covers initial Torrent Server installation procedures, from the time when
your system is delivered to when you are able to run your first analysis.

IMPORTANT! You must use your ionadmin account for steps described in the
Torrent Suite™ Software Administration Guide. (Do not use your ionuser account.)

The Torrent Server requires internet connectivity to install software updates and
patches from Ion Torrent™. To facilitate deployment, it is important that you prepare
your site network infrastructure in advance.

IMPORTANT! On the scheduled deployment date, IT support personnel should be
scheduled to be available to ensure that the Torrent Server is properly connected to
the network and, if needed, assist the FAS in troubleshooting connectivity issues.

Review the following topics to prepare your site for server installation:

Network provisioning

Network provisioning should be completed before the scheduled installation:
• A network access jack should be identified and enabled in the area where the

Torrent Server will be deployed. An Ethernet cable is provided with the server.
The cable connects to the port labeled LAN on your Torrent Server; the remaining
ports are used to connect to the Ion Proton™ and Ion PGM™ Sequencers.

• DNS should be configured in advance of the scheduled installation.

Deploy Your
System

Prepare Your Site

Network
connectivity
preparation
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Port assignment

To fully support the Torrent Server and Ion Torrent™ sequencers, remote monitoring
must be provided using Axeda® Remote System Monitoring software, enabled and
able to reverse ssh into the boxes. This requirement means that the Ion sequencers and
Torrent Servers be connected to the internet with outbound connections permitted on
the following ports:

Port Required Use

22 Yes Start reverse SSH tunnel for
remote troubleshooting

80 Yes Download updates from 
http://
updates.iontorrent.com and 
http://
us.archive.ubuntu.com

123 Yes (UDP) NTP access to the
Internet; incoming and
outgoing.

443 Yes Enable sending of basic
status information to the
remote monitoring server.

The IonReporterUploader
plugin also requires port 443
to transfer data to Ion
Reporter™ Software.

5432 No Remote access to
PostgreSQL database.
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Name resolution

A DHCP-assigned address is recommended. (The Torrent Server can be reconfigured
to use a static IP address, if necessary.)

Server run, report and configuration data are accessed using your workstation Web
browser. You must be able to access the server UI by entering the server hostname in
your browser URL address field.

IMPORTANT! Server installation should only be done by a Thermo Fisher Field
Service Engineer (FSE).

Server installation includes the following activities.

Network Connection

Use the following procedures to verify correct network configuration.

Test network connectivity (preferred)

The automated network tests (requires an ionadmin account).

Alternate network connection tests

The server is configured with DHCP. If DHCP is configured in the site network, the
server should have already acquired an IP address. Verify that the server has acquired
an IP address using the following command.

ifconfig eth0

To test connectivity for updates, type the following command:

links -dump http://updates.iontorrent.com/

This should return:

Welcome to the Ion Torrent™
 Updates Server. --------------------------------------------- 
[ICO] Name Last modified Size Description 
---------------------------------------------

followed by a few [DIR] lines.

Install the Server
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If not, check that the light is on, for the port connected to the network. Try to ping
other on-site servers by name and IP address.

Access the web browser

Use the following procedure to test web browser access.

IMPORTANT! To access the web browser, the site IT administrator may need to
configure the hostname to point to the IP address of this server. Some networks may
handle this automatically.

1. Go to another desktop or laptop on the network.

2. Open a browser and enter either http://ion‑torrent‑server or the new host name,
as applicable.

3. If the server does not respond, try using http://<<ip-address>>. If you are
able to open the browser, it indicates there is a name resolution issue on the
network, which must be fixed.

4. If there is still no response, ping the hostname and the IP address of the server.
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These instructions describe how to update your Torrent Suite™ Software to a new
version. Visit the Management Actions page for instructions to update Torrent Suite™

Software.

Next steps

After upgrading Torrent Suite™ Software, click the Admin gear menu and select
Plugins:

Check the list of enabled plugins:

Manually enable plugins of interest by checking the checkboxes in the Enabled
column.

Update Torrent
Suite™ Software
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Configure Torrent Suite™ Software

IMPORTANT! Follow these configuration steps only after updating the Torrent Suite™

Software version.

Torrent Suite™ Software works out-of-the-box.

Configuration tab

Some configuration tasks use the Linux™ command line and some use the Torrent
Browser configuration tab. To access the Torrent Browser configuration tab, use the
gear menu near the top right of a Torrent Browser page and select Configure:
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Configure disk space notification email address

The Data Management system can automatically notify you when available disk space
on a Torrent Server disk partition becomes low. However, in order to receive these
notifications, you must configure an email address in the Data Management system.

Configure contact information

Add the name, email address, and phone number of the person responsible for the
server and of an I.T. contact person, and click the Save Contacts button:
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Change the hostname

Use the following command to change the hostname:

sudo TSconfig --change-hostname

The server must reboot after the hostname is changed. The above command
automatically reboots the server.

Add an HTTP proxy

Use the following command to add an HTTP proxy:

sudo TSsetproxy

Set the proxy address and authentication according to the following prompts:

1. Enter http proxy address: Enter the proxy address. (If no address is
entered, you are prompted to exit the program.)

2. Enter http proxy port number [3128]: Enter a port number or carriage
return to accept the default, 3128, port number.

3. Enter the username for proxy authentication: Enter a username. If
you do not enter a username, no authentication is set.

4. Enter the password for proxy authentication: Enter a password. If
you do not enter a password, no authentication is set.

A proxy address confirmation message is displayed:

http_proxy is set to http://username:password@proxyAddress

The recommended usage is to enter the command sudo TSsetproxy, as shown above,
and be prompted for each value. You can however use the TSsetproxy arguments
instead:

Usage: TSsetproxy [option]... --address Proxy address (example:
                'http://proxy.net') --port Proxy port number 
(default: 3128) --username
                Username for authentication --password 
Password for authentication --remove Removes
                proxy setting --debug,-d Prints script 
commands when executing (set -x) --demo
                Prints what changes would be executed only. No 
changes are made --help,-h Prints
                command line args --version,-v Prints version
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Configure HTTPS

The Torrent Server is shipped with a self-signed SSL certificate that allows you to
enable HTTPS quickly but provides a limited degree of security. Torrent Suite™

Software administrators who are interested in securing the connection further should
read the Ubuntu® Server Guide on Certificates and Security, and investigate getting
either an SSL certificate signed by their organization or a trusted Root Certificate
Authority.

For more information on the level of security provided by Ubuntu®, see the following
site for 10.04: https://help.Ubuntu.com/10.04/serverguide/
certificates-and-security.html, or for 14.04: https://help.ubuntu.com/14.04/
serverguide/certificates-and-security.html.

With a self-signed SSL certificate, each user sees an error message on his or her first
visit to the site and is asked whether or not to trust the certificate.
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See also the following Apache™ file for information. This file is installed on your
Torrent Server as /etc/ Apache™ 2/sites-available/torrent-server-
ssl.example:

# So, you want to configure HTTPS...

# [Optional] consider creating and signing your own ssl-cert,

# and replace the 'snakeoil' cert below.

?

# Copy this file to torrent-server-ssl, edit as needed? [[ NB: 
Step missing in current file... ]]

cd /etc/ Apache™ 2/sites-available

sudo cp torrent-server-ssl.example torrent-server-ssl

?

# To activate this vhost:

?

sudo apt-get install lib Apache™ 2-mod-gnutls ssl-cert

sudo a2enmod ssl

sudo a2dissite default-ssl? ? ## should already be disabled, 
but just in case

sudo a2ensite torrent-server-ssl

sudo service  Apache™ 2 restart

?

# [Optional] If you want to block access by plain http,

# you can disable the default site.

# This may block Ion PGM™ Sequencer access to the Torrent 
Server.

# Disable at your own risk.

# echo "I'm sure I want to do this." && sudo a2dissite torrent-
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server

?

# [Optional] Enable http site which redirects to https, 
forcing https access

# a2ensite force-torrent-server-ssl

?

IMPORTANT! The Ion PGM™ and Ion Proton™ sequencing instruments do not
support HTTPS. If you configure HTTPS on the Torrent Server, ensure that Apache™ is
running both HTTPS and HTTP concurrently, so that the sequencing instruments can
connect to the Torrent Server over HTTP. If you disable HTTP, the sequencing
instruments are not be able to connect to the Torrent Server.

Change the timezone

Use the following command to change the timezone:

sudo TSconfig --configure-timezone

Configure Postfix for nightly email

Postfix is a Linux™ mail server ("post office") program. It is open-source software and
was not designed by Ion Torrent™. It is more similar to Exchange than Outlook®

software in that it is an e-mail server, not an e-mail client. Postfix is designed to work
on various infrastructures, so there are many configuration options for IT
administrators to adjust mail routing parameters.

You can find the official Postfix documentation here: http://www.postfix.org/
documentation.html.

Prepare site IT

It is useful to confirm the following with the site IT administrator:

• Outbound email from the server is allowed Many sites block the ability for
machines to send an e-mail message directly to a mail server because this is a
common avenue for virus propagation. If the site has such a restriction in place,
the IT administrator may need to make an exception for this server.

• Ideally, the domain is configured with a default "MX record" The "MX record" is
the mail exchange information that automatically knows how to handle any
email generated from the Torrent Server. If this is not in place, the nightly email
might not work.
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Add email recipients

We recommend that you add only two recipients while you are testing.

Follow these steps to enter the destination e-mail addresses.

Add Web Root and Site Name to Admin and Global Config

Make certain these fields are configured in the database so they will show up correctly
on the e-mail message:

1. Click the Torrent Browser gear menu and select Configure.

2. Scroll down to the Database Administration section and click Admin Interface. If
prompted to log in, use your ionadmin account.

3. Click on Global configs:

4. Make certain a value is entered in the Web root field and the Site name field, as
shown in the example:

The value for Web root should be the main URL that people use to access this Torrent
Browser from the desktop.
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Configure Postfix for nightly email

There is no way to know it advance what Postfix configuration settings work for a
particular site. The following example procedure shows basic configuration settings
that have worked for the servers configured to date. There is no guarantee that these
steps work for every situation. If email is still not appearing, you almost certainly
require assistance from the site IT administrator, who may or may not have
experience with Postfix.

This configuration can be re-executed at anytime:

1. Go to the Linux™ command line and start the Postfix configuration utility:

sudo TSconfig --configure-postfix

2. Select the type of mail configuration. Typically, Internet with smarthost.
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3. For System mail name, enter the site domain name. This domain needs to be
configured with a default "MX" (mail exchange) record.

4. Leave mail recipient blank.
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5. Leave other destinations blank.

6. Set Force synchronous updates on mail queue to <No>.
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7. For Local networks, accept the default, and select <OK>.

8. For Mailbox size limit, it is recommended that you not have no limit, so enter
"51200000" to not consume all disk space.

Software Administration and Data Management
The Admin Menu

430 Torrent Suite™ Software Help



9. Leave Local address extension character blank.
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10. For Internet protocols to use, accept the default and select <OK>.

11. After the last screen, the console returns to text mode and displays the status of
the Postfix configuration files update.

Running newaliases * Stopping Postfix Mail Transport Agent 
postfix [ OK ] *
                Starting Postfix Mail Transport Agent postfix 
[ OK ] root@kauai:~# sudo
                dpkg-reconfigure postfix * Stopping Postfix 
Mail Transport Agent postfix [ OK ]
                setting synchronous mail queue updates: false 
setting myorigin setting destinations:
                setting relayhost: setting mynetworks: 
127.0.0.0/8 []/104 []/128 setting
                mailbox_size_limit: 51200000 setting 
recipient_delimiter: setting inet_interfaces:
                all setting inet_protocols: ipv4 WARNING: /etc/
aliases exists, but does not have a
                root alias. Postfix is now set up with the 
changes above. If you need to make
                changes, edit /etc/postfix/main.cf (and 
others) as needed. To view Postfix
                configuration values, see postconf(1). After 
modifying main.cf, be sure to run
                '/etc/init.d/postfix reload'. Running 
newaliases * Stopping Postfix Mail
                Transport Agent postfix [ OK ] * Starting 
Postfix Mail Transport Agent postfix [ OK
                ]
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This completes Postfix configuration.

This procedure verifies that the server installation and the Torrent Suite™ Software
configuration are complete, and that the Torrent Suite™ Software is ready to run
analysis programs:

1. Go to the admin Services tab, and view the Service Name table (in the Jobs Server
section at the top of the page):

2. All services should have status Running:

Alternate checks

1. Connect to your Torrent Server host, using ssh, and verify that the Crawler and
Job Server services are running:

ps -aux | grep py

This should show active crawler.py and serve.py processes.

2. Run a test analysis of the provided cropped data set and review the resulting
report.

Verify
Functionality
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Manage Sequencer Instrument Settings from the Torrent Browser

From your Torrent Browser, you can do the following remotely:
• Set FTP information
• Set Update server address
• Monitor the state of the Ion PGM™ or Ion Proton™ sequencing instrument, such as

Idle or In experiment
• View the most recent alarms
• Get the software versions

This section uses the Ion PGM™ Sequencer as an example of how to connect an Ion
sequencer to the Torrent Server.

On the Ion PGM™ Sequencer Advanced screen, you can set Torrent Server login
information, e.g. server address ( Torrent Server), username ( TS UserName), and
password ( TS Passwd), to connect to the Torrent Server. The Torrent Server field
turns green to indicate that the login information is correct.

IMPORTANT! T he Ion PGM™ Sequencer uses the Torrent Browser API to
communicate with Torrent Suite™ Software. The username and password are the ones
used to log on to Torrent Browser. The Torrent Server ssh login can be different from
Torrent Browser login.

Connect the
sequencer
instrument to the
Torrent Server
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Ion PGM™ and Ion Proton™ instrument information is stored inside Rigs under Site
administration. First click on the Config tab; under Database Administration section,
click on Admin Interface. It prompts for user name and password. The user needs to
have staff status and the permission to update Rigs (rundb | rigs). By default,
ionadmin has this permission.

Reference library and barcode

On the Ion PGM™ or Ion Proton™ instrument, during a run, you can enter information
about the experiment, or run, on Run Info screen. The Ion PGM™ orIon Proton™

instrument gets the lists of reference library and barcode set from the Torrent Browser.
The information is queried in real time.

For example, while at this Run Info screen on theIon PGM™ or Ion Proton™

instrument, you realize the reference library has not been added on Torrent Browser.
You can go to Reference tab (with the Admin gear menu References option) on
Torrent Browser and add a new reference library. Back at the sequencing instrument,
you see the new reference library when pressing the drop-down menu (in red below,
shown on an Ion PGM™ instrument):

Update
information on an
Ion sequencer via
the Torrent
Browser
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You can view the status of Ion PGM™ or Ion Proton™ instrument in the State field. It
can be Idle, Initing, or In Experiment. You also can view the recent alarm such "No
connectivity to ftp server". You can find out the software versions in the Version field.

Maintain Your System

Perform the following tasks as needed to maintain your system in good working
order.

• Disk space, archival, data:
1. “Monitor Free Disk Space“ on page 436.

2. “Back Up and Restore Data“ on page 409.

IMPORTANT! You must use your ionadmin account.

It is critical that enough disk space is available on the server to avoid data loss so it is
important to have a strategy that periodically monitors disk space and archives or
deletes data as needed.

To access the Disk Usage section, click the Data tab and the Disk Management
subtab:

View Ion
sequencer status
and information

Monitor Free Disk
Space

Disk Usage
section
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Scroll down to the Disk Usage section:

Usage totals

The Disk Usage section also reports space and usage totals for each file system. These
totals appear to the right of the File server Space graphs in the Disk Usage section.
(Totals for only one file system are shown here.)
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Error messages

Monitor the Disk Space Management section for messages that require administrator
action:

• Backup drive is full or missing Replace the backup drive.
• Error Check the file /var/log/ion/data_management.log for information

regarding the specific error condition. If appropriate, report the error to Ion
technical support.

Disk full messages

When any storage device reaches 95% full (and again at 99%), a warning banner is
displayed across the top of Torrent Browser pages:

*** CRITICAL! /results/: Partition is getting very full ‑ 95% ***

IMPORTANT! Torrent Suite™ Software performance is impacted when a disk partition
is more than 95% full.
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Use the following procedure to monitor disk space when the Torrent Browser UI is
not available:

1. Log into the server using an ssh client:

$ ssh ionadmin@ion-torrent-server 
$ password: ionadmin

2. Enter the df command to display partitions and disk utilization:

Most growth is seen in the /results directories, which is where Ion Torrent™

data are stored.

The Use% column indicates how much space is being used.

IMPORTANT! If there is insufficient space on the Torrent Server, data files are
retained on the Ion PGM™ and Ion Proton™ Sequencers until space becomes available.

Torrent Browser Data Management features

A disk space monitoring policy can be implemented using the Data tab's Disk
Management subtab. Additionally, your I.T. department may choose to deploy a
monitoring tool such as Ganglia.

When the Torrent
Browser UI is not
available
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The admin menu Services tab also has a link to the Data tab's Disk Management
subtab (scroll to the bottom of the Services tab for this link):

Boot into Single-User Mode

You may sometimes need to boot the Torrent Server host into single user mode. One
reason would be if you forgot and need to reset your password.

1. Reboot the server. A hard reboot may be needed if there is no way to login to the
system.

2. Immediately after the BIOS completes, press the Esc key to display the grub
menu:

3. Press the E key to edit the boot command line.

4. Scroll down to the linux ... command and scroll to the end of the line.
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5. Add the word single to the end of the line:

6. Press Ctrl‑X to boot.

7. At the next window, scroll down to the netroot option and press Enter:

You are now logged into the system with root privileges.
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Mount a USB Drive

This describes the procedure for manually mounting and unmounting an external
USB drive. To follow these steps, you should feel comfortable using the Linux™

command line and have a basic understanding of disk drives and partitions.

By default, Ubuntu® Desktop automatically mounts an external USB drive when the
drive is attached to the machine, similar to Macintosh™ or Windows™ operating
systems.

The Ubuntu® Server, however, does not mount external hard drives automatically, so
the ion-usbmount utility is included with the Torrent Server Software, which
automatically mounts attached USB drives in the /media directory. If a particular
USB drive is not being automatically mounted by ion-usbmount, you may need to
mount the drive manually.

Note: These instructions only provide an overview of the required steps, and may be
a helpful reminder if you are new to the Linux™ operating system. We recommend a
system administrator perform the Linux™ mount and unmount procedures.

For more detailed instructions and background information, refer to the Ubuntu®

documentation: https://help.ubuntu.com/community/Mount

To see a list of the drives in the system, type the following command before
connecting the USB drive:

sudo fdisk \-l

Make a note of the drives that are present, so you can be sure which drives are in the
server. The local hard drive usually has a name such as /dev/sda, as in the following
example:

Mount a USB Drive
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To see a list of drives, including the new drive:

1. Connect the USB drive.

2. Wait about ten seconds and re-type: sudo fdisk -l. You should see a new
drive. You need to know the device name of your USB drive, which is usually
called /dev/sdb or /dev/sdc, depending on the number of drives installed.
The partition is a number appended to the name of the physical drive. For
example, the first partition on drive /dev/sdc would be called /dev/sdc1. In
the following example, there is a 2GB partition (1953512001 blocks) attached to
the system and named /dev/sdb1. It is configured with a Linux™ partition. (If
the drive was formatted on Windows™, it is either a FAT or NTFS partition.)
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If the drive is a Windows™ FAT or NTFS partition, reformat the drive as an ext3
partition to preserve the Linux™ file information.

IMPORTANT! Be careful that you are formatting the correct hard-drive!

To reformat the drive as ext3 partition, type sudo mkfs.ext3 <your_device>.
For example:

sudo mkfs.ext3 /dev/sde5

Label the partition on external USB drive. To label the partition, type

sudo e2label <your_device_place> <partition_label>.?

For example, external drive connected in /dev/sdbl will be labeled as 'TS_Backup1':

sudo e2label /dev/sdb1 TS_Backup1

It is important to provide a different label name to each partition to avoid error when
multiple external USB drives are connected to TS at the same time.

Test to see if external USB drive mounts automatically. Disconnect the external USB
drive and connect it back. Wait ~10 seconds. The external USB drive should now
appear under the Services tab in Torrent Browser.

Before disconnecting a drive, it is recommended that you unmount it first, to ensure
that all data has been completely written to disk. If you pull out the USB cable, there is
a real risk of data loss.

The command to unmount the drive is almost identical to the command to mount the
drive:

sudo umount /dev/sdb1 /media/external

TorrentNAS storage device

The TorrentNAS is a convenient option for backing up or archiving your run data.
This storage device is supported in Torrent Suite Software v5.2 and beyond.

Network Attached Storage (NAS), which supports NFS protocol, can be used as an
archive or export directory.

Torrent Suite™ Software will detect any storage mounted over NFS to the server as
external storage.

Your Torrent Server administrator (or local I.T. person) might need to use the "sudo
mount" command to mount an NAS drive. After the drive is mounted, it appears in
the Archive Directory drop down menus. You may need to consult with your Linux®

system administrator.

Unmount a USB
Drive
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The TorrentNAS can be plugged in directly to your Torrent Server or it can be
implemented on a network and shared among users.

1. If you are directly connecting TorrentNAS to your Torrent Server, just plug the
TorrentNAS into your server.
The TorrentNAS IP address self populates in box 1 on the interface.

2. If your TorrentNAS resides on a shared network, enter it's IP address or host
name in the box below box 1.

3. Select a Share Volume (directory of folders) where you plan to store your run
data.
The network path to your storage location appears in box 3.

4. Review the mountpoint path, make any changes necessary, and click Add
Volume.

The new storage location appears in the Currently Mounted Volumes list on the right.

To remove a storage location, select the volume and click Remove Volume.

Set up TorrentNAS
storage device
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You can check the status of your TorrentNAS devices.

1. Log in as administrator.

2. Click the gear button, then Services.

3. Scroll down to the TorrentNAS Info section and view all the TorrentNAS devices
networked to your server.
This section lists storage pool names, allocated and available storage capacity,
usage, and health of the device.

See “Data Management tab“ on page 404 for details on storing, archiving and deleting
data from your TorrentNAS device.

Axeda Remote System Monitoring (RSM)

The Axeda® RSM (Remote System Monitoring) agent is a software component
installed automatically on the Torrent Server and Ion S5™, Ion PGM™, and Ion Proton™

Sequencers via the software update process.

Approximately every sixty seconds, this agent sends a heartbeat message to Thermo
Fisher. This information is used to track the deployment and software configuration of
machines in the field.

Data is collected in the Axeda® monitoring database, where Thermo Fisher technical
support personnel can review the information collected by the agents. Since the
heartbeat message is sent many times an hour, Tech Support can quickly see if a
machine is online, the software versions, and some technical details about the
instrument such as temperature and hard drive status.

The agent also allows Ion Torrent™ to remotely log into the Ion S5™, Ion PGM™,
andIon Proton™ systems and the Torrent Server, which is required for system support.
Without remote access, Thermo Fisher Field Application Scientists cannot access,
view, and troubleshoot issues regarding machine performance.

Monitor
TorrentNAS
storage device

Archive files on
TorrentNAS
storage device

Overview
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Field names, data types, and examples of the data being collected are described in the
following tables. This information is sent automatically from the Torrent Server and
Ion S5™, Ion PGM™ andIon Proton™ Sequencers back to Thermo Fisher.

Event Name Type Sample Value

TS.Config.biosversion String 6.00

TS.Config.configuration String standalone

TS.Config.hostname String Ion-torrent-server

TS.Config.ipaddress String 10.45.3.246

TS.Config.mode String Master

TS.Config.serialnumber String 1SMJFP1 ( Dell™ service
tag)

TS.Contact.IT Contact String email, phone

TS.Contact.Lab Contact String email, phone

TS.Experiment String chip type, flow count,
run type, bedfile,
barcode count, seq s/n

TS.GPU String No problems

TS.host String Ion-torrent-server

TS.HW.HD./results Analog 58.99

TS.Location.City String Rockville

TS.Location.Org-Name String Unknown

TS.Location.Postal-
Code

String Unknown

TS.Location.State String Unknown

TS.Location.Street-
Address

String Unknown

TS.Nexenta<n>
_lic_days_left

String 180

TS.Nexenta<n>
_lic_status

String license status

TS.Nexenta<n>
_machine_sig

String 5EDI8L9NA

TS.Nexenta<n>_UUID String 44454c4c-5900-1046-80
48-b2c04f533532

Data automatically
collected by the
RSM Agents

Torrent Server
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Event Name Type Sample Value

TS.Nexenta<n>_vol<v> String pool1 size=32.5T
allocated=860G
free=31.7T capacity=2%
health=ONLINE

TS.Nexenta<n>_vol<v>
_d<d>

String c0t5d1 health=ONLINE
vendor=SEAGATE
product=ST6000NM0034
serial=Z4D1XT26
size=6TB

TS.Server.celerybeat String ok/offline/error

TS.Server.celery_diskuti
l

String ok/offline/error

TS.Server.celery_periodi
c

String ok/offline/error

TS.Server.celery_plugin
s

String ok/offline/error

TS.Server.celery_slowla
ne

String ok/offline/error

TS.Server.celery_transf
er

String ok/offline/error

TS.Server.celery_w1 String ok/offline/error

TS.Server.dhcp String ok/offline/error

TS.Server.ionCrawler String ok/offline/error

TS.Server.ionJobServer String ok/offline/error

TS.Server.ionPlugin String ok/offline/error

TS.Server.ntp String ok/offline/error

TS.Server.RabbitMQ String ok/offline/error

TS.Server.RSM_Launch String ok/offline/error

TS.Server.tomcat String ok/offline/error

TS.TYPE String TS1

TS.Version.alignment String 1.42-0

TS.Version.analysis String 1.40-0

TS.Version.dbreports String 1.95-3

TS.Version.docs String 1.15-1

TS.Version.referenceLib
rary

String 1.6-1
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Event Name Type Sample Value

TS.Version.tmap String 0.0.19-1

TS.Version.tsconfig String 1.3-9

Event Name Type Sample Value

Instrument.Event.LastExperi
ment

String R_2011_04_22_15_34_58_u
sr_S-1

Instrument.Event.Pressure Analog 0 (chart)

Instrument.Event.ValveBoar
d

String Valve Board not accessible

Valve Board Down Stream
Errors

Valve Board Up Stream
Errors

Instrument.Event.RunAborte
d

String Run aborted

Instrument.Event.LostChipC
on

String Lost chip connection, run
aborted

Instrument.Event.UBoot String U-boots don’t match

Instrument.Event.Kernel String Kernels don’t match

Instrument.Event.ResultsDri
ve

String Results drive not accessible

Instrument.Event.BootDrive String Bad boot drive detected

Instrument.Event.DataDrive String Bad data drive detected

Instrument.HW.HD1 Analog 34.001 (chart)

Instrument.InstrumentNam
e

String Stork

Instrument.Pressure Analog 10.2 (chart)

Instrument.Temperature Analog 27.06 (chart)

Instrument.TYPE String PGM1

Instrument.Version.Board String 4 A.1

Instrument.Version.Datacoll
ect

String 180

Instrument.Version.driver String 31

Instrument.Version.fpga String 70

Instrument.Version.Graphics String 15

Ion PGM™ data
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Event Name Type Sample Value

Instrument.Version.LiveView String 268

Instrument.Version.OS String 12

Instrument.Version.Scripts String 16.3.58

Ion S5™ and Ion Proton™ sequencer data is divided into these categories:
• DataCollect - These items come from the instrument configuration file.
• RunData - These items reflect parameters from the last Auto pH or sequencing

run.
• Status - These items reflect the current instrument parameters.
• System - These items provide parameters related to the operating system

supporting the instrument.
• Version - These items provide the version numbers for the various software

packages installed on the instrument.

In addition, two items (InstrumentState, Type) are not placed in any category.

The number and names of these entries are subject to change across software releases.

Data Item Name Type Sample value

Alarm.* String Various hardware alarm
messages

BIOS.BIOS Analog 5350

DataCollect.FlowsSinceClea
n

Analog 400

DataCollect.RunsSinceClean Analog 1

Event.CleanCompleted String Clean completed

Event.DatacollectStarted String Datacollect Started

Event.InstrumentMustBeInit
ialized

String Instrument must be
initialized

Event.PostRunCleanHasNot
BeenRun

String Post Run Clean has not been
run

InstrumentState String Idle

RunData.a1a2 String R_2016_02_17_13_01_08_u
ser_F4--145 W1.dat dffffe
cntArry 9 0 0 9

RunData.AutoPhFinal Analog 7.660635

RunData.AutoPhInitial Analog 6.321023

RunData.AutoPhIterations Analog 4

RunData.AutoPhResult String Pass

Ion S5™ and Ion
Proton™ data
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Data Item Name Type Sample value

RunData.AutoPhTotalW1Vol
ume

Analog 1.0

RunData.ChipGain Analog 1.066389

RunData.ChipPixelAverage Analog 8241

RunData.ChipPixelsInRange Analog 164698460

RunData.ChipPixelsPinnedH
igh

Analog 0

RunData.ChipPixelsPinnedL
ow

Analog 676

RunData.ChipTemp Analog 81.826172

RunData.CpuTemp0 Analog 53

RunData.CpuTemp1 Analog 74

RunData.efuse String **********L:Q6C841,W:
4,J:WC2012C00086-
C00272,P:16,C:PT4,F:F6,Y:
4,X:0,B:3,SB:31,B:1P,N:
343***********************
**************

RunData.FpgaMasterTemp Analog 113

RunData.FpgaSlaveTemp Analog 118.4

RunData.GpuTempC Analog 82

RunData.LastAutoPhRealPh Analog 766

RunData.LastAutoPhRef Analog 745

RunData.LastAutoPhTarget Analog 770

RunData.R1pH Analog 7.00

RunData.R2pH Analog 7.00

RunData.R3pH Analog 7.00

RunData.R4pH Analog 7.00

RunData.W1pH Analog 8762

RunData.W2pH Analog 7619

RunData.W3RefpH Analog 7.45

Status.HDPctFull Analog 0.823612

Status.SsdPctFull Analog 6.220454

System.CpuUsagePct Analog 7
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Data Item Name Type Sample value

System.Date String 2013-01-0

System.FreeMemoryKB Analog 129951948

System.Hostname String d1.ite

System.IpAddress String 10.25.3.150

System.PhysMemTotalGB Analog 128

System.Time String 03:42:58 PM GMT

TYPE String Proton1

Version.Datacollect String 3371

Version.DiskImage String 2015_06_04

Version.Graphics String 80

Version.KernelRelease String 3.13.9-ionrt1

Version.LiveView String 2166

Version.OIA String 5203

Version.OS String 17

Version.Reader FPGA String 3d400109

Version.Reader FPGA1 Analog 33400109

Version.Reader Woddr FPGA String 3400043

Version.Reader Woddr
FPGA1

String 340004b

Version.RSM String 24

Version.Scripts String 2.0.63

Version.S5 Release Analog 5.2

Version.S5 Script String 0.1.13

Version.TSLink String 1.0.2r5

Version.Valve FPGA String c010

In the event that there is a problem with the Ion sequencer or Torrent Server, this
agent will allow Thermo Fisher support personnel to remotely:

• Collect log files from the systems for review
• Restart the device
• Upgrade software
• Provide a remote login connection to the device for further diagnostic work

Remote access for
troubleshooting
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These types of activities would only be initiated at the request of the
administrative contact, to ensure compliance with site security policies.

When a issue with the Ion S5™, Ion PGM™ system, Ion Proton™ system, or Torrent
Suite™ Software is reported, we make every effort to solve the issue by telephone or
email. If remote access is required for additional troubleshooting, a member of
Thermo Fisher support staff requires authorization from the technical contact to initial
remote connection. Only after getting authorization does anyone from Thermo Fisher
proceed with remote troubleshooting. Once the issue is resolved you are be notified.
Additional authorization is required before initiating any further remote assistance.

Management Actions

Enter the Management Actions section with the admin gear menu Configure
selection:

Scroll down to the Database Administration section, and click the Admin Interface
link:

If you are prompted to log in, use your ionadmin account.

IMPORTANT! These procedures require your ionadmin account. (Do not use your
ionuser account.)
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Click the View Network Settings link to see the following information about the
Torrent Server:

The Network Settings page also describes the following ports and remote sites in its
Remote system Summary section:

• support.iontorrent.com:443
• ionupdates.com:80
• us.archive.ubuntu.com:80
• drm.appliedbiosystems.com:443
• security.Ubuntu.com:80
• rssh.iontorrent.com:22

View Network
Settings
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The Management Actions panel displays the Shutdown Server dialog:

1. In the Management Actions panel, click Shutdown Server to start the shutdown
dialog.:

2. Click OK to confirm your shutdown request. Click Cancel to exit without
shutting down the server.

You will see a confirmation message indicating the server is shutting down:

Torrent Virtual Machine BIOS Instructions

The evaluation virtual machine (TS-VM) requires virtualization to be supported on
your machine. These instructions require a reboot.

IMPORTANT! Incorrect BIOS changes can cause unexpected results including non-
operation of your server. If you are not comfortable making these changes, contact
your local Life Technologies FSE.

Shutdown Server
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This section describes BIOS changes required to enable virtualization support on your
Torrent Server. These steps are different for T7500 servers and T620 servers.

1. During system boot, click F12 for boot options.

2. Click System Setup.

3. In the left navigation panel, click the Virtualization option under Virtualization
Support.

4. In the Virtualization panel on the right, click the checkbox Enable Intel™

Virtualization Technology.

5. Back in the left navigation panel, click the VT for Direct I/O option under
Virtualization Support.

6. In the Virtualization panel on the right, click the checkbox Enable Intel™ VT for
Direct I/O.

7. Click Apply and click Exit to leave BIOS.

8. Restart your system.

1. During system boot, click F2 to select the System Menu.

2. Select System Bios.

BIOS instructions

Steps for T7500
servers

Steps for T620
servers
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3. Select Processor Settings.

4. Click Enabled on the Virtualization Technology row.

5. Save your settings and reboot your server.

Software Administration and Data Management
Torrent Virtual Machine BIOS Instructions

Torrent Suite™ Software Help 457



Update the Ion Ion OneTouch™ Device

Enter the Management Actions section with the admin gear menu Configure
selection:

Scroll down to the Database Administration section, and click the Admin Interface
link:

If you are prompted to log in, use your ionadmin account.

IMPORTANT! These procedures require your ionadmin account. (Do not use your
ionuser account.)

This procedure requires actions on both the Ion OneTouch™ device and in the Torrent
Browser Management Actions section.
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Follow these steps to update the Ion OneTouch™ device software:

1. Connect the Ion OneTouch™ device and the Torrent Server with an Ethernet
connection.

2. Get the updated IP address of the Ion OneTouch™ device. Follow either one of the
following steps:As ionadmin, in the Torrent Browser Config tab Management
Actions section, click the link Update OneTouch Device.

• Power cycle the Ion OneTouch™ device, or
• Wait for the IP address to update (takes one or two minutes).To check for the

IP address, press the About button on the Ion OneTouch™ device.

IMPORTANT! This page does not refresh. To refresh, go to a different screen
and then go back.

More than one update may appear for the optional download.

3. Click Update.
On the Ion OneTouch™ device, a splash screen appears with update progress.

4. After update is complete, the Ion OneTouch™ device reboots itself.

Update Server

1. Update your Torrent Suite™ Software.

2. Disable updates to your Torrent Suite™ Software.

IMPORTANT! After the Torrent Suite™ Software upgrade is completed, also
upgrade your instruments to the same software level to ensure that they are
compatible.

Enter the Management Actions section with the admin gear menu Configure
selection:
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Scroll down to the Database Administration section, and click the Admin
Interface link:

If you are prompted to log in, use your ionadmin account.

IMPORTANT! These procedures require your ionadmin account. (Do not use
your ionuser account.)

Update your Torrent Suite™ Software

Update to your Torrent Suite™ Software cause the Torrent web services to restart.
Make sure no analysis jobs are running on the server or are queued to run.

If you have old references present in the Obsolete References section, this triggers a
warning to rebuild your references. Rebuild is not required if your references are
already using the index tmap-f3. The upgradeto a3.x release does require rebuilding
your reference indices only if you upgrade from a release earlier than 2.2.

IMPORTANT! To get the full instructions for updating your Torrent Suite™ Software,
please refer to the latest Release Notes on the Ion Community. There may be
additional steps and procedures required, depending on the type of software
upgrade.

Follow these step to update your Torrent Suite™ Software:

1. Log in with your ionadmin account.
2. Select the Admin gear menu Configure option, click the Admin Interface link in

the Database Administration section, and scroll down on the Management
Actions section.

3. Click the Update Server link:
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The Software Versions table, in the second column header, lists the current
version of Torrent Suite™ Software ("4.0" in this example. The Available column
shows which packages are available for update and their versions:

4. Below the Software Versions list is the update area. If no updates are available,
this section is titled "No updates":
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If you click the Check button, the following appears:

If updates are available, this section is titled "Available":

5. After the Torrent Suite™ Software update is done, please verify the version
number in the Admin gear menu About tab. The version number should now
reflect the current release:
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Click the Lock current TS software version checkbox to prevent accidental updates to
your software:

Use a Torrent Virtual Machine to Evaluate a New Release of Torrent
Suite™ Software

With some new releases ofTorrent Suite™ Software, we provide a virtual machine (TS-
VM) of the new release, for evaluation purposes only.

You use TS-VM to reanalyze (in the new release version) an analysis that you already
ran in your current version of Torrent Suite™ Software. You can then compare analysis
results in your Torrent Browser. You can also run a plugin from the new release on an
analysis that you already ran in your current version of Torrent Suite™ Software. Your
Torrent Server remains on its current release during your evaluation.

After you install and initialize TS-VM on your Torrent Server, use the TS-VM Torrent
Browser's Data Management features to import the analyses and raw data from your
native Torrent Suite™ Software. With TS-VM, you do not have to copy your analysis
results or other files from your native Torrent Suite™ Software.

The output of TS-VM analyses is in a separate directory ( /results/analysis/
output/TSVM5.2 for the 5.2 TS-VM) and is not in the same location as your native
Torrent Suite™ Software analyses.

This page describes how to download, initialize, and use TS-VM. This page uses the
term native to refer to your Torrent Server or Torrent Suite™ Software where you
install TS-VM.

IMPORTANT! While TS-VM is a fully-functioning instance of Torrent Suite™

Software, TS-VM is for evaluation purposes only and is not supported for production
use. Concurrent use of TS-VM and your native Torrent Suite™ Software is not
supported (due to resource contention, processing delays, and probable system
hangs).

Disable updates to
your Torrent
Suite™ Software
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This list provides an overview how to use TS-VM to evaluate a new release:

1. Install and initialize TS-VM. TS-VM is configured with the time zone, rigs, and
references from your native Torrent Suite™ Software.

2. Open a Torrent Browser pointing to TS-VM.
3. Import the data set for the run you want to reanalyze in TS-VM.
4. From the completed run report (for a previously analyzed 5.0 run), click the

Reanalysis button.
5. Wait for the reanalysis to complete (analysis times are longer in TS-VM than in

the native Torrent Suite™ Software).
6. Import the 5.0 report files.
7. Go to the Projects tab to compare the 5.0 and 5.2 results side-by-side. Results to

be compared must be added to the same project in TS-VM.

• TS-VM runs only on Torrent Servers.
• TS-VM requires that virtualization be enabled in BIOS (these changes require a

reboot).
• TS-VM installation requires internet access.

• TS-VM cannot utilize the GPU.
• TS-VM has degraded disk access. Expect analysis times to be several times longer

than in your native Torrent Suite™ Software.
• TS-VM does not have Torrent Suite™ Software's resource optimizations.

These restrictions are in keeping with the TS-VM's purpose of evaluating a new
release before your upgrade your server. However, as a result, analysis jobs take
considerably longer than they do on your native Torrent Suite™ Software.

• All but 1 of your Torrent Server's CPU and all but 4G of its RAM are allocated to
TS-VM.

• TS-VM uses ~9 GB of disk space in your /results partition. (The VM results
files are not deleted automatically when you remove your VM.

IMPORTANT! Do not run analyses in both TS-VM and your native Torrent Suite™

Software. When TS-VM is running, system resources are allocated to TS-VM's jobs,
and analyses on yournative Torrent Suite™ Software cannot complete.

Steps

1. From the gear menu, select Configure.

2. In the Management Actions section, click on the TS Virtual Machine link.

3. If your Torrent Server's BIOS is not set to support virtualization, follow the
instructions in Torrent VM BIOS Instructions. A reboot is required.

4. Click the Start TS‑VM Setup button. This starts the installation and
configuration.

Evaluation
overview

Prerequisites

Restrictions

System resource
information

Install TS-VM on
your Torrent
Server and
initialize TS-VM
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5. If there is a newer ion-tsconfig package available, click the Update button to
install first.

Note: The Update button is disabled if there is a TS-VM currently installed. Stop
the current TS-VM and delete it to enable the Update button.

Your TS-VM is now ready to use.

Use the Torrent Browser with TS-VM

To access TS-VM, point your browser to either of these URLs:
• http://ts-vm-< nativeTS>
• http://< nativeTS>:8082

Import analysis files and resources from your native Torrent Suite™ Software

Use the Torrent Browser's Data Management Import feature. You do not have to copy
any of your native Torrent Suite™ Software files.

You import analysis files based on Data Management file categories. The file
categories that you import determine what type of analysis you can do in TS-VM:

File category imported What you can do in TS-VM

Report Files Rerun plugins

Basecaller Input Reanalyze from Base Calling

Signal Processing Input Reanalyze from Signal Processing

Import raw data sets from your native Torrent Suite™ Software

The TS-VM does not include the ionCrawler. Your import the native Torrent Suite™

Software analysis files that you want to analyze in TS-VM. (You do not have to copy
your native Torrent Suite™ Software files.)

Follow these steps to import data files from your native Torrent Suite™ Software to TS-
VM (in order to reanalyze them in TS-VM):

1. In your TS-VM Torrent Browser, go to the Data -> Data Management tab -> Data
Import section and click the Import button.

2. In the Import Data popup, click the Browse button and go to More

Reference genomes from your native Torrent Suite™ Software

TS-VM as installed includes the e-coli genome. Other references in your native Torrent
Suite™ Software are automatically imported into TS-VM.
Analyses in the TV-SM

• Auto-analysis is turned off. You manually launch analyses in TS-VM from raw
data.

• See “Import raw data sets from your native Torrent Suite™ Software“ on page 465
for steps to analyze with the From wells option.
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Run these commands in a terminal session or a Linux™ command prompt window on
your Torrent Server.

IMPORTANT! These procedures require your ionadmin account. (Do not log in with
your ionuser account.)

Start TS-VM

cd /results/tsvm

./tsvm-ctrl start

Stop TS-VM

cd /results/tsvm

./tsvm-ctrl stop

Suspend TS-VM

cd /results/tsvm

./tsvm-ctrl suspend

The suspend command saves the current state of TS-VM. The next time you start TS-
VM, this state is restored.

Remove TS-VM

This command deletes the files that comprise the TS-VM virtual machine. To use TS-
VM after running this command, you must re-create the virtual machine with the TS-
VM initialize step (see the initialization step in Install TS-VM on your Torrent Server
and initialize TS-VM).

This command does not delete any analysis files generated by your TS-VM analyses.

cd /results/tsvm

./tsvm-ctrl destroy

Purge TS-VM and associated VM files

This command both deletes the files that comprise the TS-VM virtual machine and
uninstalls the ion-tsvm package. To use TS-VM after running this command, you
must follow all the steps in “Steps“ on page 464

This command does not delete any analysis files generated by your TS-VM analyses.

sudo apt-get purge ion-tsvm

TS-VM shell
commands
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This table compares pros and cons of using TS-VM or a separate Torrent Server to
evaluate a new release ofTorrent Suite™ Software.

Issue TS-VM Separate Torrent Server

Requires a server reboot Yes No

Requires data transfer No Yes

Must stop analyses (and
possibly stop sequencing)

Yes No

Note:
· TS-VM requires a reboot if BIOS settings need to be changed to support

virtualization.
· Data transfer to a separate Torrent Server can be done with the

TorrentSuiteTransfer plugin (formerly named the TorrentSuiteCloud plugin) or
with the Data Management feature ofexporting to a removable drive.

Enable Off-cycle Product Updates

Beginning in Torrent Suite™ Software v5.2, you can add new kits, chips, templates,
plugins and Ion Chef scripts that are launched outside of the software's full launches.

When you learn of a new product that you would like to use, check to see if a software
update is available.

1. Log in as administrator.

2. Click the Gear menu and select Updates.

3. Scroll down to the Update Products section at the bottom of the screen.

4. Select the desired new product and click Update.
Your installed version of Torrent Suite™ Software is updated to include the new
products you selected.

Beginning in Torrent Suite™ Software v5.2, you can add new plugins that are launched
outside of the software's full launches.

When you learn of a new plugin that you would like to use, check to see if an update
is available.

1. Log in as administrator.

2. Click the Gear menu and select Updates.

3. Scroll down to the Update Plugins section at the bottom of the screen.

4. Select the desired new plugin and click Update.
Your installed version of Torrent Suite™ Software is updated to include the new
plugin you selected.

Evaluation
alternative

Update off-cycle
release plugins
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Update Ion Chef™ scripts

New in Torrent Suite™ Software v5.2, Ion Chef™ scripts can be updated between
software releases and you can elect to update them. When an Ion Chef™ script is
updated, you will see an announcement at the top of your Torrent Suite™ screen.

1. Click on the new Ion Chef™ script announcement and click Upgrade.
The system installs the new script.

2. If you find you need to revert back to the old script, click Revert.

3. Next, upgrade the Ion Chef™ instrument.

Troubleshooting

These troubleshooting suggestions apply to system level issues such as networking,
disk space, and system load.

For investigations of an individual failed analysis run, see instead “Handle a failed
analysis run“ on page 552.

Access the Crawler and Jobs Server page:

Click the Admin gear menu (near of top right of the Torrent Browser) and select
Services:

The following table lists the background processes that run on Torrent Suite™

Software:

Check Crawler
and Job Server
status
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Process Program Startup Script Description

Crawler crawler.py ionCrawler Searches for new
runs from the Ion
PGM™ orIon Proton™

Sequencers and puts
run information into
the database so that
they appear in the
Torrent Browser
Data > Completed
Runs & Reports
page.

Job Server serve.py ionJobServer Sends analysis jobs
to the Sun Grid
Engine (SGE).

Plugin Server ionPlugin.py ionPlugin Sends plugin jobs to
the Sun Grid Engine
(SGE).

Celeryd manage.py celeryd A background job
processor for
Django.

Note: Startup scripts for each process can be found in the /etc/init.d directory.

Note: Log file for each process can be found in the /var/log/ion directory. They
are:
· crawl.log
· iarchive.log
· celery_w1.log
· ionPlugin.log

If these processes are not running, run information is not updated and analysis
reports are not generated. If this occurs, there is no risk of data loss but the Crawler
and Jobs Server processes should always be running. The Archive process only runs
if archiving has been configured.
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Process status is displayed in the Admin Services tab, as shown in the following
figure:

If a process is not running, a Down or Offline reason is displayed in the Admin
Services tab. An example is "The crawler is offline".
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Queue status

Click the Queue Status link in the Active Jobs section to open a table of SGE queue
activity:

Currently, there is no method to restart a process using the Torrent Browser UI. The
easiest approach is to shutdown and restart the server. Before restarting the server,
make sure that no Ion PGM™ or Ion Proton™ Sequencers are uploading data to the
server, otherwise the file transfer is interrupted.

You can also restart the processes using the scripts located in the /etc/init.d
directory. For example, use the following command to restart the Crawler:

user@svr:/etc/init.d$ sudo /etc/init.d/ionCrawler restart 
Stopping crawler Starting crawler pid = 26025

Use the ps ax | grep py command or the Torrent Browser UI to verify that the
processes are running.

After restarting a process, it continues from the point where it was interrupted, and
no more user interaction is needed.

If the processes do not continue to run after being restarted, contact your Ion Torrent™

representative for assistance.

Restart services
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There can be many reasons for network connectivity or name resolution to fail. Use
the following procedure to try to resolve connectivity and name resolution problems:

1. Go to the admin interface Management Actions area and click View Network
Settings. The Torrent Browser performs several network checks:

2. You can also verify that the Torrent Server is configured correctly by reviewing
the Torrent Server deployment instructions.

3. Find the IP address of the Torrent Server as described in “Verify Torrent Server IP
address“ on page 472.

If you cannot reach the Torrent Server an IP address, you are likely to need help from
the site I.T. administrator who understands how the local network is configured.

The Torrent Server is configured out-of- the-box to automatically get an IP address
from the DHCP server on the network. Unless the local I.T. administrator has
specifically assigned an IP address in advance, you will not know what the current IP
address is.

The Torrent Server has several Ethernet ports on the back. Make sure your site
network is connected to the port labeled LAN, called eth0 in Linux™ terminology. The
Ethernet port are identified as eth0, eth1, ..., for as many ports as are available. On
Torrent Server, eth0 is the only port connected to your network and is configured by
DHCP.

Verify network
connectivity and
name resolution

Verify Torrent
Server IP address
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To determine the IP address assigned to eth0, login and type: ifconfig eth0. This
displays the following output:

ionadmin@ion-torrent-server:~$ ifconfig eth0

eth0 Link encap:Ethernet HWaddr 00:1b:21:5b:bb:44

inet addr:192.168.1.123 Bcast:192.169.4.255 Mask:255.255.255.0

inet6 addr: fe80::21b:21ff:fe5b:bb44/64 Scope:Link

UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1

RX packets:209970726 errors:0 dropped:0 overruns:0 frame:0

TX packets:419252947 errors:0 dropped:0 overruns:0 carrier:0

collisions:0 txqueuelen:1000

RX bytes:14131928595 (14.1 GB) TX bytes:607398487997 (607.3 GB)

Memory:fbea0000-fbec0000

Your IP address is the inet addr:

inet addr:192.168.1.1 Bcast:192.169.4.255 Mask:255.255.255.0

Another useful check is the line beginning with UP, which indicated the interface is
active and working:

UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1

If the eth0 port is not available, it is possible the Ethernet cable is connected to a
network, so you will not see the word UP:

BROADCAST MULTICAST MTU:1500 Metric:1

If an IP address is assigned, the interface is likely to work. If no IP address is assigned
and the interface is not UP, you may need to get help from your siteI.T. administrator.

If you are still concerned about network connectivity, you can test that different
desktops are able to successfully ping the server IP address. If you are not able to
ping the server from the desktops that need to access the Torrent Browser running on
the server, contact your site I.T. administrator.
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The Torrent Server uses the Linux™ Network Time Protocol (NTP) program to
synchronize its time with another time server. By default, the Torrent Server is
configured to synchronize its time service to a trusted time service on the Internet.
This requires that the network configuration permits the NTP network protocol to
connect to that time service on the Internet.

The Torrent Server can also act as a time server for Ion PGM™ and Ion Proton™

Sequencers. However, if the server is not able to synchronize with the trusted time
service, it does not act as a time server for the sequencers (Torrent Server does not
forward potentially incorrect information to other machines).

If the network configuration is blocking the NTP protocol from reaching the Internet,
the Torrent Server and theIon PGM™ and Ion Proton™ Sequencers are not be able to
synchronize time.

Your site network administrator is probably aware of this connectivity restriction, and
it is likely that IT has a time server in the network.

Verify that all files successfully transferred from the Ion PGM™ and Ion Proton™

Sequencers to the Torrent Server. Manually transfer files, if needed, by going to the
Data Management screen of the sequencer and select the Re-transfer option for any of
the runs in question. You can safely re-transfer data.

Do not delete the data from the Ion PGM™ orIon Proton™ Sequencer until you are
confident that the data is present on the Torrent Server, the analysis is successful, and
the Analysis Report has been generated successfully.

QMON is a graphical tool to manage the SGE Cluster. With QMON you can do tasks such
as the following:

• See the status of the servers in the cluster
• Check server CPU load and memory utilization
• See the status of jobs, are they running, completed, or still waiting in the queue
• Monitor these job queues:

– tl.q Top level control jobs
– all.q Analysis jobs
– plugin.q Plugin jobs
– thumbnail.q Ion Proton™ thumbnail analysis jobs

• Delete jobs that are currently processing or waiting in queue
• Disable servers from accepting new jobs, and re-enable them later
• And many other advanced configuration options

Troubleshoot and
configure the time
service

Verify file transfer

Use QMON to
manage the SGE
cluster
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System diagnostics information can help diagnose network, disk space, and system
status issues.

Use instrument diagnostics to investigate chip and sequencing instrument issues,
such as pH levels.

After the root cause of a major problem is identified, the following more intrusive
action may be needed:

• Replace failed hard disk drive
• Downgrade software packages
• Reinstall software
• Modify config files
• Add, modify, or delete database information

Please contact your Ion Torrent™ representative for assistance before you attempt any
of these steps.

This page describes the contents of a Customer Support Archive and how you can
generate one. The Customer Support Archive is a ZIP file of log files and other
technical data about your Torrent Suite™ Software and analysis runs. This data is
useful for our support team to diagnose issues with your Torrent Suite™ Software. A
Customer Support Archive can only be generated by a request in your Torrent
Browser an archive is not generated automatically or forwarded automatically to Ion
Torrent™.

Generate a Customer Support Archive

You can generate a Customer Support Archive from a run report in the Torrent
Browser Data > Completed Runs & Reports tab. The Support tab appears in this tab
ribbon (after the run metrics and before the plugin detailed output):

Click the Support tab and then the Customer Support Archive download link. Wait
while the file is downloaded. The zipped archive file can be 15 or 20 MB or more.

System
diagnostics

Instrument
diagnostics

Further
investigation and
problem
resolution

Customer Support
Archive
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Customer Support Archive contents

The tables in this section describe the files included in a Customer Support Archive.
Files for optional modules (such as recalibration) only appear if the optional module
is run.

In the top level directory:

File Description

alignment.log Log of the final TMAP alignment process

< RunName>_< AnalysisReportName>
.alignment.summary

Text format summary of sample alignment
final results

alignment.summary Text format summary of sample alignment
final results (same as the file < RunName>_
< AnalysisReportName>
.alignment.summary, but with a predictable
file name)

backupPDF.pdf PDF file of the analysis report and plugin
results (similar to the output of the
Download as PDF button on a run report)

Controller Live View log of user activity on the
sequencing instrument

debug Log from data collect, the background data
acquisition module

DefaultTFs.conf List of known Test Fragment sequences and
their bases

drmaa_stderr_block.txt Analysis pipelin eerror log for the block
being executed by Sun Grid Engine

drmaa_stdout.txt Log of events after primary analysis

drmaa_stdout_block.txt Analysis pipeline output log for the block
being executed by Sun Grid Engine

explog.txt Initial run s settings needed for Torrent
Browser analysis when being exported from
instrument

explog_final.txt Final run s settings needed for Torrent
Browser analysis when being exported from
instrument

InitLog.txt Instrument auto pH log

InitValsW2.txt pH log of the W2 solution

InitValsW3.txt pH log of the W3 solution

RawInit.txt Contains initialization data output

sysinfo.txt Torrent Browser system software settings
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File Description

TF.alignment.summary Summary of test fragment alignment
results in text file

uploadStatus Log of metrics being uploaded to the
Torrent Browser

version.txt Torrent Suite™ software versions used for
the analysis report

In the basecaller_results directory:

File Description

basecaller.log Log file for the basecaller analysis module

datasets_basecaller.json A JSON-format file of the settings needed
for basecaller to analyze the sample data

datasets_pipeline.json A JSON-format file of the settings needed
by the pipeline to run the basecallermodule

datasets_tf.json A JSON-format file of the settings needed
for basecaller to analyze the Test
Fragments

< RunName>_< AnalysisReportName>
.quality.summary

A quality summary of basecaller unaligned
reads/bases after filtering and trimming

quality.summary Same as above, but with a predictable file
name

TFStats.json A JSON-format file ofTest Fragments
results statistics

In the basecaller_results/recalibration directory:

File Description

alignment.log Log of the TMAP alignment process during
base recalibration

alignmentQr_out.txt Log file from the TMAP analysis module

In the basecaller_results/unfiltered.trimmed directory:

File Description

alignment.log Log of the TMAP alignment process based
on unfiltered and trimmed reads

< RunName>_< AnalysisReportName>.
alignment.summary

Text format summary of sample alignment
results for unfiltered and trimmed reads
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File Description

alignment.summary Text format summary of sample alignment
results for unfiltered and trimmed
reads(same as above, but with a predictable
file name)

datasets_basecaller.json A JSON-format file of the settings needed
for basecaller to analyze the sample data,
when generating the raw BAM file

< RunName>_< AnalysisReportName>
.quality.summary

The basecaller unfiltered and trimmed
reads/bases quality summary

quality.summary The basecaller unfiltered and trimmed
reads/bases quality summary (same as
above, but with a predictable file name)

In the basecaller_results/unfiltered.untrimmed directory:

File Description

alignment.log Log of the TMAP alignment process based
on unfiltered and trimmed reads

< RunName>_< AnalysisReportName>.
alignment.summary

Text format summary of sample alignment
results for unfiltered and untrimmed reads

alignment.summary Text format summary of sample alignment
results for unfiltered and untrimmed
reads(same as above, but with a predictable
file name)

datasets_basecaller.json A JSON-format file of the settings needed
for basecaller to analyze the sample data,
when generating the raw BAM file

< RunName>_< AnalysisReportName>
.quality.summary

The basecaller unfiltered and untrimmed
reads/bases quality summary

quality.summary The basecaller unfiltered and untrimmed
reads/bases quality summary (same as
above, but with a predictable file name)

In the sigpror_results directory:
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File Description

analysis.bfmask.stats Analysis statistics of wells in the bead find
stage (the bfmask is a set of bit flags for
each well, indicating the contents of each
well)

avgNukeTrace_ATCG.txt ATCG key signal measurements

avgNukeTrace_TCAG.txt TCAG key signal measurements

bfmask.stats Summary statistics of wells in the bead find
stage

processParameters.txt Parameter settings for analysis signal
processing

separator.bftraces.txt Matrix data to separate between live wells
and empty wells during bead find phase

separator.trace.txt Matrix data to separate between live wells
and empty wells

sigproc.log Log file for the analysis module

In the sigpror_results/dcOffset directory:

File Description

dcOffset.txt background model parameter values of
dcOffset

In the sigpror_results/NucStep directory:

The files in this folder contain background model parameter values based on the
location of the well in the chip.

File

NucStep_frametime.txt

NucStep_inlet_head.txt

NucStep_inlet_empty.txt

NucStep_inlet_empty_sd.txt

NucStep_inlet_step.txt

NucStep_middle_head.txt

NucStep_ middle_empty.txt

NucStep_ middle_empty_sd.txt

NucStep_ middle_step.txt

NucStep_outlet_head.txt

NucStep_ outlet_empty.txt
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File

NucStep_outlet_empty_sd.txt

NucStep_outlet_step.txt
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System diagnostics information can help in troubleshooting network, disk space, and
system status issues.

To access system diagnostics information, click the Admin gear menu (near of top
right of the Torrent Browser) and select About:

Scroll down to the More Information and Assistance section and click the System
Support Diagnostics link:

View System
Support
Diagnostics
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The diagnostics page has Network, System, and Data sections. A small section of each
is shown here:
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Use instrument diagnostics to investigate chip and sequencing instrument issues,
such as pH levels

To access the instrument diagnostics information, click the Admin gear menu (near of
top right of the Torrent Browser) and select About:

Scroll down to the More Information and Assistance section and click the Instrument
Diagnostics link:

View Instrument
Diagnostics
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The instrument diagnostics page lists the sequencing instruments associated with
each of your results partitions. Passed and failed analysis runs are shown for each
instrument. To investigate a failed run, click the View log link for that run:
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The InitLog.txt file opens for that run on the instrument:

The InitLog.txt file includes diagnostic measurements and if possible presents a
probable cause and suggests next steps.

QMON is a graphical tool to monitor and manage the SGE Cluster. With QMON you can
do tasks such as the following:

• See the status of the servers in the cluster
• Check server CPU load and memory utilization
• See the status of jobs, are they running, completed, or still waiting in the queue
• Disable servers from accepting new jobs, and re-enable them later
• Delete jobs that are currently processing or waiting in queue
• And many other advanced configuration options

Manage your SGE
Cluster with
QMON
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SGE is typically used in a cluster of several servers to distribute data processing jobs.
With the Torrent Server, SGE is used in the cluster configuration and also in the
single-server configuration. This design makes it it easy for users to start with one
server and add more "compute nodes," as needed, to ramp up the data processing
capacity.

Client OS support

A GUI is not installed on Torrent Server. Use ssh to start QMON remotely,

To display QMON on your desktop, you need a client that supports the X Windows
protocol; a Linux™ client automatically includes X Windows support. There are
numerous software packages that add X Windows functionality to Windows™, but the
easiest and most economical solution is to run Linux™ in a virtual machine on a
Windows™ system.

Start QMON

To start QMON, login to the server with ssh, and include the -X option, this tells the
server that you are going to be using an application that uses the X Windows display.

ssh -X ionadmin@ion-torrent-server

After you are logged into the server, just type QMON from the command line to launch
the tool.

ionadmin@ion-torrent-server:~$ qmon

The server should be preconfigured to support QMON so you should not get any error
message.

The most common error is that you forgot the -X option, which causes the following
error when you try to start QMON:

ionadmin@ion-torrent-server:~$ qmon

Error: Can't open display:

Shortly after entering the QMON command, the "Grid Engine" splash screen should
appear, indicating your X Windows display is working. If you are on a slow
connection, it may take a few seconds for the tool to launch. After a short time, the
splashscreen automatically disappears.
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When you see the following toolbar, QMON is ready to use:

There are many buttons here to access advanced options. Typically, only use the first
two buttons on the upper-left: Job Control and Queue Control.

Job Control

The Job Control screen shows you the job status.

IMPORTANT! The display does not automatically refresh, so remember to click
Refresh to update the status.

Tab Description

Pending Jobs Jobs that are in the queue waiting to be
process.

Running Jobs Jobs currently being processed.

Finished Jobs Jobs that have completed processing.

You can delete jobs from this screen by highlighting the job then pressing the Delete
button.
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Queue Control

The Queue Control Screen shows the different servers that are available for processing
jobs.

the used/total column shows the number of jobs currently running on the server
( used), and the number of processing slots available on the server ( total). This
example shows seven processing slots available and six jobs currently being
processed.

IMPORTANT! There are four queues:

· tl.q Top level control jobs
· all.q Analysis jobs
· plugin.q Plugin jobs
· thumbnail.q Ion Proton™ thumbnail analysis jobs

To show the status of all jobs, enter the command: qstat -f.

For jobs indicating an error, where an "E" is displayed in the last column of the job
status, clear the error using one of the following methods:

• Enter the command qmod -cq all.q on the command line.
• Login to QMON and, for any queues are marked with "E," highlight the entry and

click the Clear Error button.
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Monitor Your Torrent Server and Torrent Suite™ Software

Use the admin Services tab to view the current status of the essential system services:

Access the Services tab from the admin gear menu and select Services:

IMPORTANT! The Job Server and ionCrawler services should always be active. The
Archive service is only active if archiving has been configured.

The Jobs Server panel lists services used by Torrent Suite™ Software.Jobs Server
service
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During normal operation each service's status is "Running". A status of "Down"
indicates the service should be restarted.

Job requests are initiated by clicking the Analyze button for a given run or by
specifyingauto‑analysis on the Ion PGM™ or Ion Proton™ Sequencer for the run. After
data transfer following an Ion PGM™ or Ion Proton™ Sequencer auto-analysis
completes, an analysis job starts automatically for that run.

Up to two jobs can be run concurrently, by default, using the Sun Grid Engine (SGE).
Running jobs in parallel results in a longer run time for each job but gives a shorter
overall processing time compared to running the jobs concurrently.

In the Active Jobs panel, you can stop a job by clicking Terminate on the line for the
job:

The ionCrawler panel displays information about processes that transfer data from
Ion PGM™ and Ion Proton™ Sequencers to the Torrent Server.

Start a job

Stop a job

ionCrawler
service
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The RAID Info section presents the status of RAID drives on your Torrent Server:

The Show Details link opens a popup with details of the RAID drives (only one
shown here):

Refresh your browser to see changes in status. This information is not updated
automatically.

RAID Info
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Screen descriptions

Planned Runs screen

How to… Learn more about…

“Create a planned run using AmpliSeq™

DNA template“ on page 30
“Plan Tab“ on page 508

“Plan by sample set“ on page 36 “Templates “ on page 505

“Create multiple planned runs via CSV
upload“ on page 40

“Wizard Plan or Save Chevron“ on page 501

“Create a Planned Run using DNA and
Fusions template“ on page 30

“Plan a run using Generic Sequencing
template“ on page 32

“Plan a run using Ion 16S™ Target
Sequencing template“ on page 170

“Copy a template“ on page 32

“Create a Template with Ion AmpliSeq.com
Import“ on page 34

Plan > Samples screen

How to… Learn more about…

“Enter new sample“ on page 20 “Sample information“ on page 25

“Create sample sets manually“ on page 21 “Sample attributes“ on page 23

“Import samples to create a sample set“ on
page 21

“CSV Metrics File Format“ on page 516

“Create multiple planned runs via CSV
upload“ on page 40

“Search samples“ on page 26

“Edit samples“ on page 26

“Delete samples“ on page 27

“Sort samples“ on page 28

Torrent Suite™ Software Help 493



Plan > Templates screen

How to… Learn more about…

“Create a planned run using AmpliSeq™

DNA template“ on page 30
“Plan Tab“ on page 508

“Create a Planned Run using DNA and
Fusions template“ on page 30

“Templates “ on page 505

“Plan a run using Generic Sequencing
template“ on page 32

“Wizard Plan or Save Chevron“ on page 501

“Plan a run using Ion 16S™ Target
Sequencing template“ on page 170

“Copy a template“ on page 32

“Create a Template with Ion AmpliSeq.com
Import“ on page 34

“Plan by sample set“ on page 36

Plan > Planned Run List screen

How to… Learn more about…

“Execute a run plan on your sequencer“ on
page 59

“Plan Tab“ on page 508

“Start your planned run on the Ion S5™ or
Ion S5™ XL sequencer“ on page 98

“Customizing and editing templates“ on
page 29

“Wizard Plan or Save Chevron“ on page 501

“Example Planned Runs page“ on page 515

Monitor > Runs in Progress screen

How to… Learn more about…

“Review the planned run settings“ on
page 63

“Monitor tab“ on page 61

“Example monitoring metrics“ on page 61

“Views“ on page 62

“Auto Update“ on page 63

Screen descriptions
Plan > Templates screen
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Monitor > Ion Chef screen

How to… Learn more about…

“Analyze Ion AmpliSeq™ on Ion Chef™

samples“ on page 42

Plan > Planned Run List screen

How to… Learn more about…

“Execute a run plan on your sequencer“ on
page 59

“Plan Tab“ on page 508

“Start your planned run on the Ion S5™ or
Ion S5™ XL sequencer“ on page 98

“Customizing and editing templates“ on
page 29

“Wizard Plan or Save Chevron“ on page 501

“Example Planned Runs page“ on page 515

Data > Completed Runs & Results screen

How to… Learn more about…

“Manage completed runs and results“ on
page 67

“Test fragment report“ on page 137

“Search for a run“ on page 68 “Analyze Ion AmpliSeq™ on Ion Chef™

samples“ on page 42

“Add a run to a project“ on page 72 “Plugin Summary“ on page 175

“Terminate an analysis run“ on page 73

“Change the analysis reference“ on page 74

“Change run metadata“ on page 74

“Add barcoding to a completed run“ on
page 75

“View the Data Management log“ on
page 69

“Delete, archive, or export run data“ on
page 68

“Reanalyze a run“ on page 70

“Edit a run plan“ on page 70

Screen descriptions
Monitor > Ion Chef screen
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Run Report

How to… Learn more about…

“Review pre-alignment metrics“ on
page 111

“Introduction“ on page 110

“Review alignment metrics“ on page 112 “ISP density“ on page 121

“Download results set“ on page 112 “ISP summary“ on page 124

“Manually run a plugin on the run
results“ on page 112

“Read length“ on page 128

“Review the planned run settings“ on
page 114

“Key signal“ on page 122

“Review the test fragments and their quality
metrics“ on page 115

“Output files“ on page 135

“Run metrics overview“ on page 118

“Review Chef Summary“ on page 115 “Predicted quality (Q20)“ on page 119

“Review Calibration Report“ on page 116 “Quality following alignment (AQ20)“ on
page 119

“Review analysis information“ on page 116

“Compare run reports“ on page 118

“Tune Ion Reporter™ Uploader speed
parameters“ on page 297

Data > Projects screen

How to… Learn more about…

“Add a run to a project“ on page 72 “The Projects tab“ on page 101

“Download a CSV file of metrics“ on
page 107

“The Projects Listing Page“ on page 103

“Add to Project“ on page 108 “Project menus and actions“ on page 107

“Remove from Project“ on page 108 “Actions on members of a project“ on
page 108

“Search“ on page 108 “Mark as Duplicates Read“ on page 108

“Filter by date“ on page 109

Screen descriptions
Run Report
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Data > Data Management screen

How to… Learn more about…

“Access the database“ on page 79 “Data Management tab“ on page 404

“Set up TorrentNAS storage device“ on
page 445

“Configuration“ on page 404

“Monitor TorrentNAS storage device“ on
page 446

“Data Import“ on page 405

“Archive files on TorrentNAS storage
device“ on page 446

“Disk Usage“ on page 406

“Active Data Management Jobs“ on
page 407

“Category Statistics“ on page 407

“Disk Space Management“ on page 408

“Dataflow file sizes“ on page 524

Analysis Parameters screen

How to… Learn more about…

“Configure Custom Analysis
Parameters“ on page 526

References screen

How to… Learn more about…

“Upload a new reference file“ on page 323 “Prerequisites“ on page 323

“Add the Ion GRCh38 Reference to Torrent
Suite™ Software“ on page 320

“GRCh38 human reference“ on page 320

“Upload the reference“ on page 324 “Error handling“ on page 327

“Manage Target Regions Files and Hotspot
Files“ on page 331

“Target Regions Files and Hotspot Files“ on
page 327

“Modify a BED file“ on page 333 “BED File Formats and Examples“ on
page 340

“Download a hotspots or target regions
file“ on page 338

“Target Regions File Formats“ on page 340

“Delete a hotspots or target regions file“ on
page 339

“RNA Fusions BED File Formats and
Examples“ on page 350

Screen descriptions
Data > Data Management screen
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Services screen

How to… Learn more about…

“Verify Functionality“ on page 433 “Alternate checks“ on page 433

“Check Crawler and Job Server status“ on
page 468

“Restart services“ on page 471

“Monitor Your Torrent Server and Torrent
Suite™ Software“ on page 490

Plugins screen

How to… Learn more about…

“Enable an installed plugin“ on page 173 “Available plugins“ on page 178

“Delete a plugin“ on page 174 “Plugin configuration“ on page 181

“Enable or disable automatic plugin
execution“ on page 174

“Admin plugin configuration area“ on
page 182

“Modify and apply TVC settings for all or
select barcodes“ on page 250

“ERCC Analysis Plugin“ on page 204

“Add, edit and delete configurations“ on
page 251

“The FileExporter Plugin“ on page 212

“The FilterDuplicates Plugin“ on page 218

“Overview“ on page 285

“Pharmacogenomics Research Analysis
Plugin“ on page 143

“Run RecognitION Plugin“ on page 221

“Ion RNASeq Plugin“ on page 144

“The SampleID Plugin“ on page 224

“The RunTransfer Plugin“ on page 227

“The Partek Flow Uploader Plugin“ on
page 232

“Introduction“ on page 235

Screen descriptions
Services screen
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Configure screen

How to… Learn more about…

“Add Customer Support Contacts“ on
page 383

“Administration“ on page 379

“Change the displayed server name“ on
page 384

“Nightly email configuration“ on page 384

“Configure Chips“ on page 385 “Database Administration“ on page 385

“Configure Global Configs“ on page 387

“Add a configuration“ on page 388

“Change an existing configuration“ on
page 389

“Configure Experiments“ on page 389

“Modify an experiment“ on page 390

“Delete an experiment“ on page 391

“Configure Users“ on page 392

“Delete Multiple Users“ on page 397

“Configure Basecaller Default
Parameters“ on page 398

“Configure LIMS Metadata export from
Planned Runs“ on page 401

“Approve User Account Requests“ on
page 402

Ion Reporter configure screen

How to… Learn more about…

“Configure your Ion Reporter™ Uploader
Plugin Access Credentials“ on page 285

“In the plugin configuration page“ on
page 314

“Configure the Uploader plugin in the
Torrent Browser“ on page 316

“Multiple configurations“ on page 316

“Manual launch of the IonReporterUploader
plugin“ on page 300

“Configuration errors“ on page 319

“Tune Ion Reporter™ Uploader speed
parameters“ on page 297

“Advanced settings“ on page 296

Screen descriptions
Configure screen
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Account Settings

How to… Learn more about…

“Approve User Account Requests“ on
page 402

“Approval and rejection“ on page 403

Product and Plugin updates

How to… Learn more about…

“Enable Off-cycle Product Updates“ on
page 467

“Update off-cycle release plugins“ on
page 467

Screen descriptions
Account Settings
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Reference

Wizard Plan or Save Chevron

The title for last chevron of the wizard is different for templates, run plans, and run
plans that are planned by sample set:

• Templates The chevron title is Save. Here you enter the new template name and
optionally mark it as a favorite.

• Run plans The chevron title is Plan. Here you enter the new run plan name and
sample information.

• Plan by sample set The chevron title is Save & Finish. Here you enter the new
run plan name. (Sample information is automatically entered into the Barcoding
chevron.)

Note: Templates that are marked as favorites are listed in their own section at the top
of the Templates tab.

Wizard Ion Reporter Page

Ion Reporter is the first page in the Torrent Browser run template wizard. When you
select an Ion Reporter account in this page, features related to Ion Reporter™ Software
appear in the other wizard pages.

These selections on this page are only for Ion Reporter™ Software users.
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Wizard Application Page

In the Application page you select your experiment type:

Based on the information that you specify here, the Kits page is set with the
appropriate selections.

Notes about the Application choices:
• Metagenomics is reserved for future use with Ion Reporter™ Software.
• Typing is used for molecular fingerprinting to detect single strains of viral or

bacteria for research purposes.

Wizard Kits Page

On the Kits wizard page, enter the following information about laboratory kits and
other sequencing parameters:

• (Optional) Sample preparation kit
• Library kit type, including the forward library key and the forward 3' adapter
• Templating kit type
• Sequence kit
• Number of flows
• Barcode set Required for barcoded runs
• Base calibration mode
• Control sequence Required for RNA runs
• Chip type Required
• Mark PCR Duplicates Not recommended for Ion AmpliSeq™ data

Chip type is required. As with all fields, if you enter chip type in your templates, then
it is automatically entered in your run plans.

Reference
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New in version 5.2, smart filtering is enabled on the Kits screen. When you select an
instrument, the Chip Type options are filtered so that you cannot select an
incompatible chip in error.

Example Kits page:

Note: The value entered for number of flows represents the maximum possible for a
run using a planned run based on this template. Instrument conditions such as the
availability of consumables might cause fewer flows to be completed.

Beginning in Torrent Suite 4.4, there is a base calibration mode drop-down menu. For
Torrent Suite™ Software v5.2, this menu contains four options: Default Calibration,
Enable Calibration Standard, Blind Calibration, and No Calibration. (Previously, in
Torrent Suite™ Software v4.2, you could choose to Enable Base Recalibration or not.)
You can select the base calibration method during run planning and in the reanalysis
menu.

Default Calibration – allows a random subset of wells to be used for base calibration.
(This is equivalent to the default setting for Torrent Suite™ Software v4.2 and earlier,
i.e., a checked Enable Base Recalibration check box). This option uses TMAP to align
the training subset of wells and is recommended if a good reference for the template is
available.

Blind Calibration – uses the same random subset of wells as Default Calibration but
does not require an alignment step to generate the calibration model. This option is
recommended if the template does not align well to a reference genome or if no
reference is specified.

Enable Calibration Standard – allows wells belonging to the Calibration Standard to
be selected as training subset.

The Calibration Standard is a small panel consisting of known sequence content with
comprehensive and uniform representation of long homopolymers (up to 10-mers).
The calibration standard can be spiked into Ion S5™, Ion PGM™, and Ion Proton™

Base Calibration
mode options
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runs as a quality control for higher homopolymer performance and as a known
reference for base recalibration.

The Calibration Standard is designed for use in combination with IonXpress or
IonCode barcoded libraries. The calibration standard sequences are around 200 base
pairs in length. Dor best results, the DNA templates should have similar read lengths.

Please note that this method of base calibration only works if calibration standard
beads were spiked into the run. A summary of the number of calibration standard
beads found can be viewed under the Calibration Report tab on the run page.

Wizard Plugins Page

In the Plugins page, you select plugins to run with this run plan or to run every time a
run plan is created from this run template:

Note:
· The plugins available to you depend on what is installed and configured in your

Torrent Browser.
· All active plugins (those installed, configured, and enabled on your Torrent

Browser) are available in this menu.
· The IonReporterUploader plugin does not appear on this page.
· When you enable the variantCaller plugin, a Configure link appears for that

plugin. For information on configuring the variantCaller (TVC) plugin.

Reference
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Wizard Projects Page

In the Projects page, you select projects the will receive the completed analysis from
this run plan or from every time a run plan is created from this run template:

You can also create a new project in this page.

Templates 

Torrent Suite™ Software includes many planned run templates to simplify your
sequencing. Most templates have a corresponding Ion AmpliSeq™ panel. The
following describe a template:

• A canned set of instructions for both your sequencing run and your post-
sequencing data analysis.

• A digital protocol with specifications for almost your entire experiment, from
sample preparation through sequencing, data analysis, and data export to other
systems for additional analysis. (A plan template is missing only the sample
name, from your experiment information.)

• A sample planned run that you can copy to quickly create actual planned runs
with known defaults and settings.

• A reusable set of laboratory, sequencing, data analysis, and data management
instructions.

Reference
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These steps describe how a plan template fits into your Ion S5™, Ion S5™ XL, Ion
PGM™ or Ion Proton™ sequencing workflow:

• Decide what sequencing application and sequencing product (such as an Ion
AmpliSeq™ panel) you will use.

• Select a pre-installed template with defaults for your application and sequencing
product, or create your own template from scratch. Then, customize your
template.

• Copy the template to a new planned run, adding the name of the tissue sample to
be sequenced. The Torrent Browser assigns your new plan a run code.

• Enter the run code directly on the Ion sequencing instrument to initiate the
sequencing. The planned run automates the process from sequencing through
data analysis and data handling.

With the planned run wizard, you can create a new planned run with only a few
clicks and the entry of the sample name. With the Plan Multiple feature, you
download a CSV and customize it to create multiple planned runs without using the
planned run wizard.

Plan templates play an important role in enabling rapid throughput across your
sequencing instrument. Templates also help reduce the chance of error, by listing the
reagent kits used on the instrument.

The Plan4Templates screen contains your experiment templates. These include pre-
installed product templates (for instance for products such as the Ion AmpliSeq™

panels) and as well as templates that you create, and areas for recently-used templates
and ones you mark as favorites. Product templates contain the appropriate defaults
for a product, including the default kits, BED files, and reference.

Templates are organized by sequencing application (and by product for some
applications):

• AmpliSeq DNA Ion AmpliSeq™ applications, including the Ion AmpliSeq™

Comprehensive Cancer Panel, Ion AmpliSeq™ Inherited Disease panels.
• AmpliSeq RNA Ion AmpliSeq™ RNA applications, including the Ion AmpliSeq™

Transcriptome Human Gene Expression Panel and Ion AmpliSeq™ RNA Panel.
• DNA and FusionsIon AmpliSeq™ fusion applications, including the Ion

AmpliSeq™ Colon Lung v2 with RNA Lung Fusion Panel and Ion AmpliSeq™

Lung Fusion Panel.
• Generic Sequencing Your own applications that do not fit in the other categories.

With a generic sequencing template, you provide the settings for the experiment.
Your choices are not restricted based on the logic of an application workflow, and
it is theoretically possible to create a flawed template.

• Pharmacogenomics Ion AmpliSeq™ Pharmacogenomics Research Analysis Panel.
• RNA Seq RNA sequencing applications.
• TargetSeq TargetSeq™ products and other targeted resequencing applications,

with parameters optimized for hybridization-based target enrichment.
• Whole‑Genome Seq Whole genome sequencing applications, which do not

assume enrichment and do not require a target regions file.
• 16S Target Sequencing Ion AmpliSeq™ 16S metagenomics applications.

The template page also has groups for recently-used templates and for templates that
you mark as your Favorites.

Plan > Template
screen
organization
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Templates 

506 Torrent Suite™ Software Help



You can also create a template from your Ion AmpliSeq™ Designer.

You can create your own template in order to have specific customization that is not
available in the pre-installed templates. Examples of customization include the
following:

• Custom plugin usage.
• Use of custom BED file for regions of interest or hotspot locations.
• Automatic inclusion of result sets into one or more projects, for convenient data

management step later on.
• Automatic export of results sets to other analysis systems, such as to the Ion

Reporter™ Software system.

In general, you start with the product template or application template that most
closely matches your research requirements, copy that template, make your custom
changes in the template wizard, and save your new template under a new name.

Your new template appears in the same application group as the original template.
You optionally can also mark the new template to appear in your Favorites template
group.

IMPORTANT! Valid characters in a template or plan name are the following: alpha-
numeric, dashes, underscores, spaces, and periods.

Commas are not allowed in a plan or template name.

Templates are organized by sequencing application (and by product for some
applications):

• AmpliSeq DNA Ion AmpliSeq™ applications, including the Ion AmpliSeq™

Comprehensive Cancer Panel, Ion AmpliSeq™ Inherited Disease panels.
• AmpliSeq RNA Ion AmpliSeq™ RNA applications, including the Ion AmpliSeq™

Transcriptome Human Gene Expression Panel and Ion AmpliSeq™ RNA Panel.
• DNA and FusionsIon AmpliSeq™ fusion applications, including the Ion

AmpliSeq™ Colon Lung v2 with RNA Lung Fusion Panel and Ion AmpliSeq™

Lung Fusion Panel.
• Generic Sequencing Your own applications that do not fit in the other categories.

With a generic sequencing template, you provide the settings for the experiment.
Your choices are not restricted based on the logic of an application workflow, and
it is theoretically possible to create a flawed template.

• Pharmacogenomics Ion AmpliSeq™ Pharmacogenomics Research Analysis Panel.
• RNA Seq RNA sequencing applications.
• TargetSeq TargetSeq™ products and other targeted resequencing applications,

with parameters optimized for hybridization-based target enrichment.
• Whole‑Genome Seq Whole genome sequencing applications, which do not

assume enrichment and do not require a target regions file.
• 16S Target Sequencing Ion AmpliSeq™ 16S metagenomics applications.

The template page also has groups for recently-used templates and for templates that
you mark as your Favorites.

You can also create a template from your Ion AmpliSeq™ Designer.

Template
customization

Plan > Template
screen
organization
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Plan Tab

The Plan tab offers several routes for starting your sequencing experiments. The
preferred way is to use a plan template in the Plan4Template tab to create a digital
protocol with specifications for almost your entire experiment, from sample
preparation through sequencing, data analysis, and data export to other systems for
additional analysis. From the template, you create one or more planned runs, which
execute directly on your Ion S5™, Ion S5™ XL, Ion PGM™ or Ion Proton™ sequencing
instrument.

Other ways to begin a sequencing run include:
• In Plan4Plan Runs, you can plan a sequencing run by sample type or template

run.
• In Plan4Samples, you can start a run by clicking the gear button and selecting

Plan Run.
• In Plan4Planned Run List gear button, Copy, to make a copy of an existing run.

The workflow below describes how templates and planned runs fit into your
sequencing workflow:

1. Determine your sequencing application and sequencing product (such as an Ion
AmpliSeq™ panel).

2. Select a pre-installed template with defaults for your application and sequencing
product, or create your own template from scratch. Customize your template.

3. Copy the template to a new planned run, adding the name of the tissue sample
to be sequenced. The Torrent Browser assigns your new planned a run code.

4. Enter the run code directly on the Ion sequencing instrument to initiate the
sequencing. The planned run automates the process from sequencing through
data analysis and data handling.

Typically, you create and organize templates, and create planned runs in the
Plan4Templates tab. You review planned run settings, edit, delete, or copy planned
runs in the Plan4Planned Runs tab.

The Plan4Planned Runs page contains planned runs which are ready to execute on
your sequencing instrument. A planned run is an electronic protocol of everything
required for a sequencing run, from reagent kits to sample name to genome reference,
data analysis, and data management. You create each planned run from an
application template (either from a product template or from your own template).

Templates and planned runs provide alternate methods (and timing) of entering the
same data that is otherwise entered on the Ion sequencing instrument, for example on
the Ion PGM™ Run Info screen. With templates and planned runs, you can enter the
information in advance, and have an opportunity to print and review your entries.
Use of templates and planned runs reduces your hands-on time on the instrument. If
you do not create planned runs here in the Plan tab, you must enter the run
information directly on the Ion sequencing instrument.

Planned Runs 
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You can your run plans based on your sample sets or on run plan templates.

When you create a planned run, the run plan wizard walks you through each aspect
of your new planned run, using pre-populated defaults based on the application
template or product template you choose. The example below shows the defaults in
the reference selections page. The chevrons across the top show the different pages of
the wizard.

To execute a planned run, you select it directly on the sequencing instrument, for
instance on the Ion PGM™ Run Info screen.
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Wizard

When you create a new template or a planned run (from a template), the template
wizard walks you through each aspect of your new template or planned run, using
pre-populated defaults based on the application template or product template you
choose. The example below shows the defaults in the Create Plan page. The chevrons
across the top show the different pages of the wizard.
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Start the wizard

For both templates and planned runs, you start the wizard from the Plan4Templates
page. The steps to start the wizard depend on whether you want to create a planned
run from generic application template or an existing template, or create a template
from generic application template or an existing template.

How you start the wizard is important, especially if your sequencing workflow uses
common sequencing products. Pre-installed templates are available for these common
sequencing products:

• Ion AmpliSeq™ Cancer Hotspot Panel v2.0
• Ion AmpliSeq™ Comprehensive Cancer Panel
• Ion AmpliSeq™ Inherited Disease Panel
• Ion AmpliSeq™ Cancer Panel
• Ion AmpliSeq™ Any Genome Panel

If you start with a pre-install product template, your new template or planned run has
the correct settings for the product.

Wizard Ion Reporter Page

Ion Reporter is the first page in the Torrent Browser run template wizard. When you
select an Ion Reporter account in this page, features related to Ion Reporter™ Software
appear in the other wizard pages.

These selections on this page are only for Ion Reporter™ Software users.
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Wizard Application Page

In the Application page you select your experiment type:

Based on the information that you specify here, the Kits page is set with the
appropriate selections.

Notes about the Application choices:
• Metagenomics is reserved for future use with Ion Reporter™ Software.
• Typing is used for molecular fingerprinting to detect single strains of viral or

bacteria for research purposes.

Wizard Kits Page

On the Kits wizard page, enter the following information about laboratory kits and
other sequencing parameters:

• (Optional) Sample preparation kit
• Library kit type, including the forward library key and the forward 3' adapter
• Templating kit type
• Sequence kit
• Number of flows
• Barcode set Required for barcoded runs
• Base calibration mode
• Control sequence Required for RNA runs
• Chip type Required
• Mark PCR Duplicates Not recommended for Ion AmpliSeq™ data

Chip type is required. As with all fields, if you enter chip type in your templates, then
it is automatically entered in your run plans.

New in version 5.2, smart filtering is enabled on the Kits screen. When you select an
instrument, the Chip Type options are filtered so that you cannot select an
incompatible chip in error.
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Example Kits page:

Note: The value entered for number of flows represents the maximum possible for a
run using a planned run based on this template. Instrument conditions such as the
availability of consumables might cause fewer flows to be completed.

Wizard Plugins Page

In the Plugins page, you select plugins to run with this run plan or to run every time a
run plan is created from this run template:
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Note:
· The plugins available to you depend on what is installed and configured in your

Torrent Browser.
· All active plugins (those installed, configured, and enabled on your Torrent

Browser) are available in this menu.
· The IonReporterUploader plugin does not appear on this page.
· When you enable the variantCaller plugin, a Configure link appears for that

plugin. For information on configuring the variantCaller (TVC) plugin.

Wizard Projects Page

In the Projects page, you select projects the will receive the completed analysis from
this run plan or from every time a run plan is created from this run template:

You can also create a new project in this page.
Wizard Plan or Save Chevron

The title for last chevron of the wizard is different for templates, run plans, and run
plans that are planned by sample set:

• Templates The chevron title is Save. Here you enter the new template name and
optionally mark it as a favorite.

• Run plans The chevron title is Plan. Here you enter the new run plan name and
sample information.

• Plan by sample set The chevron title is Save & Finish. Here you enter the new
run plan name. (Sample information is automatically entered into the Barcoding
chevron.)

Note: Templates that are marked as favorites are listed in their own section at the top
of the Templates tab.
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The following is an example of a Planned Runs page with several planned runs.

The following table describes the Planned Runs page contents.

Column heading Description

Run Code A short code identifying the planned run.

Run Plan Name Name of the planned run.

Barcodes Name of the DNA barcode set, if any.

Application An icon identifying the sequencing
application (such as whole genome, RNA
Seq, etc.)

Example Planned
Runs page
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Column heading Description

Project Name of the project to contain the output
result sets.

Note: You can automate result sets going
to more than one project. Only one project
is shown here.

Sample Name of the sample to be sequenced.

Sample Tube Label Name of sample's tube.

Chip Barcode Chip's barcode.

Library Name of the reference library used.

Last modified Time stamp of the last time the planned run
was created or changed.

Status Only runs with status of "planned" can be
selected on the sequencing instrument.

A new planned run for the Ion Chef™

System is first set to "pending". The
instrument updates the plan to "planned"
when the plan is ready to be selected on
instrument.

Gear menu The gear menu on the right side of a
planned run allows you to review, edit, copy,
or delete the planned run:

CSV Metrics File Format

A Comma-Separated Value (CSV) file is a universal text file format for storing data.
You can download an analysis metrics CSV file that contains analysis-level
information for one or more Torrent Suite™ Software analysis runs, in the Torrent
Browser Projects > ProjectsName > Results Sets in ProjectName page.

In the CSV file, each line represents a Torrent Suite™ Software analysis run, and within
each line information fields are separated by a comma. These files are easily opened
using spreadsheet software, such as Microsoft™ Office Excel™ or OpenOffice.org Calc,
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where each comma-separated field is listed in a separate column. The Torrent Browser
CSV file has many CSV fields per entry, as described in the following table:

Field Description

Report Name of the analysis run report

Status Status of the analysis (e.g., Started,
Complete)

Flows Number of flow cycles from the actual
sequencing run

TF Name* Test Fragment Name

Q10 Mean* Average Q10 read length.

Q17 Mean* Average Q17 read length

System SNR* System Signal-to-Noise Ratio

50Q10 Reads* Number of TF Ion Sphere™ Particles (ISP) at
50+ bp at Q10

50Q17 Reads* Number of TF Ion Sphere™ Particles (ISP) at
50+ bp at Q17

Keypass Reads* Number of reads that have test fragment
keys

TF Key Peak Counts* Signal strength of the first three bases of
the TF key

Total_Num_Reads Total number of reads

Library_50Q10_Reads Reads of length at least 50bp with 90% or
greater accuracy

Library_100Q10_Reads Reads of length at least 100bp with 90% or
greater accuracy

Library_200Q10_Reads Reads of length at least 200bp with 90% or
greater accuracy

Library_Mean_Q10_Length Average length of reads with 90% or greater
accuracy

Library_Q10_Coverage Average per base coverage considering
reads with 90% or greater accuracy

Library_Q10_Longest_Alignment Longest read length amongst reads with
90% or greater accuracy

Library_Q10_Mapped Bases Total bases from reads with 90% or greater
accuracy

Library_Q10_Alignments Number of alignments from reads with 90%
or greater accuracy
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Field Description

Library_50Q17_Reads Reads of length at least 50bp with 98% or
greater accuracy

Library_100Q17_Reads Reads of length at least 100bp with 98% or
greater accuracy

Library_200Q17_Reads Reads of length at least 200bp with 98% or
greater accuracy

Library_Mean_Q17_Length Average length of reads with 98% or greater
accuracy

Library_Q17_Coverage Average per base coverage considering
reads with 98% or greater accuracy

Library_Q17_Longest_Alignment Longest read length amongst reads with
98% or greater accuracy

Library_Q17_Mapped Bases Total bases from reads with 98% or greater
accuracy

Library_Q17_Alignments Number of alignments from reads with 98%
or greater accuracy

Library_50Q20_Reads Reads of length at least 50bp with 99% or
greater accuracy

Library_100Q20_Reads Reads of length at least 100bp with 99% or
greater accuracy

Library_200Q20_Reads Reads of length at least 200bp with 99% or
greater accuracy

Library_Mean_Q20_Length Average length of reads with 99% or greater
accuracy

Library_Q20_Coverage Average per base coverage considering
reads with 99% or greater accuracy

Library_Q20_Longest_Alignment Longest read length amongst reads with
99% or greater accuracy

Library_Q20_Mapped_Bases Total bases from reads with 99% or greater
accuracy

Library_Q20_Alignments Number of alignments from reads with 99%
or greater accuracy

Library_Key_Peak_Counts Signal strength of the first three bases of
the library key

Library_50Q47_Reads Number of perfect reads of length at least
50bp

Library_100Q47_Reads Number of perfect reads of length at least
100bp
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Field Description

Library_200Q47_Reads Number of perfect reads of length at least
200bp

Library_Mean_Q47_Length Average length of perfect reads

Library_Q47_Coverage Average per base coverage considering only
perfect reads

Library_Q47_Longest_Alignment Longest reads length amongst perfect
reads

Library_Q47_Mapped_Bases Total bases from perfect reads

Library_Q47_Alignments Number of alignments from perfect reads

Library_CF CAFIE metric: Carry forward

Library_IE CAFIE metric: Incomplete extension

Library_DR CAFIE metric: Signal/polymerase loss
(droop)

Library_SNR System Signal-to-Noise Ratio

Sample Name of the sample

Library Name of the reference genome

Notes Any additional user-provided notes

Run Name Long name of the analysis run

PGM Name Name of the Ion PGM™ or Ion Proton™

instrument where the sample was
sequenced

Run Date Date the sample was sequenced

Run Directory Location of the raw DAT files on the Torrent
Server

Num_Washouts NA

Num_Dud_Washouts NA

Num_Washout_Ambigous NA

Num_Washout_Live NA

Num_Washout_Test_Fragment NA

Num_Washout_Library NA

Library_Pass_Basecalling NA

Library_pass_Cafie NA

Number_Ambiguous NA
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Field Description

Number_Live Number of wells producing a signal

Number_Dud Number of wells with ISPs but no signal

Number_TF Number of wells containing test fragment

Number_Lib Number of wells containing library

Number_Bead Number of wells containing beads

Library_Live Number of wells containing library ISP with
signal

Library_Keypass Number of wells containing library ISP with
signal and match key

TF_Live Number of wells containing test fragment
ISP with signal

TF_Keypass Number of wells containing test fragment
ISP with signal and match key

Keypass_All_Beads Number of wells containing ISP with signal
and match key

P JSON string of plugin data

s JSON string of plugin data

* Columns 4-11 contain test fragment metric. There is one row of metrics for each test
fragment: A through D. The other columns contain library read metrics.

Per-Base Quality Score System

The Ion Torrent™ per-base quality score system uses a Phred-like method to predict
the probability of correct base call. The prediction is based on the quality of the base
incorporation signal that was used for generating the base calls. The sequencers'
quality score system uses a set of 6 predictors whose values are correlated with the
probability of a base miscall.

A Phred lookup table is used for converting the values of predictors to error
probabilities. The lookup table is generated by training on a representative data set in
customer configuration. The lookup table is re-trained for each software release and is
shipped as part of the software package. Quality scores are published in the BAM file.

Torrent software uses the following six predictors that are correlated with empirical
base call quality:

P1 Penalty Residual: A penalty based on the difference between predicted
and actual flow values. Computed by the base caller.

P2 Local Noise: Noise (defined as the maximum absolute difference
between the flow value and the nearest integer) in the immediate
neighborhood (plus/minus 1 base) of the given base.

Quality Score
Predictors
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P3 High-Residual Events: Number of high-residual flows in the 20-flow
window around the flow containing the base. A flow has high residual
when the normalized difference between the observed and model-
predicted signal exceeds 0.4 or falls below –0.4. The more high-
residual flows in the window, the lower quality the base call.

P4 Multiple Incorporations: Number of incorporated bases in this flow.
Length of the homopolymer. For multiple incorporations of the same
nucleotide in one flow, the last base in the incorporation order is
assigned a value equivalent to the total number of incorporations. All
other bases in the sequence of the multiple incorporations are
assigned the value 1.

P5 Environment Noise: The average signal noise (defined as the absolute
difference between the flow value and the nearest integer) in the
neighborhood (plus/minus 5 bases) of the given base.

P6 State Inphase: Live polymerase in phase.

The six quality predictors are calculated for each base. Other predictors (not described
here) are computed from the corrected flow values generated by the base caller.

The corresponding per-base quality value is located by finding the first line in the
lookup table for which all six calculated predictors are less than or equal to the
predictor values in the table. This process occurs automatically as part of the standard
analysis.

The Phred lookup tables are stored in the /opt/ion/config directory on Torrent Server.
The Torrent Server supports separate phred tables for each type of chip (Ion 314™

Chip, Ion 316™ Chip, Ion 318™ Chip, and Ion PI™ Chip), named phredTable.314,
phredTable.316, phredTable.318 , and phredTable.p1.1.17 respectively.

The per-base quality along with all other read information is written to the unmapped
BAM file.

The per-base quality scores are reported in the QUAL field.

The quality scores are on a phred-10*log_10(error rate) scale.
References

1. Brockman et al. (2008): "Quality scores and SNP detection in sequencing-by-
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Ion Torrent BAM format

Ion Torrent BAM files follow the conventions of the SAM/BAM Format Specification
Working Group. SAM stands for Sequence Alignment/Map. .

The purpose of this section is to highlight specific Ion Torrent conventions and the
meaning of custom tags.

Ion Torrent Conventions:
• Run ID: Every TS analysis gets a run ID, a 5-character string consisting of upper

case letters and numbers, assigned. A reanalysis of a specific run will get a
different run ID assigned. Example: 0JU8V.

• Read Group ID: For non-barcoded runs the read group ID is equal to the run ID.
For barcoded runs it is a combination of the run ID and the barcode name,
separated by a dot. Example: 0JU8V.IonXpress_001.

• Key Sequences (KS): For non-barcoded runs, the key sequence tag is the Ion
Torrent library key (TCAG). For barcoded runs the KS tag entry includes the
barcode sequence and the barcode adapter sequence if barcode trimming is
enabled.

• SAM record (read) names: Read names are a combination of the run ID and the
chip coordinates of the well that produced the read. The coordinate values are 5-
digit numbers and are given in the order row and the column, separated by a
colon. Example: 0JU8V:01308:00107.

• BAM header comment lines (CO): Comment lines in the BAM header are used to
store base calibration information, or information about the 3' adapter sequences.

Ion Torrent uses a collection of custom tags to store sequencing and alignment
information useful for downstream processing. In general, custom BAM tags starting
with Z or Y are written by the BaseCaller and BAM tags starting with X stem from
TMAP. As a consequence, tags starting with Z or Y are present both in aligned and
unaligned BAM files whereas tags staring with X appear only in aligned BAM files.

Tag Type Description

XA Z The algorithm that produced this mapping and from what
stage. The format is the algorithm name and the zero-

based stage (separated by a dash).

XM i Target Length, i.e., number of reference bases spanned by
the alignment.

XS i The alignment score of next-best sub-optimal mapping.

ZA i Number of library insert bases, where the library insert is
defined as the sequence after the key and barcode adapter,
and before the 3' adapter. (Only present if a 3' adapter was

found.)

ZB i Number of overlapping adapter bases. (Only present if a 3'
adapter was found.)

Custom SAM
Recorder Tags
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Tag Type Description

ZC B:i A vector of the following four values (only present if a 3'
adapter was found):

Field 1: The zero-based flow during which the first base of
the adapter was incorporated (same as ZG)

Field 2: The zero-based flow corresponding to the last
insert base

Field 3: Length of the last insert homopolymer

Field 4: Zero-based index of adapter type found.

ZF i The zero-indexed flow position corresponding to the first
template base after 5' trimmed region.

ZG i The zero-based flow during which the first base of the
adapter was incorporated. (Only present if a 3' adapter was

found.)

ZM B:s Normalized signals, which include phasing effects. Stored
as floor(256*value)

ZP B:f Estimated phase parameters for the read. The values are
stored in the order: CF (carry forward), IE (incomplete

extension), and DR (droop).

ZT Z The trimmed 5’ unique molecular tag sequence. Only
written if a tag was trimmed.

YT Z The trimmed 3’ unique molecular tag sequence. Only
written if a tag was trimmed.

ZE Z The 5’ trimmed sequence removed by the extra-trim-
left command. Only written if a sequence was trimmed.

YE Z The 3’ trimmed sequence removed by the extra-trim-
right command. Only written if a sequence was trimmed.
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Dataflow file sizes

The Ion Torrent™ dataflow involves the transfer of raw sequencing data from the Ion
S5™, Ion S5™ XL, Ion PGM™, or Ion Proton™ sequencer to the Torrent Server for
analysis and reporting.

The following tables show a high-level view of the dataflow. File sizes for Torrent data
depend on the Torrent Suite™ Software version, chip type, and kit type.

The following table shows a high-level view of the dataflow. File sizes for Torrent data
depend on the Torrent Suite™ Software version, chip type, and kit type.

Step Resulting file
type Ion 520™ Chip Ion 530™ Chip Ion 540™ Chip

Read Capacity -- 5 M 15-20 M 60-80 M

Signal
Processing
Input

DAT 210 GB 530 GB 2 TB

Signal
Processing
Output

WELLS 30 GB 75 GB 180 GB

Base Calling
Output

Unaligned BAM 55 GB 75 GB 85 GB

Aligned Output Aligned BAM 10 GB 25 GB 55 GB

Torrent Suite™

Software 5.2/5.0
and 400 bp kit on
the Ion S5™ XL
System
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The following table shows a high-level view of the dataflow. File sizes for Torrent data
depend on the Torrent Suite™ Software version, chip type, and kit type.

Step Resulting file
type Ion 318™ Chip Ion 316™ Chip Ion 314™ Chip

Flows -- 900 900 900

Raw image
acquisition

DAT 396 GB 246 GB 52 GB

Image
processing

WELLS 31.4 GB 18.4 GB 3.5 GB

Signal
processing and
base calling

BAM 6.8 GB 4.5 GB 0.65 GB

CAUTION! File sizes vary depending on the number of flows, the number of
wells generating signal, and the number of library reads available. Your file
sizes may be different. An unmapped BAM file format is used in pipeline steps
before alignment.

.

The following table shows a high-level view of the dataflow. File sizes for Torrent data
depend on the Torrent Suite™ Software version, chip type, and kit type. The following
table shows a high-level view of the dataflow. File sizes for Torrent data depend on
the Torrent Suite™ Software version, chip type, and kit type.

Step Resulting
file type Ion Proton™ Chip Ion 318™

Chip
Ion 316™

Chip
Ion 314™

Chip

Flows -- 500 500 520 520

Raw image
acquisition

DAT 2.7 TB 225 GB 135 GB 30 GB

Image
processing

WELLS 219 GB 16.4 GB 9.0 GB 2.0 GB

Signal
processing
and base
calling

BAM 44 GB 4.2 GB 3.1 GB 0.5 GB

CAUTION! File sizes vary depending on the number of flows, the number of
wells generating signal, and the number of library reads available. Your file
sizes may be different. An unmapped BAM file format is used in pipeline steps
before alignment.

Ion Proton™

dataflow with 4.x
software and 400
bp kit

Ion Proton™

dataflow with 4.x
software and 200
bp kit
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Configure Custom Analysis Parameters

To create custom analysis parameters:

1. Log into Torrent Suite™ Software v5.0 or higher as Admin or User.

2. Click the Gear button and select Analysis Parameters.

The Analysis Parameters page appears. This page contains all the parameters
that exist. Factory parameters are denoted by the Ion icon in the Source column.

3. Select your chip type from the All Chips drop-down menu to see what parameter
sets are available for it. In our example, we chose 318.

4. Pick a set to modify. Click the Gear button in the set's row and select Copy. For
our example, we chose default_318.

The Copy Analysis Parameters screen appears.
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5. Enter a name, description, and make parameter changes. Click Save.

Your new analysis parameter set is now available on the Analysis Parameters
table. Notice the Source column denotes that a user or admin created it.

6. From the Gear button, you can View, Copy, Edit, or Delete this parameter set.

Your custom parameter set is now available for run planning.
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7. On the Edit Plan (or Plan) tab, Analysis Parameters section, select Custom. Then
select your custom parameters from the drop-down menu.

8. Click Details to review the parameters.
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9. You can also access the default and custom analysis parameters from the
Reanalyze Run page:

See “TMAP examples“ on page 544 for steps to open the run report log and search
for the TMAP command. (The analysis must be completed before you can find the
command.)

The Command Line Args (Advanced) tab

An example Advanced Options page is shown here:

Find the TMAP
command for a
specific analysis
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Setting Description

Beadfind args Beadfind module command line arguments.
Should not be modified unless instructed by
Ion Torrent™ Technical Support.

Analysis args Analysis command line arguments. Should
not be modified unless instructed by Ion
Torrent™ Technical Support.

Pre Basecaller args for calibration BaseCaller command line arguments. See
Basecaller arguments for information on
--barcode-mode, --barcode-
cutoff, and --barcode-filter. Other
Basecaller arguments should not be
modified unless instructed by Ion Torrent™

Technical Support.

This field is used only if a Base Calibration
Mode other than 'No Calibration' is used.

Recalibration Args Recalibration command line arguments.

Basecaller args BaseCaller command line arguments. See
Basecaller arguments for information on
--barcode-mode, --barcode-
cutoff, and --barcode-filter. Other
Basecaller arguments should not be
modified unless instructed by Ion Torrent™

Technical Support.

Alignment Args Arguments for the TMAP aligner.

(Replaces the TMAP Args field that appears
in previous releases.)
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Overview of BaseCaller and Barcode Classification

This page discusses BaseCaller operations in general and issues around BaseCaller
parameters, barcode classification, and filtering and trimming.

The settings of BaseCaller parameters control barcode classification as well as filtering
and trimming.

Barcodes are short base sequences that during library preparation are placed between
the library key and the read. The barcode sequences provide a mechanism to
distinguish and identify reads from different samplesduring data analysis.

The use of barcodes allows multiple samples to be sequenced together on one chip
during a sequencing run, and still have the run's read data be analyzed separately
afterward as distinct samples.

This diagram shows the placement of the barcode sequence, as well as the library key
and adapters, with the read sequence (which is labeled "Template Bases"). The key is
on the 5' end.

This example shows the location of the barcode sequence in both base space and flow
space, using barcode IonPress_001 as an example:

About barcodes
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The beginning steps of the Torrent Suite™ Software analysis pipeline are shown below:

Steps:

1. The sequencing instrument generates DAT files of electrical signals' raw traces.
2. The signal processing step converts the raw traces into a single number per flow

per well, in the 1.wells file.
3. The BaseCaller converts the 1.wells file information into a sequence of bases and

writes the sequence into an unaligned BAM file.
4. The BAM file is passed to TMAP for alignment.

The signal processing step also marks several types of low-quality reads:
• Polyclonal reads (reads with two template beads instead of one)
• Reads with high signal processing residual (indicating an ambiguous signal

value)
• Reads that do not contain a valid library key

Thesignal processing step marks these problematic reads but does not remove them.

In addition to creating a sequence of bases from the 1.wells file information, the
BaseCaller module also performs read filtering and read trimming.

Notes on read filtering:
• Filters out low-quality reads that were marked during signal processing.
• Filters out reads that fail basecalling filters.
• Filtered out reads do notappear in the BAM file. The BaseCaller keeps counts of

these reads but there is no record of specific reads that are filtered out.

Analysis pipeline
overview

Overview of
BaseCaller
functionality
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Notes on read trimming:
• Removes certain bases from the read for quality reasons.
• The read appears in the BAM file.
• The removed bases do not appear in theBAM file.

These are the steps performed in the BaseCaller:

1. Remove low-quality reads that were marked during the signal processing step.
2. Do base calling:

1. From the signal values, create the sequence of bases.
2. Estimate the base quality value for each base.

3. Do barcode classification:

1. Assign each read to a barcode.
2. Trim the barcode sequence away if --trim-barcodes=on is specified.

(The default is 'on').
4. Trim 5' unique molecular tag (only done if --trim-barcodes=on).
5. Trim extra bases at the 5' end. Controlled by --extra-trim-left (default is 0,

meaning no extra trimming).
6. Filter out reads that are too short. Controlled by --min-read-length and --

trim-min-read-len.
7. Filter out reads that do not have the correct library key. Can be turned off by --

keypass-filter.

1. Trim 3’ unique molecular tag (only done if P1 adapter was found).
2. Trim extra bases on the 3’ end. Controlled by --extra-trim-right (default is 0,

meaning no extra trimming. Only done if P1 adapter was found).
8. Trim the P1 adapter (at the 3' end).
9. Perform quality trimming. Affect ed by --trim-qual-window-size and --

trim-qual-cutoff.

Notes about quality trimming:
• The purpose of quality trimming is to identify where quality issues begin at the

end of a read. We try to identify when bases fall below a quality threshold and
trim both those bases and a bit before those bases.

• The parameter --trim-qual-window-size sets the window size for quality
trimming. The algorithm slides through the sequence of bases and, each time the
window shifts, computes the mean Base QV value for all bases in the window.

• If the mean Base QV value for all bases in the window falls below a threshold (set
the by parameter --trim-qual-cutoff, default 16), then we trim all bases
from the center of the window at that time to the 5' end.
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Notes about barcode classification and barcode filtering

Barcode classification determines which barcode group a read is assigned to. Barcode
classification is done for each read immediately after base calling.

Barcode filtering determines if a specific barcode is included in the run report or is
filtered out. Barcode filtering works on the barcode groups as a whole

Barcode classification metrics are available in the file basecaller_results/
datasets_basecaller.json in the Torrent Suite™ Software analysis directory.

This file contains information about all barcodes, no matter whether they appear in
the run report or are filtered out. This information describes the numbers of barcodes
that would be included or discarded if you reanalyze with certain changed BaseCaller
settings.

A sample of this file is shown here. Later examples in this page use this file:

"IEXL3.IonXpress_033": { "Q20_bases": 98859279, 
"barcode_adapter": "GAT", "barcode_bias": [ 0.026, -0.028, 
-0.034, 0.011, -0.019, -0.001, 0.072, -0.061, 0.103, -0.008, 
-0.062, 0.110, -0.021, 0.001], "barcode_distance_hist": 
[ 907546, 50122, 10793, 4498, 5342 ], "barcode_errors_hist": 
[ 949782, 24584, 3935 ], "barcode_match_filtered": 162, 
"barcode_name": "IonXpress_033", "barcode_sequence": 
"TTCTCATTGAAC", "description": "1T 058a0112 Lib6457 0bp lr2 
lr226b04", "filtered": false, "index": 33, "library": "hg19/
IonXpress_033", "platform_unit": "PGM/318/IonXpress_033", 
"read_count": 978301, "recalibrate": true, "sample": "None", 
"total_bases": 109292583 },

Read count

The read_count field shows how many reads were assigned to this barcode.

"read_count": 978301,

Filtered

The filtered field is true if this barcode is filtered out and false if the barcode
appears on the run report.

? "filtered": false,

Barcode errors histogram

The barcode errors histogram shows the number of reads with difference levels of
basecalling errors in this barcode:

• First field: The number of reads that have 0 basecalling errors (949782 in this
example). This is the number of reads that perfectly match this barcode (in base
space).

• Second field: The number ofreads that have one basecalling error(24584 in this
example).

• Third field: The number of reads that have two basecalling errors(3935in this
example).

Troubleshooting
Barcode
Classification
Issues

Explanation of
fields in the
BaseCaller JSON
file
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From the 3935 value with 2 basecalling errors, we know that if we reanalyze with the
number of allowed errors set to 1 instead of 2, then 3935 fewer reads will be assigned
to this barcode.

? "barcode_errors_hist": [ 949782, 24584, 3935 ],

This histogram is typical of a real barcode. A large majority of reads are perfect
matches, a few have one error, and a smaller number have two errors.

If the pattern is reversed (with very few perfect matches, some reads with one error,
and many reads with 2 errors), we suspect that this is probably a fake barcode.
Barcode distance histogram

The barcode distance histogram shows, in signal space, the number of reads at various
squared residual distances between the predictedsignal and the observed signal.

The distance fields are given in 0.2 increments:
• The first field gives the number of reads with a squared residual distance of

between 0 and 0.2.
• The second field gives the number of reads with asquared residual distance of

between 0.2 and 0.4.
• The third field gives the number of reads with a squared residual distance of

between 0.4 and 0.6, etc.

Smaller distances reflect better matches of the read to barcode. Larger distances reflect
poorer matches.

This example reflects the pattern that is typical of a real barcode:
• The most reads have shorted distance residuals.
• Fewer reads have larger distance residuals.
• The entry 5342 in the fifth field tells us that reducing --barcode-cutoff to 0.8

would cause those 5342 reads not to be assigned to a barcode.

? "barcode_distance_hist": [ 907546, 50122, 10793, 4498, 
5342 ],

Barcode match filtered

The barcode_match_filtered field gives the number of reads that perfectly
match the barcode in base space and also are filtered out because they do not meet the
separation criteria in signal space. The signal for these reads are in-between two
barcodes and are not close enough to either barcode to be assigned.

? "barcode_match_filtered": 162,
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Barcode bias

The barcode_bias values show the mean signal deviation by flow: how much the
observed signal is off from the expected signal. Low bias values, for example with the
value shown here, are indications of good signal.

Bias values around 0.33 indicate a signal that is about a third of a base off. Values near
0.5 indicate a signal that is half a base off. Values in this range indicate a problem with
the sequencing run or with the barcode classification.

? "barcode_bias": [ 0.026, -0.028, -0.034, 0.011, -0.019, 
-0.001, 0.072,? -0.061, 0.103, -0.008, -0.062, 0.110, -0.021, 
0.001],

BaseCaller arguments

This section describes select arguments used with the BaseCaller module.

This page describes BaseCaller parameters that are available when you reanalyze a
completed run.

Note: The default BaseCaller parameters are tuned for Ion Torrent™ data. In most
cases, you do not need to modify these settings. Modifying these parameters is
recommended for advanced users only.

However, if you use a custom barcode set, please see the cautions and requirements in
Design Custom Barcodes. Correct parameter settings require knowledge of your
barcode's distances in signal space. The BaseCaller defaults are optimized for the
IonXpress barcode set, and likely are not correct for a custom barcode set.

When you reanalyze a run, other parameters are also listed in the BaseCaller
arguments field. These parameters are for internal use please do not change or
remove these fields.

Note: Barcode classification is the process by which reads are assigned to one of the
barcodes present in one analysis run. Correct barcode classification is important
because a classification error results in a read being assigned to the wrong barcode,
which in turn leads to the read beinganalyzed as belonging to a wrong sample.

Barcode classification determines which barcode group a read is assigned to. Barcode
classification is done for each read immediately after base calling.

Barcode filtering determines if a specific barcode is included in the run report or is
filtered out. Barcode filtering works on the barcode groups as a whole.

BaseCaller
Parameters
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This table lists the more common BaseCaller parameters relating to barcode
classification. (All parameters listed in this table are barcode classification
parameters.)

Parameter Default Description

--barcode-cutoff 1.0

(Float)

Maximum distance allowed
in barcode matches. A
threshold that sets the
stringency for barcode
matches. Lower values
require more exact matches
when assigning reads to
barcodes. Higher values
allow less exact matches.

Reads that have a distance
greater than this value are
counted as barcode no-
matches.

--barcode-mode 2

(Integer)

Allowed values: 1, 2

• 1: A barcode is scored
by comparing each read
sequence to each
barcode sequence in a
flow space alignment.
Errors in each flow are
summed over the
length of the barcode
flows.Then any barcode
with a number of errors
equal to or less than
the --barcode-
cutoff value can be
considered, and the
barcode with the fewest
errors with respect to
the input sequence is
the matching barcode.
(The default in 4.0,
known as hard decision
classification.) 2:
Barcode classification
is based on signal
information,specifically
on the squared distance
between the measured
signal and the predicted
barcode signal. (The
default in 4.4, known as
soft decision
classification.)

Note: --barcode-mode
0 is no longer supported.

Barcode
classification
parameters
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Parameter Default Description

--barcode-separation 2.5

( Float)

This setting controls how
much ambiguity in barcode
assignment you want to
tolerate, by investigating the
distances to the both the
closest barcode and to the
next closest barcode. A read
is rejected if the difference
in these two distances is
less than the --barcode-
separation setting.

Note: --barcode-
separation has no effect
when --barcode-mode is
set to 1.
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Parameter Default Description

--barcode-filter-postpone 1 Allowed values: 0, 1, 2

• 0: Keeps the 4.0
behavior: b arcode
filtering is done
independently on each
block. This is the
default for all Ion PGM™

analyses and also for
Ion Proton™ thumbnail
(which only consist of a
single block) processing
and base calibration
training stage
processing.

• 1: BaseCaller does
barcode pre-filtering at
a 10x lower frequency
threshold (10 times
more lenient). B arcode
filtering is done on the
chip's full information
as a whole, after the 96
blocks are merged into
one. This is the default
for Ion Proton™ full-
chip (not thumbnail)
analyses.

• 2: The BaseCaller does
not do any barcode pre-
filtering. All barcode
classification happens
after the 96 blocks are
merged into one. (The
setting "2" is slower
than the setting "1". "2"
creates more files and
involves more
processing than "1".)

Note: We do not
recommend that you change
this parameter. Instead
accept the pipeline defaults
(which are different for Ion
PGM™ and Ion Proton™

analyses).
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Parameter Default Description

--barcode-filter 0.01

(Float)

Barcode frequency
threshold to be reported in
the UI. The relative
frequency of a barcode is the
number of assigned reads
divided by number of reads
assigned to the most
frequent barcode.

Set to 0.0 to turn this filter
off. The setting 0.0 causes
all barcodes in the barcode
set to be reported in the UI,
including barcodes with no
or very few reads, provided
that the barcode group has
at least --barcode-
filter-minreads
number of reads. (Typically
barcodes with no or very few
reads are not relevant to
your analysis and should be
filtered out.)

--barcode-filter-minreads 20

(INT)

Threshold for the minimum
number of reads in a
barcode group, for that
group to be reported in the
UI.

--trim-barcodes on Trim barcode and barcode
adapter. If off, disables all
other 5’ trimming.

--barcode-adpter-check 0.15 Validate barcode adapter
sequence. The parameter
given is the maximum
allowed squared residual
per flow. This feature
reduces barcode set cross
contamination, e.g., between
the IonXpress and IonCode
barcode sets. (0=off)

Notes about the --barcode-cutoff parameter with --barcode-mode 1:
• 0 is the most restrictive setting. --barcode-cutoff 0 allows only reads that

perfectly match a barcode in base space.
• The setting 0 works with any barcode set (both Ion Torrent™ sets and custom

barcode sets).
• Do not set --barcode-cutoff greater than 2 with the IonXpress barcode set.

Values greater than 2 relax the classification rules and allow incorrect barcode
assignments.

The cutoff setting
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A rule of thumb for the maximum --barcode-cutoff setting is based on the
minimum distance of the barcode set in flow space:

T he minimum distance for the IonXpress barcode set is 5. Then the maximum
recommended value for --barcode-cutoff is 2 for analyses that use the IonXpress
barcode set.

Notes about the --barcode-separation parameter:
• Larger values (close to the minimum distance of the code) require more strict

matching of the predicted signal for a read to be assigned to a barcode.
• Smaller values (for example, 0.2 and below) allow barcode assignment with an

expanded tolerance for errors. For example in the extreme case of separation=0,
the measured signal may be right in between two predicted barcode signals.

• If --barcode-separation is set at or above the minimum distance of the
barcodes in flow space, no reads at all are assigned to a barcode.

• If --barcode-separation is set close to the minimum distance of the barcodes
in flow space, very few reads are assigned to a barcode.

• If --barcode-separation is too small, the risk of cross contamination
increases. More ambiguous reads are forced into a barcodeassignment (with a
higher rate of error in these assignments).

A rule of thumb for a good --barcode-separation setting is one half of the
minimum distance of the barcode set in flow space:

This table lists the public BaseCaller parameters that are available for you to modify.
However, please note that the defaults for these parameters are optimized for most
scenarios and in most cases the default settings are recommended.

Parameter Default Description

-d, or

--disable-all-filters

off When on, disables all
filtering and trimming
and overrides other
filtering and trimming
settings.

-k, or

--keypass-filter

on When on, filters out
reads that do not both
produce a signal and
match the library key
(or the test fragment
key).

The separation
setting

Other public
parameters
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Parameter Default Description

--min-read-length 25

(Int)

F ilters out reads less
than this minimum read
length.

This filter screens out
poor reads early on to
avoid wasting
processing time on
them. See also --
trim-min-read-
len, which sets the
minimum length
threshold that is applied
after trimming.

--prefix-mol-tag Empty Base structure of 5’
unique molecular tag
(ACGTN bases) to be
trimmed after the
barcode adapter.

--suffix-mol-tag Empty Base structure of 5’
unique molecular tag
(ACGTN bases) to be
trimmed before P1
adapter.

--extra-trim-left 0

(Int)

Trims this number of
bases beyond the
barcode adapter and the
5' unique molecular tag
(if applicable).

--extra-trim-right 0 Trims this number of
bases at the 3' end of
the template before the
3' unique molecular tag
(if applicable) and the
P1 adapter. Only done if
P1 adapter was found.

--trim-adapter-cutoff 16

( Float)

A score cutoff value.

Smaller values
correspond to more
stringent adapter
search and larger
values to less stringent
adapter search.

Set to 0 to turn off.

--trim-adapter-min-
match

6

(Int)

The minimum number
of P1 adapter bases
required in order to trim
the P1 adapter.
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Parameter Default Description

--trim-qual-window-
size

30

( Int)

Window size for quality
trimming.

--trim-qual-cutoff 16

( Float)

Cutoff for quality
trimming.

Set to 100 to turn off.
When set to 100, no
reads are filtered out
due to this parameter.

--trim-min-read-len 25

(Int)

Filters out any
readsthat fall below this
minimum read length
after anytrimming step.
By default it is initialized
with the value of 'min-
read-length'.

BaseCaller filters

The BaseCaller module and its parameter settings control these types of filtering:
• Keypass
• Quality trimming
• Adapter trimming

With these examples:
• Do not remove the string "BaseCaller" from the Basecaller Args field.
• Do not change BaseCaller parameters other than those listed in the basic table or

the public table (unless specifically directed to do so by Ion).

TMAP Modules

The Torrent Mapping Alignment Program (TMAP) is a sequence alignment software
program optimized specifically for Ion Torrent™ data. TMAP contains several
mapping algorithms, each with its own best application. TMAP's current default is
map4.

When you reanalyze a run, you can optionally change both the TMAP module ( map1,
map2, map3,map4, or mapvsw) and also change the module's parameters.

Note: The default TMAP parameters are tuned for Ion data. In most cases, you do not
need to modify these settings. Modifying these parameters is recommended for
advanced users.

Examples of
BaseCaller
parameters usage
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This table lists the mapping alternatives supported by TMAP. The map4 module is the
default. (Other modules are not run unless specifically called, for instance on the
Reanalyze page.)

Click the module name link to see the options supported for that module.

Module Description

map1 BWA-short reads mapping

• Very fast at finding perfect matches

• Very slow at finding a set of matches
with up to two mismatches

map2 BWA-long / BWASW reads mapping

map3 Simplified SSAHA, based on a k-mer lookup
table

map4 Based on the BWA fastmap routine

Searches for the maximum exact matches
between the reads and reference

mapvsw A vectorized implementation of Smith-
Waterman

• A single mapping strategy that is twice
as fast as the other modules

• Modified to improve specificity

mapall A command to quickly map short
sequences to a reference genome.

See “TMAP examples“ on page 544 for steps to open the run report log and search
for the TMAP command. (The analysis must be completed before you can find the
command.)

This example is the current default setting. Only the map4 module is used.

tmap mapall ? -f /results/referenceLibrary/tmap-f3/hg19/
hg19.fasta -r /<server_path>/results/analysis/output/Home/
Auto_user_G35-685--R65832-110mM_K2SO4-
OT_salts-0630_24057_58335/IonXpress_057_rawlib.bam -v -Y -u --
prefix-exclude 5 -o 2 stage1 map4

This example is the previous TMAP default. This example uses the modules map1,
map2, and map3, in that order. Progressively more reads are mapped by each module.

tmap mapall  f <FASTA_file> -v -Y -u --prefix-exclude 5 stage1 
map1 map2 map3

Mapping modules

Find the TMAP
command for a
specific analysis

TMAP examples
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Option alternate option Type Default Description

-f --fn-fasta FILE [ no default ] FASTAreference
file

-r --fn-reads FILE Standardinput
(stdin)

The reads file
name

-i --reads-format STRING Unknown The reads file
format(fastq | fq
| fasta | fa | sff |
sam | bam)

-s ---fn-sam FILE Standardoutput
(stdout)

The SAM file
name

--bam-start-vfo INT 0 Sets the starting
virtual file
offsets that limit
the range of
BAM reads to
process

-A --score-match INT 1 Score for a
match

-M --pen-mismatch INT 3 Mismatch
penalty

-O --pen-gap-open INT 5 Indel start
penalty

-E --pen-gap-
extension

INT 2 Indel extension
penalty

-G --pen-gap-long INT -1 Long
indelpenalty

Option alternate option Type Default Description

-Q --pairing INT 0 The insert
pairing:

• 0 Do not
perform
pairing

• 1 Mate
pairs (-S 0 -
P 1)

• 2 Paired
end (-S 1 -P
0)

INT -1

INT -1

Global options
used by all TMAP
modules

Global pairing
options
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Option alternate option Type Default Description

FLOAT -1.0

FLOAT -1.0

This page describes the parameters for the TMAP map1 module. The map1 module
implements BWA-short reads mapping and has these characteristics:

• map1 is very fast at finding perfect matches
• map1 is very slow at finding a set of matches with up to two mismatches

Note: The map1 module is not the current default for TMAP.

Options supported with the TMAP map1 module (all are optional):

--seed-length INT 32
The k-mer length to

seed CALs (-1 to
disable)

--seed-max-diff INT 2 The maximum
number of edits in
the seed

--seed2-length INT 48 The secondary seed
length (-1 to disable)

--max-diff NUM 0.04 The maximum
number of edits or
false-negative
probability assuming
the maximum error
rate

--max-error-rate FLOAT 0.02 The assumed per-
base maximum error
rate

--max-mismatches NUM 3 The maximum
number of or (read
length) fraction of
mismatches

--max-gap-opens NUM 1 The maximum
number of or (read
length) fraction of
indel starts

--max-gap-
extensions

NUM 6 The maximum
number of or (read
length) fraction of
indel extensions

--max-cals-deletion INT 10 The maximum
number of CALs to
extend a deletion

TMAP map1
Options
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--seed-length INT 32
The k-mer length to

seed CALs (-1 to
disable)

--indel-ends-bound INT 5 The number of bps
from the end of the
read

--max-best-cals INT 32 Optimal CALs have
been found

--max-nodes INT 2000000 The maximum
number of alignment
nodes

--min-seq-length INT -1 The minimum
sequence length to
examine (-1 to
disable)

--max-seq-length INT -1 The maximum
sequence length to
examine (-1 to
disable)

Option Type Default Description

This page describes the parameters for the TMAP map2 module. The map2 module
implements BWA-long / BWASW reads mapping.

Note: The map2 module is not the current default for TMAP.

Options supported with the TMAP map2 module (all are optional):

Option Type Default Description

--max-seed-hits INT 1024 The maximum
number of hits
returned by a seed

--length-coef FLOAT 5.5 The coefficient of
length-threshold
adjustment

--max-seed-intv INT 6 The maximum
seeding interval size

--z-best INT 1 The maximum
number of top-
scoring nodes to
keep on each
iteration

--seeds-rev INT 5 The number of seeds
to trigger reverse
alignment

TMAP map2
Options
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Option Type Default Description

--narrow-rmdup INT false Remove duplicates
for narrow SA hits

--max-chain-gap INT 10000 The maximum gap
size during chaining

--min-seq-length INT -1 The minimum
sequence length to
examine (-1 to
disable)

--max-seq-length INT -1 The maximum
sequence length to
examine (-1 to
disable)

This page describes the parameters for the TMAP map3 module. The map3 module
implements a simplified SSAHA, based on a k-mer lookup table.

Note: The map3 module is not the current default for TMAP.

Options supported with the TMAP map3 module (all are optional):

Option Type Default Description

--seed-length INT -1 The k-mer length to
seed CALs (-1 to
disable)

--max-seed-hits INT 20 The maximum
number of hits
returned by a seed

--hit-frac FLOAT 0.2 The fraction of seed
positions that are
under the maximum

--seed-step INT 8 The number of bases
to increase the seed
for each seed
increase iteration (-1
to disable)

--hp-diff INT 0 The single
homopolymer error
difference for
enumeration

--fwd-search Boolean false Use forward search
instead of a reverse
search

--skip-seed-frac FLOAT 0.2 The fraction of a
seed to skip when a
lookup succeeds

TMAP map3
Options
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Option Type Default Description

--min-seq-length INT -1 The minimum
sequence length to
examine (-1 to
disable)

--max-seq-length INT -1 The maximum
sequence length to
examine (-1 to
disable)

This page describes the parameters for the TMAP map4 module. The map4 module is
based on the BWA fastmap routine and searches for the maximum exact matches
between the reads and reference.

Note: The map4 module is the current default for TMAP.

Options supported with the TMAP map4 module (all are optional):

Option Type Default Description

--context -- off Modifies the gap
penalty in
homopolymers to
achieve more
accurate alignments

--do-repeat-clip -- off Clips repetitive
sequence ends of
aligned reads

--hit-frac FLOAT 0.2 The fraction of seed
positions that are
under the maximum

--end-repair INT 0 Rescues false
negatives by
selectively forcing
alignment at the 3'
end of the read. The
recommended value
is 15.

--J INT off 2147483647 Rescues false
negatives by
selectively forcing
alignment at the 3'
end of the read. The
recommended value
is 25.

--seed-step INT 8 The number of bases
to increase the seed
for each seed
increase iteration (-1
to disable)

TMAP map4
Options
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Option Type Default Description

--min-seed-length INT -1 The minimum seed
length to accept hits
(-1 to disable)

--max-seed-length INT 48 The maximum seed
length to accept hits

--max-seed-length-
adj-coef (-1 to
disable)

FLOAT 2.0 maximum seed
length adjustment
coefficient (-1 to
disable)

--max-iwidth INT 20 The maximum
interval size to
accept a hit

--max-repr INT 3 The maximum
representative hits
for repetitive hits

--rand-repr INT false Choose the
representative hits
randomly. Otherwise
uniformly

--use-min Boolean false When seed stepping,
try seeding when at
least the minimum
seed length is
present. Otherwise,
use the maximum
seed length.

--min-seq-length INT -1 The minimum
sequence length to
examine (-1 to
disable)

--max-seq-length INT -1 The maximum
sequence length to
examine (-1 to
disable)
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This page describes the parameters for the TMAP mapvsw module. The mapvsw
module implements a vectorized implementation of Smith-Waterman.

Note: The mapvsw module is not the current default for TMAP.

Options supported with the TMAP mapvsw module (all are optional):

Option Type Default Description

--min-seq-length INT -1 The minimum
sequence length to
examine (-1 to
disable)

--max-seq-length INT -1 The maximum
sequence length to
examine (-1 to
disable)

TMAP mapvsw
Options

Reference
TMAP Modules
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Troubleshooting

Handle a failed analysis run

If an analysis run fails, you need to attempt to determine the cause of the failure an,
possibly, restart the run.

Determine the Fault Cause

If an analysis run fails, make the following checks:

1. Has the Ion PGM™ or Ion Proton™ Sequencer completely transferred the data for
the run? Go to the sequencer Data Management screen to verify complete data
transfer. You can re-transfer the data if you are not sure it was completely
transmitted.

2. Go to the Torrent Browser Data > Completed Runs & Reports tab and see that
the file transfer was complete. Also, check if there are any error messages, such
as User Aborted. Look for a status of Error or Pending.

3. If the report was generated, check if there are any messages on the report itself.

4. Click the Support link towards the bottom of the run report (above the Plugin
Summary row of buttons). Click View the Report Log or Download the
Customer Support Archive. You can send the customer support archive to your
Ion Torrent™ contact for review.

5. If you cannot determine the cause of the fault, try restarting the run.
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